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About this guide

This guide provides task-oriented information for administrative users of IBM Copy Services Manager.
The Copy Services Manager family of products consists of the following licenses:

- IBM Copy Services Manager
« IBM Copy Services Manager for z Systems®
« IBM Copy Services Manager Basic Edition for z Systems

Who should read this guide

This publication is for users of Copy Services Manager.

Users should be familiar with the following topics:

« Copy Services concepts

« General principles of IBM AIX®, Linux®, Windows, and the IBM z/0OS® operating systems
« Simple Network Management Protocol (SNMP) concepts

« Storage Area Network (SAN) concepts

Conventions used in this guide

Explanations are provided about the conventions that are used in this publication.

This publication uses several conventions for special terms and actions, and for operating system-
dependent commands and paths.

The following typeface conventions are used in this publication:

Bold
- Flags that display with text
« Graphical user interface (GUI) elements (except for titles of windows and dialogs)
- Names of keys

Italic

- Variables
- Values that you must provide
« New terms
« Words and phrases that are emphasized
- Titles of documents
monospace

« Commands and command options

 Flags that display on a separate line

« Code examples and output

« Message text

« Names of files and directories

- Text strings that you must type, when they display within text

» Names of Java™ methods and classes

« HTML and XML tags that display 1ike this, in monospace type

© Copyright IBM Corp. 2005, 2022 xiii



For syntax notations, remember the following details.

« In AIX, the prompt for the root user is #.

« In AIX and Linux, the commands are case-sensitive, so you must type commands exactly as they are
shown.

Publications and related information

Product guides, other IBM publications, and websites contain information that relates to IBM Copy
Services Manager.

To view a PDF file, you need Adobe Reader. You can download it at no charge from the Adobe website
(get.adobe.com/reader/).

Online documentation

The IBM Copy Services Manager online product documentation (http:/www.ibm.com/support/
knowledgecenter/SSESK4) contains all of the information that is required to install, configure, and
manage IBM Copy Services Manager. The online documentation is updated between product releases
to provide the most current documentation.

Publications

You can order or download individual publications that have an order number from the IBM Publications
Center website (www.ibm.com/resources/publications).

Table 1. IBM Copy Services Manager product publications

Title Description Order number

IBM Copy Services This guide provides task-oriented V6.2.11 SC27-8543-14

Manager Installation and | information for anyone who installs |V6.2.10 SC27-8543-13

Configuration Guide and configures IBM Copy Services V6.2.9 SC27-8543-12
Manager. V6.2.7 SC27-8543-11

V6.2.6 SC27-8543-10
V6.2.5 SC27-8543-09
V6.2.3 SC27-8543-08
V6.2.2 SC27-8543-07
V6.2.1 SC27-8543-06
V6.2.0 SC27-8543-05
V6.1.5 SC27-8543-04
V6.1.4 SC27-8543-03
V6.1.3 SC27-8543-02
V6.1.2 SC27-8543-01
V6.1.0 SC27-8543-00
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Table 1. IBM Copy Services Manager product publications (continued)

Title

Description

Order number

IBM Copy Services
Manager User's Guide

This guide provides task-oriented
information for users of IBM Copy
Services Manager. Users should be
familiar with the following topics

» Copy Services concepts

» General principles of IBM AIX,
Linux, Windows, and the IBM z/0S
operating systems

« Simple Network Management
Protocol (SNMP) concepts

» Storage Area Network (SAN)
concepts

V6.3.2 SC27-8542-22
V6.3.1 SC27-8542-21
V6.3.0.1 SC27-8542-20
V6.3.0 SC27-8542-19
V6.2.12 SC27-8542-18
V6.2.11 SC27-8542-17
V6.2.10 SC27-8542-16
V6.2.9 SC27-8542-15
V6.2.8 SC27-8542-14
V6.2.7 SC27-8542-13
V6.2.6 SC27-8542-12
V6.2.5 SC27-8542-11
V6.2.4 SC27-8542-10
V6.2.3 SC27-8542-09
V6.2.2 SC27-8542-08
V6.2.1 SC27-8542-07
V6.2.0 SC27-8542-06
V6.1.5 SC27-8542-05
V6.1.4 SC27-8542-04
V6.1.3 SC27-8542-03
V6.1.2 SC27-8542-02
V6.1.1 SC27-8542-01
V6.1.0 SC27-8542-00

IBM Copy Services

Manager Command-line

Interface User's Guide

This guide provides information

for customizing and using the
command-line interface for IBM
Copy Services Manager. This guide
provides information for customizing
and using the command-line
interface for IBM Copy Services
Manager.

V6.3.2 SC27-8998-15
V6.3.1 SC27-8998-14
V6.3.0.1 SC27-8998-13
V6.3.0 SC27-8998-12
V6.2.12 SC27-8998-11
V6.2.11 SC27-8998-10
V6.2.9 SC27-8998-09
V6.2.8 SC27-8998-08
V6.2.7 SC27-8998-07
V6.2.5 SC27-8998-06
V6.2.4 SC27-8998-05
V6.2.3 SC27-8998-04
V6.2.2 SC27-8998-03
V6.2.1 SC27-8998-02
V6.2.0 SC27-8998-01
V6.1.5 SC27-8998-00

IBM Copy Services

Manager z/OS FlashCopy

Manager User's Guide

This guide provides task-oriented
information for those who
administer FlashCopy® operations in
a z/0S environment.

V6.3.0.1 SC27-8032-06
V6.2.5 SC27-8032-05
V6.2.3 SC27-8032-04
V6.2.2 SC27-8032-03
V6.2.0 SC27-8032-02
V6.1.5 SC27-8032-01
V6.1.3 SC27-8032-00

IBM Copy Services
Manager Release Notes

This document contains the release
notes in support of IBM Copy
Services Manager.

Search on IBM Copy Services Manager

at IBM Fix Central (www.ibm.com/support/
fixcentral) to locate and download the
Release Notes® related to your product
version.
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Table 1. IBM Copy Services Manager product publications (continued)

Program Directory and IBM
Copy Services Manager
Basic Edition for z Systems
Program Directory

who are responsible for program
installation and maintenance.

They contain information about the
material and procedures associated
with the installation of IBM Copy
Services Manager for z Systems and
IBM Copy Services Manager Basic
Edition for z Systems.

Title Description Order number
IBM Copy Services These program directories are IBM Copy Services Manager for z Systems
Manager for z Systems intended for system programmers Program Directory

V6.3.0 GI13-4517-09
V6.2.5 GI13-4517-08
V6.2.3 GI13-4517-07
V6.2.2 GI13-4517-06
V6.2.1 GI13-4517-05
V6.2.0 GI13-4517-04
V6.1.4 GI13-4517-03
V6.1.3 GI13-4517-02
V6.1.1 GI13-4517-01
V6.1.0 GI13-4517-00

IBM Copy Services Manager Basic Edition for

z Systems Program Directory
V6.3.0 GI13-4518-09
V6.2.5 GI13-4518-08
V6.2.3 GI13-4518-07
V6.2.2 GI13-4518-06
V6.2.1 GI13-4518-05
V6.2.0 GI13-4518-04
V6.1.4 GI13-4518-03
V6.1.3 GI13-4518-02
V6.1.1 GI13-4518-01
V6.1.0 GI13-4518-00

Program Directory for IBM
Copy Services Manager

This guide is intended for the
system programmer or storage

V6.3.0 GI11-2904-09
V6.2.5 GI11-2904-08

Program Directory

for system programmers who are
responsible for program installation
and maintenance.

It contains information about the
material and procedures associated
with the installation of the IBM Copy
Services Manager on the DS8000°
HMC for access to the DS8000 CLI.

FlashCopy Manager for administrator of the IBM Copy V6.2.3 GI11-2904-07
IBM Copy Services Services Manager z/0S FlashCopy V6.2.2 GI11-2904-05
Manager for z Systems Manager utility. V6.2.1 GI11-2904-04
V6.2.0 GI11-2904-03
Vé6.1.4 GI11-2904-02
V6.1.3 GI11-2904-01
IBM DSCLI on z/OS This program directory is intended V6.3.0 GI13-3563-06

V6.2.5 GI13-3563-05
V6.2.3 GI13-3563-04
V6.2.2 GI13-3563-03
V6.2.1 GI13-3563-02
V6.2.0 GI13-3563-01
V6.1.4 GI13-3563-00

Related websites

View the websites in the following table to get more information about IBM Copy Services Manager.

Table 2. IBM Copy Services Manager related websites

Title

Description

IBM website (ibm.com®)

Find more information about IBM products

and services.
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Table 2. IBM Copy Services Manager related websites (continued)

Title Description

IBM Support Portal website (www.ibm.com/support/ Find support-related information

home) such as downloads, documentation,
troubleshooting, and service requests and
PMRs.

Copy Services Manager Support Portal (https://ibm.biz/ Find technical support information that is

Bdqgrwj) specific to IBM Copy Services Manager.

IBM Directory of Worldwide Contacts website Find contact information for general

(www.ibm.com/planetwide) inquiries, technical support, and hardware

and software support by country.

IBM Redbooks® website (www.redbooks.ibm.com/) Find technical information developed and
published by IBM International Technical
Support Organization (ITSO).

IBM System Storage® Interoperation Center (SSIC) website | Find information about supported host
(www.ibm.com/systems/support/storage/config/ssic) system models, operating systems,
adapters, and switches.

IBM Fix Central (www.ibm.com/support/fixcentral) Find fixes and updates for your system's
software, hardware, and operating system.

Sending comments
Your feedback is important in helping to provide the most accurate and highest quality information.

To submit any comments about this publication or any other IBM storage product documentation:
« Send your comments by email to ibmkc@us.ibm.co. Be sure to include the following information:

Exact publication title and version
Publication form number (for example, GA32-1234-00)
Page, table, orillustration numbers that you are commenting on

A detailed description of any information that should be changed

Contacting IBM Software Support

You can contact IBM Software Support by phone, and you can register for support notifications at the
technical support website.

- Go to the Copy Services Manager technical support website at Copy Services Manager Support Portal
(https://ibm.biz/Bdqgrwj).

To receive future support notifications, sign in under Subscribe to support notifications. You are
required to enter your IBM ID and password. After you are authenticated, you can configure your
subscription for Copy Services Manager technical support website updates.

You can also review the IBM Software Support Handbook, which is available at http://
www14.software.ibm.com/webapp/set2/sas/f/handbook/home.html.

The support website offers extensive information, including a guide to support services; frequently asked
qguestions (FAQs); and documentation for all IBM Software products, including Redbooks and white
papers. Translated documents are also available for some products.

When you contact IBM Software Support, be prepared to provide identification information for your
company so that support personnel can readily assist you. Company identification information might also
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be needed to access various online services available on the website. See “Reporting a problem” on page
Xviii.

Reporting a problem

Provide the IBM Support Center with information about the problems that you report.

Have the following information ready when you report a problem:

The IBM Copy Services Manager version, release, modification, and service level number.
The communication protocol (for example, TCP/IP), version, and release number that you are using.

The activity that you were doing when the problem occurred, listing the steps that you followed before
the problem occurred.

The job log output for any failing IBM Copy Services Manager jobs.
The exact text of any error messages.

The operating system, such as z/0S, IBM i.

The storage system, such as DS8000, SVC, Hitachi.

The function, such as FCM, CSM.
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Summary of changes

The following functions are introduced in IBM Copy Services Manager 6.3.2:

Version 6, Release 3, Modification 2

This table provides the current technical changes and enhancements to Copy Services Manager as of

March 2022.

Table 3. Summary of changes in Copy Services Manager 6.3.2 (March 2022)

Function or feature

Description

Support new CLI command to display volume
summary counts

A new CLI command, 1svolcounts, enables you to
view the volumes relationship summary.

New feature to rename a session from CLI
and GUI

You can rename a session by using the CLI and the

GUL. In the CLI command, you rename a session using
the -name new_session_name parameter in the chsess
command. For more information see, “Renaming a
session” on page 211.

Run an external script

Create a scheduled task action to SSH to a remote
server to issue a specific command on that server. This
can be used for external actions such as quiescing an
application before taking a FlashCopy or a Safeguarded
Copy backup. For more information, see “Creating
scheduled tasks” on page 212.

New feature to support auxiliary storage
systems migration to newer DS8000 storage
systems

You can now migrate your auxiliary storage systems
to newer DS8000 systems. For more information, see
“Migrating a secondary storage system to a newer
DS8000” on page 220.

Copy Services Manager automatic handling
when a DS8000 Global Mirror Master logical
subsystem (LSS) is deleted.

Global Mirror sessions will now alert customers when
the Master Logical Subsystem (LSS) cannot be reached
and automatically change to a new Master LSS, if the
LSS is no longer being managed by the session.

Copy Services Manager leaves base
relationships on the hardware when a Storage
system is removed with active sessions on the
server.

This prevents the need to do a full copy of the data.

Log4|is updated fromvltov 2.17.1

This update resolves known vulnerabilities in log4j.

© Copyright IBM Corp. 2005, 2022
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Chapter 1. Product overview

Copy Services Manager controls copy services in storage environments. Copy services are features that
are used by storage systems such as IBM DS8000 to configure, manage, and monitor data-copy functions.
Copy services include IBM FlashCopy, Metro Mirror, Global Mirror, and Metro Global Mirror.

Copy Services Manager runs on Windows, AIX, Linux, Linux on z Systems, and z/0OS operating systems.
When it is running on z/0S, Copy Services Manager uses the Fibre Channel connection (FICON®) to
connect to and manage count-key data (CKD) volumes.

You can use Copy Services Manager to complete the following data replication tasks and help reduce the
downtime of critical applications:

« Plan for replication when you are provisioning storage

« Keep data on multiple related volumes consistent across storage systems if there is a planned or
unplanned outage

« Monitor and track replication operations
- Automate the mapping of source volumes to target volumes

Copy Services Manager product family

The IBM Copy Services Manager family of products consists of the following products: Copy Services
Manager, Copy Services Manager for z Systems and Copy Services Manager Basic Edition for z Systems.

These products provide the following features:

« Copy Services Manager provides high availability and disaster recovery for multiple sites.
« Copy Services Manager for z Systems provides high availability and disaster recovery for multiple sites.

- Copy Services Manager Basic Edition for z Systems provides high availability for a single site if a disk
storage system failure occurs.

Copy Services Manager

The fully licensed version of Copy Services Manager provides all supported FlashCopy, Metro Mirror,
Global Copy, Global Mirror, Metro Global Mirror, and multi-target solutions.

Copy Services Manager for z Systems

The fully licensed version of Copy Services Manager provides all supported FlashCopy, Metro Mirror,
Global Copy, Global Mirror, Metro Global Mirror, and multi-target solutions.

Copy Services Manager Basic Edition for z Systems

Copy Services Manager Basic Edition for z Systems supports a Basic HyperSwap® session type on DS8000
hardware and FlashCopy sessions across any supported hardware platform.

Supported languages
The Copy Services Manager GUI supports several languages.
These languages are supported:
« Chinese (zh-CN)
« Czech (cs)
« French (fr)
« German (de)
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« Hungarian (hu)

« Ttalian (it)

- Japanese (ja)

« Korean (ko)

« Polish (pl)

« Portuguese - Brazil (pt-BR)
 Russian (ru)

« Spanish (es)

Interfaces for Copy Services Manager

Copy Services Manager provides a graphical user interface (GUI) and a command-line interface (CLI) for
managing data replication and disaster recovery.

Graphical user interface

The Copy Services Manager GUI contains the following components:

Menu bar
Use the menu bar to complete tasks, such as navigating the GUI, identifying the ID for the user who is
logged on to the GUI, logging out of the GUI, and finding help and other product information.

Navigation
The menu bar contains items that open individual pages in the GUI. For example, if you click
Sessions, the Session page opens. If you click Storage > Storage Systems, the Storage Systems
page opens. To view the items that are in a menu, hover the mouse pointer over the menu.

You can open pages in the GUI by clicking the following items in the menu bar:

Overview
Click this item to open the Overview page. This page shows a status summary for all sessions,
storage systems, host systems, and management servers that Copy Services Manager is
managing.
The Overview page is displayed when you log on to the GUI.

Sessions
Click this item to open the Sessions page. Use this page to create and manage sessions.

Storage > Storage Systems
Click either of these items to open the Storage Systems page. Use this page to create and
manage storage system connections and to configure the use of the IBM DS8000 Easy Tier®
heat map transfer function.

Storage > Host Connections
Click this item to open the Host Connections page. Use this page to create and manage
connections to host systems.

Storage > Volumes
Click this item to open the Volumes page. Use this page to view the volumes that are
associated with a storage system.

Paths or Paths > ESS/DS Paths
Click either of these items to open the ESS/DS Paths page. Use this page to view and manage
paths between source logical subsystems and target logical subsystems for TotalStorage
Enterprise Storage Server® Model 800 and IBM DS8000 storage systems.

Console
Click this item to open the Console window. Use this window to view detailed information
about actions that are taken by users, errors that occur during normal operation, and hardware
error indications.
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Settings > Advanced Tools
Use this page to perform several actions, including:

 Set user preferences for what language to use.

« Create a log file package for diagnostic purposes.

 Create a backup of the server configuration.

« Change the automatic refresh rate of the GUL.

« Enable or disable the Metro Mirror heartbeat for DS8000 storage systems.
« Export a license to enable another server.

Note: This section only appears after a license has been applied.
» Export the truststore file for remote connections.
 Synchronize the truststore file with another server.
Settings > Management Servers

Click this item to open the Management Servers page. Use this page to manage the active and
standby management servers in a high-availability relationship.

Settings > Administration
Click this item to open the Administration page. Use this page to view and manage the users
and user groups for Copy Services Manager and their access privileges.

If one or more of the components that are shown on the GUI page have an Unknown, Severe, or
Warning status, one of the following icons is displayed next to the item in the menu bar:

« Unknown status @
» Severe status Q
- Warning status i

If there are multiple components on a page and the components have different statuses, the
highest level status icon is displayed next to the item in the menu bar. Unknown is the highest
level status and Warning is lowest.

User ID
The user ID shows who is logged on to the GUI. An icon next to the user ID indicates the user role.
To view the role, hover over the icon.

To change the user password, hover over the user ID and click Edit Password.
To log out of the GUI, hover over the user ID and click Log Out.

Help icon
The Help icon a provides the links to the following items:
« Online help for the active page, window, or notebook in the GUI.
 Production documentation.
« Information about the product.

Breadcrumb
The breadcrumb shows your location in the GUI. You can click an element in the breadcrumb to jump
to the corresponding location in the GUI.

For example, when you view the details page for a session, the following breadcrumb is displayed:
Sessions > Session Name. To return to the Sessions page, click Sessions in the breadcrumb.

Content area
The content area displays a page that represents to the component that you selected in the menu bar.

Dynamic images
The GUI provides dynamic images that show the status of the sites and role pairs that are in
the session. The images present a pictorial view of information such as the status, progress, and
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direction of the replication between sites. It also shows whether volumes are consistent between
sites. Consistent volumes are blue, while inconsistent volumes are gray.

Data copying symbols indicate the type of copy that occurs between the sites and the status of the
copy. The direction that the symbol is displayed in the GUI depends on the direction of the copy.
For example, Figure 1 on page 4 represents a FlashCopy session. The FlashCopy operation occurs
from the H1 volumes to the T1 volumes as indicated by the lightning bolt symbol. The symbol is
gray because the FlashCopy operation is inactive and the T1 volumes are gray because they are not
consistent.

Figure 1. Example of a FlashCopy session

Command-line interface

You can use the Copy Services Manager CLI by using the csmc1i utilities. You can access the CLI directly
or as a script to automate functions.

RESTful interface

Staring with Copy Services Manager 6.2.9, the online help also integrates with the RESTful
(Representational State Transfer) API.

The RESTful API is a platform independent means by which to initiate create, read, update, and delete
operations to the Copy Services Manager server. These operations are initiated with the HTTP commands:
POST, GET, PUT, and DELETE. The RESTful API is intended for programmatically managing a replication
environment managed by Copy Services Manager. You can use the RESTful API with a CURL command or
through standard Web browsers.

The RESTful API is located in the Reference section of the IBM Copy Services Manager online product
documentation (http://www.ibm.com/support/knowledgecenter/SSESK4).

Key concepts

To help you understand and use Copy Services Manager effectively, an overview of key concepts is
provided.

Management server

The management server is a server that has Copy Services Manager installed. The management server
provides a central point of control for managing data replication.

For more information about the management server, see “Management servers” on page 37.
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Storage systems

A storage system is a hardware device on which data is stored. Copy Services Manager can control data
replication within and between various storage systems.

To replicate data among storage systems by using Copy Services Manager, you must manually add a
connection to each storage system in the Copy Services Manager configuration.

For more information about the storage systems that you can use with Copy Services Manager, see
“Storage systems” on page 41.

Host systems

A host system for Copy Services Manager is an IBM z/0S system that connects to storage systems to
enable certain replication features for those systems.

A connection to a z/OS host system is required if you want to enable z/OS features, such as HyperSwap
and hardened freeze in Copy Services Manager sessions.

You can add z/OS host connections in Copy Services Manager regardless of the operating system on which
the application is installed. For example, you can add a connection to a z/OS host in a Copy Services
Manager instance that is running on Windows, Linux, or AIX.

For more information about the host systems and how to manage them in Copy Services Manager, see
Chapter 5, “Managing host systems,” on page 59.

Ports

The ports that are used by Copy Services Manager are used for the graphical user interface (GUI), the
command-line interface (CLI), connecting to storage systems, and for connecting between an active and a
standby Copy Services Manager server.

Copy Services Manager

Port numbers are defined during the installation of Copy Services Manager. To determine the port number
for the ports that are used for Copy Services Manager, refer to the following table.

Table 4. Where to find Copy Services Manager port numbers

Copy Services Manager component Location of port information

Web browser To view the port number for the web browser, open
the bootstrap.properties file in the main
Copy Services Manager directory for distributed
systems, which is install
dir\liberty\wlp\usr\servers\csmServer\
properties. On z/0S systems, the directory is
path_prefix/opt/IBM/CSM/wlp/usx/
servers/csmServer/properties.

Standby management server To view the port number for each management
server, click Management Servers in the
navigation pane of the Copy Services Manager GUI.
You can also run the 1shasexvexrs command from
the command-Lline interface to view the ports for
the management servers.
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Table 4. Where to find Copy Services Manager port numbers (continued)

Copy Services Manager component Location of port information

Client and CLI port To view the port number for the client, click

About in the navigation pane of the Copy Services
Manager GUI. You can also run the whoami
command from the command-line interface to view
the port for the client.

Storage system ports

The following table lists the default ports for each storage system type.

Table 5. Storage system default ports

Storage System Connection Type Port
. DS8000 Direct Connection 2433
« DS8000 Hardware Management 1750 and 1751
Console Connection
. Systems running IBM Spectrum Virtualize | Direct Connection 443 and 22
. Systems running IBM Spectrum Accelerate, | Direct Connection 7778
including:
- XIV

— FlashSystem A9000
— FlashSystem A9000R

Ensure that your network configuration is set up so that Copy Services Manager can send outgoing TCP/IP
packets to the storage controllers.

Because multiple applications are usually running on the management server, it is possible that port
conflicts might arise if other applications attempt to use the same ports that Copy Services Manager uses.
Use the netstat command to verify which ports the various applications on the management server are
using.

When you add a storage system to the Copy Services Manager configuration, the port field is automatically
populated with the appropriate value. You can accept the default port or enter another port number.

If firewalls are being used in your configuration, ensure that none of these ports are being blocked. Also,
ensure that not only is the Copy Services Manager server granted access to reach the other components,
but that the other components are granted access to reach the Copy Services Manager server.

If the management server is running on Windows Server: Configure the inbound and outbound rules for
Copy Services Manager. To create a new outbound rule, start the New Outbound Rule Wizard from the
Windows Firewall with the Advanced Security menu.

Sessions

A session represents a specific set of volumes that is managed by the same copy services solution. The
type of copy services solution that is associated with the session determines the replication actions that
are available for the session. For example, the options for FlashCopy sessions are different from the
options for Metro Mirror sessions.

For more information about sessions, see “Sessions” on page 69.
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Copy sets

During data replication, data is copied from a source volume to one or more target volumes, depending
on the session type. The source volume and target volumes that contain copies of the same data are
collectively referred to as a copy set.

For more information about copy sets, see “Copy sets” on page 69.

Volume roles

A volume role is given to every volume in the copy set. The role defines how the volume is used in the copy
set and, for multi-site sessions, the site location of the volume. For example, the H1 role is made up of
host-attached volumes that are at site 1.

For more information about volume roles, see “Volume roles” on page 72.

Role pairs

A role pair is the association of two volume roles in a session that take part in a copy relationship. For
example, in a Metro Mirror session, the role pair can be the association between host volumes at site 1
and host volumes at site 2 (H1-H2).

The flow of data in the role pair is indicated by an arrow. For example, H1>H2 denotes that H1 is the
source and H2 is the target.

For more information about role pairs, see “Role pairs” on page 73.

Practice volumes

Practice volumes are volumes within a solution that can be used to practice disaster-recovery capability
exactly as if there was a true disaster to recover to the remote site. You can use a practice volume to
practice for disaster recovery without interrupting current data replication. Practice volumes are available
in Metro Mirror, Global Mirror, Metro Global Mirror, and Metro Mirror - Global Mirror sessions.

You can practice disaster recovery actions without using practice volumes. However, without practice
volumes, you cannot continue to copy data changes between volumes while you are practicing.

For more information about practice volumes, see “Practice volumes” on page 74.

Consistency groups

Copy Services Manager sessions are designed to maintain consistency across all the production volumes
contained in a session. When Copy Services Manager refers to a consistency group, it is referring to the
storage system container that the Copy Services Manager session is using to maintain consistency across
all the volumes in the session. A storage system container, such as the DS8000 Global Mirror Master or
the SAN Volume Controller Global Mirror consistency group, is created by Copy Services Manager so that
the storage system knows which pairs to maintain consistency across.

Copy Services Manager automatically assigns an ID to each consistency group on the storage systems.
However, you can choose to assign a custom name to a storage-system consistency group. A custom-
defined name is used to associate multiple sessions with a specific storage-system consistency group.

For more information about consistency groups, see “Working with user-defined consistency groups” on

page 198.

Data exposure

Data exposure is the period when data is written to the storage at the primary site until data is replicated
to storage at the secondary site. Data exposure is influenced by factors such as:

« Requested consistency-group interval time
 Type of storage systems
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 Physical distance between the storage systems
« Available bandwidth of the data link
« Input/output (I/0) load on the storage systems

To manage data exposure, you can change the consistency-group interval time. The consistency-group
time interval specifies how often a Global Mirror and Metro Global Mirror session attempts to form

a consistency group. When you reduce this value, it might be possible to reduce the data exposure

of the session. A smaller interval value causes the session to attempt to create consistency groups
more frequently, which might also increase the processing load and message-traffic load on the storage
systems.

Failover and failback operations

If a session has failover and failback capabilities, you can move the operation of Copy Services Manager
from one site to another, and change the direction of the copy.

Failover is the process of temporarily switching production to a backup facility by following a scheduled
maintenance period or a disaster at a production site. A failover operation can be followed by a failback
operation, which is the process of returning production to its original location and resuming the copy
between the two sites.

For more information about failover and failback operations, see “Failover and failback operations” on
page 74.

Session commands
The commands that are available for a session depend on the session type.

For descriptions of the session commands for each session type, see “Session commands” on page 111.

Session types

Copy Services Manager provides several methods to replicate data. The type of data replication that is
associated with a session is known as the session type.

The session types that are available depend on the storage system type and the edition of Copy Services
Manager that you are using.

HyperSwap

HyperSwap is a copy services solution for IBM z/OS version 1.9 and later. HyperSwap provides high
availability of data if a storage system failure occurs. If an I/O error occurs at the primary site, HyperSwap
technology automatically swaps I/O to a secondary set of volumes with little to no impact to the
customer.

Copy Services Manager supports enabling certain session types with HyperSwap capabilities. These
session types include:

« Metro Mirror

« Metro Global Mirror

« Multi-target session types:
— Metro Mirror - Metro Mirror
— Metro Mirror - Global Mirror
— Metro Mirror - Global Mirror with Practice
— Metro Mirror - Global Mirror with Site 3 Global Mirror
— Metro Mirror - Global Mirror with Site 4 Replication
— Metro Mirror - Metro Mirror with Site 4 Replication
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When enabled for HyperSwap, Copy Services Manager communicates with IBM Z to provide information
on which volumes need to be highly available.

FlashCopy

FlashCopy replication creates a point-in-time copy of the data on a source volume to a target volume.
Data that existed on the target volume is replaced by the copied data.

Snapshot

Snapshot replication creates a point-in-time copy of a volume or set of volumes without having to define
a specific target volume. The target volumes of a Snapshot session are automatically created when the
snapshot is created.

Metro Mirror Single Direction

Metro Mirror is synchronous replication that operates between two sites that are up to 300 km apart. The
source volumes are on one storage system and the target volumes are on another storage system.

Metro Mirror replication maintains identical data in both the source and target volumes. When a write
operation is issued to a source volume, the changes are propagated to the target volume before the write
operation finishes processing.

With the Metro Mirror Single Direction session type, Metro Mirror replication is available only from the
primary site.

Metro Mirror Single Direction sessions are available for the following Copy Services Manager editions and
storage systems.

Metro Mirror Single Direction

Supported editions Supported storage systems

« Copy Services Manager - IBM DS8000
= Systems running IBM Spectrum Virtualize

Metro Mirror Failover/Failback

With Metro Mirror Failover/Failback replication, you can switch the direction of the data flow so that you
can use your secondary site as your production site. You can then copy changes that are made at the
secondary site back to the primary site.

Metro Mirror Failover/Failback sessions are available for the following Copy Services Manager editions and
storage systems.

Table 6. Metro Mirror Failover/Failback

Supported editions Supported storage systems

» Copy Services Manager - IBM DS8000
« Systems running IBM Spectrum Virtualize
= Systems running IBM Spectrum Accelerate,
including:
- XIV
— FlashSystem A9000
— FlashSystem A9000R
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Metro Mirror Failover/Failback with Practice

Metro Mirror Failover/Failback with Practice replication combines Metro Mirror Failover/Failback and
FlashCopy capabilities to provide a point-in-time copy of the data on the secondary site. This session type
provides volumes that you can use to practice for disaster recovery without losing your disaster recovery
capability.

Metro Mirror Failover/Failback with Practice sessions are available for the following Copy Services
Manager editions and storage systems.

Table 7. Metro Mirror Failover/Failback with Practice

Supported editions Supported storage systems

« Copy Services Manager - IBM DS8000
« Systems running IBM Spectrum Virtualize

Metro Mirror Failover/Failback with Change Volumes

Metro Mirror Failover/Failback with Change Volumes replication provides the same capabilities as

the Metro Mirror Failover/Failback session type. However, Metro Mirror Failover/Failback with Change
Volumes sessions also associate change volumes to the primary and secondary to enable consistency
protection during restarts.

Metro Mirror Failover/Failback with Change Volumes sessions are available for the following Copy Services
Manager editions and storage systems.

Table 8. Metro Mirror Failover/Failback with Change Volumes

Supported editions Supported storage systems

« Copy Services Manager - Systems running IBM Spectrum Virtualize

Global Mirror Single Direction

Global Mirror is asynchronous replication that operates between two sites that are over 300 km apart. The
source volumes are on one storage system and the target volumes are on another storage system.

Global Mirror replication maintains identical data in both the source and target volumes. When a write
operation is issued to a source volume, the changes are typically propagated to the target volume a few
seconds after the data is written to the source volume.

With the Global Mirror Single Direction session type, Global Mirror replication is available only from the
primary site.

Global Mirror Single Direction sessions are available for the following Copy Services Manager editions and
storage systems.

Table 9. Global Mirror Single Direction

Supported editions Supported storage systems

« Copy Services Manager - IBM DS8000
= Systems running IBM Spectrum Virtualize

Global Mirror Either Direction

With Global Mirror Either Direction replication, you can run Global Mirror replication from either the
primary or secondary site.
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Global Mirror Either Direction sessions are available for the following Copy Services Manager editions and
storage systems.

Table 10. Global Mirror Either Direction

Supported editions Supported storage systems

« Copy Services Manager - IBM DS8000

Global Mirror Either Direction with Two-Site Practice

With Global Mirror Either Direction with Two-Site Practice replication, you can run Global Mirror
replication from either the primary or secondary site. This session type provides volumes on the primary
and secondary site that you can use to practice for disaster recovery without losing your disaster recovery
capability.

Global Mirror Either Direction with Two-Site Practice sessions are available for the following Copy Services
Manager editions and storage systems.

Table 11. Global Mirror Either Direction with Two-Site Practice

Supported editions Supported storage systems

« Copy Services Manager - IBM DS8000

Global Mirror Failover/Failback

With Global Mirror Failover/Failback replication, you can switch the direction of the data flow so that you
can use your secondary site as your production site. You can then copy changes that are made at the
secondary site back to the primary site.

Global Mirror Failover/Failback sessions are available for the following Copy Services Manager editions
and storage systems.

Table 12. Global Mirror Failover/Failback

Supported editions Supported storage systems

« Copy Services Manager - IBM DS8000
« Systems running IBM Spectrum Virtualize
« Systems running IBM Spectrum Accelerate,
including:
- XIV
— FlashSystem A9000
— FlashSystem A9000R

Global Mirror Failover/Failback with Change Volumes

Global Mirror Failover/Failback with Change Volumes replication provides the same capabilities as

the Global Mirror Failover/Failback session type. However, Global Mirror Failover/Failback with Change
Volumes sessions also provide the option of enabling or disabling the use of change volumes. Change
volumes are available in SAN Volume Controller and IBM Spectrum Virtualize storage systems.

Global Mirror Failover/Failback with Change Volumes sessions are available for the following Copy
Services Manager editions and storage systems.
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Table 13. Global Mirror Failover/Failback with Change Volumes

Supported editions Supported storage systems

« Copy Services Manager « Systems running IBM Spectrum Virtualize

Global Mirror Failover/Failback with Practice

Global Mirror Failover/Failback with Practice replication combines Global Mirror Failover/Failback and
FlashCopy capabilities to provide a point-in-time copy of the data on the secondary site. This session type
provides volumes that you can use to practice for disaster recovery without losing your disaster recovery
capability.

Global Mirror Failover/Failback with Practice sessions are available for the following Copy Services
Manager editions and storage systems.

Table 14. Global Mirror Failover/Failback with Practice

Supported editions Supported storage systems

« Copy Services Manager - IBM DS8000
- Systems running IBM Spectrum Virtualize

Metro Global Mirror

Metro Global Mirror replication provides continuous, remote data replication that operates between three
sites that are varying distances apart. Metro Global Mirror combines Metro Mirror synchronous copy and
Global Mirror asynchronous copy into a single session, where the Metro Mirror target is the Global Mirror
source. With Metro Global Mirror replication, you can switch the direction of the data flow so that you can
use your secondary or tertiary site as your production site.

Metro Global Mirror sessions are available for the following Copy Services Manager editions and storage
systems.

Table 15. Metro Global Mirror

Supported editions Supported storage systems

« Copy Services Manager - IBM DS8000

Metro Global Mirror with Practice

Metro Global Mirror with Practice replication combines Metro Mirror, Global Mirror, and FlashCopy
capabilities to provide a point-in-time copy of the data on the tertiary site. This session type provides
volumes that you can use to practice for disaster recovery without losing your disaster recovery capability.

Metro Global Mirror with Practice sessions are available for the following Copy Services Manager editions
and storage systems.

Table 16. Metro Global Mirror with Practice

Supported editions Supported storage systems

« Copy Services Manager -« IBM DS8000

Metro Mirror - Metro Mirror

A Metro Mirror - Metro Mirror session is a multi-target session that consists of three sites. You can define
any of the sites as the primary site and then run Metro Mirror replication from the primary site to either
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of the other sites individually or both sites simultaneously. For example, if Site 1 is the primary site, data
replication can occur between the H1 and H2 volumes and the H1 and H3 volumes separately or at the

same time.

This session type is available only for IBM DS8000 storage systems with a microcode level that supports
single source to multi-target relationships. To determine whether you can use this session type, see the
IBM DS8000 documentation for the microcode level that you are using.

Table 17. Metro Mirror - Metro Mirror

Supported editions

Supported storage systems

« Copy Services Manager

- IBM DS8000

Metro Mirror - Global Mirror

A Metro Mirror - Global Mirror session is a multi-target session that consists of three sites. From the
primary site, you can define both a Metro Mirror copy and a Global Mirror copy, which allows for
replication across both a short distance and long distance simultaneously.

This session type is available only for IBM DS8000 storage systems with a microcode level that supports
single source to multi-target relationships. To determine whether you can use this session type, see the
IBM DS8000 documentation for the microcode level that you are using.

You can also use this session type with IBM FlashSystem A9000 and A9000R storage systems.

Note: HyperSwap is always enabled for the Metro Mirror - Global Mirror multi-target session type on

FlashSystem A9000 and A9000R. If a swap occurs, the hardware automatically restarts the Metro Mirror
pair in the opposite direction and re-enables HyperSwap. And after the swap, the remote Global Mirror is
not automatically restarted.

See the IBM Redbooks publication at http://www.redbooks.ibm.com/redpieces/abstracts/redp5434.html
for more specific details on how to set up this session type on the FlashSystem A9000 and A9000R
storage systems.

Table 18. Metro Mirror - Global Mirror

Supported editions Supported storage systems

- IBM DS8000
« IBM FlashSystem A9000 and A9000R

« Copy Services Manager

Note: To convert from a multi-target configuration to a cascaded configuration, refer “Converting from
multi-target to Cascaded replication in a three site session type” on page 219.

Metro Mirror - Global Mirror with Practice

A Metro Mirror - Global Mirror with Practice session is a multi-target session that consists of three sites.
From the primary site, you can define both a Metro Mirror copy and a Global Mirror copy, which allows

for replication across both a short distance and long distance simultaneously. This session type provides
volumes that you can use to practice for disaster recovery without losing your disaster recovery capability.

This session type is available only for IBM DS8000 storage systems with a microcode level that supports
single source to multi-target relationships. To determine whether you can use this session type, see the
IBM DS8000 documentation for the microcode level that you are using.

Table 19. Metro Mirror - Global Mirror with Practice

Supported editions

Supported storage systems

» Copy Services Manager

« IBM DS8000
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Note: To convert from a multi-target configuration to a cascaded configuration, refer “Converting from
multi-target to Cascaded replication in a three site session type” on page 219.

Metro Mirror - Global Mirror with Site 3 Global Mirror

A Metro Mirror - Global Mirror with Site 3 Global Mirror session is a multi-target session that consists of
three sites. From the primary site, you can define both a Metro Mirror copy and a Global Mirror copy, which
allows for replication across both a short distance and long distance simultaneously. After recovery to Site
3, this session allows a Global Mirror replication back to either Site 1 or Site 2 and a cascaded Global Copy
to the third site. This action provides disaster recover capabilities while production runs at Site 3.

This session type is available only for IBM DS8000 storage systems with a microcode level that supports
single source to multi-target relationships. To determine whether you can use this session type, see the
IBM DS8000 documentation for the microcode level that you are using.

Table 20. Metro Mirror - Global Mirror with Site 3 Global Mirror

Supported editions Supported storage systems

» Copy Services Manager - IBM DS8000

Note: To convert from a multi-target configuration to a cascaded configuration, refer “Converting from
multi-target to Cascaded replication in a three site session type” on page 219.

Metro Mirror - Global Mirror with Site 4 Replication

A Metro Mirror - Global Mirror with Site 4 Replication session is a multi-target session that consists of

four sites. From the primary site, you can define both a Metro Mirror copy and a Global Mirror copy, which
allows for replication across both a short distance and long distance simultaneously. After recovery to Site
4, this session allows a Global Mirror replication back to either Site 1, Site 2, or Site 3, and a cascaded
Global Copy to the fourth site. This action provides disaster recover capabilities while production runs at
Site 4.

This session type is available only for IBM DS8000 storage systems with a microcode level that supports
single source to multi-target relationships. To determine whether you can use this session type, see the
IBM DS8000 documentation for the microcode level that you are using.

Table 21. Metro Mirror - Global Mirror with Site 4 Replication

Supported editions Supported storage systems

« Copy Services Manager - IBM DS8000

Metro Mirror - Metro Mirror with Site 4 Replication

A Metro Mirror - Metro Mirror with Site 4 Replication session is a multi-target session that consists of four
sites. From the primary site, you can define a Metro Mirror - Metro Mirror copy, which allows for replication
across two short distances simultaneously. After recovery to Site 4, this session allows a Metro Mirror
replication back to either Site 1, Site 2, or Site 3, and a cascaded Metro Copy to the fourth site. This action
provides disaster recovery capabilities while production runs at Site 4.

This session type is available only for IBM DS8000 storage systems with a microcode level that supports
single source to multi-target relationships. To determine whether you can use this session type, see the
IBM DS8000 documentation for the microcode level that you are using.

Table 22. Metro Mirror - Metro Mirror with Site 4 Replication

Supported editions Supported storage systems

« Copy Services Manager - IBM DS8000
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Safeguarded Copy

A Safeguarded Copy session is designed to capture many point-in-time images of a production
environment with optimized capacity usage and minimized performance impact. The backup created
by a Safeguarded Copy session can be recovered to another set of volumes while the production
environment continues to run. Safeguarded Copies help to prevent the data from being compromised,
either accidentally or deliberately. Therefore, the Safeguarded Copy session type offers another layer of
security in your environment.

Table 23. Safeguarded Copy

Supported editions Supported storage systems

« Copy Services Manager - IBM DS8000

« SAN Volume Controller and Spectrum Virtualize
based FlashSystem devices

Migration

The new Migration session is available starting with Copy Services Manager 6.2.10. The Migration session
is a two-volume session type with roles H1 and H2.

The Migration session ignores the rule that the primary and secondary have to be the same size and type.
Therefore, you can use this session to migrate data from one set of volumes to another, regardless of size,
as long as the hardware supports it.

You can only start a Migration session from HZ1. You cannot start in Metro Mirror mode. And a Migration
session running in Global Copy mode will not manage freeze or run conditions.

You can still manually Suspend or Stop the session for consistent or inconsistent suspends. And you can
Recover the session to failover the pairs, thereby allowing the targets to be writable.

From the Target Available state, you can only restart in the original direction or terminate. You cannot
restart in the opposite direction.

Table 24. Migration

Supported editions Supported storage systems

« Copy Services Manager - IBM DS8000

Extent Space Efficient Sizer

The ESE Sizer session supports analyzing space requirements for DS8000 Extent Space Efficient (ESE)
FlashCopy and Safeguarded Copy.

An accurate sizing of ESE FlashCopy and Safeguarded Copy is crucial. With the DS8880 microcode 8.5.4
release and DS8900F 9.1 release a Write Monitoring (WM) bitmap is implemented in the DS8000 to track
all write to each volume.

The purpose of the Write Monitoring Bitmap is to provide an effective way to determine usable space
requirements for both Extent Space Efficient (ESE) FlashCopy and Safeguarded Copy without impacting
host write I/O or disk replication performance. The write monitoring bitmap enables a DS8000 to track
the amount and locality of its changed data over definable time intervals and across a set time period in
an existing production environment.

The new session type queries the Write Monitoring bitmap and provides output files on box and volume
level. These output files contain the currently allocated extents, changed tracks, changed small extents
and change large extents. This level of detail can readily be used to determine how much capacity will be
allocated over time for both functions ESE FlashCopy and Safeguarded Copy.
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The following tool can be used to process the data collected from the Copy Services Manager ESE

Sizer session to provide more accurate capacity sizings in the configurations. Refer the link https://
www.ibm.com/support/pages/node/6372180 for more detailed information regarding ESE Sizer session
and the collected data.

The ESE Sizer session can start, stop, and reset the WM bitmap. With the available properties, you can
define the volume query interval and the bitmap reset interval.

Note: It is recommended to run the ESE Sizer session on a Copy Services Manager instance that is not
currently managing replication. While the ESE Sizer session does not affect replication, the data collected
uses system memory resources so running on a separate server is recommended to avoid any memory
constraints. Refer “Calculating server memory requirements” on page 33 for more information.

Table 25. ESE Sizer session

Supported editions Supported storage systems

Copy Services Manager IBM DS8000

Metro Mirror heartbeat

The Metro Mirror heartbeat guarantees data consistency across multiple storage systems when the Copy
Services Manager management server cannot communicate with one or more storage systems.

The Metro Mirror heartbeat is disabled by default. When determining whether to use the Metro Mirror
heartbeat, analyze your business needs. If you disable the Metro Mirror heartbeat, data might become
inconsistent. If you enable the Metro Mirror heartbeat and a freeze occurs on the storage system, your
applications cannot perform write operations during the freeze.

For more information about the Metro Mirror heartbeat, see “Metro Mirror heartbeat” on page 204.

Site awareness

You can associate a location with each storage system and each site in a session. This site awareness
ensures that only the volumes whose location matches the location of the site are allowed for selection
when you add copy sets to the session. Site awareness prevents a session relationship from being
established in the wrong direction.

For more information about site awareness, see “Site awareness” on page 45.

User and group authentication
To log on to Copy Services Manager, a user ID and password are required.
Copy Services Manager uses one of the following repositories for user or group authentication:

« The basic user registry for distributed systems, or an operating system repository, such as RACF, for
z/0S systems

- A Lightweight Directory Access Protocol (LDAP) repository for both distributed systems and z/0S
systems

The basic user registry is a registry of users that is managed internally by the application by using the
WebSphere® Liberty Profile.

If you choose to use LDAP authentication, you must configure the LDAP server information with the Copy
Services Manager authentication server after the installation of Copy Services Manager is complete.

For information on managing user and group authentication, see Chapter 10, “Managing security,” on
page 295.
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User roles

A user role is a set of privileges that is assigned to a user or user group to allow the user or user group to
perform certain tasks and manage certain sessions.

To be assigned to a role, each user or group of users must have a valid user ID or group ID in the user
registry on the management server.

Both individual users and a group of users can be assigned to a role. All users in a group are assigned the
role of the group. If a user is assigned to one role as an individual and a different role as a member of a
group, the user has access to the permissions of the role that has greater access.

Restricting access to sessions prevents unwarranted administrative access. This is especially useful in an
open environment, where there can be many storage administrators who are responsible for their servers,
applications, databases, file systems, and so on.

By default, the user that was defined during installation is granted access to Copy Services Manager and
assigned to the Administrator role.

Copy Services Manager provides a set of predefined user roles: Monitor, Operator, User Administrator and
Administrator.

For information on assigning and modifying user roles, see Chapter 10, “Managing security,” on page 295.

Monitor

Monitors can view the health and status in the Copy Services Manager GUI and CLI; however, they cannot
modify or perform any commands or actions.

Monitors can view the following information:

- All storage systems and storage system details
« All connections and connection details
« All sessions and session details

All path information
- Management server status and details

When should a Monitor be used:
A user or group should be set to a Monitor when you only want to provide that user or group the ability
to view the status of the sessions and various server connections. Examples might include upper
management or an external team that does not directly manage the replication, but might need to
know whether their data is currently protected.

Operator

Operators can only monitor the sessions that they have access to. They can perform the following actions
on their assigned sessions:

- Adding or removing a session. The user ID that created the session is automatically granted access to
manage that session.

 Performing actions on an assigned session, such as start, flash, terminate, and suspend.
« Modifying session properties.
- Removing copy sets from a session.

Note: Starting with Copy Services Manager 6.2.10, operators can no longer add copy sets to a session.
This new behavior prevents operators from adding volumes that are in use, or are meant for another
session or operator, including in multi-tenancy environments. Because Copy Services Manager sees all
the volumes on a storage system, an administrator needs to add the copy sets to ensure that volumes
are used by the correct sessions and operators.
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« Adding Peer To Peer Remote Copy (PPRC) paths, and removing paths with no hardware relationships.
PPRC paths are a common resource used in Copy Services Manager sessions and also in a DS8000
storage system relationship that is established between two common logical subsystems (LSSs).

Notes:

— The session operator cannot issue a force removal of a path.
— A path can also be auto-generated when starting a session.
- Monitoring health and status, including viewing the following information:

All storage systems and storage system details
All connections and connection details

All sessions and session details

All path information

Management server status and details
« Packaging program error (PE) log files

When you select the Operator role, you must indicate which sessions the Operator has access to. You can
either choose individual sessions from a list of sessions, or select the all sessions option. If you select all
sessions, then the Operator will have the ability to manage all existing sessions, as well as automatically

managing any new sessions that get created.

When should an Operator be used:
A user or group should be set to an Operator when you only want to provide that user or group the
ability to manage one or more sessions, but not the ability to manage higher level features, such as
user access or server connections. Examples might include a multi-tenancy situation where more than
one group is using the same Copy Services Manager server for replication, and you do not want one
group to affect the replication of another.

The session Operator can also be used to provide a more-secure environment when combined with
the User Administrator role. An Administrator is required for the initial setup of the server to create
storage system connections, and so on. After all the connections are established, an Administrator
can assign one or more users to the User Administrator role. The User Administrator can then remove
Administrator privileges of the original Administrator, thereby making that Administrator an Operator.

This design creates a situation where you have User Administrators and Session Operators, but no one
with all-encompassing Administrator access. A User Administrator might need to make individuals
Administrators from time to time if server modifications need to be made. However, this action would
require approval from the User Administrator; thereby creating a more-secure environment.

User Administrator

User Administrators do not have permissions to manage sessions, storage systems, and so on. User
Administrators only have permission to manage the permissions for other users or groups, including;:

« Creating and Removing basic users

- Granting permissions to users and groups of users

« Managing LDAP or Active Directory authentication

« Packaging program error (PE) log files

Note: User Administrators cannot modify their own administrative access rights.

When should a User Administrator be used:
A user or group should be set to a User Administrator when you only want to provide that user or
group the ability to manage the permissions of other users on the server.

You are not required to assign a User Administrator, because the Administrator role also allows
a user to manage the permissions of others. However, you might want to separate the ability to
manage permissions from the ability to manage sessions for security reasons. Examples might include
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environments where security for all servers are managed by a common group outside of the actual
storage management group.

Administrator

Administrators have unrestricted access. They can manage all sessions and perform all actions associated
with Copy Services Manager, including:

« Granting permissions to users and groups of users

- Adding or removing a session. The user ID that created the session is automatically granted access
manage that session.

« Performing actions on all sessions, such as start, flash, terminate, and suspend
- Modifying session properties

- Adding and removing copy sets from a session. The administrator can add volumes to a copy set only
when the volume is not protected and not in another session.

« Protecting volumes and removing volume protection
- Adding or removing storage system connections

« Modifying connection properties

« Assigning or changing storage system locations

« Upload new certificates in the GUI

- Adding PPRC paths and removing paths with no hardware relationships. PPRC paths are a common
resource used in Copy Services Manager sessions and also in a DS8000 storage-system relationship
that is established between two common logical subsystems (LSSs).

Note: A path can also be auto-generated when starting a session.

« Managing management servers. The standby management server is a common resource that is
available to multiple sessions.

« Packaging program error (PE) log files
- Monitoring health and status, including viewing the following information:

All storage systems and storage system details

All connections and connection details

All sessions and session details

All path information

Management server status and details
Note: Administrators cannot revoke their own administrative access rights.

When should an Administrator be used:
A user or group should be set to an Administrator when you want that user or group to have all
permissions on the server, including granting new permissions to other users, or managing replication
sessions. Examples include environments where the same user or group that is managing the
replication is also managing the security for the server.

Automation

Automation users have Administrator level access to the server but do not have permission to use the
User Administrator commands. Administrators can specify whether the Automation users can log in using
GUI, CLI or both. Automation users can always log in with REST API. Automation users can perform the
following actions on all sessions:

« Create or delete sessions
« Add or remove copy sets to sessions
« Issue commands to sessions
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View all sessions and modify properties

Create log packages

Create database backups

Create hardware connections

Manage active and standby servers

Manage, create, delete, and run scheduled tasks

Automation users cannot perform the following actions:

Create new users

Change authority for existing users

Add LDAP-based users

Export license keys

Manage notifications like setup SNMP or email alerts
Set up DS8000 heartbeat

Upload new certificates in the GUI

Warning: When dual control is enabled, Automation users can issue commands without a second
user approval. You must implement the Automation role with dual control, only if the automation
tool has significant security to prevent any malicious user from bypassing Copy Services Manager
dual control through automation tool.

Automation user for running scheduled tasks only

In addition to allowing the Automation user access through CLI and GUI, the Administrator can also
limit the Automation user to run scheduled tasks only. To allow the Automation user to run scheduled
tasks only, the Administrator must select the Only run Scheduled Tasks check box while creating

a new Automation user. When the Only run Scheduled Tasks check box is selected, the Allow GUI
access check box is disabled. Automation users that are created to run scheduled tasks only, can
login either through REST API or CLI.

When should an Automation be used:

A user or group should be set to automation when the user or group is meant for running commands
through external automation. This user role will bypass dual control for commands that are issued
through an external automation tool. Examples include setting up automation through a Copy Services
Manager CLI script which is invoked by a batch job. You can define the script to use an automation
user so that a second user does not have to approve the command if dual control is enabled on the
server. When setting up automation through an Ansible playbook, you can define the calls to use

an automation user so that a second user does not have to approve the command if dual control is
enabled on the server.
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Administrative tasks within Copy Services Manager include authorizing users, starting and stopping
services, and performing backup and recovery operations.

Exporting a license file

You can export a license (. zip) file from the Copy Services Manager GUI that contains the installed
product licenses.

You can use the export license feature to transfer full licensed support to another server.
Use these steps to export a license (. zip) file from the Copy Services Manager GUI:

1. Log in to the Copy Services Manager GUI as a user with administrative privileges.
2. In the menu bar, click Settings > Advanced Tools. The Advanced Tools panel is displayed.

3. Scroll down to locate the Copy License Key or Export License section of the panel. Click
Export.

Note: If no license file is available for export, a status message is displayed saying so.

When you click Export, the server creates and stores a compressed (.zip) file of all the license
information in the <path_prefix>/csmServer/license directory.

When the license data is exported, the file name and location on the management server appears as a
link. You can click the link to download the exported licenses to the server on which the web browser
is running. You can import the file when you click Update Licenses from the Copy Services Manager
GUI on another server. For information on how to import a license, see “Applying license files after
installation or migration, or updating licenses” on page 21.

Copying a license key

The Copy Services Manager GUI supports the ability to import a string-based key for transferring a license
to another server.

You can use the copy license key feature to transfer full licensed support to another server.
Use these steps to copy a license key from the Copy Services Manager GUI:

1. Log in to the Copy Services Manager GUI as a user with administrative privileges.
2. In the menu bar, click Settings > Advanced Tools. The Advanced Tools panel is displayed.

3. Scroll down to locate the Copy License Key or Export License section of the panel. Click the

displayed string value, or the Copy License Key button, to copy the license key string to the clipboard
to enable another server.

You can import the license key when you click Update Licenses from the Copy Services Manager
GUI on another server. For information on how to import a license, see “Applying license files after
installation or migration, or updating licenses” on page 21.

Applying license files after installation or migration, or updating
licenses

After you install or migrate to Copy Services Manager, you must apply the available license files if you
did not do so during the installation process. This task can also be used to update licenses, such as for
transfer to another server.

Contact your IBM representative to either obtain a Try-and-Buy key, or to determine where the license
files are stored for your version of Copy Services Manager. The license enablement files, which contain the
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license keys to be applied, are stored within the ordering system that you used. You need to download the
files from this location.

If you want to import a license to transfer licensed support to another server, you must first export the
license (. zip) file. See “Exporting a license file” on page 21 for more information before you follow the
procedure to apply the license file. Alternatively, you can import a license key string if your system does
not support importing a license file, for example when Copy Services Manager is installed on the DS8000
HMC. The license key works like the Try-and-Buy activation key. See “Copying a license key” on page 21
for more information.

The following steps detail how to apply Copy Services Manager license files after installation or migration,
or how to update licenses, such as for transfer to another server.

Use these steps to apply or update license files:

1. If necessary, download the appropriate license files as instructed by your IBM representative. These
files are in compressed (.zip) file format.

2. Log in to the Copy Services Manager GUI as a user with administrative privileges.

3. In the menu bar, on the far right, click Update Licenses.

Note: This menu option only appears when there is no Try-and-Buy key and no full license applied. If
either of those items are applied, this menu option disappears.

« You can also click Settings > Administration to get to the Update Licenses button. This button
appears on the Administration page if either no license files are applied, or only the Try-and-Buy
license is applied. The button disappears only after you upload the full license compressed (.zip)
file.

4. Update the license by either typing in the activation key or uploading a license file. The activation key is
a string value that is provided for Try-and-Buy capabilities by your account representative, or through
an export licenses action on an existing installation. If a license file was provided for activation, such
asacsm-license.zip file, click the Click here to activate the product by using the key file text,
and then click Browse to select a license file to upload.

5. Click Apply to submit, or click Cancel to exit without applying any licenses.

When the necessary license files are applied, the available functions are enabled for use.

Starting and stopping Copy Services Manager

Use these procedures to manually start and stop Copy Services Manager.

Starting the Copy Services Manager server

The commands that are required to manually start the Copy Services Manager server depend on the
operating system.

The Copy Services Manager server is started by default after the application is installed. A service is
created that automatically restarts when the server is restarted. The start and stop features can be done
manually, but that is not typically necessary.

Starting the Copy Services Manager server on Windows
To start the Copy Services Manager server, issue the following command from the command prompt:

Program Files\IBM\CSM\startCSM.bat

Where the variable Program Files\IBM\CSM is the installation directory. The default directory is
C:\Program Files\IBM\CSM.

Starting the Copy Services Manager server on AIX or Linux

To start the Copy Services Manager server, issue the following command from the command line:
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/CSM_install_directory/startCSM.sh

Where CSM_install_directory is the installation directory. The default directory is /opt/IBM/CSM.

Starting the Copy Services Manager server on z/0S
To start theCopy Services Manager server, complete the following steps:

1. Ensure that the Copy Services Manager HFS is mounted on the UNIX System Services.
The root production directory is path_prefix/opt/IBM/CSM.

2. Issue the command from the IBM z/0S System Display and Search Facility (SDSF) panel to start the
Copy Services Manager server, as shown in the following example. The address spaces that are shown
might be different in your environment.

/START IWNSRV

The initiator is IWNSRV and the job name is IWNSRV. For information about the IWNSRV job, see the
IBM Copy Services Manager Installation and Configuration Guide.

Starting the Copy Services Manager authentication server

The commands that are required to manually start the Copy Services Manager authentication server
depend on the operating system.

The Copy Services Manager authentication server is started by default after the application is installed. A
service is created that automatically restarts when the server is restarted. The start and stop features can
be done manually, but that is not typically necessary.

Starting theCopy Services Manager authentication server on Windows

To start the Copy Services Manager authentication server, issue the following command from the
command prompt:

Program Files\IBM\CSM\startAuth.bat

Where the variable Program Files\IBM|CSM is the installation directory. The default directory is
C:\Program Files\IBM\CSM.
Starting theCopy Services Manager authentication server on AIX or Linux

To start the Copy Services Manager authentication server, issue the following command from the
command line:

/CSM_install_directory/startAuth.sh

Where CSM_install_directory is the installation directory. The default directory is /opt/IBM/CSM.

Starting the Copy Services Manager authentication server on z/0S
To start the Copy Services Manager authentication server, complete the following steps:

1. Ensure that the Copy Services Manager HFS is mounted on the UNIX System Services.
The root production directory is path_prefix/opt/IBM/CSM.

2. Issue the command from the IBM z/0OS System Display and Search Facility (SDSF) panel to start the
Copy Services Manager authentication server, as shown in the following example. The address spaces
that are shown might be different in your environment.

/START IWNAUTH
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The initiator is IWNAUTH and the job name is IWNAUTH. For information about the INNAUTH job, see
the IBM Copy Services Manager Installation and Configuration Guide.

Stopping the Copy Services Manager server

The commands that are required to manually stop the Copy Services Manager server depend on the
operating system.

Stopping the Copy Services Manager server on Windows
To stop the Copy Services Manager server, issue the following command from the command prompt:

CSM_install_directory\IBM\CSM\stopCSM.bat

Where the variable CSM_install_directory is the installation directory. The default directory is
C:\Program Files\IBM\CSM.

Stopping the Copy Services Manager server on AIX or Linux

To stop the Copy Services Manager server, issue the following command from the command line:

/CSM_install_directory/stopCSM. sh

Where CSM_install_directory is the installation directory. The default directory is /opt/IBM/CSM.

Stopping the Copy Services Manager server on z/0S
To stop the Copy Services Manager server, complete the following steps:

1. Issue a command from the IBM z/0S System Display and Search Facility (SDSF) panel to stop Copy
Services Manager, as shown in the following example command. The address space that is shown
might be different in your environment.

/STOP IWNSRV

Where /STOP IWNSRV stops the server address space.

2. Issue the /D A,L command to show the processes that are running and verify that the stop command
completed. If the IWNSRV address space is displayed, issue the /CANCEL command for the address
space.

Stopping the Copy Services Manager authentication server

The commands that are required to manually stop the Copy Services Manager authentication server
depend on the operating system.

Stopping the Copy Services Manager authentication server on Windows

To stop the Copy Services Manager authentication server, issue the following command from the
command prompt:

CSM_install_directory\IBM\CSM\stopAuth.bat

Where the variable CSM_install_directory is the installation directory. The default directory is
C:\Program Files\IBM\CSM.

Stopping the Copy Services Manager authentication server on AIX or Linux

To stop the Copy Services Manager authentication server, issue the following command from the
command line:

/CSM_install_directory/stopAuth.sh
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Where CSM_install_directory is the installation directory. The default directory is /opt/IBM/CSM.

Stopping the Copy Services Manager authentication server on z/0S
To stop the Copy Services Manager authentication server, complete the following steps:

1. Issue a command from the IBM z/0S System Display and Search Facility (SDSF) panel to stop the Copy
Services Manager authentication server, as shown in the following example command. The address
space that is shown might be different in your environment.

/STOP IWNAUTH

Where /STOP IWNAUTH stops the server address space.

2. Issue the /D A,L command to show the processes that are running and verify that the stop command
completed. If the IWNAUTH address space is displayed, issue the /CANCEL command for the address
space.

Verifying that the Copy Services Manager server is running

You can verify that the Copy Services Manager server is running in several ways.

Complete one or more of these tasks to determine whether the Copy Services Manager server is running:

« Start the Copy Services Manager GUI or command-line interface shell. If either of these methods is
successful, the Copy Services Manager server is running.

- Viewthe csmTrace.log file. For distributed systems, this file is in the install
dir\liberty\wlp\usr\servers\csmServer\logs\CSM\ directory. For z/OS systems, this file
isinthe path_prefix/opt/IBM/CSM/wlp/usr/servers/csmServer/logs/CSM directory. If the
csmTrace.log file is updated regularly and is increasing in size, the Copy Services Manager server is
running.

Note: For z/0OS systems, you can also issue the /D A,L command to display the processes that are
running.
Verifying that the Copy Services Manager authentication server is
running

You can verify that the Copy Services Manager authentication server is running in several ways.

Complete one or more of these tasks to determine whether the Copy Services Manager authentication
server is running:

- Attempt to log in to the Copy Services Manager GUI or CLI by using an LDAP user or group. If you are
able to do log in this way, the authentication server is running because it is required to perform LDAP
authentication.

« Ondistributed systems, open the
CSM_install_directory\liberty\wlp\usr\servers\csmAuth\workarea directory. You see
an .sRunning file if the authentication server is active. For z/OS systems, issue the /D A,L command
to display the processes that are running.

Updating the server properties file

You can update the server properties file by using the Copy Services Manager GUI. You can also edit the
file outside of the GUI if necessary.

The server properties file defines advanced properties for the Copy Services Manager server. Starting with
Copy Services Manager Version 6.2.1, you can use the GUI to update the server properties configuration
file.
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Note: If the GUI is not available, you can also edit the server properties by using the
rmserver.properties file in one of the following locations:

 Fordistributed systems: install dir\liberty\wlp\usr\servers\csmServer\properties
« Forz/OS: path_prefix/opt/IBM/CSM/wlp/usxr/servers/csmServer/properties

For more information, see “rmserver.properties file” on page 326.

Follow these steps to update the server properties in the Copy Services Manager GUI:
1. Log in to the Copy Services Manager GUI as a user with administrator privileges.
2. Click Settings > Server Properties.
3. Click Edit and enter any properties in the text area.
The following rules apply when you edit the server properties file:
- Each line in the file represents a server property. Specify the property by writing the property name,
the equals (=) sign, and then the value for the property. Example: log.file.maxFiles=50

« To comment out a line place the pound (#) symbol at the start of the line. Example:
#log.file.maxFiles=50

4. After the information is complete, click Save to save the properties. If any errors in the format are
detected while the file is being saved, an error message displays to indicate the error. Click Edit to
correct any format errors. Click Cancel to quit editing and restore the current server properties file.

The server properties are updated according to the changes that you made.

Starting the Copy Services Manager GUI

You can start the graphical user interface (GUI) by opening a web browser and entering a web address for
the Copy Services Manager logon page.

To start the Copy Services Manager GUI, use these steps:

1. Start a web browser and enter the following address in the address field. The address field is case-
sensitive.

https://hostname:port/CSM

In the preceding address field, specify these values:

hostname
The Copy Services Manager server. You can specify the host name as an IP address or a Domain
Name System (DNS) name.

port
The port number for Copy Services Manager.
Note: The default port for Copy Services Manager is 9559.

You can find the port number in the bootstrap.properties fileinthe install
dir\liberty\wlp\usr\servers\csmServer)\ directory for distributed systems, and in the
path_prefix/opt/IBM/CSM/wlp/usr/sexrvers/csmServer/ directory for z/OS.

2. From the Copy Services Manager logon page, enter your user ID and password, and click the Log in
arrow.

The GUI opens in the browser.

For z/0S installations: Ensure that you use the user ID that was specified in the IWNRACF job and the
password for that user.
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Identifying the version of Copy Services Manager

The Copy Services Manager version determines the features that are available in the product.

To view the version of Copy Services Manager from the GUI, hover over the ? icon in the menu bar, and
click About.

To view the version of Copy Services Manager from the command-line interface, use the -ver command.

Setting the language preference

Starting with Copy Services Manager Version 6.2.2, you can change the language preference for the GUL.

You can choose what language to display in the Copy Services Manager GUI. The GUI defaults to the
language in your browser setting, but you can set it to display a different language from the default.

This setting persists per associated user login for the currently used browser, so that different users can
see different languages.

Perform the following steps to set the preferred language:

1. Log in to the Copy Services Manager GUI as an administrator.
2. Go to Settings > Advanced Tools.
3. Under User Preferences, select which language that you want the GUI to display.

The Copy Services Manager GUI text appears in the selected language. This same language is displayed
each time you log in unless you change it again.

Backing up and restoring product data

You can back up the entire Copy Services Manager database, copy sets in a specific session, and registry
files. You can then use the backup files to restore a previous configuration or recover from a disaster.

Backing up and recovering copy set data and the Copy Services Manager
database

You can back up and recover copy set data for a specific session and the complete Copy Services Manager
database.

Automatic backups
Copy Services Manager takes automatic backups during key configuration changes.

The automatic backups are stored in the install
dir\liberty\wlp\usr\servers\csmServer\database\autobackup directory for distributed
systems and in the path_prefix/opt/IBM/CSM/wlp/usr/servers/csmServer/database/
autobackup directory for z/OS. The file names include a timestamp (for example,
csmAutoBackup_20150526_103041965).

The following events will trigger an automatic backup:

« DELETE_SESSION
NUM_COPYSET_CHANGE

« ROLE_PAIR_DIRECTION_CHANGE
SESSION_ACTIVATED
SESSION_DEACTIVATED

« ROLE_PAIR_CGNAME_CHANGE

You can also perform manual backups. For more information on performing backups, see “Backing up the
Copy Services Manager database” on page 29.
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Copy sets

You can export data about all copy sets in a specific session to maintain a backup copy that you can use to
recover if you lose the session or to upgrade to a different management server.

When you export copy sets, Copy Services Manager creates a backup of the session and saves
the data in a comma-separated value (CSV) file, which you can view or edit in a spreadsheet
program such as Microsoft Excel. The exported CSV file includes the session name, session
type, date that the data was exported, and the copy sets for each role pair. There is one

line per copy set, and the volumes in the copy set are separated by a comma (for example:
DS8000:2107.FX101:VOL:1408,DS8000:2107.HJ102:VOL:1408).

The following example illustrates the content of the CSV file for a FlashCopy session. The first valid row
must contain the appropriate role names for the session. The order of the copy sets does not matter,
and you can include extra roles. A copy set is created from each row that follows the role names. All
rows must have data in each column to be a valid row. The number sign (#) indicates that the line is a
comment. Lines that are comments are ignored.

J##Sessioni,
#FlashCopy,
#0ct 2, 2009 10:03:18 AM

H1,T1

DS8000:2107.FRLL1:VOL:1004,DS8000:2107.FRLL1:VOL:1104
DS8000:2107.FRLL1:VOL:1011,DS8000:2107.FRLL1:VOL:1101
DS8000:2107.FRLL1:VOL:1005,DS8000:2107.FRLL1:VOL:1105

Important: You must manually save this file on the local system when you export copy sets from the Copy
Services Manager web interface.

Copy Services Manager database

Copy Services Manager database contains all product data, including data about storage systems,
sessions, copy sets, paths, user administration, and management servers. You can back up this data
and use the backup file to recover from a disaster or restore a previous configuration.

Important: You must have Administrator privileges to back up and recover the database.

The current data is stored in a new file each time you create a backup. The backup file is named
yyyyMMdd_HHmmssSSS . zip, where yyyy is the year, MM is the month, dd is the day, HH is the hour, mm
is the minute, ss is the seconds, SSS is the milliseconds when the backup command was run. It is your
responsibility to delete backup versions that are no longer needed.

By default, the backup file is stored in the following location:

Copy Services Manager for Distributed Systems
path_prefix\liberty\wlp\usr\servers\csmServer\properties

Copy Services Manager for z/0S Systems
path_prefix/opt/IBM/CSM/wlp/usr/servers/csmSexrver/properties

You can change the default location by editing the db.backup.location property in the
rmserver.properties file, which is in the following location:

Copy Services Manager for Distributed Systems
path_prefix\liberty\wlp\usr\servers\csmServer\properties

Copy Services Manager for z/0S Systems
path_prefix/opt/IBM/CSM/wlp/usr/servers/csmServer/properties

The backup file contains the Copy Services Manager database data at the time the backup was
completed. Any changes that were made after the backup are not reflected when the backup files are
used to restore an Copy Services Manager database.

Create a new backup file in the following situations:
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- After you change the Copy Services Manager database data, such as adding or deleting a storage
system, changing properties, and changing user privileges

« After an Copy Services Manager session changes direction. For example, if a Metro Mirror session was
copying data from H1 to H2 when the backup was taken, and later, the session was started in the H2 to
H1 direction. The session must be in the Prepared state before you create the backup.

« After a site switch has been declared and the Enable Copy To Site or Set Production to Site command
is issued. After you create a backup, consider deleting the previous backup to prevent Copy Services
Manager from starting the copy in the wrong direction.

When you create a backup, ensure that all Copy Services Manager sessions are either in the Defined,
Prepared, or Target Available state.

Restoring the Copy Services Manager database from a backup copy puts Copy Services Manager back

to the point in time when the backup was made. Relationships that exist on the storage systems that
were created by Copy Services Manager after the backup was made are no longer be managed by Copy
Services Manager until you add the copy set to the session and Copy Services Manager assimilates the
relationship into the session. Copy sets that were deleted after the backup are restored and a subsequent
Start command to the session creates new relationships. Therefore, you must remove the deprecated
copy sets before you issue the Start command.

After you restore a Global Mirror session, you must stop the Global Mirror master and subordinates before
you restart the Global Mirror session. Refer to your storage system documentation for more information.

Backing up the Copy Services Manager database

The database contains information about the storage systems, sessions, copy sets, user administration,
and management server configuration in Copy Services Manager.

You can back up the Copy Services Manager database by using either the GUI or the command line.

Backing up the Copy Services Manager database by using the GUI
You can back up the Copy Services Manager database by using the GUL.
Perform the following steps to back up the Copy Services Manager database through the GUI:

1. Log in to the Copy Services Manager GUI as a user with administrative privileges.
2. Go to Settings > Advanced Tools, and locate the Create Backup section.

3. Click Create to create a . zip file that contains the backup. When the backup is created, the file name
and location on the management server is displayed as a link.

4. Click the Download Backups link to download older backups to the server on which the web browser
is running.

Backing up the Copy Services Manager database by using the CLI
You can back up the Copy Services Manager database by using the CLI.

To back up the Copy Services Manager database at the command line, run the mkbackup command, as
shown in the following example:

csmcli> mkbackup

You must have Administrator privileges to run this command.

For more information on the mkbackup command, see the IBM Copy Services Manager online

product documentation (http://www-01.ibm.com/support/knowledgecenter/SSESK4). You can also see
the associated command help information available from the Copy Services Manager command-line
interface.
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Restoring the Copy Services Manager database
You can restore a Copy Services Manager database that was previously backed up to the local system.

Restoring the database does not require administrator privileges. However, you must be able to access
the files on the Copy Services Manager server that are listed in the procedure.

Complete these steps to restore the Copy Services Manager database from a backup database:

1. Stop Copy Services Manager on the active management server as described in “Stopping the Copy
Services Manager server” on page 24.

2. Copy the following directories, and all of their contents to another location, such as <path
prefix>/..../csmdb_bak:

 For distributed systems, copy the install
dir\liberty\wlp\usr\servers\csmServer\database\csmdb directory.

« For z/OS, copy the path_prefix/opt/IBM/CSM/wlp/usr/servers/csmServer/database/
csmdb directory.

You can delete the copy of the database directory after you restore the database.
3. Delete the following directories and all of their contents:

« Fordistributed systems, delete the install
dir\liberty\wlp\usr\servers\csmServer\database\csmdb directory.

» Forz/0S, delete the path_prefixopt/IBM/CSM/database/csmdb directory.
4. Extract the backup database in the following locations:

« Fordistributed systems, in the install
dir\liberty\wlp\usr\servers\csmServer\database\csmdb directory.

« Forz/0S, inthe path_prefix/opt/IBM/CSM/wlp/usr/servers/csmServer/database/
csmdb directory.

The backup database is in the following locations:

« For distributed systems, in the install
dir\liberty\wlp\usr\servers\csmServer\database\backup)\ directory.

« Forz/OS, inthe path_prefix/opt/IBM/CSM/wlp/usr/servers/csmServer/database/
backup/ directory.

Tip: You can use the Java Archive (JAR) Packing Tool to extract the archived Copy Services Manager
database backup on Linux and IBM Z by using the jax -xvf command.

From the . . /database folder, run the following command in the JAR Packing Tool to extract the Copy
Services Manager database (csmdb):

<path to java runtime>/jar -xvf <path to backup>/csmBackup_<DATESTAMP>.zip

Note: You can also restore from the automatic backup file, which has the following naming convention:
csmAutoBackup_YYYYMMDD_HHMMSSmmm. zip

Only the <path to java runtime> is different between Linux and IBM Z.

For more information on how to use the JAR Packing Tool and jaxr command, including examples, see
https://docs.oracle.com/javase/8/docs/technotes/tools/unix/jar.html.

On Windows operating systems, if the WinZip utility does not open by default, you can download it
from http://www.winzip.com/win/en/index.htm. To extract all the contents of a compressed (. zip)
folder on Windows, press and hold (or right-click) the folder, select Extract All..., and then follow the
instructions.

5. For UNIX and IBM Z only: Issue the following commands to change the permissions of the csmdb
directory:

« chgrp -R csm_user csmdb

30 IBM Copy Services Manager: User's Guide


https://docs.oracle.com/javase/8/docs/technotes/tools/unix/jar.html
http://www.winzip.com/win/en/index.htm

« chmod -R u+rwx csmdb

« chmod -R g+rwx csmdb

e chmod -R o+r csmdb

Where csm_user is the Copy Services Manager user that is defined in the IWNRACFL1 job, or a user that

has authority to run z/OS UNIX System Services. For more information about the IWNRACF1 job, see
the IBM Copy Services Manager Installation and Configuration Guide.

. Restart Copy Services Manager on the active management server as described in “Starting the Copy

Services Manager server” on page 22.

. Verify that the sessions reflect the correct state and status, and contain all copy sets that were last

known. Resolve any changes that occurred since the backup was created. If you exported copy sets,
you can resolve changes by using the exported . csv files. For more information, see “Exporting copy
set data” on page 31 and “Importing copy set data” on page 31.

. Optional: Start the Copy Services Manager sessions by using the appropriate start commands. The

start commands reestablish the relationship between the volume pairs and synchronize data on those
volumes.

Note: This step is not necessary if the database has the most recent data. Perform this step only if
both the session state is not the same as the last known state and the changes that were made after
the last backup require a start command to get the session in sync with the hardware. Ensure that
the session state is unchanged. There might be a change if, for example, a disaster recovery event
occurred while you were performing these steps by using the DS command-line interface (DSCLI).
Otherwise, issuing a start command might overwrite the last valid consistency group.

. Optional: If you have a standby management server, reestablish that standby relationship to update

the database on the standby server.

Note: This step is only needed if the standby server has also become corrupted and unusable.
Otherwise, use the high availability (HA) function to restore the settings on the active server.

Exporting copy set data

You can export data about all copy sets in a specific session to maintain a backup copy that can be used to
recover if you lose your session or upgrade to a different server.

Complete these steps to export the copy sets in a specific session:

1.
2.
3.

4.

In the menu bar, click Sessions.
On the Sessions page, select the session for which you want to export copy sets.

From the Session Actions list, select Export > Export Copy Sets. The Export Copy Sets window
displays the status of the export and a link to the exported file if the export completed.

Right-click the link and save the file to a local system.

Importing copy set data

You can import copy set data that was previously exported to a comma separated value (CSV) file.

Perform the following steps to import copy sets into an existing session:

1.
2.
3.

o g o o1 b~

In the menu bar, click Sessions.
On the Sessions page, select the session for which you want to import copy sets.

From the Session Actions list, select View/Modify > Add Copy Sets. The Add Copy Sets wizard is
displayed.

. Select Use a CSV file to import copy sets.

. Click Browse, select the CSV file, and then click Next.

. Verify that the matching results were successful, and then click Next.

. Select the copy sets that you want to add, and then click Next.

. Confirm the number of copy sets that you want to create, and then click Next.
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9. View the information on the Results page of the wizard, and then click Finish.

Exporting the LDAP and basic user registries

The 1dapRegistry.xml and basicRegistry.xml files need to be regularly backed up in case you lose
access to the Copy Services Manager server, or if the product needs to be uninstalled and reinstalled later.

The 1dapRegistry.xml file contains information about how Copy Services Manager connects to an
LDAP server. The basicRegistry.xml file contains encrypted information about the users that are
allowed to access the product. These files are not backed up by any GUI or CLI commands, and are not
replicated with high availability server relationships.

You can export the current LDAP and basic user registries by locating them on the file system and using
the operating system copy function to create a new file to save.

Complete these steps to export the LDAP and basic user registries:
1. Locate the files on your system.
« On Windows systems:
— The LDAP registry is at C: \program
files\IBM\CSM\wlp\servers\csmAuth\registries\ldapregistry.xml.

— The basic user registry is at C: \program
files\IBM\CSM\wlp\servers\csmServer\registries\basicregistry.xml.

« On UNIX or z/OS systems:
— The LDAP registry is at /opt/IBM/CSM/wlp/servers/csmAuth/registries/
ldapregistry.xml.

— The basic user registry is at /opt/IBM/CSM/wlp/servers/csmServer/registries/
basicregistry.xml.

2. Copy the files into a secure backup location whenever changes are made to the users or LDAP system.

Importing the LDAP and basic user registries

You can restore the 1dapRegistry.xml and basicRegistry.xml files on a new installation of Copy
Services Manager from a backup of the files on the file system.

Restoring the registries requires access to the file system on which the Copy Services Manager server is
running. The files can be copied over to restore the users that are already set up to use Copy Services
Manager.

Complete these steps to import the LDAP and custom user registries:
1. Locate the files on your system.
« On Windows systems:
— The LDAP registry is at C: \program

files\IBM\CSM\wlp\servers\csmAuth\registries\ldapregistry.xml.

— The basic user registry is at C: \program
files\IBM\CSM\wlp\servers\csmServer\registries\basicregistry.xml.

« On UNIX or z/OS systems:
— The LDAP registry is at /opt/IBM/CSM/wlp/servers/csmAuth/registries/
ldapregistry.xml.

— The basic user registry is at /opt/IBM/CSM/wlp/servers/csmServer/registries/
basicregistry.xml.

2. Stop Copy Services Manager as described in “Stopping the Copy Services Manager server” on page 24.

3. For UNIX and z/0S systems, issue the following commands to change the permissions of the registries
directory:
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chgrp -R csm_id *.xml
chmod -R u+rwx *.xml
chmod -R g+rwx *.xml
chmod -R o+r *.xml

Where csm_id is the Copy Services Manager user, or a user with authority to access Copy
Services Manager. If you have a z/OS installation, that user is defined in the IWNRACF1 job. For
more information about the IWNRACFL1 job, see the IBM Copy Services Manager Installation and
Configuration Guide.

4, Restart Copy Services Manager on the active management server as described in “Starting the Copy
Services Manager server” on page 22.

Calculating server memory requirements

Itis important to determine the amount of memory required on a server to run Copy Services Manager for
a given replication environment.

The Java heap size setting provides the maximum amount of memory that the server is allowed to use
from the system memory. You can determine the maximum Java heap size setting by using the following
table to calculate the maximum amount of memory that the configuration requires.

Note: The default Java heap size is 1280 MB on stand-alone installations, and 1024 MB on HMC
installations.

Table 26. Calculation for estimating recommended Java heap size

Java heap size estimation

Non-session processing = 512 MB

Non-Safeguarded Copy sessions = 256 MB / 25,000 pairs

Note: The number of pairs for a session is the number of copy sets times the number of role pairs in
the session. See the topic titled "Copy sets" in the online help documentation at https:/www.ibm.com/
support/knowledgecenter/SSESK4 for more information.

Safeguarded Copy sessions = .8KB * number of volumes * number of backups

Total recommended heap size = non-session + non-Safeguarded Copy sessions + Safeguarded Copy
sessions

Example: The following scenario shows how you would determine the necessary Java heap size for an
environment like the one described:

Non-session processing
512 MB

Note: All servers need 512 MB for non-session processing.

Non-Safeguarded Copy sessions
A customer has a Global Mirror Failover/Failback DS8000 session with 15,000 copy sets. This session
type has 3 role pairs. So the total number of pairs in the session is 15,000 x 3, or 45,000 pairs.
Looking at the table, 256 MB is needed for every 25,000 pairs. This means that the customer would
need at least 512 MB to cover their 45,000 pairs.

Safeguarded Copy sessions
The customer also has a Safeguarded Copy session with 2000 volumes. If the customer wants to keep
250 backups for each of those 2000 volumes, then according to the table, the customer would need
2000 x 250 x .8 KB = 400°,000 KB = 400 MB

Adding up all the calculations gives 512 MB (non-session) + 512 MB (non-Safeguarded Copy session) +
400 MB (Safeguarded Copy session) = 1424 MB. So the customer needs at least 1424 MB of memory
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allocated to Copy Services Manager for processing. Because memory is allocated in chunks of 256 MB,
the recommended Java heap setting for this configuration would be 1536 MB.

If the calculation determines that more memory is required than the default setting on the server
platform, then the maximum heap size can be modified by shutting down the Copy Services Manager
server, changing the -Xmx parameter setting in the jvm.options file, and then restarting the Copy
Services Manager server.

For distributed systems: The install dir/liberty/wlp/usr/servers/csmServer/
jvm.options file now holds the maximum heap size for distributed systems, and can be used to
configure the session with the -Xmx parameter (for example, -Xmx1280m).

For z/0S systems: The path_prefix/opt/IBM/CSM/wlp/usr/sexrver/csmServer/jvm.options
file now holds the maximum heap size for z/OS, and can be used to configure the session with the =Xmx
parameter (for example, ~Xmx1280m).

Recommended: If Copy Services Manager is running on a DS8000 HMC, the default heap size is set to
1024 MB. If the memory calculation goes above 768 MB, it is highly recommended that Copy Services
Manager runs on an external server instead of the HMC.

For Copy Services Manager 6.2.10 and higher running on an HMC, if the HMC is configured with 32 GB, the
maximum heap size is automatically set to 4096 MB. If the memory calculation goes above 3840 MB, it is
highly recommended that Copy Services Manager runs on an external server instead of the HMC.

Contact support if you have questions on where Copy Services Manager should run, and the heap size
setting.

Table 27. Recommended Copy Services Manager JAVA heap size for ESESizer session:

Java heap size DS8000 capacity
4GB<=20TiB
8GB<=60TiB
16 GB > 60TiB

Warning: It is not recommended to start an ESESizer session on a CSM server that is actively
managing other sessions. Due to the heap requirements of the ESESizer session, the ESESizer
session may affect the other sessions running on the same server.

For more information about the maximum heap size, see the information about sizing the Java heap size
in the IBM SDK for Java Tools at https://www.ibm.com/developerworks/java/jdk/howdoi/index.html.

For more information about how to set up the Java heap size, see the WebSphere Application Server V8.5
Liberty profile technote at http://www.ibm.com/support/docview.wss?uid=swg21596474.

Disabling the SSLv3 protocol

You can disable SSLv3 after you upgrade to a system that no longer requires this protocol.

Newer levels of the IBM Java virtual machine (JVM) now disable SSLv3 by default, because it is no longer
considered a secure protocol. This protocol can be affected by the Padding Oracle On Downgraded Legacy
Encryption (POODLE) vulnerability. Systems with the POODLE fix should not use SSLv3 connections.
However, older systems that do not have this fix still connect by using SSLv3. Copy Services Manager
enables limited support for the SSLv3 protocol to accommodate these older systems. After you upgrade
your system, you need to disable SSLv3.

Note: This procedure is not necessary for Copy Services Manager on the HMC because it only uses
TLSv1.2 connections.
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Disabling the SSLv3 protocol for DS8000 connections
You can disable the SSLv3 protocol for DS8000 connections.

Perform the following steps to disable SSLv3 in Copy Services Manager for DS8000 connections. You
can either edit the essclient.properties and jvm.options files directly, or use the chsystem
command.

Note: This procedure is not necessary for Copy Services Manager on the HMC because it only uses
TLSv1.2 connections.

Disable SSLv3 on DS8000 by editing the essclient.propexrties and
jvm.options files

You can edit the essclient.properties and jvm.options files to change the protocol from SSLv3 to
TLSv1.2 for DS8000 connections.

Follow these steps to change the protocol from SSLv3 to TLSv1.2 by editing the
essclient.properties and jvm.options files:

1. Inthecsm_install_directory/liberty/wlp/usr/servers/csmSexrver/properties/
essclient.propexrties file, add this line:

ssl_protocol=TLSv1.2

2.Inthecsm_install_directory/liberty/wlp/usr/sexrvers/csmServer/jvm.options file,
delete the following line:

-Dcom.ibm.jsse2.disableSSLv3=false

Disable SSLv3 on DS8000 by using the chsystem command

You can use the chsystem command to change the protocol from SSLv3 to TLSv1.2 for DS8000
connections.

Follow these steps to change the protocol from SSLv3 to TLSv1.2 by using the chsystem command:
1. Log in to the Copy Services Manager command line as a user with administrative authority.

2. Run the chsystem command as follows:

csmcli> chsystem -f essclient -p ssl_protocol -v TLSv1.2

Note: See the chsystem command in the IBM Copy Services Manager online product documentation
(http://www-01.ibm.com/support/knowledgecenter/SSESK4) for more information.

The Command-line Interface User's Guide also provides details on the chsystem command. See
“Publications and related information” on page xiv for where to locate this guide.

Disabling the SSLv3 protocol for z/0OS host connections
You can disable the SSLv3 protocol for z/OS host connections by using the chsystem command.
Follow this procedure to disable the SSLv3 protocol for z/OS host connections:
1. Log in to the Copy Services Manager command line as a user with administrative authority.

2. Run the chsystem command as follows:

csmcli> chsystem -f zosclient -p protocol -v TLSv1.2

Note: See the chsystem command in the IBM Copy Services Manager online product documentation
(http://www-01.ibm.com/support/knowledgecenter/SSESK4) for more information.

The Command-line Interface User's Guide also provides details on the chsystem command. See
“Publications and related information” on page xiv for where to locate this guide.
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Chapter 3. Managing management servers

You can set up active and standby management servers, restore a lost connection between the
management servers, or complete a takeover on the standby management server.

Copy Services Manager Basic Edition does not support active and standby management servers. If you are
using this product, the menu item Management Servers is not available.

Management servers

The management server is a system that has IBM Copy Services Manager installed. The management
server provides a central point of control for managing data replication.

You can create a high-availability environment by setting up a standby management server. A standby
management server is a second instance of Copy Services Manager that runs on a different physical
system, but is continuously synchronized with the primary (or active) Copy Services Manager server.

The active management server issues commands and processes events, while the standby management
server records the changes to the active server. As a result, the standby management server contains
identical data to the active management server and can take over and run the environment without any
loss of data. If the active management server fails, you can issue the Takeover command to make the
standby management server take over.

Connecting the active management server to the standby management server

Ensure that the active management server is connected to the standby management server. This
connection creates the management server relationship that begins the synchronization process. Each
management server can be in only one management server relationship.

Problems might occur during the synchronization process. For example, the management server
relationship might become disconnected for a number of reasons, including a connectivity problem or
a problem with the alternative server.

If a problem occurs during the synchronization process, the alternative server database is restored to
its original state before the synchronization process began. Issue the Reconnect command to restore
synchronization.

Completing a takeover on the standby management server

Avoid having two active management servers. If there are two active management servers and a condition
occurs on the storage systems, both management servers respond to the same conditions, which might
lead to unexpected behavior.

Important: After you perform the takeover, shut down the active server to prevent the two servers from
managing the same set of pairs.

If you complete an action on the active management server when the servers are disconnected, the
servers will be out of sync.

Viewing the status of the management servers

You can view the status of the active and standby management severs from the Management Servers
page in the Copy Services Manager graphical user interface (GUI). If you are logged on to the active
management server, the icons on this panel show the status of the standby management server. If you
are logged on to the standby management server, the icons on this panel show the status of the active
management server.

When the status is Synchronized, the standby management server contains the same data that the active
management server contains. Any update to the active management server database is replicated to the
standby server database.
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Setting exceptions for ephemeral port numbers

For management servers that use an Internet Protocol version 4 (IPv4) connection, the port that is shown
on the Management Servers page of the Copy Services Manager GUI is the listener port. This port is set
when Copy Services Manager is installed.

However, when the management server initiates a connection to standby server, the management server
uses an ephemeral port.

An ephemeral port is a temporary port number that is assigned for the duration the connection. When
the connection terminates, the ephemeral port is available for reuse. When the management server
reconnects to the standby server, a new ephemeral port number is assigned.

If you are using a firewall, you must create exceptions that enable the management server to connect to
the standby server by using outbound ephemeral ports.

Information specific to management servers in z/0S environments

If the standby management server is not in the active server z/OS sysplex, the standby server is not able
to communicate with the storage systems by using a z/OS connection. Therefore, another connection
must be made by using a TCP/IP connection.

Copy Services Manager Basic Edition does not support active and standby management servers. If you are
using this product, the menu item Management Servers is not available.

Setting up a standby management server

The management server on which you are currently logged in can be set up as the standby, or a different
server can be selected for this purpose.

Note: When you define a standby management server, the Copy Services Manager code must be at the
same level on both the standby and active management servers.

Setting the local management server as the standby server
You can set the server on which you are currently logged in as the standby management server.

Attention: When you set a management server as the standby server, all the information on that
management server is cleared. The operation cannot be undone.

To set the local management server as the standby server, complete the following steps:

1. In the menu bar, click Settings > Management Servers.
2. On the Management Servers page, from the Select Action list, select Set this Server as Standby.

3. Enter the domain name or IP address of the server that you want to use as the active management
server.

4. Click OK to connect to the active server. The server on which you are logged in is now the standby
server.

Setting a remote management server as the standby server
You can define a remote server as the standby management server.

Attention: When you set a management server as the standby server, all the information on that
management server is cleared. The operation cannot be undone.

To set a remote management server as the standby server, complete the following steps:

1. In the menu bar, click Settings > Management Servers.
2. On the Management Servers page, from the Select Action list, select Define Standby.

3. Enter the domain name or IP address of the server that you want to use as the standby management
server. Log in to the standby management server by entering the user name and password.
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4.

Apply

Click OK to connect to the standby management server.

ing maintenance to an active management server

If you need to apply maintenance to an active management server, you can reinstall Copy Services

Ma
Fol
1

10.

nager on the server without affecting the session.
low these steps to reinstall Copy Services Manager on the active management server.

. If the heartbeat is enabled, disable it:
a) In the menu bar, click Settings > Advanced Tools.
b) On the Advanced Tools page, click Disable Heartbeat.

. On the standby server, Server 2, issue a take-over. This makes Server 2 the active server. It is
possible that the original active server, Server 1, is still listed on the Server 2 Management Servers
page. If so, select Remove Standby.

. Disable the heartbeat on Server 2, in case there are any problems.

. Upgrade Copy Services Manager on Server 1.
Note: If no changes have been made to the configuration while Server 1 was being upgraded, steps 5
and 6 are not necessary.

. When Copy Services Manager is running on Server 1, log into Server 2 and set Server 1 as the standby
server for Server 2.
This step copies the configuration from Server 2 to Server 1. This process takes a few minutes.

. When the management servers status is synchronized, issue a take-over on Server 1.
This makes Server 1 an active server, able to control sessions.
Note: It is possible that Server 2 is still listed on the Server 1 Management Servers page. If this is the
case, select Remove Standby.

. Disable the heartbeat on Server 1 to make sure this active server does not have any problems.

Note: If you do not need to upgrade Copy Services Manager on Server 2, skip the next step.
. Upgrade Copy Services Manager on Server 2.

. On Server 2, go to the Management Servers page and select the Set This Server As Standby option,
entering the information for Server 1. When this step is complete, Server 1 is the active server, and
Server 2 is the standby server.

When you are confident that the active server is running without any problems, enable the heartbeat
again, if needed.

Reconnecting the active and standby management servers

If the active and standby management servers become disconnected, reestablish that connection.

To reconnect the active and standby management servers, complete the following steps:

1.
2.

In the menu bar, click Settings > Management Servers.
On the Management Servers page, from the Select Action list, select Reconnect.

Changing the standby management server port number

The standby management server port is used is used for communication between the active and standby

ma

nagement server. This port is initially defined during the installation. You can manually change this port

after installation.

1.

Open the rmserver.properties fileinthe install
dir\liberty\wlp\usr\servers\csmServer\properties directory for distributed systems, or
inthe path_prefix/opt/IBM/CSM/wlp/usx/servers/csmServer/properties directory for
z/0S systems.
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2. Modify the port number for the following property:
communications.haPort=port_number

3. Restart Copy Services Manager.

You must restart Copy Services Manager to activate property changes. Properties are not synchronized
between the Copy Services Manager management servers and must be done on each Copy Services
Manager management server.

Changing the client port number

The client port is used to log in to the graphical user interface and command-Lline interface from a remote
system. This port is initially defined during the installation. You can manually change this port after
installation.

1. Open the rmserver.properties fileinthe install
dir\liberty\wlp\usr\servers\csmServer\properties directory for distributed systems, or
the path_prefix/opt/IBM/CSM/wlp/usxr/servers/csmServer/properties directory for z/OS
systems.

2. Modify the port number for the following property:
communications.port=port_number

3. Openthe repcli.propertiesfileinthe install dir\CLI\ directory for distributed systems, or
inthe path_prefix/opt/IBM/CSM/CLI directory for z/OS systems.

4. Modify the port number for the following property:
port=port_number

5. Restart Copy Services Manager.

You must restart Copy Services Manager to activate property changes. Properties are not synchronized
between the Copy Services Manager management servers and must be maintained on each Copy
Services Manager management server.
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Chapter 4. Managing storage systems

To replicate data among storage systems using Copy Services Manager, you must add connections to
the storage systems. After a storage system is added, you can associate a location, modify connection
properties, set volume protection, and refresh the storage configuration for that storage system.

Storage systems

A storage system is a hardware device that contains data storage. Copy Services Manager can control data
replication within and between various storage systems.

To replicate data among storage systems that use Copy Services Manager, you must manually add a
connection to each storage system in the Copy Services Manager configuration. You can then omit storage
systems for which Copy Services Manager does not manage replication and omit storage systems that are
being managed by another Copy Services Manager management server.

For redundancy, you can connect a single storage system by using a combination of direct, Hardware
Management Console (HMC), and IBM z/0OS connections.

You can use the following storage systems:

- IBM DS8000
« Systems running IBM Spectrum Virtualize
- Systems running IBM Spectrum Accelerate, including:

- XIV
— FlashSystem A9000
— FlashSystem A9000R

FlashSystem V840, FlashSystem V9000, FlashSystem 9100, FlashSystem 9200, and SAN Volume
Controller systems can virtualize various storage systems. Although Copy Services Manager does not
support all storage systems, you can manage other storage systems through a single FlashSystems/IBM
Spectrum Virtualize or SAN Volume Controller cluster interface. Copy Services Manager connects directly
to the FlashSystems/IBM Spectrum Virtualize or SAN Volume Controller clusters.

You can define a location for each storage system and for each site in a session. When you are adding
copy sets to the session, only the storage systems whose location matches the location of the site are
allowed for selection. This design ensures that a session relationship is not established in the wrong
direction.

Easy Tier heat map transfer

The IBM DS8000 Easy Tier heat map transfer function transfers heat map information from a source
storage system to one or more target storage systems. Each target storage system then generates volume
migration plans based on the heat map data and the physical configuration of the storage system.

This process ensures that the performance characteristics of the target storage systems are consistently
updated to reflect the performance characteristics of the source storage system.

The Easy Tier heat map transfer function is available for IBM DS8000 Release 7.1 and later.

You can enable heat map transfers for IBM DS8000 storage systems from the IBM Copy Services Manager
graphical user interface (GUI). The storage systems must meet the following requirements:

- The source and target storage systems must be connected to Copy Services Manager by using a
Hardware Management Console (HMC) connection.

« The Easy Tier heat map transfer function must be enabled on the source and target storage systems.
If the function is disabled on either the source or target storage system, an error is displayed when the
next transfer is attempted.
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To enable, disable, and configure heat map transfers, see “Configuring the use of the Easy Tier heat map
transfer function” on page 52.

Important:

When you enable or disable the use of the Easy Tier heat map transfer function in Copy Services Manager,
the function is not enabled or disabled on the storage systems that are connected to Copy Services
Manager. The configuration options that you set for Easy Tier heat map transfer in Copy Services Manager
are used only by Copy Services Manager.

Do not manage heat map transfers for the same IBM DS8000 storage systems from multiple Copy
Services Manager servers. Doing so causes transfers to occur more frequently than the default transfer
schedule, which is 12 hours after the previous transfer.

Easy Tier heat map transfer log files

Easy Tier heat map transfer log files are in the install
dir\liberty\wlp\usr\servers\csmServer\logs\ethmt\log\ directory for distributed systems
and in the path_prefix/opt/IBM/CSM/wlp/usr/servers/csmServer/logs/ethmt/log directory
for z/OS systems. If a problem related to the Easy Tier heat map transfer function occurs, you can send
these log files to IBM Software Support for troubleshooting purposes.

Storage connections

You must create a connection from the IBM Copy Services Manager management server to each storage
system.

The following types of connection are available. The connection type that you can use depends on the
storage system type.

Direct Connection
This connection type is available for all storage systems other than IBM System Storage DS8700 or
later storage systems or IBM DS8000 storage systems that are on an Internet Protocol version 6
(IPv6) network.

Hardware Management Console (HMC) Connection
This connection type is available for System Storage DS8700 or later storage systems and IBM
DS8000 storage systems that are on an IPv4 or IPv6 network.

IBM z/0S Connection
This connection type is available for IBM DS8000 storage systems. If the storage system is connected
to a z/0OS system on which Copy Services Manager is installed, a native connection is automatically
added. If the storage system is connected to another z/OS system, you can use an IP connection to
connect to the system.

A single storage system can be connected by using multiple connections for redundancy. For example,
you can connect to a IBM DS8000 storage system by using an HMC connection and a z/OS connection.

When you add a storage connection to the Copy Services Manager configuration, the storage system and
the connection are added to the active management server and the standby server configuration.

Important: If the Metro Mirror heartbeat is enabled, do not connect to an IBM DS8000 storage system
by using both an HMC connection and a direct connection. If you have both types of connections and the
direct connection is lost, the session changes to the suspended state even though the HMC connection is
still valid. If both connections are lost and the session is in the suspended state, restart the session when
connectivity is regained to synchronize the session with the hardware.

Direct connection

By using a TCP/IP connection, the Copy Services Manager management server can connect directly to
certain storage systems. The TCP/IP connection is required to discover a system’s configuration (such as
LSSs, volumes, volume size, and format), issue queries, and receive asynchronous events.

The Copy Services Manager management server can connect directly with the following systems:
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- DS8000

« Systems running IBM Spectrum Virtualize

« Systems running IBM Spectrum Accelerate, including;:
- XIV
— FlashSystem A9000
— FlashSystem A9000R

DS8000 storage systems on an IPv4 network can be connected directly to the management server. A
direct connection requires an Ethernet card in the cluster. DS8000 systems on an IPv6 network cannot
use a direct connection. They can be connected only through an HMC or z/OS connection.

When you add a direct connection to a DS or ESS cluster, specify the following information for clusters 0
and 1:

IP addresses or domain names

« Ports
« User names
« Passwords

FlashSystem V840, FlashSystem V9000, FlashSystem 9100, FlashSystem 9200, SAN Volume Controller,
and FlashSystems/IBM Spectrum Virtualize systems can virtualize various storage systems. Although
Copy Services Manager does not support all storage systems, you can manage other storage systems
through a single FlashSystems/IBM Spectrum Virtualize or SAN Volume Controller cluster interface.
Copy Services Manager connects directly to the FlashSystems/IBM Spectrum Virtualize or SAN Volume
Controller clusters.

When you add a direct connection to a cluster to the Copy Services Manager configuration, specify the
cluster IP address of the cluster. Ensure that the user name and password are correct for the cluster. If
incorrect values are used, significant communication problems can occur, such as never advancing to the
Prepared state.

Important: The storage system user name must have privileges to maintain SSH keys. For

information about troubleshooting Secure Shell connections to the storage system, see the Ethernet
Connection Restrictions on SAN Volume Controller website at www-01.ibm.com/support/docview.wss?
uid=ssg151002896.

Hardware Management Console connection

The Copy Services Manager management server can connect to DS8000 storage systems through a
Hardware Management Console (HMC). An HMC can have multiple DS8000 storage systems that are
connected to it. When you add an HMC to the Copy Services Manager configuration, all DS8000 storage
systems that are behind the HMC are also added. You cannot add or remove individual storage systems
that are behind an HMC.

You can also add a dual-HMC configuration, in which you have two HMCs for redundancy. You must
configure both HMCs identically, including the user ID and password.

If planned maintenance is necessary on the HMC, it is recommended that you disable the Metro Mirror
heartbeat on the management server while the maintenance is performed.

If the HMC needs to go down frequently or restarts frequently, it is recommended that you disable the
Metro Mirror heartbeat. If the Metro Mirror heartbeat is required, the direct connection is recommended
instead of an HMC connection.

Important: If a DS8000 storage system uses an HMC connection, the Metro Mirror heartbeat might
trigger a freeze operation on the storage system. This freeze operation can impact applications during the
long busy timeout timer if the HMC is shut down for any reason, including upgrading microcode. The long
busy timeout timer is the time after which the storage system allows I/O to begin again after a freeze
operation occurs if no run command is issued by Copy Services Manager. The default value is 2 minutes
for CKD volumes or 1 minute for fixed block volumes.
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Notes:

« The user ID that you use to connect to the HMC must have admin, op_storage, or op_copy_services
privileges on the DS8000 storage system. In addition, the user ID must have Copy Services access to
any volumes that are in resource groups on the DS8000 storage system.

« The user ID that you use to connect to the HMC must have admin-level authority to view the advanced
storage system settings for DS8000. The op_storage, or op_copy_services privileges are not sufficient.

- Although you can use either an IP address or a host name to connect to an HMC, the use of a host name
ensures that connection to the HMC is not lost if the IP address changes.

 You cannot modify the primary IP address or host name for the HMC in Copy Services Manager after you
add the connection. If you want to change the IP address or host name, you must add a connection to
the HMC and then remove the old connection.

« For minimum microcode requirements to connect to a DS8000 through a management console,
see the Supported Storage Products List website at www-01.ibm.com/support/docview.wss?
uid=ssg151005402.

z/0S connection

This connection type is available for IBM DS8000 storage systems. If the storage system is connected to
an IBM z/0S system on which Copy Services Manager is installed, a native connection is automatically
added. If the storage system is connected to another z/OS system, you must you use an IP connection to
connect to the z/OS system.

To add a z/OS connection, the system must be listed on the Host Connections page and in the Connected
state. You can add a connection to a z/OS system from Copy Services Manager that is running on any
operating system. For example, you can add a connection to a z/OS system in Copy Services Manager
that is running on Windows, Linux, or AIX. Or, you can add a connection in Copy Services Manager that is
running on z/0S to another z/OS system.

The z/OS connection is used to issue replication commands and queries for attached count key data
(CKD) volumes over an existing Fibre Channel network and to receive asynchronous events. When a
storage system is added to Copy Services Manager through a z/OS connection, all CKD volumes that are
attached to the Copy Services Manager management system are added to the Copy Services Manager
configuration. CKD volumes that are not attached to the Copy Services Manager z/OS management server
are not added to the Copy Services Manager configuration through the z/OS connection.

Ensure that all volumes in the logical storage subsystem (LSS) that you want to manage through a z/0S
connection are attached to a z/OS system. Either the entire LSS must be attached to z/OS or none of the
volumes in the LSS should be attached to z/OS for Copy Services Manager to properly manage queries

to the hardware. For example, if there are two CKD volumes in an LSS, and one volume is attached to
Copy Services Manager by using a z/OS connection and the other is attached through a direct connection,
Copy Services Manager issues commands to both volumes over the Fibre Channel network. However,
commands issued to the direct connection volume fail, and Copy Services Manager shows that the copy
set that contains that volume has an error.

Tip: It is recommended that you create both a Hardware Management Console (HMC) and direct
connection for CKD volumes to allow for greater storage accessibility.

If a storage system was previously added to the Copy Services Manager configuration through a z/0OS
connection and later the storage system is added through a TCP/IP connection, all non-attached CKD
volumes and fixed block volumes are added to the Copy Services Manager configuration.

The Metro Mirror heartbeat

The Metro Mirror heartbeat is not supported through a z/OS connection. To use the Metro Mirror
heartbeat, the storage systems must be added by using an HMC or direct connection. If the Metro Mirror
heartbeat is enabled and a storage system is added through a direct connection and a z/OS connection, a
suspend results if the direct connection becomes disconnected because there is no heartbeat through the
z/OS connection.
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Removing connections to a z/0S system

If Copy Services Manager has multiple connections to a storage system, the order in which you remove
the connections produces different results:

« If you remove direct and HMC connections first, the fixed-block and non-attached CKD volumes that are
attached through these connection types are removed from the Copy Services Manager configuration.

« The remaining CKD volumes that are attached through the z/OS host connection remain in the Copy
Services Manager configuration until the z/OS host connection is removed.

« If you remove the z/OS host connection first and there is an HMC or direct connection to volumes, those
volumes are not removed from the Copy Services Manager configuration.

Protected volumes

You can mark volumes as protected if you do not want those volumes used for replication.

When a volume is marked as protected, you cannot include that volume in a copy set. This protection
applies only to Copy Services Manager.

You might want to protect a volume in the following instances:

« The volume contains data that you never want to be copied to another volume. For example, the volume
is secure, but if the data is copied to an unsecured volume, the data could be read. For this reason, the
volume should not be the source for a relationship.

« The volume contains data that you do not want to be overwritten. For this reason, the volume should not
be the target of a relationship.

Only administrators can change the volume protection settings.

Site awareness

You can associate a location with each storage system and each site in a session. This site awareness
ensures that only the volumes whose location matches the location of the site are allowed for selection
when you add copy sets to the session. This prevents a session relationship from being established in the
wrong direction.

Note: To filter the locations for site awareness, you must first assign a site location to each storage
system.

Copy Services Manager does not perform automatic discovery of locations. Locations are user-defined
and specified manually.

You can change the location associated with a storage system that has been added to the Copy Services
Manager configuration. You can choose an existing location or add a new one. Locations are deleted when
there is no longer a storage system with an association to that location.

When adding a copy set to a session, a list of candidate storage systems is presented, organized by
location. Storage systems that do not have a location are displayed and available for use when you create
a copy set.

You can also change the location for any site in a session. Changing the location of a session does not
affect the location of the storage systems that are in the session.

Changing the location of a storage system might have consequences. When a session has a volume role
with a location that is linked to the location of the storage system, changing the location of the storage
system could change the session's volume role location. For example, if there is one storage system with
the location of A_Location and a session with the location of A_Location for its H1 role, changing the
location of the storage system to a different location, such as B_Location, also changes the session's H1
location to Site 1. However, if there is a second storage system that has the location of A_Location, the
session's role location is not changed.
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Important: Location matching is enabled only when adding copy sets. If you change the location of a
storage system or volume role, Copy Services Manager does not audit existing copy sets to confirm or
deny location mismatches.

Adding a storage connection

You must add connections to storage systems before you can use Copy Services Manager to manage data
replication.

To add a storage system connection, you must have an Administrator role.

Adding a connection to an IBM DS8000 storage system by using an HMC
connection

You must use a Hardware Management Console (HMC) connection to connect to an IBM DS8000 storage
system if the system is a DS8700 or later or is on an Internet Protocol version 6 (IPv6) network.

Complete the following steps to add a storage system connection:

1. In the menu bar, click Storage > Storage Systems.
2. On the Storage Systems page, click Add Storage Connection.
3. Click the DS8000 icon.

4. On the Connection page of the Add Storage System wizard, click HMC and complete the following
fields.

Primary HMC
Specify the following information about the primary HMC that is used to connect to the storage
system.

IP Address/Domain Name
Enter the IP address or host name for the primary HMC. Although either an IP address or a host
name are acceptable, the use of a host name ensures that connection to the HMC is not lost if
the IP address changes.

You cannot modify the primary IP address or host name for the HMC in Copy Services Manager
after you add the connection. If you want to change the IP address or host name, you must add
a new connection to the HMC and then remove the old connection.

Username
Enter the user name for the HMC.

Password
Enter the password for the HMC.

Secondary HMC (Optional)
Specify information about the secondary HMC, if applicable. A secondary HMC is used for
redundancy.

Both HMCs must be configured identically and must have the same user name and password.

IP Address/Domain Name
Enter the IP address or host name for the secondary HMC.

5. Click Next and follow the instructions in the wizard.

Adding a connection to an IBM DS8000 storage system by using a direct
connection

You can connect to an IBM DS8000 storage system by using a direct connection if the system is earlier
than a DS8700 and is on an Internet Protocol version 4 (IPv4) network.

Direct connection requires that each of the storage system clusters contains an Ethernet card.

Complete the following steps to add a storage system connection:
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1. In the menu bar, click Storage > Storage Systems.

2. On the Storage Systems page, click Add Storage Connection.

3. Click the DS8000 icon.

4. On the Connection page of the Add Storage System wizard, click Direct Connect and complete the

5.

following fields.
Cluster 0

Specify the following information about connection to cluster O:

IP Address/Domain Name
Enter the IP address or host name for the cluster.

Port
Enter the port number for the cluster. The default value is 2433.

Username
Enter the user name for the cluster.

Password
Enter the password for the cluster.

Cluster 1
Specify the following information about connection to cluster 1. The port, user name, and
password for cluster 0 are automatically entered in the corresponding fields for cluster 1. You
can edit this information, if required for your environment.

IP Address/Domain Name
Enter the IP address or host name for the cluster.

Port
Enter the port number for the cluster. The default value is 2433.

Username
Enter the user name for the cluster.

Password
Enter the password for the cluster.

Click Next and follow the instructions in the wizard.

Adding a connection to a TotalStorage Enterprise Storage Server storage
system

You can connect to a TotalStorage Enterprise Storage Server storage system by using a direct connection

to the storage system.

Complete the following steps to add a storage system connection:

1.
2. On the Storage Systems page, click Add Storage Connection.

3.

4. On the Connection page of the Add Storage System wizard, enter the following information for the

In the menu bar, click Storage > Storage Systems.

Click the ES800 icon.

storage system clusters:

Cluster 0
Specify the following information about connection to cluster O:

IP Address/Domain Name
Enter the IP address or host name for the cluster.

Port
Enter the port number for the cluster. The default value is 2433.

Username
Enter the user name for the cluster.
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5.

Password
Enter the password for the cluster.

Cluster 1
Specify the following information about connection to cluster 1. The port, user name, and
password for cluster O are automatically entered in the corresponding fields for cluster 1. You
can edit this information, if required for your environment.

IP Address/Domain Name
Enter the IP address or host name for the cluster.

Port
Enter the port number for the cluster. The default value is 2433.

Username
Enter the user name for the cluster.

Password
Enter the password for the cluster.

Click Next and follow the instructions in the wizard.

Adding a connection to a FlashSystem/IBM Spectrum Virtualize or SAN
Volume Controller storage system

You can connect to a FlashSystem/IBM Spectrum Virtualize or SAN Volume Controller storage system by
using a direct connection.

Complete the following steps to add a storage system connection:

1.
2.
3.
4.

5.

In the menu bar, click Storage > Storage Systems.

On the Storage Systems page, click Add Storage Connection.

Click the icon for either FlashSystem Spectrum Virtualize or SAN Volume Controller.

On the Connection page of the Add Storage System wizard, enter the following information for the
storage system cluster:

Cluster IP / Domain Name
Enter the IP address or host name of the storage system node.

Username
Enter the user name for the node.

Password
Enter the password for the node.

Click Next and follow the instructions in the wizard.

Adding a connection to a FlashSystem/IBM Spectrum Accelerate

You can connect to a FlashSystem/IBM Spectrum Accelerate by using a direct connection to the storage
system.

Complete the following steps to add a storage system connection:

1.
2. On the Storage Systems page, click Add Storage Connection.

3.

4. On the Connection page of the Add Storage System wizard, enter the following information for a node

In the menu bar, click Storage > Storage Systems.

Click the FlashSystem Spectrum Accelerate icon.

on the storage system.
When you specify the information for one node, the remaining nodes are discovered automatically.

IP Address/Domain Name
Enter the IP address or host name for a node in the storage system.

Username
Enter the user name for the node.
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Password
Enter the password for the node.

5. Click Next and follow the instructions in the wizard.

Adding a connection to a z/0S system

You can connect to storage systems that are connected to an IBM z/0S system regardless of the operating
system on which Copy Services Manager is installed.

If a z/OS system is defined on the Host Connections page, you can add a connection to a z/OS from any
operating system. For example, you can add a connection to a z/OS system in Copy Services Manager that
is running on Windows, Linux, or AIX.

Complete the following steps to add a z/OS system connection:

1. In the menu bar, click Storage > Storage Systems.
2. On the Storage Systems page, click Add Storage Connection.
3. Click the z/0OS Direct Connection icon.

4. On the Connection page of the Add Storage System wizard, select the storage systems that you want
to add.

5. Click Next and follow the instructions in the wizard.

Removing a storage system

You can remove a storage system from the Copy Services Manager configuration.

Prerequisites: You must have Administrator privileges to remove a storage system.

Removing a storage system removes all volumes on that storage system from management server control.
All copy sets with a volume on the removed storage system are removed from their respective sessions,
making the target volume unrecoverable. All connections to the removed storage system are removed,
and any storage systems sharing these connections are also removed.

Perform these steps to remove a storage system:

1. In the menu bar, click Storage > Storage Systems.

2. On the Storage Systems page, select the storage system that you want to remove.
Important: All connections to this storage system will be removed, all volumes on the storage system
will be removed from management server control, and all copy sets that have a volume on this storage

system will be removed from their respective sessions, leaving the target volume unrecoverable. Any
storage systems sharing these connections will be removed as well.

3. From the Select Action list, select Remove Storage System.
4. Click Yes to remove the storage system.
For high availability (HA) users: If you have a standby server, removing a storage system from the active

server does not automatically remove it from the standby. If you want to remove the storage system from
the standby server, you can resync the standby server with the following steps:

1. On the Overview panel of the Copy Services Manager GUI, click Management Servers > Select Action
> Remove Standby.

2. Then, on the same panel, click Select Action > Define Standby. Enter the associated Domain/IP,
Username, and Password for the standby server, and click OK. The standby server is then
resynchronized.

Modifying the location of storage systems

You can associate a location with a storage system after a connection has been made to that storage
system.

Prerequisites: You must have Administrator privileges to modify the location of a storage system.
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Changing the location of a storage system might have consequences. When a session has a volume role
with a location that is linked to the location of the storage system, changing the location of the storage
system could change the session's volume role location. For example, if there is one storage system with
the location of A_Location and a session with the location of A_Location for its H1 role, changing the
location of the storage system to a different location, such as B_Location, also changes the session's H1

location to Site 1. However, if there is a second storage system that has the location of A_Location, the
session's role location is not changed.

Perform these steps to modify the location of a storage system:

1. In the menu bar, click Storage > Storage Systems.

2. On the Storage Systems page, change the location of the storage system by selecting a previously
defined location from the drop-down list or type a new name in the table cell.

To disable site awareness, set the location to None.

Note: Locations are deleted from the drop-down list when there is no longer a storage system with an
association to that location.

Modifying storage connection properties

You can modify the connection properties for a storage system, including IP addresses, user name and
password.

Prerequisites:

« You must have Administrator privileges to modify storage connection properties.
« The storage system must be in the Disconnected state to change most storage connection parameters.
You can add a secondary HMC to an existing HMC connection without the HMC being disconnected.

A storage system can lose connection to the management server, for example, if a port is blocked by

a firewall or the user name or password is changed on the storage system. If the storage system loses
connection, you might need to modify parameters (for example, user name or password) manually on the
storage system, and then update the parameters in Copy Services Manager.

Perform these steps to modify storage connection properties:

1. In the menu bar, click Storage > Storage Systems.
2. On the Storage Systems page, click the Connections tab.
3. Click the storage connection ID.

4. Modify the appropriate settings to match the settings for the storage system.
5. Click Apply.

Refreshing the storage system configuration

You can refresh the storage system configuration to query the storage system for changes, such as which
volumes are contained in an LSS. You might do this when you reconfigure a storage system and you want
Copy Services Manager to be aware of the changes.

Prerequisites: You must have Administrator privileges to modify storage connection settings.
Perform these steps to refresh the storage configuration:
1. In the menu bar, click Storage > Storage Systems.

2. On the Storage Systems page, select the storage system for which you want to refresh the
configuration.

3. From the Select Action list, select Refresh Configuration.
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Setting volume protection

To ensure that data on a volume is not overwritten, you set its status to protected. Protected volumes are
excluded from replication.

You must have Administrator privileges to change the protection setting of a volume.

1. In the menu bar, click Storage > Storage Systems.
2. On the Storage Systems page, click Volume Protection.
The Volume Protection wizard is opened.
3. The Volume Protection wizard, select a storage system and complete the following steps:
4. Optional: Depending on the type of storage system:
a) Select AU IO Groups or a specific I/O group.
b) Select All Logical Storage Subsystems or a specific logical storage subsystem.
c) Select All Pools or a specific pool.
5. Optional: In the Volume field, select a single volume.

6. Optional: In the Volume Mask field, enter a sequence of characters and wildcards that match user-
defined or system-defined volume IDs.

To protect a specific volume, enter the volume ID such as ESS:2105.FCA57:VOL:1000. To use a
pattern to retrieve one or more volume IDs, you can enter a partial volume ID and use the wildcard
character (*) to represent zero or more characters.

For example, to retrieve all volume IDs that contain the characters FCA57, you enter xFCA57*.
7. Click Next.
8. Verify the search results, and click Next.

9. Click Select All to protect all the volumes. Alternatively, select a check box next to the volumes that
you want to protect.

10. Click Next.
11. Click Finish.

Restoring data from a journal volume

This topic provides information on restoring data from a journal (J) volume. It describes how to restore
data from journal volume used as part of a DS8000 Global Mirror session, or as part of a Metro Global
Mirror session, if data was corrupted on a host volume after you issued a Recover command. Following
these steps will enable you to return to a consistent copy of the data on the host volume.

Perform the following steps to move the data from the journal volume back to the host volume:

Note: Follow these instructions only if you have already issued a Recover command to the site containing
the journal volume. After the Recover command is issued, the journal volume will hold a copy of the
consistent data at the time the command was issued.

1. Outside of Copy Services Manager, using the DS8000 GUI /CLI, issue withdraw initiate background
copy (issue a rmflash -cp command) on pairs containing the journal volume (for example, H2J2).
This copies the remaining uncopied tracks from the host to the journal. Then, ensure all the Out of
Sync (00S) tracks reach zero.

2. Create a separate FlashCopy session either with Copy Services Manager, or with the DS8000 GUI /CLI
(issue amkflash command with background copy), with the following conditions:

« The journal volume (Jx) is the source volume.
« The host volume (Hx or Ix if using a session with Practice capabilities) is the target volume.
« x is the site the Recover command was issued to.
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Configuring the use of the Easy Tier heat map transfer function

You can enable Easy Tier heat map transfers for IBM DS8000 storage systems that are connected to IBM
Copy Services Manager from the Copy Services Manager graphical user interface (GUI).

The heat map transfer configuration options that are available in Copy Services Manager include adding
storage systems for which you want to transfer heat map data, and enabling or disabling the transfer of
Easy Tier heat map data for those storage systems.

1. In the menu bar, click Storage > Storage Systems.
2. Click the Easy Tier Heat Map Transfer tab.
3. The following configuration options are available:

Status
Indicates whether the transfer of Easy Tier heat map data is enabled or disabled.
Enable Transfer
Click to enable the transfer of Easy Tier heat map data, and then click Yes in the confirmation
window. Easy Tier heat map data is copied from the storage systems that are listed on this page to
the target storage systems that are associated with those storage systems.
Disable Transfer
Click to disable the transfer of Easy Tier heat map data, and then click Yes in the confirmation
window. The storage systems that are listed on this page remain displayed with a status of
Inactive.
Transfer only session-managed relationships
Select this option to transfer Easy Tier heat map data for relationships that are defined in sessions
on this server. Only relationships that are defined in sessions have the data transferred. The option
can only be modified when the status is disabled.
Transfer all relationships on the storage systems
Select this option to transfer Easy Tier heat map data for all relationships that are defined on
storage systems that are connected to this server. The option can only be modified when the status
is disabled.
Select Action
Select a storage system that is listed on this page, and then select one of the following actions.
After you make your selection, click Go:
View Transfer Details
Click to view detailed information about the transfer from the source storage system to its
target storage systems. This information includes whether the transfer succeeded or failed
and the date and time that the transfer started and stopped. This action is not available if the
source storage system does not have target storage systems.
Storage system details
The following information is shown for each storage system:

Storage System
Lists each source storage system and its target storage systems, if available.
Connection Status
One of the following states is displayed for each storage system connection:
Connecting
Indicates that connection to the storage system is in progress.

Connected
Indicates that connection to the storage system is established.

Disconnected

Indicates that connection to the storage system was lost. The connection can be lost for
several reasons, including:

- The storage system is not available.
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« The user name and password that is used to connect to the storage system was changed.
« Firewall issues prevent connection to the storage system.

Inactive
Indicates that the transfer of Easy Tier heat map data is disabled.

Transfer Results for Storage System window

Use the Transfer Results for Storage System window to view details about the transfer of Easy Tier heat
map data to target storage systems.

The following information is displayed in this window. This information includes the number of successful
and failed transfers and the last start and stop time that a transfer occurred.
Target Storage System
Select the storage system for which you want to view the transfer details.
Attempts
Shows the number of attempts that were made to transfer the Easy Tier heat map data to the target
storage system.
Successful Transfers
Shows the number transfers that were successful.
Failed Transfers
Shows the number of transfers that failed.
Last Transfer Start Time
Shows the date and time that the last transfer started. If a transfer is in progress, In Progress is
shown.
Last Transfer Stop Time
Shows the date and time that the last transfer stopped. If a transfer is in progress, Unknown is
shown.
Last Transfer Result
Provides a message that explains the results of the last transfer. If a transfer is in progress, a message
specifying that the transfer is in progress is shown.
Next Transfer Time

Shows the date and time that the transfer is scheduled to occur again. If a transfer is in progress,
Unknown is shown. Transfers are automatically scheduled for 12 hours after the previous transfer.

Viewing the storage system Topology Overview

You can use the storage system Topology Overview panel in the GUI to see a high-level view of the
relationships between storage systems managed by Copy Services Manager.

When you share common resources across sessions, it is helpful to have the capability to identify which
sessions are dependent on each other. Shared subsystem usage across sessions causes Metro Mirror

or data-path management dependencies, as well as Metro Mirror and Global Mirror consistency-group
handling dependencies.

Starting with V6.2.8, you can use the Topology Overview panel to view these dependencies by session or
site.

Perform these steps to use the Topology Overview:
1. Log in to the Copy Services Manager GUI.
2. In the menu bar, click Storage > Topology Overview.

3. On the Topology Overview page, you see a table that lists the following information across sessions:

Site Location

A user-defined name given to a storage system to organize storage that resides in a location. The
site name that is associated with the session is used to determine the data that populates the
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Topology Overview panel. This data is shown for each defined session created in Copy Services
Manager. If a session does not have a site location set it defaults to Site 1, Site 2, Site 3, and so on.

Storage System

A storage system defined to Copy Services Manager in the Storage Systems panel. It can be
associated with several sessions. Each storage system can be given a user-defined location name
in the Storage Systems panel; otherwise, the name defaults to none.

Direction

An arrow, which indicates the site direction of the relationship source to target. This column points
left to right. If the direction of the replication is reversed, that is, after a recover command is issued
to a session, the site and storage system order are switched in the table.

Notes:

« If you click the direction arrow, you are taken to a filtered version of the Topology Details panel.
The filter is based on the columns on either side of the arrow. For example, if you assume
columns on the Overview panel that are denoted by | Site 1 | Storage A | > | Site 2 | Storage B
|, then clicking on the arrow filters the pull-down menus on the Details panel to Site 1 > Site 2.

« When you first enter the Details page, it has an automatic filter set on that site with a target filter
of ALL selected. You can use the selections above the Details table to change the filtering.

See “Viewing the storage system Topology Details” on page 55 for more information.

Number of Sessions

The number of sessions that are sharing the same site and storage system combination.

Notes:

You do not need to have the session started for it to populate in the Topology Overview.

Columns cannot be moved, because the topology direction is dependent on the source and target
storage system replication.

Each row is based off the number of sites that make up various session solutions, which include
cascaded relationships. A three-site session type, such as Metro Global Mirror, or a four-site session
type, such as Metro Mirror - Global Mirror with Site 4 Replication, will cascade the copy of the data
over three different sites. If the first two sites use the same storage systems as a two-site solution,
such as Metro Mirror Failover/Failback, then those storage systems are depicted in multiple rows in
the table: one for the two-site topology, and another row for a cascaded three-site topology, even
though both the first and second site storage systems are the same.

The table is dynamic and updates in context to the session site copy direction. For example, after
recovering to site 3, the overview shows site 3 in the first column. The table also updates with any
changes to site location or session site changes.

When sessions and role pairs are in a Target Available state, although Copy Services Manager
displays a direction, there is no true direction yet because both sites are writable on the hardware.
Therefore, the relationship between sites might not be as expected when a Target Available state
is shown in the Topology Overview. For example, on a Metro Mirror - Global Mirror with Site 4
Replication session, after recovering to site 4, it is possible that the relationships might indicate a
4-site cascaded topology. This situation is corrected when you choose which site to start from, and
then restart the Copy Services Manager session.

Use the Filter field in the top right to filter on various views for the table. See the GUI panel help for
additional information.

4. Optional: The configuration refreshes every 30 minutes by default. However, you can also use the
Refresh button above the table to manually refresh the configuration whenever you choose.

Note: You can also set a property to refresh at a higher or lower rate if you go to Settings > Server
Properties and edit the properties in the displayed file. The property can be used to change the refresh
rate after the next scheduled refresh.
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Viewing the storage system Topology Details

You can use the storage system Topology Details panel in the GUI to see more detailed information about
relationships between site location and storage systems sessions that are managed by Copy Services
Manager.

This panel shows the topology details that are associated with a session copy role, its site relationship,
copy type, consistency group name, and storage system. Table data is refreshed automatically based on
the selected items.

Perform these steps to use the Topology Details panel:

1. Log in to the Copy Services Manager GUI.
2. In the menu bar, click Storage > Topology Details.

Notes:

« You can also open the Topology Details panel from the Topology Overview panel when you click
the direction arrow for a particular site location and storage system partnership. If you enter this
way, then you are taken to a filtered version of the Details panel. The filter is based on the columns
on either side of the arrow. For example, if you assume columns on the Overview panel that are
denoted by | Site 1 | Storage A | > | Site 2 | Storage B |, then clicking on the arrow filters the
pull-down menus on the Details panel to Site 1 > Site 2.

« When you first enter this detailed view from another panel, it has no filter set on either site because

ALL is selected for the source and target. You can use the drop-down selections above the Details
table to change the filtering.

See “Viewing the storage system Topology Overview” on page 53 for more information.

3. On the Topology Details page, you have filters above the table for Source and Target. Select the
source site, target site, or both, for the session topology details that you want to view; or select All to
view all relationships. You also see a table that lists the following information for each volume:

Source
The source storage system and subsystem (that is, LSS or I/O group).

Source Role
The role considered a source role in a role pair for a given session.

Target
The target storage system and subsystem (that is, LSS or I/O group).

Target Role
The role considered a target role in a role pair for a given session.

Session
The session that this relationship belongs to.

Copy Type
Shows the short name form of the copy type that is associated with this session role pair. The long
form is shown when you hover over. The following copy types are possible:

MM
Metro Mirror

GC
Global Copy

GM
Global Mirror

HS
HyperSwap
CG Name
The consistency group name set for the particular role-pair in the session if one is present. This is
a user-defined consistency group name or Global Mirror session ID on DS8000. This field can help
you to determine if sessions are sharing a consistency group.
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Use the Filter field in the top right to filter on various views for the table. See the GUI panel help for
additional information.

. Optional: The configuration refreshes every 30 minutes by default. However, you can also use the
Refresh button above the table to manually refresh the configuration whenever you choose.

Note: You can also set a property to refresh at a higher or lower rate if you go to Settings > Server
Properties and edit the properties in the displayed file. The property can be used to change the refresh
rate after the next scheduled refresh.

Topology Overview usage scenarios:

Find all H1 boxes for session "myself."

Find all sessions that use box "ANXR32."

Make sure that all connections from ANXR32 LSS 0 to ANZW65 LSS 0 are defined for MM.
Determine if the data is flowing between the correct boxes at each site.

Determine how many LSSs are using a given LSS as a target for remote copy.

Determine which LSSs on a given box are using the same user-defined consistency group nhame (sharing
the same Master session).

After receiving an xOF12 or x0f85 error starting a session, filter on the LSS containing the volume and
check if another session already has a relationship.

After receiving the following error message, you can filter on the session ID to determine what other
sessions are already using the consistency group name:

IWNR2326E

Message Text:

[timestamp] The pair in session VALUE_1 for copy set VALUE_2 with source
VALUE_3 and target VALUE_4 could not be started because the maximum number
of allowed Global Mirror sessions on the logical subsystem has been reached.
No action was taken on this pair.

Notes:

« Four-site sessions are shown as two rows in the Overview panel, one for the Metro Global Mirror

(MGM), and one for the multi-target Metro Mirror leg. Multi-target is also split into two rows. In the
Details panel, this feature becomes more clear because each role has its own row.

« Single site sessions like FlashCopy or Safeguarded Copy are not displayed in either the Overview or

Details panel.

Exporting data from GUI tables into a CSV file

You can export data from several tables in the GUI, including Volumes, Topology Overview, and Topology
Details.

Perform these steps to export data from the following tables in the GUI:

Exporting data from the Volumes table

1. Log in to the Copy Services Manager GUI.

2.
3.

In the menu bar, click Storage > Volumes.

Select a Storage System and Logical Storage Subsystem or Pool for which you want to export data
from the pull-down menus at the top of the page, and click Perform Query.

4. Optional: You can use the Filter field to filter on any of the data. See the GUI help for instructions on

using the filter.

. Click the export icon (=) in the upper right corner of the table to export the data to a comma-separated
(CSV) file.
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6.
7.

Note: Data in the CSV file is filtered according to the filter criteria that you selected. The data is
presented the same in the exported file as it is shown in the GUI table (for example, column ordering
and hiding).

Select whether you want to Open or Save the file.

Click OK to confirm your selection, or click Cancel to exit the dialog without exporting the information.

Exporting data from the Topology Overview table

1.
2.
3.

5.
6.

Log in to the Copy Services Manager GUL.
In the menu bar, click Storage > Topology Overview.

Optional: You can use the Filter field to filter on any of the data. See the GUI help for instructions on
using the filter.

. Click the export icon (=) in the upper right corner of the table to export the data to a comma-separated

(CSV) file.

Note: Data in the CSV file is filtered according to the filter criteria that you selected. The data is
presented the same in the exported file as it is shown in the GUI table (for example, column ordering
and hiding).

Select whether you want to Open or Save the file.
Click OK to confirm your selection, or click Cancel to exit the dialog without exporting the information.

Exporting data from the Topology Details table

1.
2.

Log in to the Copy Services Manager GUI.

In the menu bar, click Storage > Topology Details, or you can enter from the Topology Overview
panel when you click the copy direction arrow <<insert copy direction graphic here>>.

. Select a Source Site and Target Site for which you want to export data from the pull-down menus at

the top of the page.

Note: If you entered this panel from the Topology Overview, then the Details panel reflects the site
location and storage system combination that you were viewing in the previous panel. Therefore, you
might not need to make any additional selections if the table already displays the information that you
want to export.

. Optional: You can use the Filter field to filter on any of the data. See the GUI help for instructions on

using the filter.

. Click the export icon (=) in the upper right corner of the table to export the data to a comma-separated

(CSV) file.

Note: Data in the CSV file is filtered according to the filter criteria that you selected. The data is
presented the same in the exported file as it is shown in the GUI table (for example, column ordering
and hiding).

. Select whether you want to Open or Save the file.
. Click OK to confirm your selection, or click Cancel to exit the dialog without exporting the information.
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Chapter 5. Managing host systems

A host system is an IBM z/0S system that connects to storage systems to enable certain replication
features for those systems.

A connection to a z/OS host system is required if you want to enable z/OS features such as HyperSwap
and hardened freeze in Copy Services Manager sessions.

If Copy Services Manager is installed on the host system, the host system connection is automatically
added to Copy Services Manager. This connection is referred to as the native z/OS connection.

If Copy Services Manager is not installed on the host system, you must add the connection to the host
system by using an IP connection. To use an IP connection, you must set certain Resource Access Control
Facility (RACF®) settings on the z/OS host as described in the IBM Copy Services Manager Installation and
Configuration Guide.

You can add z/OS host connections in Copy Services Manager regardless of the operating system on which
the application is installed. For example, you can add a connection to a z/OS host system in Copy Services
Manager that is running on Windows, Linux, or AIX.

Adding a host system connection

You can add a connection to one or more host systems to the Copy Services Manager configuration.

Prerequisites: You must have Administrator privileges to add a host system connection.
Follow these steps to add a host system connection:

1. In the menu bar, click Storage > Host Connections.
2. On the Host Connections page, click Add Host Connection.
3. In the Add Host Connection window, enter the following information:

Connection Type
Select the host system type: z/OS or AIX.

Host name / IP address
Enter the host name or IP address for the host system.

Port
Enter the port for the host system.

For z/0S, the port number must be the same as the port number that is specified for the
HyperSwap management address space IOSHMCTL SOCKPORT parameter on the z/OS system. For
more information about the SOCKPORT parameter, see the IBM Copy Services Manager Installation
and Configuration Guide.

For AIX, use the default port number 9930 unless the port was modified in Subsystem Device
Driver Path Control Module (SDDPCM).

User name
Enter the user name. The User name field is displayed only for z/OS host systems. The user name
and password must be the same name and password that are specified in the Resource Access
Control Facility (RACF) settings on the host system. For more information about the RACF settings,
see the IBM Copy Services Manager Installation and Configuration Guide.

Password
Enter the password. The Password field is displayed only for z/OS host systems.

4. Click Add Host.

The host system is displayed on the Host Connections page. If connection to the host system is
successful, the status Connected is displayed. If the connection to the host system failed, the status
Disconnected is displayed.
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Note: On z/0S host systems, the TCPMAXRCVBUFRSIZE must be set to a minimum of 32K to
accommodate the maximum size of an Secure Sockets Layer (SSL) record. Otherwise AT-TLS fails during
the initial handshake.

Modifying a host system connection

You can modify host system connections that are in the Copy Services Manager configuration.

Prerequisites: You must have Administrator privileges to modify a host system connection and the
connection must be in the Disconnected state.

Follow these steps to modify a host system connection:

1. In the menu bar, click Storage > Host Connections.
2. On the Host Connections page, click the link for the host system in the Host System column.

Complete the information in the following fields. The fields that are displayed depend on the host
system and the type of connection to the host system.

Note: All fields are presented for informational purposes; however, some fields are information-only
fields.

Host name or IP address
For IBM z/0S host systems that are connected by using an IP connection, enter the host name or
IP address for the host system.

If Copy Services Manager is installed on the z/OS host system, ZOS_NATIVE_CONNECTION is
displayed.

Port
Enter the port for the host system.

For z/0S, the port number must be the same as the port number that is specified for the
HyperSwap management address space IOSHMCTL SOCKPORT parameter on the z/OS system. For
more information about the SOCKPORT parameter, see the IBM Copy Services Manager Installation
and Configuration Guide.

Type
Shows the type of host system connection.

System name
Shows the name of the z/OS host system. If there is no connection to the host system, Unknown is
displayed in this field.

Sysplex name
Shows the name of the z/0S sysplex that the host system is in or specifies that the system is not in
a sysplex. If there is no connection to the host system, Unknown is displayed.

User name
Enter the user name for the z/OS host system. The user name and password must be the same
name and password that are specified in the Resource Access Control Facility (RACF) settings
on the host system. For more information about the RACF settings, see the IBM Copy Services
Manager Installation and Configuration Guide.

Password
Enter the user password for the z/OS host system. If you change the user name, you must change
the password.

3. Click Update Host.

The host system is displayed on the Host Connections page. If connection to the host system is
successful, the status Connected is displayed. If the connection to the host system failed, the status
Disconnected is displayed.
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Removing a host system connection

You can remove host system connections from the Copy Services Manager configuration.

Prerequisites: You must have Administrator privileges to remove a host system.

Removing a host system connection disables the ability to use features that are supported by the
host, such as HyperSwap. Sessions that use the host system to provide these features can no longer
communicate with the host and the features are disabled for the entire session.

Follow these steps to remove a host system connection:

1. In the menu bar, click Storage > Host Connections.

2. On the Host Connections page, select the host system connection that you want to remove.
3. From the Select Action list, select Remove Host Connection.

4. Click OK to remove the host system connection.

The host system is removed from the Host Connections page.

Managing Sysplexes with the same name

Copy Services Manager allows multiple host connections to z/OS Sysplexes that have the same name. To
use this feature, a CSV file can be used to give a user-defined name for the host connection or for the

set of host connections. When the Sysplex name for a host connection is displayed, that was defined in
the CSV file, Copy Services Manager displays the user-defined name. If multiple Sysplexes have the same
name, define a unique user-defined name for each Sysplex. So that, when you associate a Sysplex to a
particular session, the Sysplexes are distinguishable, which allows the user to select the correct Sysplex
without renaming the Sysplex on z/OS.

Follow these steps to set Sysplexes with the same name:

Tip: Before you associate any session to a Sysplex, define the zosSysplexAlias.csv file.

If sessions are already associated with host connections whose Sysplex ID is changed in the
zosSysplexAlias.csv, for each of those sessions, open the session properties and disable HyperSwap
or Hardened Freeze, wherever applicable before you add the host connection to the zosSysplexAlias file.

1. Define a file in csmServer > properties with a file name zosSysplexAlias.csv.

2. For each host connection that is supposed to be given a different Sysplex name
than the pre-defined name in the system, create a line with the following format:
hostname:port, systemName, newSysplexID
For example,
hostnamel.labs.ibm.com:5858, LOCAL1, ZOSID1
hostname2.labs.ibm.com:5858, LOCAL2, ZOSID2
hostname3.labs.ibm.com:5858, LOCAL3, ZOSID3

3. Ensure that all host connections are added. (Refer “Adding a host system connection” on page 59)
4. Restart the Copy Services Manager server.

5. For each session that is associated with the changed sysplex ID, open the session properties and
set the z/OS Sysplex Association to the correct Sysplex ID. Then, re-enable HyperSwap or Hardened
Freeze as needed.
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Chapter 6. Managing logical paths

Logical paths define the relationship between a source logical subsystem (LSS) and a target LSS that is
created over a physical path. To configure logical paths for IBM DS8000 use the ESS/DS Paths panel in
Copy Services Manager.

To configure partnerships for the following storage systems, use the graphical user interface (GUI) or
command-line interface (CLI) for the storage system:

« FlashSystems/IBM Spectrum Virtualize
« SAN Volume Controller
» A FlashSystem/IBM Spectrum Accelerate

Viewing logical paths

You can view all logical paths that are defined on an IBM DS8000 storage system.
Complete one of these procedures to view logical paths:
- From the ESS/DS Paths page of Copy Services Manager:

a) In menu bar, click Paths.

b) Click the storage system ID to display logical paths for that storage system.
- From the Storage Systems page:

a) In menu bar, click Storage > Storage Systems.

b) Select the storage system for which you want to view logical paths.

¢) From the Select Action list, select View Paths. The paths page is displayed with a list of defined
logical paths.

Adding logical paths

You can add logical paths for IBM DS8000 storage systems.

Ensure that you have defined the appropriate storage systems on the Storage Systems page.
Perform these steps to add logical paths:

1. In menu bar, click Paths.
2. Click Manage Paths. The Path Management wizard is displayed.

3. From the drop-down boxes in the Path Management wizard, select the source storage system, source
logical subsystem, target storage system, and target logical subsystem. Then, click Next.

4. From the drop-down boxes in the Path Management wizard, select the source port and target port and
click Add.

You can add multiple paths between the logical subsystems, or just one at a time. When you have
made your selections, click Next.

5. Confirm your selections and click Next.
6. Verify the remaining wizard panels and click Next.
7. Click Finish.

Adding logical paths by using a CSV file

You can create a comma-separated value (CSV) file to define logical paths. The CSV file specifies storage
systems pairings and associated port pairings that are used for replication. Copy Services Manager uses
the port pairings that are defined in the CSV file to establish logical paths. You can edit the port pairings
file by using the Copy Services Manager GUI. You can also edit the file manually if necessary.
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You can define the following types of port pairings for the source and target storage systems:

« Port pairings for all logical subsystems that are in a session.
« Port pairings for a logical subsystem to logical subsystem mapping.

« Port pairings for all logical subsystems. You can define a single set of port pairings for the logical
subsystems or you can define different pairings for all even logical subsystems and all odd logical
subsystems.

« Port pairings based on the direction of the copy.

Adding logical paths with a CSV file by using the GUI

You can use the DS8000 Port Pairings CSV panel in the Copy Services Manager GUI to add logical paths
by editing a sample CSV file.

You can define the port pairings within a CSV file by using the GUI. However, if the GUI is not accessible,
you can also define them by manually editing the portpairings.csv file. For more information, see
“Adding logical paths with a CSV file by editing it manually” on page 64.

Complete these steps to add IBM DS8000 logical paths with a CSV file in the Copy Services Manager GUI:

1. Log in to the Copy Services Manager GUI as a user with administrator privileges.
2. Click Paths > DS8000 Port Pairings CSV.

3. Click Edit to put the CSV file into edit mode.

4

. Enter the necessary changes to the sample portpairings.csv file for your environment. For more
information, see the online help at ? > Help for guidance and tips on editing the file.

5. When you are finished updating the file, click Save to keep your changes, or click Cancel to exit
without saving changes.

New logical paths are added according to the updates that you made in the CSV file.

Adding logical paths with a CSV file by editing it manually
You can manually edit a portpairings.csv sample file to add logical paths.

You can define the port pairings within a CSV file through a manual edit, if necessary. However, the
preferred method is to define this file by using the Copy Services Manager GUI. For more information, see
“Adding logical paths with a CSV file by using the GUI” on page 64.

Complete these steps to add IBM DS8000 logical paths with a CSV file by editing it manually:

1. Create a CSV file that is named portpairings.csvinthe install
dir\liberty\wlp\usr\sexrvers\csmServer\properties directory for distributed systems, or
inthe path_prefix/opt/IBM/CSM/wlp/usr/servers/csmServer/properties directory for
z/0S. You can create the CSV file in a spreadsheet such as Microsoft Excel or in a text editor.

In the propexrties directory, find the sample CSV file that is named portpairings.csv. This file
contains the following example port pairs:

# 1. Each line in the file represents a storage system pairing and its
i associated port pairings.
i There are multiple formats that define different port pairing types:

# Specific Session: This format can be used if you want to use a

# different set of port pairings for each session.

# This might be necessary in some environments to prevent

# the paths of a session from affecting the paths of another session.

# Format:
# storageSystemA:storageSystemB:sessionName,portl:port2,...,portN:portM

i storageSystemA:storageSystemB,portl:port2,...,portN:portM

# where storageSystemA and storageSystemB are the storage system IDs

# that are used to identify the storage systems, and sessionName is

# the name of the session that you wish this port pairing to be used for.
# portl, port2, portN, portM are hexadecimal numbers which indicate the
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storage system communication ports.

A valid example is:
2107.04131:2107.01532:myPayRol1Session,0x0331:0x0024,
0x0330:0x0100,0x0331:0x000C

Specific LSS to LSS pairing: This format can be used if you want
to specify for a specific LSS pairing to use a specific set of
port pairings.

Format:
storageSystemA:systemALSS:storageSystemB:systemBLSS,
portl:poxt2,...,poxrtN:portM

where storageSystemA and storageSystemB are the storage system IDs

that are used to identify the storage systems, and systemALSS/systemBLSS
are LSSs on storage Systems in hexadecimal format. portl, port2,

portN, portM are hexadecimal numbers which indicate the storage system
communication ports.

A valid example is:
2107.04131:0x52:2107.01532:0x5f,0x0331:0x0024,0x0330:0x0100,
0x0331:0x000C

Box to Box pairing: This format can be used if you want to

specify a set of port pairings to use for all LSS pairings

across the same source and target Box. This pairing has multiple options.

A single set of port pairings can be defined for all LSS pairings between
the boxes, OR the port pairings can define that the even source LSSs should
use one set, and the odd LSSs should use a different set. There are some
scenarios particularly with Global Mirror support where performance can be
improved by mapping even and odd LSSs.

Format:
Option 1:
storageSystemA:storageSystemB, portl:port2,...,portN:portM

where storageSystemA and storageSystemB are the storage system IDs
that are used to identify the storage systems.

portl:port2,... portN:portM are hexadecimal numbers which indicate
the storage system communication ports.

A valid example is:
2107.04131:2107.01532,0x0331:0x0024,0x0330:0x0100,0x0331:0x000C

Option 2:
storageSystemA:storageSystemB,even, portl:port2,...,portN:portM,
odd, portl:port2,...portX:portY

where storageSystemA and storageSystemB are the storage system IDs
that are used to identify the storage systems.
portl:port2,...portN:portM is the set of port pairings to use when
the source is on an even LSS

portl:port2,...portX:portY is the set of port pairings to use when
the source is on an odd LSS

All ports are hexadecimal numbers which indicate the storage system
communication ports.

A valid example would be:
2107.04131:2107.01532,even, 0x0331:0x0024,0x0330:0x0100,
odd, 0x0331:0x000C, 0x0334:0x0330

2. To enable the changes in the file, complete a task that requires new paths to be established.
For example, suspend a session to remove the logical paths, and then issue the Start H1->H2
command to enable the paths to use the port pairings in the CSV file.

Considerations when you are creating and using the CSV file:

« The CSV file now supports Global Mirror control paths. Please refer “Adding Global Mirror Control paths
with a CSV file by editing it manually” on page 67 for more information.
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« The entries for the port pairs are bidirectional unless the last comma-separated entry on the line is
the string onedizr. The portpairings.csv file contains the following information about using the
onedir string:
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2. The entry for the port pairs are bi-directional unless the last
comma-separated entry on the line is the string "onedir".

This means that a line that has systemA:systemB is equivalent to a line
that has systemB:systemA, and the last entry in the file takes precedence.

If the string "onedir" is the last entry in the line, as in the
following example:
2107.04131:2107.01532,0x0331:0x0024,0x0330:0x0100,
0x0331:0x000C,onedir

then the entry is not considered to be bi-directional, and the
port pairings are only used if the first box listed (2107:04131)
is the source of the pair, and the second box listed (2107.01532)
is the target of the pair.

NOTE: You can specify the "onedir" tag on any of the supported
formats for port pairs. However, if there is also an entry for
the same set of boxes without the "onedir" tag, the entry without
the "onedir" tag might take precedence.

Example Session format:
2107.ZA811:2107 .BAY81:myMM, 0x0133:0x0332, onedir

2107 .BAY81:2107.ZA811:myMM, Ox0033:0x0030,0nedir

The above example indicates that session "myMM" will use
0x0133:0x0332 for any establishes from ZA811 to BAY81,
but will use 0x0033:0x0030 for any establishes

from BAY81 to ZA811.

Example LSS to LSS format:
2107.ZA811:0xD0:2107.BAY81:0xD0O, 0x0133:0x0332, onedir
2107 .BAY81:0xD0:2107.ZA811:0xD0O, 0x0033:0x0030, onedir
The above example indicates that ports 0x0133:0x0332
will be used for any establishes from ZA811 LSS 0xDO
to BAY81 LSS 0xDO, but that ports 0x0033:0x0030

will be used from BAY81 LSS 0xDO to ZA811 LSS 0OXDO.

Example Box to Box format:

2107 .ZA811:2107 .BAY81,0x0133:0x0332,0nedir

2107 .BAY81:2107.ZA811,0x0033:0x0030,0nedir

The above example indicates that ports 0x0133:0x0332
will be used for any establishes from ZA811 to BAY81,
but that ports 0x0033:0x0030 will be used for any
establishes from BAY81 to ZA811.

3. Lines that are incorrectly formatted are discarded. For example,
if a line contains ports without the 0x, or does not contain port
pairs delimited by the : character, then the whole line is discarded.

4. A line can be properly formatted but contain invalid ports for your
given storage system configuration. In this case, the ports will be
passed down to the storage system to be established, and no validation
is done. The valid ports might be established by the storage system,
while the invalid ones might be rejected.

5. If a file contains duplicate lines for the same storage systems, the

last line is used. And the ports on the last line are the ones that are used.
Also note that the entries are bi-directional (see rule 2). Therefore, if you
have systemA:systemB, and then a line with systemB:systemA, this second

line is the one that is used.

6. This file is read at most once every 60 seconds. Therefore, if you change
the file you might need to wait two minutes until you issue the next start
command.

7. Any line that starts with a # character is counted as a comment and is
discarded. The # must be at the start of the line. Placing it in other
positions might cause the line to be invalid.

8. The portpairings.csv file is not automatically shared between

two copy services management servers in a high availability environment.
Therefore, it is possible that different port pairings can be established
from the standby server after a takeover. In most cases you will want to
copy the portpairings.csv file to the standby server to ensure that the
two files are equal.

9. The following is the order in which each port pairing is checked.
The first match when going down this order is used as the port pairings:
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# a) If a Specific LSS pairing is found for the given LSS pairing being
i established

# b) If a Specific Session port pairing is found for the given session
# c) If a box to box mapping is found for the given pair being established
i

# For more information on how the port pairings works, see the

# user’'s guide and other documentation.

i

i# Examples:

# Normal Box to Box Mappings

#2107 .04131:2107.01532,0x0331:0x0024,0x0330:0x0100,0x0331:0x000C
#2107.05131:2107.01532,0x0330:0x0029,0x0331:0x0001

# Specific Session Option

#2107 .04131:2107.01532:GMP, 0x0030:0x0303,0x0031:0x0303

# Specific LSS to LSS Mapping Option

#2107 .04131:0x50:2107.01532:0x51,0x0301:0x0303,0x0302:0x0303

# Box to Box Mapping with Even and 0dd LSS pairings defined
#2107.04131:2107.01532,even, 0x0030:0x0031,0x0032:0x0033,0x0030:

0x0033, 0odd, 0x0300:0x0301,0x0302:0x0303

- If the CSV file contains multiple lines that specify the same storage system to storage system pairing,
Copy Services Manager uses the last line. This rule applies regardless of the order of the storage system
pairing. For example, if you have storage systems 2107.04131:2107.01532 defined on the first line of
the CSV file and then have 2107.01532:2107.04131 defined on the second line, Copy Services Manager
uses second line.

« Ifaline in the CSV contains information that is not formatted correctly, the line is ignored. This rule
includes lines that specify storage systems but do not include ports or include ports that are not
formatted correctly.

« If the CSV file contains valid and invalid port pairs, the valid port pairs might or might not be
established. Invalid port pairs can cause the following errors to be displayed in the Copy Services
Manager console and on the ESS/DS Paths page:

— Return Code F52: This error is displayed if a port is invalid.
— Return Code 0400: This error is displayed if a port is invalid and out of the range for the device.

Other storage system error codes might be displayed also, depending on the path topology, types of
paths, and the incorrect port pairings that are specified in the CSV file.

« If the CSV file contains no valid port pairs, no logical paths are established and subsequent commands
to the storage systems that require logical paths might fail. Any existing logical paths for a storage
system are used until they are removed.

Adding Global Mirror Control paths with a CSV file by editing it manually
You can manually edit a sample. csv file to add logical paths.

You can define the port pairings within a CSV file through a manual edit, if necessary. However, the
preferred method is to define this file by using the Copy Services Manager GUI. For more information, see
“Adding logical paths with a CSV file by using the GUI” on page 64.

Complete these steps to add IBM DS8000 logical paths with a CSV file by editing it manually:

1. Create a CSV file that is named sample.csvinthe install
dir\liberty\wlp\usr\servers\csmServer\properties directory for distributed systems, or
inthe path_prefix/opt/IBM/CSM/wlp/usr/servers/csmServer/properties directory for
z/0S. You can create the CSV file in a spreadsheet such as Microsoft Excel or in a text editor.

2. Inthe properties directory, find the sample CSV file that is named sample. csv. This file contains
the following example port pairs:

JHHHHHHHHHHHHEHEEHEEHEHEHERHERHEEHEEEEFEEEEEEERHEEE

# Starting in CSM 6.2.12, this file can now define Control Paths to use for sessions with
DS8000 Global Mirror

i

# Lines starting with "GM" define port pairings that should be used for Global Mirror
control paths between Master and Subordinate control systems

# This file supports two ways to define the control paths

i
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# LSS to LSS - This format specifies the LSS on the Master and the LSS on the subordinate to
use when establishing the path

# The format for an LSS to LSS mapping is

i

GM,master:subordinate, LSS, master_lss:subordinate_lss,master_portl:subordinate_portl,master_po
rt2:subordinate_port2....

i

# LSS to LSS For Specific Session - This format also specifies specific LSSs but will only

be applied to a specific session

i NOTE: When specifying the session name in the properties file, all spaces should be
replaced with "_". Example "My session" should be specified as "My_session"
i NOTE: When using this format, if you have multiple sessions with GM that share the

same consistency group name, all shared sessions should have a line in the file with the
same port pairings

# The format for a Specific Session mapping is

i
GM,master:subordinate:session_name,master_lss:subordinate_lss,master_portl:subordinate_portil,
master_port2:subordinate_port2....

i

it

# NOTE 1: 1In orxrder for the control paths to be created, there must be a line in this file
specifying the paths for every Master to Subordinate relationship in the session.

i This line is NOT bi-directional as it is for MM or GC paths and as such will be
used to determine which of the source boxes will be the Master box.

# NOTE 2: This file will only take affect when the Master is started new. This might be a
new start or after a Suspend/Recover and restart.

i Control paths in this file will not be used when simply restarting a session

1

# The following examples consider a session that has H1 volumes in a GM session across the
following boxes

# GXE34, KX432, LR345

it

# Example of defining LSS to LSS Mappings for the session where GXE34 is the desired Master
box

# GM,2107.GXE34:2107.KX432,LSS,0x05:0x10,0x0133:0x0130,0x0300:0x0301

# GM,2107.GXE34:2107.LR345,LSS,0x4D:0x5E,0x0233:0x0230,0x0320:0x0321

i

# Example of defining Specific Session Mappings for the session where GXE34 is the desired
Master box and the session is "My session"

# GM,2107.GXE34:2107.KX432:My_session, LSS, 0x05:0x10,0x0133:0x0130,0x0300:0x0301

# GM,2107.GXE34:2107.LR345:My_session, LSS, 0x4D:0x5E,0x0233:0x0230,0x0320:0x0321

New logical paths are added according to the updates that you made in the CSV file.

Removing logical paths

You can remove logical paths that are defined on an IBM DS8000 storage system.

1. In menu bar, click Paths.

2. Click the link for the storage system that contains the paths that you want to remove.
3. Select the paths that you want to remove.

4. From the Select Action list, select Remove.
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Chapter 7. Setting up data replication

This topic describes the how to set up data replication in your environment, including creating sessions
and adding copy sets to those sessions.

In areplication session, the number of volumes in a copy set and the role that each volume in the copy set
plays are determined by the session type.

Sessions

A session completes a specific type of data replication for a specific set of volumes. During data
replication, data is copied from a source volume to one or more target volumes, depending on the session
type. The source volume and target volumes that contain copies of the same data are collectively referred
to as a copy set. A session can contain one or more copy sets.

The type of data replication that is associated with the session determines the actions that you can
perform against all copy sets in the session, the number of volumes that a copy set can contain, and the
role that each volume plays.

Note: IBM i volumes should be initialized before you add them to Copy Services Manager sessions to start
replication.

Attention: Use only the Copy Services Manager graphical user interface (GUI) or command-line interface
CLI to manage session relationships, such as volume pairs and copy sets. Do not modify session
relationships through other interfaces such as the System Storage DS CLI. If you modify relationships
through other interfaces, a loss of consistency can occur across the relationships that are managed

by the session. The exceptions to this requirement are failover operations that are managed by

external applications for certain session and storage system types as described in “Failover and failback
operations” on page 74.

Single-target and multi-target sessions

Sessions are referred to as single-target or multi-target sessions. With single-target sessions, the source
volume site can have only one target site. Data replication occurs from the source to the target.

With multi-target sessions, the source volume site can have multiple target sites. Data replication can
occur from the source to an individual target or to all targets simultaneously.

Copy sets

During data replication, data is copied from a source volume to one or more target volumes, depending
on the session type. The source volume and target volumes that contain copies of the same data are
collectively referred to as a copy set.

Each volume in a copy set must be of the same size and volume type. For example, SAN Volume Controller
volumes must be used with other SAN Volume Controller volumes. The number of volumes in the copy set
and the role that each volume plays is determined by the session type that is associated with the session
to which the copy set belongs.

The following table lists the estimated number of role pairs and volumes per copy set that are supported
for each session type.

Table 28. Number of role pairs and volumes per copy set for each session type

Session Role Pairs Volumes
Basic HyperSwap 1 2
FlashCopy 1 2
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Table 28. Number of role pairs and volumes per copy set for each session type (continued)

Session Role Pairs Volumes
Snapshot? 0 1
Metro Mirror Single Direction 1 2
Metro Mirror Failover/Failback 1 2
Metro Mirror Failover/Failback with Practice 3 3
Metro Mirror Failover/Failback with Change Volumes 1 4
Metro Mirror - Metro Mirror 3 3
Global Mirror Single Direction (IBM DS8000) 3 3
Global Mirror Single Direction (FlashSystems/IBM Spectrum 1 2
Virtualize, SAN Volume Controller)

Global Mirror Failover/Failback (IBM DS8000) 3 3
Global Mirror Failover/Failback (FlashSystems/IBM Spectrum 1 1
Virtualize, SAN Volume Controller)

Global Mirror Failover/Failback with Practice (IBM DS8000) 5 4
Global Mirror Failover/Failback with Practice (FlashSystems/IBM 3 3
Spectrum Virtualize, SAN Volume Controller)

Global Mirror Either Direction 5 4
Global Mirror Either Direction with Two-Site Practice 8 6
Global Mirror Failover/Failback with Change Volumes 1 4
Metro Global Mirror 6 4
Metro Global Mirror with Practice 8 5
Metro Mirror - Global Mirror2 6 4
Metro Mirror - Global Mirror with Practice 9 5
Metro Mirror - Global Mirror with Site 3 Global Mirror 10 6
Metro Mirror - Global Mirror with Site 4 Replication 11 6
Metro Mirror - Metro Mirror with Site 4 Replication 5 4
Safeguarded Copy 3 1 2
Migration 1 2

1. A FlashSystem/IBM Spectrum Accelerate Snapshot session requires that the user define only the H1
volumes. All target volumes are created on the same storage pool as the source volumes.

2. For IBM FlashSystem A9000 and A9000R storage systems, there are 3 role pairs, and 3 volumes.

3. Source volumes need to have the safeguarded capacity defined on the DS8000 for use in a
Safeguarded Copy session.

Use the Add Copy Sets wizard to add copy sets to a session. You can select a storage system; a logical
subsystem (LSS), I/0 group, or pool; or a single volume for reach role and then create one or more copy
sets for the session.

You can use one of the following volume pairing options to automatically create multiple copy sets in the
same session.
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Storage system matching (IBM DS8000 Metro Mirror sessions only)
Creates copy sets by matching volumes (based on the volume IDs) across all LSSs for the selected
storage systems. For example, volume 01 on the source LSS is matched with volume 01 on the target
LSS.

You can select the storage system and select All Logical Subsystems in the list of LSSs. You can also
do auto-matching at the LSS level for Metro Mirror sessions.

LSS, I/0 group, or pool matching
Creates copy sets by matching all volumes based on the selected LSS, I/O group, or pool for each role
in copy set.

Select the storage system and LSS, I/O group, or pool, and then select All Volumes in the Volume list.

If you do not want to use the auto-generated volume pairing for a copy set, clear that copy set so that it is
not added during the wizard. Then, add the remaining copy sets and reopen the Add Copy Set wizard and
manually enter the volume pairings that you want.

Invalid copy set are not added to the session. Copy sets can be invalid if their volumes are not the same
type or size.

You can remove copy sets that you do not want to add to the session, even if they are valid. You can use
this process to filter and eliminate unwanted copy sets before they are added to the session.

You can export the copy sets to take a snapshot of your session at a particular point in time for backup
purposes.

Note: You can copy an entire storage system only for Metro Mirror sessions.

Adding copy sets

When you create a copy set for a session, a warning is displayed if one or more of the selected volumes
exist in another session. If the volume you selected is in another session, confirm whether you want to
add the volume to this session. Ensure that you intend to have the volume in multiple sessions because
having the volume in multiple sessions can create conflicts. A scenario in which you would want the same
volumes in multiple sessions is one in which you create a session for normal replication, and then create
another session for a disaster recovery practice. You must use the same target volumes in both sessions.

You can use extent space-efficient volumes as copy set volumes, depending on the capabilities of the
storage system.

Removing copy sets
You remove a copy set or range of copy sets by selecting the following items:

» Source volume
« LSS, I/O group, or pool
- Storage system

When the list of copy sets that meet your criteria is displayed, you can select the copy sets that you want
to remove.

The consequence of removing copy sets varies depending on the state of the session:

Defined
There is no relationship on the hardware. The copy set is removed from the Copy Services Manager
data store.

Preparing or Prepared
The copy set is copying data, so Copy Services Manager terminates the hardware relationship for the
copy set. The rest of the copy sets continue to run uninterrupted.

Suspended or Target Available
Any existing relationships on the hardware are removed for the copy set.
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Before you remove all copy sets from that session, terminate the session. Removing the copy sets when
the session is active can considerably increase the amount of time it takes for the copy set removal to
complete. Copy sets are removed one at a time, and when the session is active, commands are issued to
the hardware. However, if you terminate the session first, then commands are not issued to the hardware
and the removal process completes faster.

Tip: When you a remove copy set from Copy Services Manager, you might want to keep hardware
relationships on the storage systems. These relationships are useful when you want to migrate from one
session type to another, or when you are resolving problems. For more information about keeping the
hardware relationships when you are removing copy sets, see Removing Copy Sets.

Depending on the storage system, the following actions occur when a copy set is removed:
DS8000:

« The complete copy set is removed from Copy Services Manager.

« Any Peer-to-Peer Remote Copy (PPRC) pair that is part of a Global Mirror consistency group is
removed from the consistency group on the storage system.

- If the PPRC pair is part of a Global Mirror consistency group and is the last remaining source volume
in a subordinate session, the subordinate session is removed from the storage system.

« If the PPRC pair is the last remaining participant in a Global Mirror session, the Global Mirror session
is removed from the storage system.

< Any PPRC relationship remains on the storage system.

 FlashCopy relationship remains on the storage system if the hardware background copy is not
complete.

FlashSystems/IBM Spectrum Virtualize, SAN Volume Controller, or a FlashSystem/IBM Spectrum
Accelerate

« The complete copy set is removed from Copy Services Manager.

« FlashCopy, Metro Mirror, and Global Mirror relationships are pulled out of their consistency group. If
they are the last remaining relationship in a consistency group, that consistency group is removed
from the hardware.

When you specify the force removal option, all knowledge of the specified copy set is removed from Copy
Services Manager, even if the relationship itself still exists. In this situation, you are not able to remove the
relationship by using Copy Services Manager because no information about the relationship exists. If you
force a removal of a copy set and the removal fails, you must manually remove the relationship from the
hardware. If you do not, you cannot to create new relationships.

One benefit of forcing a removal of the copy sets is that Copy Services Manager does not manage the
consistency of copy sets that it has no knowledge of. This situation means that more commands to the
session do not affect the removed copy sets, even though they are still in a relationship on the hardware.

If you do not specify the force removal option and an error occurs that prevents the hardware
relationships from being removed, the copy set is not removed from Copy Services Manager. The copy
set remains as part of the session, and you can still perform actions on it.

Volume roles

Volume roles are given to every volume in the copy set. The role defines how the volume is used in
the copy set and the site location of the volume. For example, the H1 role is made up of host-attached
volumes that are located at the primary site.

The site determines the location of the volumes. The number of sites in a copy set is determined by the
session type. Copy Services Manager supports up to three sites:

Site 1
The location of the primary storage that contain the source data. Upon initial configuration, this site
contains the host volumes with updates that are copied to the target volumes.
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Site 2
The location of the secondary storage that receives the copy updates from the primary storage.

Site 3
The location of the tertiary storage that receives data updates from the secondary storage.

Site 4
The location for a fourth copy of the data that receives asynchronous updates from the third site.

The volume roles that are needed in a copy set are determined by the type of replication that is associated
with the session. Copy Services Manager supports these volume roles:

Host volume
A host volume is a volume that is connected to a server that reads and writes I/O. A host volume can
be the source of updated tracks when the server connected to the host volume is actively issuing read
and write input/output (I/0). A host volume can also be the target of the replication. When the host
volume is the target, writes are inhibited.

Host volumes are abbreviated as Hx, where x identifies the site.

Journal volume
A journal volume stores data that has changed since the last consistent copy was created. This
volume functions like a journal and holds the required data to reconstruct consistent data at the
Global Mirror remote site. When a session must be recovered at the remote site, the journal volume
is used to restore data to the last consistency point. A FlashCopy replication session can be created
between the host or intermediate volume and the corresponding journal volume after a recover
request is initiated to create another consistent version of the data.

Journal volumes are abbreviated as Jx, where x identifies the site.

Intermediate volume
An intermediate volume receives data from the primary host volume during a replication with practice
session. During a practice, data on the intermediate volumes is flash copied to the practice host
volumes.

Depending on the replication method being used, data on intermediate volumes might not be
consistent.

Intermediate volumes are abbreviated as Ix, where x identifies the site.

Target volume
A target volume receives data from a host or intermediate volume. Depending on the replication type,
that data might or might not be consistent. A target volume can also function as a source volume. For
example, a common use of the target volume is as a source volume to allow practicing for a disaster
(such as data mining at the recovery site while still maintaining disaster recovery capability at the
production site).

Change volume (only FlashSystems/IBM Spectrum Virtualize or SAN Volume Controller storage
systems)

A volume that contains point-in-time images that are copied from the host or target volume.
Change volumes are abbreviated as Cx, where x identifies the site.

Role pairs

A role pair is the association of two volume roles in a session that take part in a copy relationship. For
example, in a Metro Mirror session, the role pair can be the association between host volumes at the
primary site and host volumes at the secondary site (H1-H2).

The flow of data in the role pair is shown using an arrow. For example, H1>H2 denotes that H1 is the
source and H2 is the target.

Participating role pairs are role pairs that are currently participating in the session's copy.

Non-participating role pairs are role pairs that are not actively participating in the session's copy.
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Snapshot sessions do not use role pairs.

Practice volumes

You can use a practice volume to practice what you would do in the event of a disaster, without
interrupting current data replication. Practice volumes are available in Metro Mirror, Global Mirror, Metro
Global Mirror, and Metro Mirror - Global Mirror sessions.

To use the practice volumes, the session must be in the prepared state. Issuing the Flash command
against the session while in the Prepared state creates a usable practice copy of the data on the target
site.

Note: You can test disaster-recovery actions without using practice volumes. However, without practice
volumes, you cannot continue to copy data changes between volumes while testing disaster-recovery
actions.

Consistency groups

For Global Mirror, Metro Global Mirror, and the multi-target session types, Copy Services Manager
manages the consistency of dependent writes by creating a consistent point-in-time copy across multiple
volumes or storage systems. A consistency group is a set of target volumes in a session that have been
updated to preserve write order and are therefore recoverable.

Copy Services Manager automatically assigns an ID to each consistency group on the storage systems.
However, you can choose to assign a custom name to a storage system consistency group. A custom-
defined name allows you to associate multiple sessions with a specific storage system consistency group.

Data exposure is the period when data is written to the storage at the primary site until data is replicated
to storage at the secondary site. Data exposure is influenced by factors such as:

« Requested consistency-group interval time
 Type of storage systems

Physical distance between the storage systems
Available bandwidth of the data link
Input/output (I/0) load on the storage systems

To manage data exposure, you can change the consistency group interval time. The consistency group
time interval specifies how often a Global Mirror and Metro Global Mirror session attempts to form

a consistency group. When you reduce this value, it might be possible to reduce the data exposure

of the session. A smaller interval value causes the session to attempt to create consistency groups
more frequently, which might also increase the processing load and message-traffic load on the storage
systems.

Failover and failback operations

If a session has failover and failback capabilities, you can perform a site switch in which you move
the operation of Copy Services Manager from one site to another, and change the direction of the copy
without completing a full copy.

Failover is the process of temporarily switching production to a backup facility after a scheduled
maintenance period or a disaster at a production site. A failover operation can be followed by a failback
operation, which is the process of returning production to its original location and resuming the copy
between the two sites.

The failover and failback operations use remote mirror and copy functions for these tasks:

 To reduce the time that is required to synchronize volumes after sites are switched during planned or
unplanned outages.

« To eliminate the need to perform a full volume copy from the recovery site to the production site, which
can reduce the time that is required to resume operations at the production site.
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Failover operations that are managed by other applications

Applications such as the IBM Series i Toolkit, VMware Site Recovery Manager, and Veritas Cluster Server
can also manage failover operations for the session types that are listed in the following table.

Session type

Storage systems

Metro Mirror Single Direction

IBM DS8000
« Systems running IBM Spectrum Virtualize

Metro Mirror Failover/Failback

- IBM DS8000

« Systems running IBM Spectrum Virtualize

« Systems running IBM Spectrum Accelerate, including:
- X1V
— FlashSystem A9000
— FlashSystem A9000R

Metro Mirror Failover/Failback with
Practice

- IBM DS8000
« Systems running IBM Spectrum Virtualize

Metro Mirror Failover/Failback with
Change Volumes

« Systems running IBM Spectrum Virtualize

Multi-target session types:
« Metro Mirror - Metro Mirror
« Metro Mirror - Global Mirror

« Metro Mirror - Global Mirror with
Practice

Global Mirror

« Metro Mirror - Global Mirror with Site 3

« IBM DS8000

Note: Multi-target session types are available only for
IBM DS8000 storage systems with a microcode level that
supports single source to multi-target relationships. To
determine whether you can use this session type, see the
IBM DS8000 documentation for the microcode level that
you are using.

« IBM FlashSystem A9000 and A9000R
Note: Only the Metro Mirror - Global Mirror multi-target

session type is available for the FlashSystem A9000 and
A9000R storage systems.

Global Mirror Single Direction

- IBM DS8000
« Systems running IBM Spectrum Virtualize

Site Practice

Global Mirror Either Direction with Two-

- IBM DS8000

Global Mirror Failover/Failback

- IBM DS8000

« Systems running IBM Spectrum Virtualize

» Systems running IBM Spectrum Accelerate, including:
- XIV
— FlashSystem A9000
— FlashSystem A9000R

Global Mirror Failover/Failback with
Practice

- IBM DS8000
« Systems running IBM Spectrum Virtualize
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Session type Storage systems

Global Mirror Failover/Failback with - Systems running IBM Spectrum Virtualize
Change Volumes

If an application completes a failover operation for a session, the Severe status is displayed for the
session on the Session Details page in Copy Services Manager. An error message is also generated for the
role pairs for which the failover occurred. To view the error message:

1. On the Session Details page, click the link for each role pair for which the failover occurred.
2. On the Role Pair Details page, click the Show link for each role pair. This link is in the Details column.

To change the session status to Normal, use the application to confirm that the role pairs that are in the
session are consistent and then restart the session.

Session types

Copy Services Manager provides several methods to replicate data. The type of data replication that is
associated with a session is known as the session type.

The session types that are available depend on the storage system type and the edition of Copy Services
Manager that you are using.

HyperSwap

HyperSwap is a copy services solution for IBM z/0S version 1.9 and later. HyperSwap provides high
availability of data if a storage system failure occurs. If an I/O error occurs at the primary site, HyperSwap
technology automatically swaps I/O to a secondary set of volumes with little to no impact to the
customer.

Copy Services Manager supports enabling certain session types with HyperSwap capabilities. These
session types include:

- Metro Mirror

« Metro Global Mirror

« Multi-target session types:
— Metro Mirror - Metro Mirror
— Metro Mirror - Global Mirror
— Metro Mirror - Global Mirror with Practice
— Metro Mirror - Global Mirror with Site 3 Global Mirror
— Metro Mirror - Global Mirror with Site 4 Replication
— Metro Mirror - Metro Mirror with Site 4 Replication

When enabled for HyperSwap, Copy Services Manager communicates with IBM Z to provide information
on which volumes need to be highly available.

FlashCopy

FlashCopy replication creates a point-in-time copy of the data on a source volume to a target volume.
Data that existed on the target volume is replaced by the copied data.

Snapshot

Snapshot replication creates a point-in-time copy of a volume or set of volumes without having to define
a specific target volume. The target volumes of a Snapshot session are automatically created when the
snapshot is created.
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Metro Mirror Single Direction

Metro Mirror is synchronous replication that operates between two sites that are up to 300 km apart. The
source volumes are on one storage system and the target volumes are on another storage system.

Metro Mirror replication maintains identical data in both the source and target volumes. When a write
operation is issued to a source volume, the changes are propagated to the target volume before the write
operation finishes processing.

With the Metro Mirror Single Direction session type, Metro Mirror replication is available only from the
primary site.

Metro Mirror Single Direction sessions are available for the following Copy Services Manager editions and
storage systems.

Metro Mirror Single Direction

Supported editions Supported storage systems

« Copy Services Manager - IBM DS8000
« Systems running IBM Spectrum Virtualize

Metro Mirror Failover/Failback

With Metro Mirror Failover/Failback replication, you can switch the direction of the data flow so that you
can use your secondary site as your production site. You can then copy changes that are made at the
secondary site back to the primary site.

Metro Mirror Failover/Failback sessions are available for the following Copy Services Manager editions and
storage systems.

Table 29. Metro Mirror Failover/Failback

Supported editions Supported storage systems

« Copy Services Manager - IBM DS8000
« Systems running IBM Spectrum Virtualize
« Systems running IBM Spectrum Accelerate,
including:
- XIV
— FlashSystem A9000
— FlashSystem A9000R

Metro Mirror Failover/Failback with Practice

Metro Mirror Failover/Failback with Practice replication combines Metro Mirror Failover/Failback and
FlashCopy capabilities to provide a point-in-time copy of the data on the secondary site. This session type
provides volumes that you can use to practice for disaster recovery without losing your disaster recovery
capability.

Metro Mirror Failover/Failback with Practice sessions are available for the following Copy Services
Manager editions and storage systems.

Table 30. Metro Mirror Failover/Failback with Practice

Supported editions Supported storage systems

» Copy Services Manager - IBM DS8000
« Systems running IBM Spectrum Virtualize
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Metro Mirror Failover/Failback with Change Volumes

Metro Mirror Failover/Failback with Change Volumes replication provides the same capabilities as

the Metro Mirror Failover/Failback session type. However, Metro Mirror Failover/Failback with Change
Volumes sessions also associate change volumes to the primary and secondary to enable consistency
protection during restarts.

Metro Mirror Failover/Failback with Change Volumes sessions are available for the following Copy Services
Manager editions and storage systems.

Table 31. Metro Mirror Failover/Failback with Change Volumes

Supported editions Supported storage systems

« Copy Services Manager « Systems running IBM Spectrum Virtualize

Global Mirror Single Direction

Global Mirror is asynchronous replication that operates between two sites that are over 300 km apart. The
source volumes are on one storage system and the target volumes are on another storage system.

Global Mirror replication maintains identical data in both the source and target volumes. When a write
operation is issued to a source volume, the changes are typically propagated to the target volume a few
seconds after the data is written to the source volume.

With the Global Mirror Single Direction session type, Global Mirror replication is available only from the
primary site.

Global Mirror Single Direction sessions are available for the following Copy Services Manager editions and
storage systems.

Table 32. Global Mirror Single Direction

Supported editions Supported storage systems

« Copy Services Manager - IBM DS8000
« Systems running IBM Spectrum Virtualize

Global Mirror Either Direction

With Global Mirror Either Direction replication, you can run Global Mirror replication from either the
primary or secondary site.

Global Mirror Either Direction sessions are available for the following Copy Services Manager editions and
storage systems.

Table 33. Global Mirror Either Direction

Supported editions Supported storage systems

« Copy Services Manager - IBM DS8000

Global Mirror Either Direction with Two-Site Practice

With Global Mirror Either Direction with Two-Site Practice replication, you can run Global Mirror
replication from either the primary or secondary site. This session type provides volumes on the primary
and secondary site that you can use to practice for disaster recovery without losing your disaster recovery
capability.

Global Mirror Either Direction with Two-Site Practice sessions are available for the following Copy Services
Manager editions and storage systems.

78 IBM Copy Services Manager: User's Guide



Table 34. Global Mirror Either Direction with Two-Site Practice

Supported editions Supported storage systems

« Copy Services Manager - IBM DS8000

Global Mirror Failover/Failback

With Global Mirror Failover/Failback replication, you can switch the direction of the data flow so that you
can use your secondary site as your production site. You can then copy changes that are made at the
secondary site back to the primary site.

Global Mirror Failover/Failback sessions are available for the following Copy Services Manager editions
and storage systems.

Table 35. Global Mirror Failover/Failback

Supported editions Supported storage systems

« Copy Services Manager - IBM DS8000
« Systems running IBM Spectrum Virtualize
« Systems running IBM Spectrum Accelerate,
including:
- XIV
— FlashSystem A9000
— FlashSystem A9000R

Global Mirror Failover/Failback with Change Volumes

Global Mirror Failover/Failback with Change Volumes replication provides the same capabilities as

the Global Mirror Failover/Failback session type. However, Global Mirror Failover/Failback with Change
Volumes sessions also provide the option of enabling or disabling the use of change volumes. Change
volumes are available in SAN Volume Controller and IBM Spectrum Virtualize storage systems.

Global Mirror Failover/Failback with Change Volumes sessions are available for the following Copy
Services Manager editions and storage systems.

Table 36. Global Mirror Failover/Failback with Change Volumes

Supported editions Supported storage systems

« Copy Services Manager « Systems running IBM Spectrum Virtualize

Global Mirror Failover/Failback with Practice

Global Mirror Failover/Failback with Practice replication combines Global Mirror Failover/Failback and
FlashCopy capabilities to provide a point-in-time copy of the data on the secondary site. This session type
provides volumes that you can use to practice for disaster recovery without losing your disaster recovery
capability.

Global Mirror Failover/Failback with Practice sessions are available for the following Copy Services
Manager editions and storage systems.
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Table 37. Global Mirror Failover/Failback with Practice

Supported editions Supported storage systems

« Copy Services Manager - IBM DS8000
« Systems running IBM Spectrum Virtualize

Metro Global Mirror

Metro Global Mirror replication provides continuous, remote data replication that operates between three
sites that are varying distances apart. Metro Global Mirror combines Metro Mirror synchronous copy and
Global Mirror asynchronous copy into a single session, where the Metro Mirror target is the Global Mirror
source. With Metro Global Mirror replication, you can switch the direction of the data flow so that you can
use your secondary or tertiary site as your production site.

Metro Global Mirror sessions are available for the following Copy Services Manager editions and storage
systems.

Table 38. Metro Global Mirror

Supported editions Supported storage systems

« Copy Services Manager - IBM DS8000

Metro Global Mirror with Practice

Metro Global Mirror with Practice replication combines Metro Mirror, Global Mirror, and FlashCopy
capabilities to provide a point-in-time copy of the data on the tertiary site. This session type provides
volumes that you can use to practice for disaster recovery without losing your disaster recovery capability.

Metro Global Mirror with Practice sessions are available for the following Copy Services Manager editions
and storage systems.

Table 39. Metro Global Mirror with Practice

Supported editions Supported storage systems

« Copy Services Manager - IBM DS8000

Metro Mirror - Metro Mirror

A Metro Mirror - Metro Mirror session is a multi-target session that consists of three sites. You can define
any of the sites as the primary site and then run Metro Mirror replication from the primary site to either
of the other sites individually or both sites simultaneously. For example, if Site 1 is the primary site, data
replication can occur between the H1 and H2 volumes and the H1 and H3 volumes separately or at the
same time.

This session type is available only for IBM DS8000 storage systems with a microcode level that supports
single source to multi-target relationships. To determine whether you can use this session type, see the
IBM DS8000 documentation for the microcode level that you are using.

Table 40. Metro Mirror - Metro Mirror

Supported editions Supported storage systems

« Copy Services Manager - IBM DS8000
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Metro Mirror - Global Mirror

A Metro Mirror - Global Mirror session is a multi-target session that consists of three sites. From the
primary site, you can define both a Metro Mirror copy and a Global Mirror copy, which allows for
replication across both a short distance and long distance simultaneously.

This session type is available only for IBM DS8000 storage systems with a microcode level that supports
single source to multi-target relationships. To determine whether you can use this session type, see the
IBM DS8000 documentation for the microcode level that you are using.

You can also use this session type with IBM FlashSystem A9000 and A9000R storage systems.

Note: HyperSwap is always enabled for the Metro Mirror - Global Mirror multi-target session type on
FlashSystem A9000 and A9000R. If a swap occurs, the hardware automatically restarts the Metro Mirror
pair in the opposite direction and re-enables HyperSwap. And after the swap, the remote Global Mirror is
not automatically restarted.

See the IBM Redbooks publication at http://www.redbooks.ibm.com/redpieces/abstracts/redp5434.html
for more specific details on how to set up this session type on the FlashSystem A9000 and A9000R
storage systems.

Table 41. Metro Mirror - Global Mirror

Supported editions Supported storage systems

« Copy Services Manager - IBM DS8000
« IBM FlashSystem A9000 and A9000R

Note: To convert from a multi-target configuration to a cascaded configuration, refer “Converting from
multi-target to Cascaded replication in a three site session type” on page 219.

Metro Mirror - Global Mirror with Practice

A Metro Mirror - Global Mirror with Practice session is a multi-target session that consists of three sites.
From the primary site, you can define both a Metro Mirror copy and a Global Mirror copy, which allows

for replication across both a short distance and long distance simultaneously. This session type provides
volumes that you can use to practice for disaster recovery without losing your disaster recovery capability.

This session type is available only for IBM DS8000 storage systems with a microcode level that supports
single source to multi-target relationships. To determine whether you can use this session type, see the
IBM DS8000 documentation for the microcode level that you are using.

Table 42. Metro Mirror - Global Mirror with Practice

Supported editions Supported storage systems

» Copy Services Manager - IBM DS8000

Note: To convert from a multi-target configuration to a cascaded configuration, refer “Converting from
multi-target to Cascaded replication in a three site session type” on page 219.

Metro Mirror - Global Mirror with Site 3 Global Mirror

A Metro Mirror - Global Mirror with Site 3 Global Mirror session is a multi-target session that consists of
three sites. From the primary site, you can define both a Metro Mirror copy and a Global Mirror copy, which
allows for replication across both a short distance and long distance simultaneously. After recovery to Site
3, this session allows a Global Mirror replication back to either Site 1 or Site 2 and a cascaded Global Copy
to the third site. This action provides disaster recover capabilities while production runs at Site 3.
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This session type is available only for IBM DS8000 storage systems with a microcode level that supports
single source to multi-target relationships. To determine whether you can use this session type, see the
IBM DS8000 documentation for the microcode level that you are using.

Table 43. Metro Mirror - Global Mirror with Site 3 Global Mirror

Supported editions Supported storage systems

« Copy Services Manager - IBM DS8000

Note: To convert from a multi-target configuration to a cascaded configuration, refer “Converting from
multi-target to Cascaded replication in a three site session type” on page 219.

Metro Mirror - Global Mirror with Site 4 Replication

A Metro Mirror - Global Mirror with Site 4 Replication session is a multi-target session that consists of

four sites. From the primary site, you can define both a Metro Mirror copy and a Global Mirror copy, which
allows for replication across both a short distance and long distance simultaneously. After recovery to Site
4, this session allows a Global Mirror replication back to either Site 1, Site 2, or Site 3, and a cascaded
Global Copy to the fourth site. This action provides disaster recover capabilities while production runs at
Site 4.

This session type is available only for IBM DS8000 storage systems with a microcode level that supports
single source to multi-target relationships. To determine whether you can use this session type, see the
IBM DS8000 documentation for the microcode level that you are using.

Table 44. Metro Mirror - Global Mirror with Site 4 Replication

Supported editions Supported storage systems

« Copy Services Manager - IBM DS8000

Metro Mirror - Metro Mirror with Site 4 Replication

A Metro Mirror - Metro Mirror with Site 4 Replication session is a multi-target session that consists of four
sites. From the primary site, you can define a Metro Mirror - Metro Mirror copy, which allows for replication
across two short distances simultaneously. After recovery to Site 4, this session allows a Metro Mirror
replication back to either Site 1, Site 2, or Site 3, and a cascaded Metro Copy to the fourth site. This action
provides disaster recovery capabilities while production runs at Site 4.

This session type is available only for IBM DS8000 storage systems with a microcode level that supports
single source to multi-target relationships. To determine whether you can use this session type, see the
IBM DS8000 documentation for the microcode level that you are using.

Table 45. Metro Mirror - Metro Mirror with Site 4 Replication

Supported editions Supported storage systems
« Copy Services Manager - IBM DS8000
Safeguarded Copy

A Safeguarded Copy session is designed to capture many point-in-time images of a production
environment with optimized capacity usage and minimized performance impact. The backup created
by a Safeguarded Copy session can be recovered to another set of volumes while the production
environment continues to run. Safeguarded Copies help to prevent the data from being compromised,
either accidentally or deliberately. Therefore, the Safeguarded Copy session type offers another layer of
security in your environment.
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Table 46. Safeguarded Copy

Supported editions Supported storage systems

« Copy Services Manager - IBM DS8000

« SAN Volume Controller and Spectrum Virtualize
based FlashSystem devices

Migration

The new Migration session is available starting with Copy Services Manager 6.2.10. The Migration session
is a two-volume session type with roles H1 and H2.

The Migration session ignores the rule that the primary and secondary have to be the same size and type.
Therefore, you can use this session to migrate data from one set of volumes to another, regardless of size,
as long as the hardware supports it.

You can only start a Migration session from HZ1. You cannot start in Metro Mirror mode. And a Migration
session running in Global Copy mode will not manage freeze or run conditions.

You can still manually Suspend or Stop the session for consistent or inconsistent suspends. And you can
Recover the session to failover the pairs, thereby allowing the targets to be writable.

From the Target Available state, you can only restart in the original direction or terminate. You cannot
restart in the opposite direction.

Table 47. Migration

Supported editions Supported storage systems

« Copy Services Manager - IBM DS8000

Extent Space Efficient Sizer

The ESE Sizer session supports analyzing space requirements for DS8000 Extent Space Efficient (ESE)
FlashCopy and Safeguarded Copy.

An accurate sizing of ESE FlashCopy and Safeguarded Copy is crucial. With the DS8880 microcode 8.5.4
release and DS8900F 9.1 release a Write Monitoring (WM) bitmap is implemented in the DS8000 to track
all write to each volume.

The purpose of the Write Monitoring Bitmap is to provide an effective way to determine usable space
requirements for both Extent Space Efficient (ESE) FlashCopy and Safeguarded Copy without impacting
host write I/O or disk replication performance. The write monitoring bitmap enables a DS8000 to track
the amount and locality of its changed data over definable time intervals and across a set time period in
an existing production environment.

The new session type queries the Write Monitoring bitmap and provides output files on box and volume
level. These output files contain the currently allocated extents, changed tracks, changed small extents
and change large extents. This level of detail can readily be used to determine how much capacity will be
allocated over time for both functions ESE FlashCopy and Safeguarded Copy.

The following tool can be used to process the data collected from the Copy Services Manager ESE

Sizer session to provide more accurate capacity sizings in the configurations. Refer the link https://
www.ibm.com/support/pages/node/6372180 for more detailed information regarding ESE Sizer session
and the collected data.

The ESE Sizer session can start, stop, and reset the WM bitmap. With the available properties, you can
define the volume query interval and the bitmap reset interval.

Note: It is recommended to run the ESE Sizer session on a Copy Services Manager instance that is not
currently managing replication. While the ESE Sizer session does not affect replication, the data collected
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uses system memory resources so running on a separate server is recommended to avoid any memory
constraints. Refer “Calculating server memory requirements” on page 33 for more information.

Table 48. ESE Sizer session

Supported editions Supported storage systems
Copy Services Manager IBM DS8000
Basic HyperSwap

Basic HyperSwap is a copy services solution for z/OS version 1.9 and later. It provides high availability

of data if a disk storage system failure occurs. Basic HyperSwap does not replace a disaster recovery
solution. If a session is suspended but the suspend operation was not caused by a HyperSwap trigger, the
session is not frozen to ensure that it is consistent.

When HyperSwap is combined with Metro Mirror and Metro Global Mirror replication, you can prepare
your system for disaster recovery and ensure high availability of data. If a session is suspended but the
suspend operation was not caused by a HyperSwap trigger, the session is frozen to ensure that it is
consistent.

Restriction: This replication method is available only for DS8000 storage systems.
Basic HyperSwap replication performs the following actions:

« Manages CKD volumes in Metro Mirror to manage synchronous peer-to-peer remote copy (PPRC)
relationships.

« Permits only CKD volumes to be added to the HyperSwap session. The graphical user interface (GUI)
shows only CKD volumes when you add a copy set. The command-line interface (CLI) does not add a
copy set if a fixed block volume is specified.

« Monitors events that indicate a storage device failed.

- Determines whether the failing storage device is part of a Metro Mirror synchronous PPRC pair.
« Determines the action to be taken from policy.

 Ensures that data remains consistent.

« Swaps the I/O between the primary logical devices in the consistency group with the secondary logical
devices in the consistency group. A swap can occur from the preferred logical devices to the alternate
logical devices or from the alternate logical devices to the preferred logical devices.

Example

Jane is using multiple DS8000 storage systems. The host applications run on a z/OS operating system and
the z/OS environment is connected to the DS8000 storage systems. She has a site in Manhattan and a
secondary DS8000 in Hoboken. While it is not required that she has a disaster recovery solution in effect,
she does need to have a high-availability solution to keep her applications running all the time. Jane is
worried that if a volume fails on the DS8000 in Manhattan, her database application might fail. Even a
small downtime can be costly to Jane.

Jane uses a Basic HyperSwap session to mirror the data on the DS8000 in Manhattan to the secondary
DS8000 in Hoboken. If a volume at the Manhattan site fails, Basic HyperSwap automatically directs
application I/0O to the mirrored volumes in Hoboken.

FlashCopy

FlashCopy replication creates a point-in-time copy in which the target volume contains a copy of the data
that was on the source volume when the FlashCopy was established.

The DS8000 provides multiple logical subsystems (LSSs) within a single physical subsystem, while the
following platforms provide multiple I/O groups:

« Systems running IBM Spectrum Virtualize
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All platforms can use local replication in which the source volume is located in one LSS or I/O group and
the target volume is located in the same or another LSS or I/O group. Using the FlashCopy feature, you
can reference and update the source volume and target volume independently.

Figure 2 on page 85 illustrates a FlashCopy session.

Figure 2. FlashCopy session

z/0S Management option
When a z/0S system or sysplex name is set, the Flash command is submitted through the z/0OS
connection to that system or sysplex to provide performance improvements during the FlashCopy
process for mainframe volumes.

Note: To enable this feature and take advantage of the performance enhancements, volumes in the
session must be attached to the system or sysplex and I0S APAR OA59561 must be applied. In
addition, for all storage systems that are going to be managed, a z/OS connection must be defined
on the Storage Systems panel. Ensure that you create a z/OS storage system connection (“Storage
connections” on page 42) for each storage system in the system or sysplex that will be managed by
the session.

Example

Jane works for a bank. Jane uses a FlashCopy session to make a point-in-time copy of the customer data
in existing international accounts. Every night, the bank's servers start batch processing. Jane uses the
FlashCopy session to create checkpoint restarts for the batch processing if the batch processing fails.

In the batch processing, the first step is to balance all international accounts and to make a FlashCopy
point-in-time copy of the resulting data. The second step in the batch processing is to complete the
international disbursements.

If the second step in the batch process fails, Jane can use the data from the FlashCopy session that was
taken of the first step to repeat the second step. In this way, Jane does not have to begin the entire
process again. Jane also uses a CLI script that performs a FlashCopy operation every night at 11:59

PM, and another script that quiesces the database. She backs up the data to tape on the target storage
system, and then sends the tape to the bank's data facility for storage.

Snapshot

Snapshot is a session type that creates a point-in-time copy of a volume or set of volumes. You do not
have to define a specific target volume. The target volumes of a Snapshot session are automatically
created when the snapshot is created.

A FlashSystem/IBM Spectrum Accelerate uses a snapshot session to create a large number of volume
copies without affecting system performance. By using the snapshot function to create a point-in-time
copy, and to manage the copy, you can save storage. With the FlashSystem/IBM Spectrum Accelerate
snapshots, no storage capacity is used by the snapshot until the source volume or the snapshot is
changed.

Figure 3 on page 86 illustrates a Snapshot session.
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Figure 3. Snapshot session

Example

Jane's host applications are using a FlashSystem/IBM Spectrum Accelerate for their back-end storage.
With the FlashSystem/IBM Spectrum Accelerate, Jane can create a large number of point-in-time copies
of the data. The snapshot function ensures that if data becomes corrupted, she can restore the data to
any point in time.

Jane sets up a Snapshot session by using Copy Services Manager and specifies the volumes on the
FlashSystem/IBM Spectrum Accelerate that are used by the host applications. Jane does not have to
provision target volumes for all the snapshots she intends to make. She can quickly configure a single
Snapshot session.

When the session is configured, Jane uses a CLI script that runs a Cxreate Snapshot command to the
session every two hours. If a problem occurs, such as data becoming corrupted, Jane can find a snapshot
of the data from a time before the problem occurred. She can restore the data to that point.

By creating a set of snapshots of the data, Jane can also schedule batch processing against that data
every day. She can use the batch processing to analyze certain trends in the market without affecting the
host applications.

Metro Mirror

Metro Mirror is a method of synchronous, remote data replication that operates between two sites that
are up to 300 KM apart. The source is in one storage system and the target is in another storage system.

Attention: If you have sessions that contain Metro Mirror relationships, ensure that the session
does not contain system volumes (such as paging volumes) unless you select the Manage H1-H2
with HyperSwap or the Enable Hardened Freeze option for the session. By using these options,
z/0S Input/Output Supervisor (I0S) manages freeze operations for the volumes in the session,
which prevents Copy Services Manager from freezing the volumes and possibly freezing itself.

Metro Mirror replication maintains identical data on both the source and target. When a write operation
is issued to the source copy, the changes that are made to the source data are propagated to the target
before the write operation finishes processing. If the storage system ends, no data is lost when you use
Metro Mirror if data must be used from the recovery site.

A Metro Mirror session in Global Copy mode creates an asynchronous relationship to accommodate the
high volume of data that is migrated. As a result, the data on the target system might no longer be
consistent with the source system. The Metro Mirror session switches back to a synchronous relationship
when Metro Mirror reissues a Staxrt command. In addition, you can start a Metro Mirror session in Global
Copy mode and toggle between Metro Mirror and Global Copy modes to accommodate periods in which
you require host I/O response time over data consistency.

Tip: To determine whether there is any out-of-sync data that must to be copied before the session is
consistent, check the percent that is complete in the session details page.
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Setting up multiple Copy Services Manager sessions with DS8000 Metro Mirror pairs

Starting with the Copy Services Manager 6.2.0 release, it is now possible to set up multiple Copy Services
Manager sessions with DS8000 Metro Mirror pairs. By performing this set up, a suspend by command or
event suspends the sessions consistently by freezing all sessions before thawing any session, according
to the session policy.

To set up multiple sessions so that they freeze consistently:

« On the Session Details panel, or by going to the Session Overview panel and clicking View/Modify
> Set Consistency Group name, modify the consistency group name for the role pair (for example,
H1-H2) in each session that should be suspended consistently.

When a suspend by command or event occurs, all role pairs across all sessions that have the same
consistency group name, process the suspend together.

Metro Mirror Single Direction

Figure 4 on page 87 illustrates a Metro Mirror Single Direction session.

Figure 4. Metro Mirror Single Direction session

Metro Mirror Failover/Failback

Using Metro Mirror Failover/Failback, the data exists on the second site, which is less than 300 KM away,
and you can switch the direction of the data flow. You can use this session type to run your business from
the secondary site, and to copy changes that are made at the second site back to the primary site when
you want to resume production at the primary site.

Figure 5 on page 87 illustrates a Metro Mirror with Failover/Failback session.

Figure 5. Metro Mirror Failover/Failback session

Metro Mirror Failover/Failback with Practice

A Metro Mirror Failover/Failback with Practice session combines Metro Mirror and FlashCopy features to
provide a point-in-time copy of the data on the remote site. You can use this session type to practice what
you might do if a disaster occurs, without losing your disaster recovery capability.

This solution consists of two host volumes and an intermediate volume.
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Figure 6 on page 88 illustrates a Metro Mirror Failover/Failback with Practice session.

Figure 6. Metro Mirror Failover/Failback with Practice session

Metro Mirror Failover/Failback with HyperSwap

You can enable a Metro Mirror Failover/Failback session to have HyperSwap capabilities. To enable
HyperSwap processing, see “Setting up the environment for HyperSwap” on page 105.

Metro Mirror Failover/Failback with HyperSwap combines the high availability of Basic HyperSwap with
the redundancy of a two-site Metro Mirror Failover/Failback solution for managing count key data (CKD)
volumes on z/0S. If the primary volumes encounter a permanent I/O error, the I/O is automatically
swapped to the secondary site with minimal effect on the application.

A swap can be planned or unplanned. A planned swap occurs when you issue a HyperSwap command
from the Session Actions list in the graphical user interface (GUI) or when you issue a cmdsess
-action hyperswap command.

Figure 7 on page 88 illustrates a Metro Mirror Failover/Failback session that is enabled for HyperSwap.

Figure 7. Metro Mirror Failover/Failback session with HyperSwap

Metro Mirror - Metro Mirror

A Metro Mirror - Metro Mirror session is a multi-target session that consists of three sites. You can define
any of the sites as the primary site and then run Metro Mirror replication from the primary site to either
of the other sites individually or both sites simultaneously. For example, if Site 1 is the primary site, data
replication can occur between the H1 and H2 volumes and the H1 and H3 volumes separately or at the
same time.

This session type is available only for IBM DS8000 storage systems with a microcode level that supports
single source to multi-target relationships. To determine whether you can use this session type, refer to
the IBM DS8000 documentation for the microcode level that you are using.

Figure 8 on page 89 illustrates a Metro Mirror - Metro Mirror session.
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Figure 8. Metro Mirror - Metro Mirror session

Examples

Read the following scenarios for information on using Metro Mirror for synchronous, remote data
replication between two sites.

Metro Mirror Single Direction

At the beginning of a work week, Jane is notified that between 10:00 AM and 11:00 AM on the next
Friday, power in her building is going to be shut off. Jane does not want to lose any transactions
during the power outage, so she decides to transfer operations to the backup site during the outage.
She wants a synchronous copy method with no data loss for the critical business functions, so she
chooses Metro Mirror, which can be used between locations that are less than 300 KM apart.

In a synchronous copy method, when a write is issued to change the source, the change is propagated
to the target before the write is posted. This method of replication maintains identical data in both
the source and target. The advantage of this method is when a disaster occurs, there is no data loss

at the recovery site because both writes must complete before signaling completion of a write to the
source application. Because the data must be copied to both IBM DS8000 devices before the write is
completed, Jane can be sure that the data is safe.

The night before the planned outage, Jane quiesces the database and servers in San Francisco and
starts the database and servers in Oakland. To accomplish this task, Jane issues the Suspend and
Recover commands, and then issues the Staxrt command on the secondary site. She shuts down the
equipment in San Francisco to avoid any power spikes when she restarts the system after the power is
turned on.

Metro Mirror in Global Copy mode

At the beginning of a work week, Jane is notified that between 10:00 AM and 11:00 AM on the next
Friday, power in her building is going to be shut off. Jane does not want to lose any transactions
during the power outage, so she decides to transfer operations to the backup site during the outage.
She wants a synchronous copy method with no data loss for the critical business functions, so she
chooses Metro Mirror, which can be used between locations that are less than 300 KM apart.
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Jane wants to limit the effect on any applications while completing the initial Metro Mirror
synchronization, so she begins the session in Global Copy mode. After she sees that approximately
70% of the data is copied, Jane decides to switch the session to Metro Mirror mode, assuring data
consistency.

Metro Mirror with Practice

Jane wants to run a Metro Mirror with Practice from San Francisco to Oakland. She wants to verify
the recovery procedure for the Oakland site, but she cannot stop running the Metro Mirror session
while she takes time to practice a recovery. By using a Metro Mirror with Practice session, Jane can
practice the disaster recovery scenario in Oakland while the Metro Mirror session runs uninterrupted.
By practicing running the applications at the Oakland site, Jane is better prepared to recover data if a
disaster occurs at the San Francisco site.

While her session is running in Prepared state, Jane practices a recovery at the Oakland site by issuing
the Flash command. This command momentarily pauses the session and starts a FlashCopy to the
H2 volumes. As soon as the FlashCopy is started, the session is restarted. These FlashCopy files
create a consistent version of the data on the H2 volume that she can use for recovery testing, while
the session continues to replicate data from San Francisco to Oakland. As a result, she can carry out
the recovery testing without stopping the replication for any extended duration of time.

If, at some point, the Metro Mirror session is suspended because of a failure, Jane can use the
practice session to restart the data replication process. She maintains a consistent copy of the data
at the Oakland site, in case of a failure during the resynchronization process. When the session is
suspended, she can issue a Recover command to create a consistent version of the data on the H2
volumes. After the Recovexr command completes, she can issue the Start H1->H2 command to
resynchronize the data from the San Francisco site to the Oakland site.

If a failure occurs before the restarted session is in Prepared state, she has a consistent version of
the data on the H2 volumes. She only has to issue the Recovexr command to put the session into
Target Available state and make the H2 volumes accessible from the servers. If the session was not
in Prepared state when it was suspended, the subsequent Recovexr command does not issue the
FlashCopy files to put the data on the H2 volumes. This means that the consistent data on the H2
volumes is not overwritten if the data to be copied to them is not consistent.

Selecting a HyperSwap session
A global insurance company decided to use Copy Services Manager to manage its disaster recovery
environment. Jane wants minimal data exposure, both for planned outages such as routine
maintenance, and for unplanned disasters. They have CKD volumes on IBM DS8000 devices, and
use z/0S operating systems. They have two data centers in New York.

Jane chooses a Metro Mirror recovery solution because her priority is to protect the system from
regional disasters. Jane decides to use Metro Mirror solution because her company has two data
centers that are located near each other. Jane realizes that because she uses a z/OS operating
system, CKD, and IBM DS8000 hardware, she can also use a HyperSwap solution. Using Metro Mirror
Failover/Failback with HyperSwap, Jane can minimize the effects on any applications, while she
maintains the failover process to the secondary site. Jane decides Metro Mirror Failover/Failback with
HyperSwap is the best solution.

After installing and configuring Copy Services Manager on z/0S, Jane starts the Copy Services
Manager GUIL. She adds the Copy Services Manager storage devices that she intends to use on

all sites. From the Sessions page, Jane opens the Create Session window and selects the Metro
Mirror Failover/Failback session type. After completing the information in the window, Jane clicks
Launch Add Copy Sets Wizard. After she completes the wizard, she selects the Manage H1-H2 with
HyperSwap option in the View/Modify Properties notebook.

Jane then issues a Start H1->H2 command. After the initial copy is completed, Jane can safely
replicate the data between both sites. She can also issue the HypexrSwap command between sites 1
and 2 to switch sites with minimal effect on the application during either a disaster or maintenance
period.
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Performing a planned HyperSwap
Jane's company used Metro Mirror Failover/Failback with HyperSwap sessions for the past three
months. However, Jane must perform maintenance on an H1 volume. During this time, Jane does
not want the applications or replication to be interrupted. To prevent this interruption, before
the maintenance is scheduled to begin, Jane uses the Copy Services Manager GUI to perform a
HyperSwap operation to the H2 volumes. This process changes the applications so that the data is
written to H2. To perform a planned HyperSwap operation, Jane issues a HypexSwap command.

Understanding what happens when an unplanned HyperSwap occurs
Several weeks after the planned maintenance at Jane's company is completed, an incident occurs
at the H1 site. A disk controller fails, causing one of the H1 volumes to encounter a permanent I/O
error. Jane's data is safe because she used Metro Mirror Failover/Failback with HyperSwap, and the
H2 volume is an exact duplicate of the H1 volume. When the permanent I/O error is detected, a
HyperSwap is triggered. The application changes to write data to the H2 volumes. The applications
are not interrupted.

Jane configured a Simple Network Management Protocol (SNMP) listener to alert her to any events,
so she receives the SNMP event that indicates that a HyperSwap occurred. Jane investigates the
cause of the HyperSwap process and uses the z/OS console to identify the volume that triggered the
HyperSwap process. Jane replaces the faulty disk controller. Then, to recover from the unplanned
HyperSwap process, Jane issues the Start H2->H1 command.

Global Mirror

Global Mirror is asynchronous replication that operates between two sites that are over 300 km apart. The
source volumes are on one storage system and the target volumes are on another storage system. Global
Mirror replication maintains identical data in both the source and target volumes.

When a write operation is issued to a source volume, the changes are typically propagated to the target
volume a few seconds after the data is written to the source volume. However, changes can occur on the
source volume before the target volume verifies that it received the change.

Because consistent copies of data are formed on the secondary site at set intervals, data loss is
determined by the amount of time since the last consistency group was formed. If the system fails,
Global Mirror might lose some data that was transmitted when the failure occurred.

Global Mirror Single Direction

The Global Mirror Single Direction session type enables you to run Global Mirror replication from the
primary site.

For IBM DS8000 storage systems, each copy set in the single direction session consists of two host
volumes and a journal volume. Figure 9 on page 91 illustrates a Global Mirror Single Direction session for
these storage systems.

Figure 9. Global Mirror Single Direction session
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For FlashSystems/IBM Spectrum Virtualize and SAN Volume Controller storage systems, each copy set in
the Global Mirror Single Direction session consists of two host volumes. Figure 10 on page 92 illustrates
a Global Mirror Single Direction session for these storage systems.

Figure 10. Global Mirror Single Direction session

Global Mirror Failover/Failback

The Global Mirror Failover/Failback with Practice session type combines Global Mirror Failover/Failback
and FlashCopy capabilities to provide a point-in-time copy of the data on the secondary site. This session
type provides volumes that you can use to practice for disaster recovery without losing your disaster
recovery capability.

For IBM DS8000 storage systems, each copy set in the Global Mirror Failover/Failback session consists
of two host volumes and a journal volume. Figure 11 on page 92 illustrates a Global Mirror Failover/
Failback session for these storage systems.

Figure 11. Global Mirror Failover/Failback session

For FlashSystems/IBM Spectrum Virtualize and SAN Volume Controller storage systems, each copy set
in the Global Mirror Failover/Failback session consists of two host volumes. Figure 12 on page 92
illustrates a Global Mirror Failover/Failback session for these storage systems.

Figure 12. Global Mirror Failover/Failback session
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Global Mirror Failover/Failback with Change Volumes

Global Mirror Failover/Failback with Change Volumes replication provides the same capabilities as

the Global Mirror Failover/Failback session type. However, Global Mirror Failover/Failback with Change
Volumes sessions also provide the option of enabling or disabling the use of change volumes. Change
volumes are available in FlashSystems/IBM Spectrum Virtualize and SAN Volume Controller storage
systems.

Change volumes are composed of a source change volume and a target change volume that contain a
point-in-time image of the data from the source and target volumes, respectively.

A FlashCopy operation occurs between the source volume and the source change volume. The frequency
of the FlashCopy operation is determined by the cycle period. For information about the cycle period and
how it is set, see “Global Mirror Failover/Failback with Change Volumes session properties” on page 277.
The data on the source change volume is then replicated to the target volume, and finally to the target
change volume.

Because the data that is replicated between sites contains point-in-time changes rather than all changes,
a lower bandwidth link is required between the sites. However, when you use change volumes, your data
exposure can increase. Therefore, you might want to include or exclude change volumes depending on
your network traffic or business requirements.

This session type is available only for FlashSystems/IBM Spectrum Virtualize and SAN Volume Controller
storage systems. Figure 13 on page 93 illustrates a Global Mirror Failover/Failback with Change Volumes
session for these storage systems.

Figure 13. Global Mirror Failover/Failback session

Global Mirror Failover/Failback with Practice

The Global Mirror Failover/Failback with Practice session type combines Global Mirror Failover/Failback
and FlashCopy capabilities to provide a point-in-time copy of the data on the secondary site. This session
type provides volumes that you can use to practice for disaster recovery without losing your disaster
recovery capability.

For IBM DS8000 storage systems, each copy set in the Global Mirror Failover/Failback with Practice
session consists of two host volumes, an intermediate volume, and a journal volume. Figure 14 on page
94 illustrates a Global Mirror Failover/Failback with Practice session for these storage systems.
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Figure 14. Global Mirror Failover/Failback with Practice session for DS8000 storage systems

For FlashSystems/IBM Spectrum Virtualize and SAN Volume Controller storage systems, each copy set in
the Global Mirror failover/failback with Practice session consists of two host volumes and an intermediate
volume. Figure 15 on page 94 illustrates a Global Mirror Failover/Failback with Practice session for these
storage systems.

Figure 15. Global Mirror Failover/Failback with Practice session for FlashSystems/IBM Spectrum Virtualize
and SAN Volume Controller

Global Mirror Either Direction

Global Mirror Either Direction enables you to run Global Mirror replication from either the primary or
secondary site.

This session type is available only for IBM DS8000 storage systems.

The session consists of two host volumes and two journal volumes. Figure 16 on page 94 illustrates a
Global Mirror Either Direction session for these storage systems.

Figure 16. Global Mirror Either Direction session
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Global Mirror Either Direction with Two-Site Practice

Global Mirror Either Direction with Two-Site Practice enables you to run Global Mirror replication from
either the primary or secondary site. This session type provides volumes on the primary and secondary
site that you can use to practice for disaster recovery without losing your disaster recovery capability.

This session type is available only for IBM DS8000 storage systems.

The session consists of two host volumes, two intermediate volumes, and two journal volumes. Figure 17
on page 95 illustrates a Global Mirror Either Direction with Two-Site Practice session for these storage
systems.

Figure 17. Global Mirror Either Direction with Two-Site Practice session

Examples

Read the following scenarios for information about using Global Mirror for asynchronous, remote data
replication between two sites.

Global Mirror Single Direction
Although Jane's FlashCopy and Metro Mirror copies were both planned, Jane realizes that sometimes
a failure can occur, and she wants to ensure that the data is safe. Because Jane works in San
Francisco, she wants her other site to be far away if a disaster occurs locally. Her other site is based
in Houston. A minor earthquake occurs in San Francisco and power and communications both fails.
Jane arranged for the data on customer accounts that recently opened or closed to be asynchronously
copied in Houston, using Global Mirror. Jane risks losing the bytes of data that were being processed
when the tremor disrupted the processing in San Francisco. However, she understands that it is minor
inconvenience when weighed next to the value of backing up her data to an area that is not prone to
earthquakes.

Global Mirror with Practice
Jane wants to run a Global Mirror with practice from San Francisco to Houston. She plans to verify her
recovery procedure for the Houston site, but she cannot stop running the Global Mirror session while
she takes time to practice a recovery. By using a Global Mirror with Practice session, Jane can practice
her disaster recovery scenario in Houston while the Global Mirror session runs uninterrupted. When
she practices running the applications at the Houston site, Jane is better prepared to recover the data
if a disaster ever strikes the San Francisco site.

Global Mirror Either Direction with Two-Site Practice
Jane wants to run a Global Mirror with Practice from San Francisco to Houston. She plans to verify her
recovery procedure for the Houston site, but she cannot stop running the Global Mirror session while
she takes time to practice a recovery. By using a Global Mirror Either Direction with Two-Site Practice
session, Jane can practice her disaster recovery scenario in Houston while the Global Mirror session
runs uninterrupted. When she practices running the applications at the Houston site, Jane is better
prepared to recover the data if a disaster ever strikes the San Francisco site.

Jane can use the Global Mirror Either Direction with Two-Site Practice session to run asynchronous
consistent data replication from either the San Francisco site or the Houston site. She can practice
the disaster-recovery tasks at the target site, regardless of the location of the current production site.
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Jane's business can run a consistent Global Mirror session from its Houston site back to San Francisco
while it runs a production site at Houston.

Metro Global Mirror

Metro Global Mirror is a method of continuous, remote data replication that operates between three sites
that are varying distances apart. Metro Global Mirror combines Metro Mirror synchronous copy and Global
Mirror asynchronous copy into a single session, where the Metro Mirror target is the Global Mirror source.

This replication method is available on only TotalStorage Enterprise Storage Server Model 800 and IBM
DS8000 storage systems. You can select ESS storage systems in only the H1 volume role. All other
volume roles must use DS8000 volumes.

You can use both ESS and DS8000 volumes in the H1 volume role. If ESS and DS8000 storage systems
are both used in the H1 role, the DS8000 storage system performs Incremental Resync processing,

and the ESS storage system performs a full copy operation. Because you cannot use the Incremental
Resync function with ESS, a full copy is required when you change from H1->H2->H3 to H1>H3 and from
H2->H1->H3 to H2->H3.

Attention: If you have Copy Services Manager sessions that contain Metro Global Mirror
relationships, ensure that the session does not contain system volumes (such as paging volumes)
unless you select the Manage H1-H2 with HyperSwap or the Enable Hardened Freeze option
for the session. By using these options, z/OS Input/Output Supervisor (I0S) manages freeze
operations for the volumes in the session, which prevents Copy Services Manager from freezing
the volumes and possibly freezing itself.

Metro Global Mirror maintains a consistent copy of data at the remote site, with minimal effect on
applications at the local site. This remote mirroring function works in combination with FlashCopy to
provide a disaster-recovery solution that includes the following features:

- Fast failover and failback
- Rapid reestablishment of three-site mirroring, without production outages

- Data currency at the remote site with minimal time lag at the local site, an average of only 3 - 5 seconds
for many environments

» Quick resynchronization of mirrored sites using only incremental changes

If Copy Services Manager runs on a z/OS operating system, you can configure a Metro Global Mirror
session to control the Metro Mirror relationship between the primary and secondary site by using

the HyperSwap feature. With HyperSwap enabled, a failure on the primary storage system causes an
automatic HyperSwap operation, which transparently redirects application I/O to the auxiliary storage
system. The Global Mirror relationship continues to run uninterrupted throughout this process. With this
configuration, you can achieve almost a zero data loss at larger distances.

Using synchronous mirroring, you can switch from local site H1 to remote site H2 during a planned or
unplanned outage. It also provides continuous disaster recovery protection of the H2 and H3 sites. You
do not have to configure H2, if a switch from site H1 occurs. With this configuration, you can reestablish
H2->H1->H3 recoverability while production continues to run at site H2. Additionally, this setup can
reduce the workload on site H1.

Important: In Metro Global Mirror and Metro Global Mirror with Practice sessions, when the H1 is on an
ESS storage system, you might risk filling up the space efficient journal volumes. Because incremental
resynchronization is not available on the ESS storage system, full copies are performed in many of the
transitions.

Metro Global Mirror

A Metro Global Mirror session with Practice combines Metro Mirror, Global Mirror, and FlashCopy across
three sites to provide a point-in-time copy of the data on the third site.

Figure 18 on page 97 illustrates a Metro Global Mirror session.
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Figure 18. Metro Global Mirror session

Metro Global Mirror with Practice

A Metro Global Mirror session with Practice combines Metro Mirror, Global Mirror, and FlashCopy across
three sites to provide a point-in-time copy of the data on the third site. You can use this session to
practice what you might do if a disaster occurred without losing your disaster recovery capability.

The session consists of three host volumes, an intermediate volume, and a journal volume. Figure 19 on
page 98 illustrates a Metro Global Mirror with Practice session.
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Figure 19. Metro Global Mirror with Practice session

Note: In Metro Global Mirror and Metro Global Mirror with Practice sessions, when the H1 is on an
ESS storage system, you might risk filling up the space efficient journal volumes. Because incremental
resynchronization is not available on the ESS storage system, full copies are performed in many of the
transitions.

Examples

Read the following scenarios for information on using Metro Global Mirror for continuous, remote data
replication between three sites.

Metro Global Mirror
Although Jane works in San Francisco, she wants to run the business from either Oakland, the
secondary site, or Houston, the tertiary site. Jane can use Metro Global Mirror with Failover/Failback
to switch the direction of the data flow, so that she can run the business from either Oakland or
Houston. Using Metro Global Mirror, Jane has zero data loss at the secondary site and minimal data
loss at the tertiary site.

Metro Global Mirror with Practice

Jane wants to run a Metro Global Mirror with Practice from San Francisco to Houston. She plans to
verify her recovery procedure for the Houston site. However, she cannot stop running the Metro Global
Mirror session while she takes time to practice a recovery. By using a Metro Global Mirror with Practice
session, Jane can practice her disaster recovery scenario in Houston while the Metro Global Mirror
session runs uninterrupted. When she practices running the applications at the Houston site and is
prepared to run the applications at the Oakland site, if necessary, Jane is prepared to recover data if a
disaster occurs at the San Francisco site.

Jane can use Metro Global Mirror with Practice to switch the direction of the data flow, so that she can
run the business from either Oakland or Houston. Using Metro Global Mirror, Jane has zero data loss
at the secondary site and minimal data loss at the tertiary site.
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Safeguarded Copy

Safeguarded Copy is a protection mechanism that supports the ability to create cyber-resilient, point-in-
time copies of volumes of data.

The Safeguarded Copy sessions secure data to prevent it from being compromised, either accidentally
or deliberately. The function integrates with IBM Copy Services Manager to provide automated backup
copies and data recovery.

Safeguarded Copy uses a backup capacity, production volume, and recovery volume:

« Backup capacity is the space needed for all backups. The size of the backup capacity depends on the
frequency of the backups and the duration that backups need to be retained.

« The Safeguarded Copy session creates a consistency group across the source volumes to create a
safeguarded backup, which stores the required data in the backup capacity.

« The production volume is the source volume for a Safeguarded Copy relationship. Depending on the
specific client topology, this relationship can be a Metro Mirror, Global Mirror, or z/OS Global Mirror
primary or secondary volume, or a Simplex volume.

« A recovery volume is used to restore a backup copy for host access while production continues to run
on the production volume. The recovery volume is the target volume for a Safeguarded Copy recovery,
which enables a previous backup copy to be accessed by a host that is attached to this volume. The
recovery volume is typically thin-provisioned, but it does not have to be.

Accessing a backup copy on a recovery volume:

« Production systems can continue to run while this is done
« Optional background copy to copy all required data out of the backup capacity
- Identification of a good recovery point is expected to be done on the recovery volume

Safeguarded Copy terms

Safeguarded Copy (SGC)
A function that provides protection from logical data corruption. Usage: The Safeguarded Copy
function provides protection from logical data corruption.

Safeguarded source (SGC source)
A volume that is protected by the Safeguarded Copy function. Usage: The Safeguarded source volume
is protected by a Safeguarded backup capacity that contains a copy of the data in the source volume.

Safeguarded backup (SGC backup)
A point-in-time version of data that is created by the Safeguarded Copy function to protect a
Safeguarded source volume. Usage: The Safeguarded backup capacity contains a copy of the data
in the Safeguarded source volume.

Safeguarded backup location (SGC backup location)
The pool where the safeguarded backup capacity is stored for a safeguarded source. Usage: The
safeguarded backup location contains the safeguarded backup capacity.

Safeguarded backup capacity (SGC backup capacity)
The physical capacity in the safeguarded backup location that contains the data that is stored the
safeguarded backup copies. Usage: The safeguarded backup capacity is based on the size of the extra
capacity that is allocated to that volume for creating backups.

Safeguarded virtual backup capacity (SGC virtual backup capacity)
The amount of volume (virtual) capacity that is configured to store safeguarded backup copies for
a safeguarded source. The capacity that is required depends on the size of the source volume, the
number of copies, and the predicted destage rate of the source volume’s data.

Configure safeguarded backup Capacity (Configure SGC backup capacity)
Configure the location of the backup capacity, and use the backup planning tool to determine the
virtual capacity that is required to store backup copies of a safeguarded source volume.
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Recover backup
Recovers a safeguarded backup copy for a safeguarded source to a separate volume by selecting a
safeguarded source volume, specifying a backup copy to recover, and determining the target volume
to receive the data from the backup capacity.

Configure backup schedule/policy
Configure the backup schedule for a safeguarded source volume.

Create backup
Create a safeguarded backup copy outside of the normal backup schedule.

Recover/Recovery volume
A recovery volume is a normal addressable volume that can be accessed by the host for read and
write operations. A safeguarded backup copy can be viewed or updated by recovering a backup
capacity to a recovery volume.

Expire backup
Remove all backup copies and schedules for a safeguarded source.

Restore backup
Restores a Safeguarded backup copy to the Safeguarded Copy source volumes using FlashCopy.

Safeguarded Copy in DS8000
Safeguarded Copy provides data protection on DS8000 storage systems.

Safeguarded Copies can be used to take many frequent copies of a production environment (for example,
hourly copies maintained for a number of days), while FlashCopy continues to be used to take a small
number of less frequent copies (such as weekly copies maintained for 1-2 weeks).

See “Safeguarded Copy commands” on page 173 for more information on the commands that are
available with this session type.

Safeguarded Copy capacity and scheduling

To use the Safeguarded Copy function, you can schedule backups and must assign backup capacity.

Backup capacity
Extra capacity allocated to that volume for the purpose of creating backups. The backup capacity
should be allocated with enough space to accommodate your service level agreements (SLAs) to meet
your requirement for frequency and retention period of backups.

You must first go to the DS8000 command line or GUI and define the backup capacity for the

volumes that you want to enable for Safeguarded Copy. See the topic "Configuring safeguarded virtual
capacity" in the DS8000 online documentation at https://www.ibm.com/support/knowledgecenter/
ST5GLI/ds8000_kcwelcome.html for more information.

Scheduler
You can set up an internal scheduler in Copy Services Manager to run a backup at the frequency that
you require. The lowest interval time for a schedule is 30 minutes.

See “Creating scheduled tasks” on page 212 for more information.

Tip: If you choose a backup schedule that fills up your backup capacity before the duration of

what you specified as the retention period, then you will see messages in Copy Services Manager
indicating that the older backups have automatically rolled off the hardware. You need to maintain a
balance driven by the SLA. Therefore, the retention should drive both the backup capacity size and
the schedule. For example, if the SLA requires you to have a month's worth of backups on a daily
schedule, then the retention would be 30 days, the schedule would be daily, and the backup capacity
needs to be enough to hold 30 backups.

Minimum time frame per backup
This backup option is the number of minutes that controls the frequency that backups can be
issued. If you set it to 30 minutes, then you can only backup every 30 minutes. This option provides
extra security against malicious attempts to corrupt the data by preventing repeated backups from
automatically rolling off all valid backups for the volumes.
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Retention period since last recoverable backup
This backup option controls when Copy Services Manager expires older backups.

Important: The retention period is based on the second-to-last recoverable backup. The retention
design always keeps at least two recoverable backups. The hardware might not support recovery of
the last recoverable backup. If the hardware does not support it, Copy Services Manager allows you
to recover the last recoverable backup, but automatically takes a new backup so that the recover can
complete. Because a new backup takes up additional backup capacity, the design ensures that there
is always one backup available for recovery that does not use more backup capacity. If additional
backup capacity is used, it might cause older backups to automatically expire on the hardware due to
a lack of space. However, if the hardware supports it, the last backup can be recovered without the
need for an additional backup.

Backup option to Expire Backup on Auto Roll
When this option is set, the session automatically expires a backup when the session determines that
one or more of the volumes has auto rolled the backup.

Expire Backup
When a backup is expired, the backup is removed from all volumes that contain the expired
backup ID. A backup can be expired manually by command, automatically through the retention
policy, or automatically when the Expire Backup on Auto Roll optionis set, and one or
more volumes have auto rolled the backup.

Auto Roll
A volume auto rolls an older backup to provide room for newer backups. If a volume is auto rolling
backups, then the volume backup capacity might need to be re-sized or retention for the session
might need to be reevaluated. When properly configured, the backup capacity for all volumes
should have enough space to keep all necessary backups based off the retention and backup
frequency.

Set the Expire Backup on Auto Roll option to free up additional space whenever one or more
volumes do not have enough backup capacity to form new backups. This feature can help avoid
out-of-space conditions. However, when a backup is automatically expired, it is no longer available
for recovery across any of the volumes that contained that backup. By default, this option is NOT
selected, so you must select it to enable this feature. When this option is not set, the backup is not
automatically expired so that if one or more volumes did not auto roll the backup, those volumes can
still be recovered to that backup. To allow recovery to those volumes, you must remove any volumes
indicating that they auto rolled that backup, from the session. Search on the topic "Recovering
volumes to backups marked as not recoverable due to volume auto roll" in the Troubleshooting
section of the Copy Services Manager online help documentation at https:/www.ibm.com/support/
knowledgecenter/SSESK4 for more information.

Notes:

« If you select the Expire Backup on Auto Roll option, but the backup is in a recovery
relationship, and the hardware rolls a volume off, Copy Services Manager does not expire it.

- When a backup is automatically expired by Copy Services Manager, it remains in the list of backups
displayed on the Session Details page for diagnostic purposes.

— You can view the volume results to determine which volumes were auto rolled by the hardware
and evaluate if the volumes need more capacity, or if the frequency and retention options need
adjusting.

- To determine which volume or volumes might need increased capacity, select the backup on
the Session Details page to view the list of volumes results.

— To completely remove the backup from the list of backups in the Session Details page, navigate
to the Expire Backup command and select the backup to remove.

H1-R1 No Copy option
This option defines if the recovery relationship will be established with background copy. If No Copy is
selected, then a background copy is not automatically started when the relationship is established. To
start the background copy for a no copy relationship, issue the Initiate® Background Copy command.
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If No Copy is not selected, then a full background copy of the data will occur when the relationship
is established. If the recovery volume is a space-efficient volume, the background copy might lead to
fully provisioning the volume.

H1-R1 Persistent option
When this option is selected, the recovery relationship does not go away when the background copy
completes.

Note: Microcode 9.02 level or higher is necessary to take advantage of the persistent feature. If
you set the Persistent option, and microcode does not support it, the option is ignored, and the
relationship disappears from the hardware when the background copy is complete.

z/0S Management option
When a z/0OS system of sysplex name is set, the Backup command is submitted through the z/0OS
connection to that system or sysplex to provide performance improvements during the backup
process for mainframe volumes.

Note: To enable this feature and take advantage of the performance enhancements, volumes in the
session must be attached to the system or sysplex and I0S APAR OA59561 must be applied. In
addition, for all storage systems that are going to be managed, a z/OS connection must be defined
on the Storage Systems panel. Ensure that you create a z/OS storage system connection (“Storage
connections” on page 42) for each storage system in the system or sysplex that will be managed by
the session.

See “Creating a Safeguarded Copy session and adding copy sets” on page 190 for more details.

Safeguarded Copy in IBM FlashSystems/IBM Spectrum Virtualize

IBM Spectrum Virtualize is mapped to an Administrator account in Copy Services Manager to provide
automated backup copies and data recovery.

Copy Services Manager automatically detects volume groups with defined Safeguarded backup policies
and creates safeguarded backup copies according to the schedule defined in the policy.

Automated sessions

« To use Safeguarded Copy for IBM Spectrum Virtualize, you do not need to create sessions in Copy
Services Manager. Copy Services Manager automates the creation of Safeguarded Copy sessions
based on the volume groups that are defined on the system. Copy Services Manager also supports
testing, restoring, and recovering operations with safeguarded backup copies. To configure the
Safeguarded Copy function, it is recommended to create a new Administrator user.

- After a connection is established, Copy Services Manager queries the system every 5 minutes to
process volume groups with Safeguarded backup policies.

« When Copy Services Manager detects a new populated volume group with a Safeguarded backup
policy, it creates a session. After a session is created it adds all volumes in the volume group to
the session. It also creates a scheduled task to create the Safeguarded backup copies. The session
remains until the volume group is deleted or it no longer contains any volumes.

« Scheduled tasks that are created automatically by Copy Services Manager cannot be modified.
However, you can set up automatic collection of log files when an error occurs or set-up tasks that
are run when the current task completes.

 During the automated 5-minutes check, if Copy Services Manager identifies a volume group that is
modified to no longer have a Safeguard backup policy, the scheduled task is removed from Copy
Services Manager. The creation of backups is also stopped. If the policy is modified or a new policy
is applied to the volume group, Copy Services Manager makes the appropriate changes as well.

« Copy Services Manager detects and handles changes to the volume group. It automatically adds or
removes copy set from the session.

« To prevent Copy Services Manager from automatically discovering volume groups with policies, you
can add the following property to server properties.

csm.server.enable.auto.specv.sgc=false
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Note: When this property is added, any existing sessions and tasks that are discovered, are removed
from Copy Services Manager as well. The volume group and backups remain on the storage system.

Manual backup
You can create manual backups in between the scheduled task by running the Backup command in
the session. You are prompted to specify a retention time for the backup.

Backup copies expiration

- After copies expire according to the Safeguarded backup policy, IBM Spectrum Virtualize deletes
them from the Safeguarded backup location. Copy Services Manager cannot expire or delete
existing backups. If you need to detect an expired copy sooner, you can run the Refresh States
command on the session to force Copy Services Manager to run the query.

Recovering and restoring data

« To recover a backup to a set of new recovery volumes, run the Recover Backup command and
then select the relevant backup to recover. Copy Services Manager creates a recovery volume by
using one or more parent pools of the source volumes or the pool that is specified in the Session
properties. To view the volume names, click the Recover Backup Info tab on the session details
panel. A pop-up window with all the >R1 volumes in the session is displayed.

- When a recovered backup is no longer needed, you can run the Terminate H1R1 command on
the session, and select one or more recovered backups that you want to delete. This removes the
relationships for the backups and deletes the recovery volumes from the hardware.

- If the same backup is recovered to again without previously terminating the relationships, the data
from the backup is reflashed onto the existing R1 volumes. New volumes are not created again,
unless a Terminate H1R1 is issued.

- If you want to end the H1R1 recovery relationship but permanently keep the R1 volume, run the
Terminate H1R1 Keep R1 command.

Note: When you run the Terminate H1R1 Keep R1 command, Copy Services Manager stops
managing the R1 volume. If the volume is no longer needed in the future, you must delete it from
the IBM Spectrum Virtualize command-Lline interface(CLI) and graphical user interface(GUI).

 You can restore the original source from a backup by running the Restore Backup command and
then selecting the relevant backup that you want to restore. Copy Services Manager automatically
copies the data from the backup image that is selected to the original source. The session remains
in the Restoring state until the restore is complete.

Recovery Volumes
When creating recovery volumes, Copy Services Manager uses the mkvolume command on the
Spectrum Virtualize system. This allows the volume to use the provisioning policy that is assigned to
the pool to define the attributes of the newly created volumes. To ensure that your recovery volumes
have the correct attributes, you must define a provisioning policy on the pool that is associated with
the recovery volumes. By default the recovery volumes are created in the source volume's parent
pool. You can change the location of the pool recovery volumes by updating the Recovery Pool option
on the Recovery Options tab for the Copy Services Manager session.

You can assign and remove recovery volumes from a host or host cluster by using the Copy Services
Manager GUI.

- Assign R1 to host: To assign the R1 volumes to a host or host cluster, perform the following steps:

1. In the Copy Services Manager GUI, click the Recover Backup Info tab and select a recovered
backup. A table with all the R1 volumes is displayed.

2. Select one or more R1 volumes from the table and click Assign R1 to Host. A confirmation
window appears with a list of host or host clusters that are connected to the storage device.

3. Select the host or host cluster that you want to map to the R1 volumes and click Yes. The R1
volume or volumes is successfully assigned to the host and a confirmation message is displayed.

« Remove R1 host mappings: To remove a host mapping from R1 volumes, perform the following
steps:
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1. In the Copy Services Manager GUI, click the Recover Backup Info tab and select a recovered
backup. A table with all the R1 volumes is displayed.

2. Select one or more R1 volumes from the table and click Remove Host Mapping. All the host and
host cluster mappings are removed from the selected R1 volumes and a confirmation message is
displayed.

Recovery Options
The following recover options are available.

« Background copy rate: Set copy rate for the recovery relationships that the storage system uses to
perform the background copy of the FlashCopy.

« Recovery pool: Choose a pool that is to be used to automatically create volumes for recovery
relationships. If a pool is not specified, the pool of the source H1 volume is used.

ESE Sizer

The ESE Sizer session supports analyzing space requirements for DS8000 Extent Space Efficient(ESE)
FlashCopy and Safeguarded Copy.

An accurate sizing of ESE FlashCopy and Safeguarded Copy is crucial. With the DS8000 microcode release
8.5.4 and DS8900F release 9.1, a Write Monitoring(WM) bitmap is implemented in the DS8000 to track all
writes to each volume. This session type is available on any preinstalled version of Copy Services Manager
on the DS8000 HMC without the need to purchase the full Copy Services Manager license.

The purpose of the Write Monitoring Bitmap is to provide an effective way to determine usable space
requirements for both Extent Space Efficient(ESE) FlashCopy and Safeguarded Copy without impacting
host write I/O or disk replication performance. The Write Monitoring bitmap enables a DS8000 to track
the amount and locality of its changed data over definable time intervals and across a set time period in
an existing production environment.

The new session type queries the Write Monitoring bitmap and provides output files on the box and
volume level. Those output files contain the currently allocated extents, changed tracks, changed small
extents and change large extents. This level of detail can readily be used to determine how much capacity
would be allocated over time for both functions, ESE FlashCopy and Safeguarded Copy.

The following tool can be used to process the data collected from the Copy Services Manager ESE

Sizer session to provide more accurate capacity sizings in the configurations. Refer the link https://
www.ibm.com/support/pages/node/6372180 for more detailed information regarding ESE Sizer session
and the collected data.

The ESE Sizer session can start, stop, and reset the WM bitmap. With the available properties, you can
define the volume query interval and the bitmap reset interval.

Note: It is recommended to run the ESE Sizer session on a Copy Services Manager instance that is not
currently managing replication. While the ESE Sizer session does not affect replication, the data collected
uses system memory resources so running on a separate server is recommended to avoid any memory
constraints. Refer “Calculating server memory requirements” on page 33 for more information.

Managing a session with HyperSwap

HyperSwapprovides high availability of data if a primary disk storage system failure occurs. When a failure
occurs in writing I/O to the primary storage system, the failure is detected by I0S, and I0S automatically
swaps the I/0 to the secondary site with no user interaction and minimal application effect.
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Sessions that can be enabled for HyperSwap

You can create sessions that enable swapping, which provides a session with a highly available business
continuity solution.

Sessions that can enable HyperSwap
The following session types can enable HyperSwap processing;:

« Basic HyperSwap

« Metro Mirror with Failover/Failback

« Metro Global Mirror

« Metro Global Mirror with Practice

= Metro Mirror - Metro Mirror

« Metro Mirror - Global Mirror

« Metro Mirror - Global Mirror with Practice

To enable HyperSwap processing, one of the following conditions must apply:

« The volumes that are managed by the session are only IBM DS8000 storage system volumes.
« The volumes are count key data (CKD) volumes that are attached to an IBM z/0S system.

« The z/OS system is listed on the Copy Services Manager Host Connections page and is in the Connected
state.

Sessions that can enable FlashSystem/IBM Spectrum Accelerate HyperSwap

Only the Metro Mirror with Failover/Failback session type can enable FlashSystem/IBM Spectrum
Accelerate HyperSwap processing.

To enable FlashSystem/IBM Spectrum Accelerate HyperSwap processing, the volumes in the session
must be FlashSystem/IBM Spectrum Accelerate 12.1 or later volumes.

Setting up the environment for HyperSwap

You must set up an environment in which you can run HyperSwap processing before you can enable
HyperSwap for a Copy Services Manager session.

To enable HyperSwap processing on IBM z/0S systems, the following conditions must exist:

« The HSIB and IOSHSAPI address spaces are started on the z/OS system to which the storage systems
are connected.

« All reserve volumes are converted to global enqueues (ENQs).

« The storage system volumes are count key data (CKD) volumes that are attached to a z/OS system. The
volumes can be attached to the same z/0S system or different systems.

- If the storage system volumes are not connected to a z/OS system on which Copy Services Manager is
installed, the required Resource Access Control Facility (RACF) settings are set on the z/OS system and
the SOCKPORT parameter is defined for the HyperSwap management address space IOSHMCTL. This
set up enables Copy Services Manager to connect to the z/OS system by using an IP connection. For the
required RACF settings, see the IBM Copy Services Manager Installation and Configuration Guide.

To enable HyperSwap processing on FlashSystem/IBM Spectrum Accelerate systems, the following
conditions must exist:

« When adding copy sets to a FlashSystem/IBM Spectrum Accelerate session that will support
HyperSwap, the source and target volumes in the copy set MUST have the same name.
FlashSystem/IBM Spectrum Accelerate requires that the source and target have the same name.

« Before a FlashSystem/IBM Spectrum Accelerate session can be enabled for HyperSwap, a Quorum
Witness must be defined on the storage system. See the following Redbooks publication (http://
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www.redbooks.ibm.com/abstracts/redp5434.html) for more information. Also see the Quorum Witness
section in the IBM online documentation at https://www.ibm.com/support/knowledgecenter/en/
STIKMM_12.3.2/cli_12.3.2.x/r_command__mirroring__quorum_witness_define.html.

Complete the following tasks to set up an environment in which you can run HyperSwap processing on
z/0S or FlashSystem/IBM Spectrum Accelerate:

1. Add a host connection for each z/OS system in the Copy Services Manager GUI. To add a connection,
open the Host Connections page and click Add Host Connection.

Note: If the z/OS system is the system on which Copy Services Manager is installed, a native
connection is automatically added in the GUI. If the z/OS system does not have Copy Services Manager
installed, you must you use an IP connection to connect to the z/OS system.

2. Add a connection to the storage systems that are attached to the z/OS or FlashSystem/IBM Spectrum
Accelerate systems. To add a connection, open the Storage Systems page and click Add Storage
Connection. You can connect to a storage system by using a Hardware Management Console (HMC),
direct, or a z/OS connection.

3. Create a session that enables HyperSwap. To create a session, open the Sessions page and click
Create Session.

Enabling HyperSwap for a session
Enabling HyperSwap for a session provides business recovery and business continuity.

Ensure that you can use the HyperSwap functions in your environment. See “Setting up the environment
for HyperSwap” on page 105.

To enable HyperSwap for a session, complete the following steps:

1. In the Copy Services Manager menu bar, click Sessions.

2. On the Sessions page, select the session.

3. From the Session Actions list, select View/Modify > Properties.
4

. In the View/Modify Properties notebook, select the following properties on the applicable role pair
options tab:

For HyperSwap

System or sysplex
Select the z/0S system or sysplex that you want to associate with the session. Commands for
z/0S features are issued to this system or sysplex. Volumes in the session must be attached to
the system or sysplex to enable the features.

Manage H1-H2 with HyperSwap
Select this option to trigger a HyperSwap operation, which redirects application I/O to the
target volumes when there is a failure on the host accessible volumes. Copy Services Manager
uses HyperSwap to manage the H1-H2 sequence of a Metro Mirror or Metro Global Mirror
session.

Disable HyperSwap
Select this option to prevent a HyperSwap operation from occurring.

Reset In Use By System on Secondary Volumes
Select this option to have the load of the configuration automatically reset the In Use
By System state on all secondary volumes (UCBNALOC = OFF). When this option is not
selected, a load of the configuration fails when secondary volumes are in the In Use By
System state (UCBNALOC is ON). This feature is only available after APAR OA53082 is
applied to the z/OS system.

Unbox Secondary Volumes
Select this option to have the load of the configuration automatically unbox all secondary
volumes in the configuration. When this option is not selected, a load of the configuration
fails when secondary volumes are in a boxed state. This feature is only available after APAR
OA53082 is applied to the z/OS system.
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On Planned HyperSwap Error:

Partition out the failing system(s) and continue swap processing on the remaining
system(s)
Select this option to partition out the failing system and continue the swap processing
on any remaining systems.

Disable HyperSwap after attempting backout

Select this option to enable IOS to back out the HyperSwap operation, if possible, if an
error occurs during HyperSwap processing. HyperSwap is disabled.

On Unplanned HyperSwap Error:

Partition out the failing system(s) and continue swap processing on the remaining
system(s)
Select this option to partition out the failing systems and continue HyperSwap
processing on the remaining systems when a new system is added to the sysplex and
the HyperSwap operation does not complete.

Requirement: If you select this option, you must restart the system.

Disable HyperSwap after attempting backout
Select this option to enable IOS to back out the HyperSwap operation, if possible, if an
error occurs during HyperSwap processing. HyperSwap is disabled.

For FlashSystem/IBM Spectrum Accelerate HyperSwap

Manage H1-H2 with HyperSwap
Select this option to enable the relationship for HyperSwap on FlashSystem/IBM Spectrum
Accelerate volumes. This option redirects application I/O to the target volumes when there is a
failure on the host accessible volumes.

Copy Services Manager uses HyperSwap to manage the H1-H2 sequence of a Metro Mirror
session.

Planned and unplanned swaps

After a FlashSystem/IBM Spectrum Accelerate or z/OS session is enabled for HyperSwap, Copy Services
Manager will set up HyperSwap relationships on the storage system. When the relationships are created
and in a Prepared state, a planned or unplanned HyperSwap can occur.

When they are enabled, the session can start a planned or unplanned swap. A HyperSwap symbol is
displayed over the arrow that shows replication between sites, as shown in Figure 20 on page 107.

Figure 20. Swap-capable session

Completing a planned swap

When the session is enabled on z/0S or FlashSystem/IBM Spectrum Accelerate for HyperSwap, the
session is considered swap-capable. There might be cases such as a planned maintenance or a migration
from the primary storage, in which a planned swap might be required. When the session is in swap-
capable state, a planned swap can be completed by issuing the HypexSwap command for the session.
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After you run a planned swap for z/OS, the session transitions to Target Available state and all the H1-H2
pairs are in Target Available state. If the H1-H2 role pair was consistent at the time of the swap, the
session has a status of Normal, which indicates that H1-H2 is consistent. If the H1-H2 role pair was not
consistent at the time of the swap, the session has a status of SEVERE. The active host on the session is
shown as H2.

After a planned swap for FlashSystem/IBM Spectrum Accelerate, the session does not go into a Target
Available state. The FlashSystem/IBM Spectrum Accelerate automatically reverses the replication so that
the session goes Prepared in the opposite direction if the auto restart is successful, or it goes Target
Available if it is not successful.

AllI/O is redirected to the H2 volumes. After a successful swap to site 2, you cannot enable the copy
function to site 2. The only way to restart the copy processing is by issuing the Start H2->H1 command.
To have the volumes protected with high availability and disaster recovery again, correct the error that
caused the swap to occur, and manually restart the session to begin copying data to the other site.

Unplanned swaps

When the session is enabled on z/0S or FlashSystem/IBM Spectrum Accelerate for HyperSwap
processing, the session is considered swap-capable. If a primary I/O error occurs, a swap occurs
automatically.

When an unplanned swap occurs for z/0S, the session transitions to Target Available state and all the
H1-H2 pairs are in Target Available state. If the H1-H2 role pair was consistent at the time of the swap,
the session has a status of Normal, and indicates that H1-H2 is consistent. If the H1-H2 role pair was not
consistent at the time of the swap, the session might show a status of SEVERE. The active host on the
session is shown as H2.

An unplanned swap on FlashSystem/IBM Spectrum Accelerate, most likely results in Target Available
state. Because there is a primary I/O error in this situation, it probably means that the replication will not
automatically start back in the opposite direction either.

AlLI/O is redirected to the H2 volumes. After a successful swap to site 2, you cannot enable the copy
function to site 2. Therefore, it is not possible to issue a Staxrt H1->H2 command. The only way to
restart the copy processing is by issuing a Staxrt H2->H1 command. To have the volumes protected
with high availability and disaster recovery again, correct the error that caused the swap to occur, and
manually restart the session to begin copying data to the other site.

Verifying a session for a planned or unplanned swap
You can verify whether a session is capable of a planned or unplanned swap from the z/OS console on
HyperSwap

Verify the status of HyperSwap from the z/OS console:

1. View the overall status of the HyperSwap session. Issue the d hs, status command. For example:

15.03.06 SYSTEM1 d hs,status

15.03.06 SYSTEM1 STCO0063 IOSHMO303I HyperSwap Status 531
Replication Session: SR_HS

HyperSwap enabled

New member configuration load failed: Disable

Planned swap recovery: Disable

Unplanned swap recovery: Disable

FreezeAll: No

Stop: No

2. Verify all the volumes in the configuration. Issue the ds hs,config(detail,all) command. For
example:

15.03.51 SYSTEM1 d hs,config(detail,all)

15.03.51 SYSTEM1 STCOOO63 IOSHMO304I HyperSwap Configuration 534
Replication Session: SR_HS

Prim. SSID UA DEV# VOLSER Sec. SSID UA DEVi# Status

06 02 OOF42 8K3602 06 04 OOFA2

06 01 OOF41 8K3601 06 03 OOFA1L

06 00 OOF40 8K3600 06 02 OOFAQ
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Temporarily disabling HyperSwap
In some situations, it might be necessary to temporarily disable the HyperSwap function for a session.
You might want to disable HyperSwap in the following circumstances:

« If you are performing maintenance on the system
- If one sysplex member cannot communicate with one or more volumes

Complete these steps to disable HyperSwap for a specific session:

1. In the Copy Services Manager menu bar, click Sessions.

2. On the Sessions page, select the sessions for which you want to disable the HyperSwap function.
3. From the Session Actions list, select View/Modify > Properties.

4. On the applicable tab of the View/Modify Properties notebook, select Disable HyperSwap.

Tip: On management servers that run on a z/OS operating system, you can disable the HyperSwap
function from an MVS command prompt window by entering the SETHS DISABLE command.

Using active and standby Copy Services Manager servers with HyperSwap

You can set up an active and standby management server configuration with HyperSwap.

Active and standby servers with z/0OS HyperSwap

When the storage system is set up to connect through the z/OS interface, the connection information is
sent to the standby server and a connection is attempted. The connection might fail if the standby server
does not run on a z/OS operating system or does not have access to the same volumes. If the connection
fails and the standby server resumes the processing, the standby server cannot manage the HyperSwap
processing.

On the z/0OS system, if the session configuration was successfully loaded before the HyperSwap
processing, the z/OS system can manage the HyperSwap processing. If the z/OS system swaps the
volumes but cannot communicate with the Copy Services Manager server, the session is set to Suspended
or Severe state. To set the session to Target Available state, clear the Manage H1-H2 with Hyperswap
option, and issue the Recovexr command for the session.

Managing z/0S HyperSwap or hardened freeze across multiple sessions
within the same sysplex

You can manage z/0S HyperSwap or hardened freeze operations across multiple sessions within the
same sysplex.

Copy Services Manager supports the ability to enable z/OS HyperSwap on DS8000 sessions that contain
Metro Mirror pairs. However, only one HyperSwap configuration can be loaded at a time within a sysplex.
This limitation means that only a single session that is associated with a particular sysplex can load a
HyperSwap configuration.

However, in specific cases you might want all of your Metro Mirror pairs to be enabled with HyperSwap.
But only a subset of those pairs requires an extra replication to a third site. For example, you might have
production and development servers that are running Metro Mirror between two local sites and want both
of these servers to be HyperSwap capable. But to save on replication and storage costs, perhaps only the
production data needs to be replicated to the third site in a disaster.

Starting with the Copy Services Manager 6.2.0 release, you can now configure your environment so that
multiple sessions of different session types can be HyperSwap capable within the same sysplex. With this
feature, you can have asymmetric configurations for the data that you are replicating, while also ensuing
that all of the data is HyperSwap capable.

Follow these steps to set up multiple sessions on the same sysplex to be HyperSwap capable:

1. Log in to the Copy Services Manager GUI as a user with administrative privileges.
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2. Click Sessions.
3. From the Sessions Overview panel, click Session Actions > View/Modify > Properties.

4. In the session properties for each session, clear the Manage Hx-Hy with HyperSwap and the Enable
Hardened Freeze options, if checked. This action temporarily disables HyperSwap or hardened freeze.

5. In the session properties for each session, associate the session to the same Sysplex.

6. On the Session Details panel, or by selecting View/Modify > Set Consistency Group name, modify
the consistency group name for the role pair (for example, H1-H2) in each session that will be
HyperSwap capable, to the same name. The consistency group name that is defined on the Metro
Mirror role pair is used to load the HyperSwap configuration on to z/OS.

7. In the session properties for each session, select the Manage Hx-Hy with HyperSwap option again.

When all pairs in all sessions that have the same consistency group name for the HyperSwap role pair,
reach a Prepared state, a load is issued that contains the configuration of all Metro Mirror pairs across all
the sessions.

If there are multiple sessions with the same consistency group name defined, a configuration does not
load until all the pairs across all the sessions are ready and in a Prepared state. If any session has pairs in
a state other than Prepared, except for the Defined state, no load is issued and a warning is placed on the
session until all sessions reach the Prepared state and load a configuration.

Special considerations: You can also use this feature to manage hardened freeze across multiple
sessions. If you use the same process that was described in the previous task, except select only the
hardened freeze option in step “7” on page 110, multiple sessions load a hardened freeze configuration
on z/0S. You can use this method to manage data in separate sessions and session types, but keep
consistency across those sessions in a disaster. For example, you might have a Metro Global Mirror

and a Metro Mirror session in your configuration. Without the consistency group name, you can set up
hardened freeze for both sessions individually. However, if the Metro Global Mirror session processed an
unexpected suspend and Suspended the session, the Metro Mirror session does not suspend. With the
same consistency group name defined on the session, a single hardened freeze configuration is loaded on
z/0S so that when an unexpected suspend occurs, both sessions are suspended consistently.

All sessions that have the same consistency group name defined need to have the same load type
defined. If multiple sessions have the same consistency group name defined, but one is set up with
HyperSwap and another with hardened freeze, the load does not occur and an error message appears on
the session. To run separate load types, the consistency group name needs to be removed first. After you
remove the consistency group name, then the session can load a different type of configuration.

Managing hardware reserves
Copy Services Manager 6.2.11 supports a new hardware reserves option for HyperSwap configurations.

This option requires the z/OS I0S APAR OA57049. It provides support to ensure that active hardware
reserves on primary PPRC devices are properly transferred to the new primary devices after a HyperSwap,
helping to remove the need to convert hardware reserves to Global ENQs. This option also provides
support for sharing devices between sysplexes in a z/OS HyperSwap environment. The sharing is limited
to devices in a single Metro Mirror HyperSwap configuration.

Follow these steps to enable the hardware reserves option for HyperSwap:

Note: This option is only supported on the two-site and multi-target Metro Mirror - Global Mirror sessions
that support HyperSwap. This option is not supported on Metro Global Mirror, Metro Global Mirror with
Practice, or the multi-target Metro Mirror - Metro Mirror session types.

1. Log in to the Copy Services Manager GUI as a user with administrative privileges.

2. Click Sessions.

3. From the Session Overview panel, click Session Actions > View/Modify > Properties.

4. In the session properties for sessions that support HyperSwap, select the Enable Hardware Reserves
option.
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Session commands

The commands that are available for a session depend on the session type, and for some commands, the

storage system type.

Commands are issued to Copy Services Manager sessions. Any subsequent command that is issued to an
individual session is not processed until the first command is completed. Some commands, such as the
Start command, can take an extended amount of time to complete because the commands set up the
hardware relationships. You can continue to issue commands to other sessions during this time. When a
command is completed, the console shows the results of the command.

Basic HyperSwap commands

Use this information to learn about commands available for Basic HyperSwap sessions.

Note: Individual suspend and recover commands are not available in HyperSwap.

Table 49. Basic HyperSwap commands

Command

Action

HyperSwap

Triggers a HyperSwap where I/O is redirected from the source volume to
the target volume, without affecting the application using those volumes.
You can use this command if you want to perform maintenance on the
original source volumes.

Refresh States

Refreshes the states of the role pairs that are in the session (if
applicable for the session type) and refreshes the state of the session

if it is incorrect. This command queries the states of the copy sets

on the hardware. You are not required to run this command under
typical circumstances; Copy Services Manager refreshes the states

of its sessions through multiple means. However, if you discover an
inconsistency between Copy Services Manager and the hardware, you
can use this command to enable Copy Services Manager to update itself.

This command triggers multiple queries on the hardware, which can
impact hardware performance. Do not run this command more frequently
than every few minutes in each session.

This command is not available if the session is in the Defined state.

Start H1->H2

Starts copying data synchronously from H1 to H2 in a Metro Mirror
session.

Note: A session might go into a Severe state with error code 1000000
before the session returns to Normal/Prepared State and HyperSwap
Capable. The duration of the Severe state depends on how large of a
session is running.

Start H2->H1

Starts copying data synchronously from H2 to H1 in a Metro Mirror
session. You can issue this command only after the session has been
swapped and the production site is H2. To enable data protection when
the H1 volumes are available again, start I/O to the H2 volumes, and
issue this command to replicate data from the H2 volumes to H1
volumes.

Stop

Suspends updates to all the targets of pairs in a session. You can issue
this command at any time during an active session.

Note: After you issue the stop command, targets might not be consistent.
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Table 49. Basic HyperSwap commands (continued)

Command

Action

Terminate

Removes all physical copies and relationships from the hardware during
an active session.

FlashCopy commands

Use this information to learn about commands available for FlashCopy sessions.

Table 50. FlashCopy commands

Command Action

Flash Performs the FlashCopy operation using the specified options. Issue the
Flash command to create a data consistent point-in-time copy for a
FlashCopy Session with volumes on the following storage systems:
« Systems running IBM Spectrum Virtualize
- DS8000

Discover

Assimilates existing hardware relationships in a FlashCopy session on
DS8000 and Spectrum Virtualize based storage systems.

Note: For DS8000 systems, although discovered pairs are set consistent,
the session is not able to validate that they are consistent to the time of
all other pairs in the session. Be careful when using the feature, and keep
this situation in mind if a restore has to be performed.

See “Assimilate FlashCopy relationships” on page 203 for more
information.

InitiateBackgroundCopy

Copies all tracks from the source to the target immediately, instead of
waiting until the source track is written to. This command is valid only
when the background copy is not already running.

Refresh States

Refreshes the states of the role pairs that are in the session (if
applicable for the session type) and refreshes the state of the session

if it is incorrect. This command queries the states of the copy sets

on the hardware. You are not required to run this command under
typical circumstances; Copy Services Manager refreshes the states

of its sessions through multiple means. However, if you discover an
inconsistency between Copy Services Manager and the hardware, you
can use this command to enable Copy Services Manager to update itself.

This command triggers multiple queries on the hardware, which can
impact hardware performance. Do not run this command more frequently
than every few minutes in each session.

This command is not available if the session is in the Defined state.
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Table 50. FlashCopy commands (continued)

Command

Action

Restore

Restores the point-in-time relationships from the target volumes to the
source volumes of the FlashCopy session, and overwrites any data on the
source volumes.

Notes:

» Copy Services Manager can currently only perform a FlashCopy session
restore operation on DS8000 and SAN Volume Controller systems.

- If Restore is not a command option, a flash operation has not been
done. You must perform a flash at least one time before you can do a
restore.

See “Restoring a FlashCopy session” on page 201 for more information.

Start

Performs any steps necessary to define the relationship before
performing a FlashCopy operation. For DS8000, this command is not an
option. Issue this command to put the session in the prepared state for
the following storage systems:

« Systems running IBM Spectrum Virtualize

Terminate

Removes all active physical copies and relationships from the hardware
during an active session.

If you want the targets to be data consistent before removing their
relationship, you must issue the InitiateBackgroundCopy command
if NOCOPY was specified, and then wait for the background copy to
complete by checking the copying status of the pairs.

Snapshot commands

Use this information to learn about commands that are available for Snapshot sessions and groups. A
snapshot group is a grouping of snapshots of individual volumes in a consistency group at a specific point

in time.

Table 51. Snapshot session commands

Command

Action

Create Snapshot

Creates a snapshot of the volumes in the session

Refresh States

Refreshes the states of the role pairs that are in the session (if
applicable for the session type) and refreshes the state of the session

if it is incorrect. This command queries the states of the copy sets

on the hardware. You are not required to run this command under
typical circumstances; Copy Services Manager refreshes the states

of its sessions through multiple means. However, if you discover an
inconsistency between Copy Services Manager and the hardware, you
can use this command to enable Copy Services Manager to update itself.

This command triggers multiple queries on the hardware, which can
impact hardware performance. Do not run this command more frequently
than every few minutes in each session.

This command is not available if the session is in the Defined state.
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Table 51. Snapshot session commands (continued)

Command

Action

Restore

Restores the H1 volumes in the session from a set of snapshot volumes.
You must have at least one snapshot group to restore from. When

you issue this command in the Copy Services Manager graphical user
interface (GUI), you are prompted to select the snapshot group.

Table 52. Snapshot group commands

Command

Action

Delete

Deletes the snapshot group and all the individual snapshots that are in
the group from the session and from the FlashSystem/IBM Spectrum
Accelerate. If the deleted snapshot group is the last snapshot group that
is associated with the session, the session returns to the Defined state.

Disband

Disbands the snapshot group. When a snapshot group is disbanded,
the snapshot group no longer exists. All snapshots in the snapshot
group become individual snapshots that are no longer associated to the
consistency group or the session. After a snapshot group is disbanded,
it is no longer displayed in or managed by Copy Services Manager. If the
disbanded snapshot group is the last snapshot group that is associated
with the session, the session returns to the Defined state.

Duplicate

Duplicates the snapshot group. When a snapshot group is duplicated,
a new snapshot group is created with new snapshots for all volumes
that are in the duplicated group. The name of the duplicated snapshot
group is generated automatically by the FlashSystem/IBM Spectrum
Accelerate.

Lock

Locks a snapshot group. If the snapshot group is locked, write operations
to the snapshots that are in the snapshot group are prevented. By
default, a snapshot group is locked when it is created. This action is valid
only if the snapshot group is unlocked.

Overwrite

Overwrites the snapshot group to reflect the data that is on the H1
volume.

Rename

Renames the snapshot group to a name that you provide. The name can
be a maximum of 64 alphanumeric characters.

Restore

Restores the contents of a snapshot group by using another snapshot
group in the session. Both of the snapshot groups must contain the same
subset of volumes.

Set Priority

Sets the priority in which a snapshot group is deleted. The value can
be the number 1 - 4. A value of 1 specifies that the snapshot group is
deleted last. A value of 4 specifies that the snapshot group is deleted
first.

Unlock

Unlocks a snapshot group. If the snapshot group is unlocked, write
operations to the snapshots that are in the snapshot group are enabled
and the snapshot group is displayed as modified. This action is valid only
if the snapshot group is locked.
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Metro Mirror commands

Use this information to learn about commands available for Metro Mirror sessions.

Table 53. Metro Mirror commands

Command

Action

Enable Copy to Site 1

Run this command and confirm that you want to reverse the direction
of replication before you reverse the direction of copying in a failover
and failback session. After you issue this command, the Start H2->H1
command becomes available.

Enable Copy to Site 2

Run this command and confirm that you want to reverse the direction
of replication before you reverse the direction of copying in a failover
and failback session. After you issue this command, the Start H1->H2
command becomes available.

HyperSwap

Triggers a HyperSwap where I/0 is redirected from the source volume to
the target volume, without affecting the application using those volumes.
You can use this command if you want to perform maintenance on the
original source volumes.

Note: This command is available only for Copy Services Manager in
DS8000 environments.

Refresh States

Refreshes the states of the role pairs that are in the session (if
applicable for the session type) and refreshes the state of the session

if it is incorrect. This command queries the states of the copy sets

on the hardware. You are not required to run this command under
typical circumstances; Copy Services Manager refreshes the states

of its sessions through multiple means. However, if you discover an
inconsistency between Copy Services Manager and the hardware, you
can use this command to enable Copy Services Manager to update itself.

This command triggers multiple queries on the hardware, which can
impact hardware performance. Do not run this command more frequently
than every few minutes in each session.

This command is not available if the session is in the Defined state.

Recover

Issues the Recover command to suspended sessions. This command
performs the steps necessary to make the target available as the new
primary site. After this command completes, the session becomes Target
Available.

Release I/O

Enables the source volume to receive data after a copy relationship is
suspended. This command is not displayed if the Release I/0 after
Suspend property is selected for the session.

Start

Establishes a single-direction session with the hardware and begins the
synchronization process between the source and target volumes.

Start H1->H2

Establishes Metro Mirror relationships between the H1 volumes and the
H2 volumes, and begins data replication from H1 to H2.

Start H2->H1

Establishes Metro Mirror relationships between the H2 volumes and the
H1 volumes and starts data replication from H2 to H1. Indicates direction
of a failover and failback between two hosts in a Metro Mirror session. If
the session has been recovered such that the production site is now H2,
you can issue the Start H2->H1 command to start production on H2 and
start data replication.
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Table 53. Metro Mirror commands (continued)

Command Action

Stop Inconsistently suspends updates to all the targets of pairs in a session.
This command can be issued at any point during an active session.
Note: Targets after the suspend are not considered to be consistent.

StartGC Establishes Global Copy relationships between the H1 volumes and the

H2 volumes, and begins asynchronous data replication from H1 to H2.
While in the Preparing state, it will not change to the Prepared state
unless you switch to Metro Mirror.

Note: This command is available only for Copy Services Manager in
DS8000 environments.

Stop When Drained

After a StartGC command, the session is in a Preparing and Global Copy
mode. The Stop When Drained command starts a thread that queries
all pairs until zero pairs are out-of-sync (00S). After the OOS for the pairs
goes to zero, the Stop command is issued.

Note: The Stop command is issued, rather than Suspend, so that this
procedure can be used in cascaded environments. Suspend puts the
pairs in Metro Mirror mode, which is not allowed if the source of the
session is the target of another relationship.

Suspend

Causes all target volumes to remain at a data-consistent point and stops
all data that is moving to the target volumes. This command can be
issued at any point during a session when the data is actively being
copied.

Note: Avoid using the same LSS pairs for multiple Metro Mirror sessions.
Metro Mirror uses a freeze command on DS8000 storage systems to
create the data-consistent point. If there are other Metro Mirror sessions
overlapping the same LSS pairs as in this session, those sessions are also
suspended.

When a Suspend command is issued to a source volume in an LSS that
has source volumes in another active Metro Mirror session, the other
source volumes are affected only if they have the same target LSS. The
primary volumes are suspended, but volumes in the same source LSS
that have target volumes in a different LSS are not affected because they
use a different PPRC path connection.

Terminate

Removes all copy relationships from the hardware during an active
session. If you want the targets to be data consistent before removing
their relationship, you must issue the Suspend command, then the
Recover command, and then the Terminate command.

Metro Mirror with Practice commands

Use this information to learn about commands available for Metro Mirror with Practice sessions.

Table 54. Metro Mirror with Practice commands

Command

Action

Enable Copy to Site 1

Run this command and confirm that you want to reverse the direction of
replication before you reverse the direction of copying in a failover and
failback session. After you issue this command, the Start H2->H1 command
becomes available.
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Table 54. Metro Mirror with Practice commands (continued)

Command Action

Enable Copy to Site 2 Run this command and confirm that you want to reverse the direction of
replication before you reverse the direction of copying in a failover and
failback session. After you issue this command, the Start H1->H2 command
becomes available.

Flash Creates a FlashCopy image from I2 volumes to H2 volumes. The amount of
time for this to occur will vary depending on the number of copy sets in the
session.

Note: For DS8000 storage systems, the Flash command uses the freeze
and thaw processing to create a data consistent point for the FlashCopy.

If there is another Metro Mirror session overlapping on one or more of the
same LSS pairs, that session will be suspended. It is also possible that the
suspension of the other session might cause the Metro Mirror session to
remain suspended after the flash command is issued instead of returning
to Prepared state. Avoid using the same LSS pairs for multiple Metro Mirror
sessions if possible.

Allow Practice Flash Issued to allow a Flash operation again on a Practice session after it has
been suspended with the Prevent Reflash of Practice volume
after Flash oxr Recover option.

The Allow Practice Flash command appears in the Preparing or
Prepared states only if it is currently preventing the reflash. If the session
is Preparing, the Flash command does not display until the session gets to
the Prepared state.

See “Prevent a reflash when practicing disaster recovery” on page 225 for
more information on using this command.

Recover Takes a point-in-time copy of the data on I2 to the H2 volumes, enabling the
application to be attached and run from the H2 volumes on site 2.

Note: The point-in-time copy is performed when the sessionis in a
recoverable state to avoid that previous consistent data on H2 are
overwritten by inconsistent data upon Recover. You can issue the Flash
command if you want to force a point-in-time copy from I2 to H2 volumes
afterward.

Refresh States Refreshes the states of the role pairs that are in the session (if applicable
for the session type) and refreshes the state of the session if it is incorrect.
This command queries the states of the copy sets on the hardware. You
are not required to run this command under typical circumstances; Copy
Services Manager refreshes the states of its sessions through multiple
means. However, if you discover an inconsistency between Copy Services
Manager and the hardware, you can use this command to enable Copy
Services Manager to update itself.

This command triggers multiple queries on the hardware, which can impact
hardware performance. Do not run this command more frequently than
every few minutes in each session.

This command is not available if the session is in the Defined state.

Release I/0 Enables the source volume to receive data after a copy relationship is
suspended. This command is not displayed if the Release I/0 after
Suspend property is selected for the session.
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Table 54. Metro Mirror with Practice commands (continued)

Command

Action

Start H1->H2

Establishes a Metro Mirror relationship from the H1 volumes to the 12
volumes, and begins data replication.

Start H2->H1

Establishes a Metro Mirror relationship from H2 to H1 and begins data
replication.

StartGC_H1H2

Distinguishes when the session is in the Preparing state from H1 to I2 and
begins the asynchronous process between the source and target volumes.
While in the Preparing state the session will not change to the Prepared
state unless you switch to Metro Mirror.

StartGC_H2H1

Distinguishes when the session is in the Preparing state from H2 to H1 and
begins the asynchronous process between the source and target volumes.
While in the Preparing state the session will not change to the Prepared
state unless you switch to Metro Mirror.

Suspend

Causes all target volumes to remain at a data-consistent point and stops all
data that is moving to the target volumes. This command can be issued at
any point during a session when the data is actively being copied.

Note: The Metro Mirror command uses a freeze command on the DS8000
devices to create the data-consistent point. If there are other Metro Mirror
sessions overlapping the same LSS pairs as in this session, those sessions
will also become suspended. Avoid using the same LSS pairs for multiple
Metro Mirror sessions.

When a Suspend command is issued to a source volume in an LSS that

has source volumes in another active Metro Mirror session, the other source
volumes are affected only if they have the same target LSS. The primary
volumes are suspended, but volumes in the same source LSS that have
target volumes in a different LSS are not affected because they use a
different PPRC path connection.

Stop

Inconsistently suspends updates to all the targets of pairs in a session. This
command can be issued at any point during an active session.

Note: Targets after the suspend are not considered to be consistent.

Terminate

Terminates all copy relationships on the hardware.

TerminateH2I2

Removes the FlashCopy relationships after a Flash command is issued.
When you use Extent Space Efficient (ESE) volumes for your practice
volumes (H2), it is recommended to set the No Copy option on the H2I2 role
pair. When No Copy is set, data will only be physically written to H2 when a
track is updated on I2. If the practice copy of the data is no longer needed,
this command can be run to remove the FlashCopy relationship from I2 to
H2, to prevent the relationship from consuming backend space.

Notes:

« If the command is issued, H2 will no longer hold a consistent logical copy
of the data until the next Flash or Recover is issued.

= This command is only available for DS8000 practice sessions while in the
Preparing, Prepared, or Suspended states. This command is not available
while in the Defined or Target Available states.
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Global Mirror commands

Use this information to learn about commands available for Global Mirror sessions.

Table 55. Global Mirror commands

Command

Action

Enable Copy to Site 1

Run this command and confirm that you want to reverse the direction
of replication before you reverse the direction of copying in a failover
and failback session. After you issue this command, the Start H2->H1
command becomes available.

Enable Copy to Site 2

Run this command and confirm that you want to reverse the direction
of replication before you reverse the direction of copying in a failover
and failback session. After you issue this command, the Start H1->H2
command becomes available.

Recover

Issue this command to recover the session to the target site. This
command performs the steps necessary to make the target host volumes
consistent and available for access as the new primary site. After this
command completes, the session state becomes Target Available. Do not
access H2 volumes until the Recover command is completed and the
session displays Target Available and Recoverable. A Recover to H2 also
establishes a point-in-time copy to J2 to preserve the last consistent
data.

Refresh States

Refreshes the states of the role pairs that are in the session (if
applicable for the session type) and refreshes the state of the session

if it is incorrect. This command queries the states of the copy sets

on the hardware. You are not required to run this command under
typical circumstances; Copy Services Manager refreshes the states

of its sessions through multiple means. However, if you discover an
inconsistency between Copy Services Manager and the hardware, you
can use this command to enable Copy Services Manager to update itself.

This command triggers multiple queries on the hardware, which can
impact hardware performance. Do not run this command more frequently
than every few minutes in each session.

This command is not available if the session is in the Defined state.

Set Production to Site 1

Allows you to set the production volume to be at Site 1 from the Defined
state.

Set Production to Site 2

Allows you to set the production volume to be at Site 2 from the Defined
state.

Start

Establishes all relationships in a single-direction session and begins the
process necessary to start forming consistency groups on the hardware.

Start H1->H2

Starts copying data from H1 to H2 in a Global Mirror Failover/Failback
session. Establishes the necessary relationships in the session and
begins the process necessary to start copying data from the H1 site to
the H2 site and to start forming consistency groups.
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Table 55. Global Mirror commands (continued)

Command

Action

Start H2->H1

Starts copying data from H2 to H1 in a failover and failback session

for DS8000. If a recover was performed on a session such that the
production site is now H2, you can issue a Start H2->H1 command to
start moving data back to Site 1. However, this start does not provide
consistent protection as it copies only asynchronously back because of
the long distance. A Global Copy relationship is used. When you are ready
to move production back to Site 1, issue a suspend to the session. This
action puts the relationships into a synchronized state and suspends
them consistently. Sessions are consistent when a H2->H1 copy occurs
for the FlashSystem/IBM Spectrum Virtualize storage systems

StartGC H1->H2

This command is available
only for Global Mirror
Failover/Failback and Global
Mirror Failover/Failback with
Practice sessions.

Establishes Global Copy relationships between site 1 and site 2 and
begins asynchronous data replication from H1 to H2. To change the
session state from Preparing to Prepared, you must issue the Start H1-
>H2 command and the session must begin to form consistency groups.

There is no disaster recovery protection for Global Copy relationships. If
a disaster such as the loss of a primary storage system or a link failure
between the sites occurs, the session might be inconsistent when you
issue the Recovexr command.

This command is available for the DS8000 storage system.

Stop

Inconsistently stops the pairs that are in a Global Copy mode.

Stop When Drained

After a StartGC command, the session is in a Preparing and Global Copy
mode. The Stop When Drained command starts a thread that queries
all pairs until zero pairs are out-of-sync (00S). After the OOS for the pairs
goes to zero, the Stop command is issued.

Note: The Stop command is issued, rather than Suspend, so that this
procedure can be used in cascaded environments. Suspend puts the
pairs in Metro Mirror mode, which is not allowed if the source of the
session is the target of another relationship.
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Table 55. Global Mirror commands (continued)

Command

Action

Suspend

Pauses the Global Mirror master session, which causes the session to
stop forming consistency groups, and suspends the H1 to H2 Global Copy
pairs.

Note: This action occurs only if the session is in Global Mirror mode. If
the session is in Global Copy mode, the Suspend command attempts to
consistently suspend the pairs by establishing the Global Copy pairs as
Metro Mirror pairs. When these pairs all reach a Prepared state, a Freeze
is then issued to have consistency at the remote site.

If you are using a System Storage DS8000: The Suspend command
invokes a pause command for IBM DS8000. The pause command that is
invoked depends on the IBM DS8000 microcode level.

If the following conditions are true, the Suspend command invokes a
command that is equivalent to the IBM DS8000 command pausegmir
-withsecondary:

« All primary volumes that are in the session are on a IBM DS8000
storage system with a microcode level that includes the pause with
secondary consistency option. To determine whether this option is
available for your storage system, see the IBM DS8000 documentation
for the microcode level that you are using.

« The pause with secondary consistency option is enabled on the storage
system.

If these conditions are not true, the Suspend command invokes a
command that is equivalent to the IBM DS8000 command pausegmiz.

Both commands temporarily pause the formation of consistency groups
after the current consistency group is formed. However, the command for
a pause with secondary consistency creates a consistent data set on the
secondary volumes.

If you do not want to suspend the Global Copy

pairs when a Global Mirror session is suspended,

openthe rmserver.properties fileinthe install
dir\liberty\wlp\usr\servers\csmServer\properties
directory on distributed systems, or

the path_prefix/opt/IBM/CSM/wlp/usr/servers/csmServer/
properties directory on z/0OS, and add the following property:

csm.server.sus_gc_pairs_on_gm_pause = false

Tip: The pause with secondary consistency option requires that the
Global Copy pairs are suspended. If you do not want to use the pause
with secondary consistency option for storage systems on which the
option is enabled, set the csm.sexver.sus_gc_pairs_on_gm_pause
property to false.

Terminate

Removes all physical copies and relationships from the hardware during
an active session.

If you want the targets to be data consistent before you remove
their relationship, you must issue the Suspend command, the Recover
command, and then the Terminate command.
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Global Mirror with Practice commands

Use this information to learn about commands available for Global Mirror with Practice sessions.

Table 56. Global Mirror with Practice commands

Command

Action

Enable Copy to Site 1

Run this command and confirm that you want to reverse the direction of
replication before you reverse the direction of copying in a failover and
failback session. After you issue this command, the Start H2->H1 command
becomes available.

Enable Copy to Site 2

Run this command and confirm that you want to reverse the direction of
replication before you reverse the direction of copying in a failover and
failback session. After you issue this command, the Start H1->H2 command
becomes available.

Flash

The Flash command ensures that all I2s are consistent, and then flashes
the data from I2 to the H2 volumes. After the flash is complete, the Global
Mirror session is automatically restarted, and the session begins forming
consistency groups on I2. You can then use the H2 volumes to practice your
disaster recovery procedures.

For Global Mirror with Practice sessions for DS8000, the Flash command
temporarily pauses the formation of consistency groups.

Allow Practice Flash

Issued to allow a Flash operation again on a Practice session after it has
been suspended with the Prevent Reflash of Practice volume
after Flash or Recover option.

The Allow Practice Flash command appears in the Preparing or
Prepared states only if it is currently preventing the reflash. If the session

is Preparing, the Flash command does not display until the session gets to
the Prepared state.

See “Prevent a reflash when practicing disaster recovery” on page 225 for
more information on using this command.

Recover

Restores consistent data on I2 volumes and takes a point-in-time copy of
the data on I2 to the H2 volumes, enabling the application to be attached
and run from the H2 volumes on site 2. The I2 volumes continue to hold
the consistent data and can be flashed again to H2 by using the Flash
command.

Refresh States

Refreshes the states of the role pairs that are in the session (if applicable
for the session type) and refreshes the state of the session if it is incorrect.
This command queries the states of the copy sets on the hardware. You
are not required to run this command under typical circumstances; Copy
Services Manager refreshes the states of its sessions through multiple
means. However, if you discover an inconsistency between Copy Services
Manager and the hardware, you can use this command to enable Copy
Services Manager to update itself.

This command triggers multiple queries on the hardware, which can impact
hardware performance. Do not run this command more frequently than
every few minutes in each session.

This command is not available if the session is in the Defined state.
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Table 56. Global Mirror with Practice commands (continued)

Command

Action

ResumeGM

Resumes the Global Mirror master session on the hardware allowing the
hardware to restart all relationships and consistency group formation. The
command does not do any of the additional checks such as establishing for
logical paths, etc. that are run by issuing the Start command. This command
is only recommended to be used when the session is suspended for a short
amount of time, such as when creating a FlashCopy or Safeguarded Copy
backup at the remote site.

Note: The command does not work for sessions that are suspended

and share the same consistency group on the hardware. When sessions
share a consistency group, the Suspend command removes the volumes

of the suspended session out of the hardware session in order to allow
other sessions to continue to form consistency groups. So the ResumeGM
command will not cause the pairs in the suspended session to be restarted,
you must run the Start command for the same.

Start H1->H2

Starts copying data from H1 to H2. After the first pass of the copy is
complete for all pairs, the session establishes the 12->J2 FlashCopy pairs.
The session starts the Global Mirror master so that the hardware begins to
form consistency groups, to ensure that consistent data is at site 2.

Start H2->H1

Starts copying data from H2 to H1 in a failover and failback session. If a
recover was performed on a session such that the production site is now H2,
you can issue a Start H2->H1 command to start moving data back to Site 1.
However, this start does not provide consistent protection as it copies only
asynchronously back because of the long distance.

Note: DS8000 volumes are not consistent for the Start H2->H1 command.

A Global Copy relationship is used. When you are ready to move production
back to Site 1, issue a suspend command to the session. The relationships
are put into a synchronized state and are suspended consistently.

StartGC H1->H2

This command is
available only for Global
Mirror Failover/Failback
and Global Mirror
Failover/Failback with
Practice sessions.

Establishes Global Copy relationships between site 1 and site 2 and begins
asynchronous data replication from H1 to I2. To change the session state
from Preparing to Prepared, you must issue the Staxrt H1->H2 command
and the session must begin to form consistency groups.

There is no disaster recovery protection for Global Copy relationships. If
a disaster such as the loss of the primary Copy Services Manager server
occurs, the session might be inconsistent when you issue the Recover
command.

This command is available for the DS8000 storage system.
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Table 56. Global Mirror with Practice commands (continued)

Command

Action

Suspend

Pauses the Global Mirror master session, which causes the session to stop
forming consistency groups, and suspends the H1 to H2 Global Copy pairs.

Note: This action occurs only if the session is in Global Mirror mode. If

the session is in Global Copy mode, the Suspend command attempts to
consistently suspend the pairs by establishing the Global Copy pairs as
Metro Mirror pairs. When these pairs all reach a Prepared state, a Freeze is
then issued to have consistency at the remote site.

If you are using a System Storage DS8000: The Suspend command
invokes a pause command for IBM DS8000. The pause command that is
invoked depends on the IBM DS8000 microcode level.

If the following conditions are true, the Suspend command invokes a
command that is equivalent to the IBM DS8000 command pausegmir
-withsecondary:

« All primary volumes that are in the session are on a IBM DS8000 storage
system with a microcode level that includes the pause with secondary
consistency option. To determine whether this option is available for your
storage system, see the IBM DS8000 documentation for the microcode
level that you are using.

- The pause with secondary consistency option is enabled on the storage
system.

If these conditions are not true, the Suspend command invokes a command
that is equivalent to the IBM DS8000 command pausegmir.

Both commands temporarily pause the formation of consistency groups
after the current consistency group is formed. However, the command for
a pause with secondary consistency creates a consistent data set on the
secondary volumes.

If you do not want to suspend the Global Copy

pairs when a Global Mirror session is suspended,

open the rmserver.properties fileinthe install
dir\liberty\wlp\usr\servers\csmServer\properties directory
on distributed systems, or the path_prefix/opt/IBM/CSM/wlp/usx/
servers/csmServer/properties directory on z/OS, and add the
following property:

csm.server.sus_gc_pairs_on_gm_pause = false

Tip: The pause with secondary consistency option requires that the Global
Copy pairs are suspended. If you do not want to use the pause with
secondary consistency option for storage systems on which the option is
enabled, set the csm.sexver.sus_gc_pairs_on_gm_pause property to
false.

Terminate

Removes all physical copies and relationships that are on the hardware.
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Table 56. Global Mirror with Practice commands (continued)

Command

Action

TerminateH2I2

Removes the FlashCopy relationships after a Flash command is issued.
When you use Extent Space Efficient (ESE) volumes for your practice
volumes (H2), it is recommended to set the No Copy option on the H2I2 role
pair. When No Copy is set, data will only be physically written to H2 when a
track is updated on I2. If the practice copy of the data is no longer needed,
this command can be run to remove the FlashCopy relationship from 12 to
H2, to prevent the relationship from consuming backend space.

Notes:

« If the command is issued, H2 will no longer hold a consistent logical copy
of the data until the next Flash or Recover is issued.

« This command is only available for DS8000 practice sessions while in the
Preparing, Prepared, or Suspended states. This command is not available
while in the Defined or Target Available states.

Global Mirror Either Direction commands

Use this information to learn about commands available for Global Mirror Either Direction sessions.

Table 57. Global Mirror Either Direction commands

Command

Action

Enable Copy to Site 1

Run this command and confirm that you want to reverse the direction of
replication before you reverse the direction of copying in a Global Mirror
Either Direction session. After you issue this command, the Start H2->H1
command becomes available.

Enable Copy to Site 2

Run this command and confirm that you want to reverse the direction of
replication before you reverse the direction of copying in a Global Mirror
Either Direction session. After you issue this command, the Start H1->H2
command becomes available.

Allow Practice Flash

Issued to allow a Flash operation again on a Practice session after it has
been suspended with the Prevent Reflash of Practice volume
after Flash or Recover option.

The Allow Practice Flash command appears in the Preparing or
Prepared states only if it is currently preventing the reflash. If the session
is Preparing, the Flash command does not display until the session gets
to the Prepared state.

See “Prevent a reflash when practicing disaster recovery” on page 225
for more information on using this command.

Free Journal Space

Frees up journal space by deleting the FlashCopy relationships from the
hardware.

The Free Journal Space command is only available after a recover
operation is issued on the Global Mirror leg of the selected session.
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Table 57. Global Mirror Either Direction commands (continued)

Command

Action

Recover

Issue this command to recover the session to the target site. This
command performs the steps necessary to make the target host volumes
consistent and available for access as the new primary site. After this
command completes, the session state becomes Target Available. Do not
access H2 volumes until the Recover command is completed and the
session displays Target Available and Recoverable. A Recover to H2 also
establishes a point-in-time copy to J2 to preserve the last consistent
data.

Refresh States

Refreshes the states of the role pairs that are in the session (if
applicable for the session type) and refreshes the state of the session

if it is incorrect. This command queries the states of the copy sets

on the hardware. You are not required to run this command under
typical circumstances; Copy Services Manager refreshes the states

of its sessions through multiple means. However, if you discover an
inconsistency between Copy Services Manager and the hardware, you
can use this command to enable Copy Services Manager to update itself.

This command triggers multiple queries on the hardware, which can
impact hardware performance. Do not run this command more frequently
than every few minutes in each session.

This command is not available if the session is in the Defined state.

Set Production to Site 1

Sets the production volume to be at Site 1 from the Defined state.

Set Production to Site 2

Sets the production volume to be at Site 2 from the Defined state.

Start

Establishes all relationships in a single-direction session and begins the
process necessary to start forming consistency groups on the hardware.

Start H1->H2

Starts copying data from H1 to H2 in a Global Mirror Either Direction
session. Establishes the necessary relationships in the session and
begins the process necessary to start copying data from the H1 site to
the H2 site and to start forming consistency groups.

Start H2->H1

Starts copying data from H2 to H1 in a Global Mirror Either Direction
session. Establishes the necessary relationships in the session and
begins the process necessary to start copying data from the H2 site to
the H1 site and to start forming consistency groups.

StartGC H1->H2

This command is available
only for Global Mirror
Failover/Failback and Global
Mirror Failover/Failback with
Practice sessions.

Establishes Global Copy relationships between site 1 and site 2 and
begins asynchronous data replication from H1 to H2. To change the
session state from Preparing to Prepared, you must issue the Start H1-
>H2 command and the session must form consistency groups.

There is no disaster recovery protection for Global Copy relationships. If
a disaster such as the loss of a primary storage system or a link failure
between the sites occurs, the session might be inconsistent when you
issue the Recovexr command.

This command is available for the DS8000 storage system.
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Table 57. Global Mirror Either Direction commands (continued)

Command

Action

StartGC H2->H1

Establishes Global Copy relationships between site 1 and site 2 and
begins asynchronous data replication from H2 to H1. To change the
session state from Preparing to Prepared, you must issue the Start H2-
>H1 command and the session must form consistency groups.

There is no disaster recovery protection for Global Copy relationships. If
a disaster such as the loss of a primary storage system or a link failure
between the sites occurs, the session might be inconsistent when you
issue the Recovexr command.

This command is available for the DS8000 storage system.

Stop

Inconsistently stops the pairs that are in a Global Copy mode.

Stop When Drained

After a StartGC command, the session is in a Preparing and Global Copy
mode. The Stop When Drained command starts a thread that queries
all pairs until zero pairs are out-of-sync (0O0S). After the OOS for the pairs
goes to zero, the Stop command is issued.

Note: The Stop command is issued, rather than Suspend, so that this
procedure can be used in cascaded environments. Suspend puts the
pairs in Metro Mirror mode, which is not allowed if the source of the
session is the target of another relationship.
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Table 57. Global Mirror Either Direction commands (continued)

Command

Action

Suspend

Pauses the Global Mirror master session, which causes the session to
stop forming consistency groups, and suspends the H1 to H2 Global Copy
pairs.

Note: This action occurs only if the session is in Global Mirror mode. If
the session is in Global Copy mode, the Suspend command attempts to
consistently suspend the pairs by establishing the Global Copy pairs as
Metro Mirror pairs. When these pairs all reach a Prepared state, a Freeze
is then issued to have consistency at the remote site.

If you are using a System Storage DS8000: The Suspend command
invokes a pause command for IBM DS8000. The pause command that is
invoked depends on the IBM DS8000 microcode level.

If the following conditions are true, the Suspend command invokes a
command that is equivalent to the IBM DS8000 command pausegmir
-withsecondary:

« All primary volumes that are in the session are on a IBM DS8000
storage system with a microcode level that includes the pause with
secondary consistency option. To determine whether this option is
available for your storage system, see the IBM DS8000 documentation
for the microcode level that you are using.

« The pause with secondary consistency option is enabled on the storage
system.

If these conditions are not true, the Suspend command invokes a
command that is equivalent to the IBM DS8000 command pausegmiz.

Both commands temporarily pause the formation of consistency groups
after the current consistency group is formed. However, the command for
a pause with secondary consistency creates a consistent data set on the
secondary volumes.

If you do not want to suspend the Global Copy

pairs when a Global Mirror session is suspended,

openthe rmserver.properties fileinthe install
dir\liberty\wlp\usr\servers\csmServer\properties
directory on distributed systems, or

the path_prefix/opt/IBM/CSM/wlp/usr/servers/csmServer/
properties directory on z/0OS, and add the following property:

csm.server.sus_gc_pairs_on_gm_pause = false

Tip: The pause with secondary consistency option requires that the
Global Copy pairs are suspended. If you do not want to use the pause
with secondary consistency option for storage systems on which the
option is enabled, set the csm.sexver.sus_gc_pairs_on_gm_pause
property to false.

Terminate

Removes all physical copies and relationships from the hardware during
an active session.

If you want the targets to be data consistent before you remove
their relationship, you must issue the Suspend command, the Recover
command, and then the Terminate command.
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Table 57. Global Mirror Either Direction commands (continued)

Command

Action

TerminateH1I1 or
TerminateH2I2

Removes the FlashCopy relationships after a Flash command is issued.
When you use Extent Space Efficient (ESE) volumes for your practice
volumes (H1 or H2), it is recommended to set the No Copy option on the
H1I1 or H21I2 role pair. When No Copy is set, data will only be physically
written to H1 or H2 when a track is updated on I1 or I2. If the practice
copy of the data is no longer needed, this command can be run to remove
the FlashCopy relationship from I1 or I2 to H1 or H2, to prevent the
relationship from consuming backend space.

Notes:

« If the command is issued, H1 or H2 will no longer hold a consistent
logical copy of the data until the next Flash or Recover is issued.

« The command that you use, Terminate H1I1 or Terminate H212,
depends on the copy direction.

» This command is only available for DS8000 practice sessions while in
the Preparing, Prepared, or Suspended states. This command is not
available while in the Defined or Target Available states.

Metro Global Mirror commands

Use this information to learn about commands available for Metro Global Mirror sessions.

Table 58. Metro Global Mirror commands

Command

Action

Enable Copy to Site 1

Run this command and confirm that you want to reverse the direction of
replication before you reverse the direction of copying in a failover and
failback session. After you issue this command, the Start H2->H1->H3
command becomes available.

Enable Copy to Site 2

Run this command and confirm that you want to reverse the direction of
replication before you reverse the direction of copying in a failover and
failback session. After you issue this command, the Start H1->H2->H3
command becomes available.

HyperSwap

Causes a site switch, equivalent to a suspend and recover for a Metro Mirror
with failover and failback individual suspend and recover commands are not
available. This command is available only for Copy Services Manager.

RecoverH1

Specifying H1 makes the H1 volume TargetAvailable. Metro Global Mirror
(when running H2->H1->H3) can move production to either the H1 or H3
set of volumes. Copy Services Manager processing differs, depending on
the recovery site. Therefore, the site designation is added to the Recover
command so Copy Services Manager can set up for the failback.

RecoverH2

Specifying H2 makes the H2 volume TargetAvailable. Metro Global Mirror
(when running H1->H2->H3) can move production to either the H2 or H3
set of volumes. Copy Services Manager processing is different depending on
the recovery site. Therefore the site designation is added to the Recover
command so Copy Services Manager can prepare for the failback.
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Table 58. Metro Global Mirror commands (continued)

Command Action

RecoverH3 Specifying H3 makes the H3 volume TargetAvailable. Metro Global Mirror
(when H1->H2->H3 is run) can then move production to the H3 set of
volumes. Because Copy Services Manager processing differs depending on
the recovery site, the site designation is added to the Recover command so
that Copy Services Manager can prepare for the failback.

This command prepares H3 so that you can start the application on H3. H3
becomes the active host, and you then have the option start H3->H1->H2
to perform a Global Copy copy back. The recovery establishes point-in-time
copy to J3 volumes to preserve the last consistent data.

Re-enable Copy to Site 1 | After you issue a RecoverH1 command, you can run this command to restart
the copy to the original the direction of replication in a failover and failback
session.

Re-enable Copy to Site 2 | After you issue a RecoverH2 command, you can run this command to restart
the copy to the original the direction of replication in a failover and failback
session.

Re-enable Copy to Site 3 | After you issue a RecoverH3 command, you can run this command to restart
the copy to the original the direction of replication in a failover and failback
session.

Refresh States Refreshes the states of the role pairs that are in the session (if applicable
for the session type) and refreshes the state of the session if it is incorrect.
This command queries the states of the copy sets on the hardware. You
are not required to run this command under typical circumstances; Copy
Services Manager refreshes the states of its sessions through multiple
means. However, if you discover an inconsistency between Copy Services
Manager and the hardware, you can use this command to enable Copy
Services Manager to update itself.

This command triggers multiple queries on the hardware, which can impact
hardware performance. Do not run this command more frequently than
every few minutes in each session.

This command is not available if the session is in the Defined state.

Release I/0 Enables the source volume to receive data after a copy relationship is
suspended. This command is not displayed if the Release I/0 after
Suspend property is selected for the session.

Start H1->H2->H3 Establishes Metro Mirror relationships between H1 and H2, and Global
Mirror relationships between H2 and H3. For Metro Global Mirror, this
relationship includes the J3 volume to complete the Global Mirror
configuration. (The J3 volume role is the journal volume at site 3.) The
Start H1->H2->H3 command can be used from some Metro Global Mirror
configurations to transition back to the starting H1->H2->H3 configuration.

This command is the
Metro Global Mirror initial
start command.

This command is valid only when the session is in a defined, preparing,
prepared, target available, or suspended state.
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Table 58. Metro Global Mirror commands (continued)

Command

Action

Start H1->H3

From the H1->H2->H3 configuration, this command changes the session
configuration to a Global Mirror-only session between H1 and H3, with H1 as
the source. Use this command in case of an H2 failure with transition bitmap
support provided by incremental resynchronization. It can be used when a
session is in preparing, prepared, and suspended states because there is not
a source host change involved.

You can use this command to bypass the H2 volume in case of an H2

failure and copy only the changed tracks and tracks in flight from H1 to H3.
After the incremental resynchronization is performed, the session is running
Global Mirror from H1 to H3 and loses the near-zero data loss protection
that is achieved with Metro Mirror when H1->H2->H3 is run. However, data
consistency is still maintained at the remote site with the Global Mirror
solution.

From H2->H1->H3 configuration, this command changes the session
configuration to a Global Mirror-only session configuration between H1 and
H3, with H1 as the source. Use this command when the source site has

a failure and production is moved to the H1 site. For example, for an
unplanned HyperSwap. The Global Mirror session is continued. This is a
host-volume change so this command is valid only when you restart the
H1->H3 configuration or from the TargetAvailable H2->H1->H3 state.

Start H2->H3

From the H1->H2->H3 configuration, this command moves the session
configuration to a configuration between H2 and H3, with H2 as the source.
Use this command when the source site has a failure and production is
moved to the H2 site. For example, for an unplanned HyperSwap. The Global
Mirror session is continued. This session is a host-volume change so this
command is valid only when you restart the H1->H3 configuration or from
the TargetAvailable H2->H1>H3 state.

From the H2->H1->H3 configuration, this command changes the session
configuration to a configuration between H2 and H3 with H2 as the source.
Use this command in case of an H1 failure with transition bitmap support
provided by incremental resynchronization. Because there is not a source-
host change involved, this command can be used when the session is in
the preparing, prepared, and suspended states. The Start H2->H1->H3
command can be used to transition back to the starting H2->H1->H3
configuration.

Start H2->H1->H3

This command is the
Metro Global Mirror start
command.

This configuration completes the HyperSwap processing. This command

creates Metro Mirror relationships between H2 and H1 and Global Mirror
relationships between H1 and H3. For Metro Global Mirror, the J3 volume
completes the Global Mirror configuration.

Start H3->H1->H2

After a recovery to H3 is completed, this command sets up the hardware

to allow the application to begin writing to H3, and the data is copied

back to H1 and H2. However, issuing this command does not guarantee
consistency in the case of a disaster because only Global Copy relationships
are established to cover the long-distance copy back to site 1.

To move the application back to H1, you can issue a suspend while in this
state to drive all the relationships to a consistent state and then issue a
freeze to make the session consistent. You can then issue a Rcover followed
by a Start H1->H2->H3 to go back to the original configuration.
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Table 58. Metro Global Mirror commands (continued)

Command

Action

SuspendH2H3

Pauses the Global Mirror master session, which causes the session to stop
forming consistency groups, and suspends the H2 to H3 Global Copy pairs.

If you are using a System Storage DS8000: The Suspend command
invokes a pause command for IBM DS8000. The pause command that is
invoked depends on the IBM DS8000 microcode level.

If the following conditions are true, the Suspend command invokes a
command that is equivalent to the IBM DS8000 command pausegmir
-withsecondary:

« All primary volumes that are in the session are on a IBM DS8000 storage
system with a microcode level that includes the pause with secondary
consistency option. To determine whether this option is available for your
storage system, see the IBM DS8000 documentation for the microcode
level that you are using.

- The pause with secondary consistency option is enabled on the storage
system.

If these conditions are not true, the Suspend command invokes a command
that is equivalent to the IBM DS8000 command pausegmir.

Both commands temporarily pause the formation of consistency groups
after the current consistency group is formed. However, the command for
a pause with secondary consistency creates a consistent data set on the
secondary volumes.

If you do not want to suspend the Global Copy

pairs when a Global Mirror session is suspended,

open the rmserver.properties fileinthe install
dir\liberty\wlp\usr\servers\csmServer\properties directory
on distributed systems, or the path_prefix/opt/IBM/CSM/wlp/usx/
servers/csmServer/properties directory on z/OS, and add the
following property:

csm.server.sus_gc_pairs_on_gm_pause = false

Tip: The pause with secondary consistency option requires that the Global
Copy pairs are suspended. If you do not want to use the pause with
secondary consistency option for storage systems on which the option is
enabled, set the csm.sexver.sus_gc_pairs_on_gm_pause property to
false.

SuspendH1H3

Pauses the Global Mirror master session, which causes the session to stop
forming consistency groups, and suspends the H1 to H3 Global Copy pairs.

The information that is specific to IBM DS8000 in the previous description
for the SuspendH2H3 command is also applicable to this command.
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Metro Global Mirror with Practice commands

Use this information to learn about commands available for Metro Global Mirror with Practice sessions.

Table 59. Metro Global Mirror with Practice commands

Command

Action

Enable Copy to Site 1

Run this command and confirm that you want to reverse the direction of
replication before you reverse the direction of copying in a failover and
failback session.

Enable Copy to Site 2

Run this command and confirm that you want to reverse the direction of
replication before you reverse the direction of copying in a failover and
failback session.

Flash

This command is available in the following states:
- Target Available state when the active host is H3

Note: Use this command if the FlashCopy portion of the Recover command
from I3 to H3, fails for any reason. The problem can be addressed; and a
Flash command can be issued to complete the flash of the consistent data
from I3 to H3.

- Prepared state when the active host is H1 and data is copying H1 to H2 to
I3, or the active host is H2 and data is copying H2 to H1 to H3.

« Prepared state when the active host is H2 and data is copying H2 to I3.
 Prepared state when the active host is H1 and data is copying H1 to I3.

Use this command if the FlashCopy portion of the Recover command from
I3 to H3, fails for any reason. The problem can be addressed; and a Flash
command can be issued to complete the flash of the consistent data from I3
to H3.

Issuing a Flash command on a Global Mirror Practice session for DS8000
temporarily pauses the formation of consistency groups. Ensure that all I3s
are consistent, and then flash the data from I3 to the H3 volumes. After the
flash is complete, the Global Mirror session will automatically restart, and
the session will begin forming consistency groups on I3. You can then use
the H3 volumes to practice your disaster recovery procedures.

Allow Practice Flash

Issued to allow a Flash operation again on a Practice session after it has
been suspended with the Prevent Reflash of Practice volume
after Flash or Recover option.

The Allow Practice Flash command appears in the Preparing or
Prepared states only if it is currently preventing the reflash. If the session

is Preparing, the Flash command does not display until the session gets to
the Prepared state.

See “Prevent a reflash when practicing disaster recovery” on page 225 for
more information on using this command.

HyperSwap

Causes a site switch, equivalent to a suspend and recover for a Metro Mirror
with failover and failback individual suspend and recover commands are not
available. This command is available only for Copy Services Manager.
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Table 59. Metro Global Mirror with Practice commands (continued)

Command

Action

RecoverH1

Specifying H1 makes the H1 volume TargetAvailable. When H1->H2->H3

is run, Metro Global Mirror can move production to either the H2 or H3

set of volumes. Copy Services Manager processing differs, depending on

the recovery site. Therefore the site designation is added to the Recover
command so Copy Services Manager can prepare for the failback. The
FlashCopy creates a consistent copy of the data on the H3 volumes so that
an application can recover to those volumes and begin writing I/0. When the
FlashCopy is complete, the session reaches a Target Available state, and you
can attach your volumes on Site 3.

RecoverH2

Specifying H2 makes the H2 volume TargetAvailable. When H1->H2->H3
is run, Metro Global Mirror can move production to either the H2 or H3
set of volumes. Copy Services Manager processing differs, depending on
the recovery site. Therefore the site designation is added to the Recover
command so Copy Services Manager can prepare for the failback.

RecoverH3

Specifying H3 makes the H3 volume the TargetAvailable. When H1->H2->H3
is run, Metro Global Mirror can move production to either the H2 or H3

set of volumes. Copy Services Manager processing differs, depending on

the recovery site; therefore, the site designation is added to the Recover
command so Copy Services Manager can prepare for the failback.

Re-enable Copy to Site 1

After you issue a RecoverH1 command, you can run this command to restart
the copy to the original the direction of replication in a failover and failback
session.

Re-enable Copy to Site 2

After you issue a RecoverH2 command, you can run this command to restart
the copy to the original the direction of replication in a failover and failback
session.

Re-enable Copy to Site 3

After you issue a RecoverH3 command, you can run this command to restart
the copy to the original the direction of replication in a failover and failback
session.

Refresh States

Refreshes the states of the role pairs that are in the session (if applicable
for the session type) and refreshes the state of the session if it is incorrect.
This command queries the states of the copy sets on the hardware. You
are not required to run this command under typical circumstances; Copy
Services Manager refreshes the states of its sessions through multiple
means. However, if you discover an inconsistency between Copy Services
Manager and the hardware, you can use this command to enable Copy
Services Manager to update itself.

This command triggers multiple queries on the hardware, which can impact
hardware performance. Do not run this command more frequently than
every few minutes in each session.

This command is not available if the session is in the Defined state.

Release I/O

Enables the source volume to receive data after a copy relationship is
suspended. This command is not displayed if the Release I/0 after
Suspend property is selected for the session.
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Table 59. Metro Global Mirror with Practice commands (continued)

Command

Action

Start H1->H2->H3

This command is the
Metro Global Mirror initial
start command.

This command creates Metro Mirror relationships between H1 and H2, and
Global Mirror relationships between H2 and H3. For Metro Global Mirror,
this relationship includes the J3 volume to complete the Global Mirror
configuration. (The J3 volume role is the journal volume at site 3.) The
Start H1->H2->H3 command can be used from some Metro Global Mirror
configurations to return to the starting H1>H2>H3 configuration.

This command is valid only when the session is in a defined, preparing,
prepared, target available, or suspended state.

Start H1->H3

From the H1->H2->H3 configuration, this command changes the session
configuration to a Global-Mirror-only session between H1 and H3, with H1
as the source. Use this command in case of an H2 failure with transition
bitmap support provided by incremental resynchronization. Because there
is not a source host change involved, it can be used when a session is in
preparing, prepared, and suspended states.

You can use this command to bypass the H2 volume in case of an H2

failure and copy only the changed tracks and tracks in flight from H1 to H3.
After the incremental resynchronization is completed, the session is running
Global Mirror from H1 to H3 and loses the near-zero data loss protection
that is achieved with Metro Mirror when H1->H2->H3 is run. However, data
consistency is still maintained at the remote site with the Global Mirror
solution.

From H2->H1->H3 configuration, this command changes the session
configuration to a Global-Mirror-only session configuration between H1 and
H3, with H1 as the source. Use this command when the source site has

a failure and production is moved to the H1 site. For example, for an
unplanned HyperSwap. The Global Mirror session is continued. This is a
host-volume change so this command is valid only when you restart the
H1->H3 configuration or from the TargetAvailable H2->H1->H3 state.

Start H2->H3

From the H1->H2->H3 configuration, this command moves the session
configuration to a configuration between H2 and H3, with H2 as the source.
Use this command when the source site has a failure and production is
moved to the H2 site. For example, for an unplanned HyperSwap. The
Global Mirror session is continued. This is a host-volume change so this
command is valid only when you restart the H1>H3 configuration or from the
TargetAvailable H2->H1->H3 state.

From the H2->H1->H3 configuration, this command changes the session
configuration to a configuration between H2 and H3 with H2 as the source.
Use this command in case of an H1 failure with transition bitmap support
provided by incremental resynchronization. Because there is not a source-
host change involved, this command can be used when the session is in
the preparing, prepared, and suspended states. The Start H2->H1->H3
command can be used to return to the starting H2->H1->H3 configuration.

Start H2->H1->H3

This command is the
Metro Global Mirror start
command.

This configuration completes the HyperSwap processing. This command

creates Metro Mirror relationships between H2 and H1 and Global Mirror
relationships between H1 and H3. For Metro Global Mirror, the J3 volume
completes the Global Mirror configuration.
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Table 59. Metro Global Mirror with Practice commands (continued)

Command

Action

Start H3->H1->H2

After a recovery to H3 is completed, this command sets up the hardware

to allow the application to begin writing to H3, and the data is copied

back to H1 and H2. However, issuing this command does not guarantee
consistency in the case of a disaster because only Global Copy relationships
are established to cover the long-distance copy back to site 1.

To move the application back to H1, you can issue a suspend while in this
state to drive all the relationships to a consistent state and then issue a
freeze to make the session consistent. You can then issue a Rcover followed
by a Start H1->H2->H3 to go back to the original configuration.

SuspendH2H3

Pauses the Global Mirror master session, which causes the session to stop
forming consistency groups, and suspends the H2 to H3 Global Copy pairs.

If you are using a System Storage DS8000: The Suspend command
invokes a pause command for IBM DS8000. The pause command that is
invoked depends on the IBM DS8000 microcode level.

If the following conditions are true, the Suspend command invokes a
command that is equivalent to the IBM DS8000 command pausegmix
-withsecondary:

« All primary volumes that are in the session are on a IBM DS8000 storage
system with a microcode level that includes the pause with secondary
consistency option. To determine whether this option is available for your
storage system, see the IBM DS8000 documentation for the microcode
level that you are using.

» The pause with secondary consistency option is enabled on the storage
system.

If these conditions are not true, the Suspend command invokes a command
that is equivalent to the IBM DS8000 command pausegmixr.

Both commands temporarily pause the formation of consistency groups
after the current consistency group is formed. However, the command for
a pause with secondary consistency creates a consistent data set on the
secondary volumes.

If you do not want to suspend the Global Copy

pairs when a Global Mirror session is suspended,

open the rmserver.propertiesfile inthe install
dir\liberty\wlp\usr\servers\csmServer\properties directory
on distributed systems, or the path_prefix/opt/IBM/CSM/wlp/usr/
servers/csmServer/properties directory on z/OS, and add the
following property:

csm.server.sus_gc_pairs_on_gm_pause = false

Tip: The pause with secondary consistency option requires that the Global
Copy pairs are suspended. If you do not want to use the pause with
secondary consistency option for storage systems on which the option is
enabled, set the csm.sexrver.sus_gc_pairs_on_gm_pause property to
false.
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Table 59. Metro Global Mirror with Practice commands (continued)

Command Action

SuspendH1H3 Pauses the Global Mirror master session, which causes the session to stop
forming consistency groups, and suspends the H1 to H3 Global Copy pairs.
The information that is specific to IBM DS8000 in the previous description
for the SuspendH2H3 command is also applicable to this command.

Terminate This command terminates all copy relationships on the hardware.

TerminateH313

Removes the FlashCopy relationships after a Flash command is issued.
When you use Extent Space Efficient (ESE) volumes for your practice
volumes (H3), it is recommended to set the No Copy option on the H313 role
pair. When No Copy is set, data will only be physically written to H3 when a
track is updated on I3. If the practice copy of the data is no longer needed,
this command can be run to remove the FlashCopy relationship from I3 to
H3, to prevent the relationship from consuming backend space.

Notes:

« If the command is issued, H3 will no longer hold a consistent logical copy
of the data until the next Flash or Recover is issued.

» This command is only available for DS8000 practice sessions while in the
Preparing, Prepared, or Suspended states. This command is not available
while in the Defined or Target Available states.

Metro Mirror - Metro Mirror commands

Use this information to learn about commands available for Metro Mirror - Metro Mirror sessions.

Table 60. Metro Mirror - Metro Mirror commands

Command

Action

Confirm Production at
Site 1

Confirms that you want to establish site 1 as the production site after you
issue suspend and recover commands for the session.

Confirm Production at
Site 2

Confirms that you want to establish site 2 as the production site after you
issue suspend and recover commands for the session.

Confirm Production at
Site 3

Confirms that you want to establish site 3 as the production site after you
issue suspend and recover commands for the session.

FailoverH1

Completes a failover operation to the H1 target site. This command enables
read and write access to the target volumes. At the same time, it maintains
a recording of changes to the volumes that prevents a full copy when the
relationship is restarted. You can use this command to practice your disaster
recovery capabilities without initiating a site switch. To switch sites, the
RecoverH1 command is required.

FailoverH2

Completes a failover operation to the H2 target site. This command enables
read and write access to the target volumes. At the same time, it maintains

a recording of changes to the volumes that prevents a full copy when the
relationship is restarted. You can use this command to practice your disaster
recovery capabilities without initiating a site switch. To switch sites, the
RecoverH2 command is required.
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Table 60. Metro Mirror - Metro Mirror commands (continued)

Command

Action

FailoverH3

Completes a failover operation to the H3 target site. This command enables
read and write access to the target volumes. At the same time, it maintains

a recording of changes to the volumes that prevents a full copy when the
relationship is restarted. You can use this command to practice your disaster
recovery capabilities without initiating a site switch. To switch sites, the
RecoverH3 command is required.

HyperSwap H1

Triggers a HyperSwap operation where I/0 is redirected from the source
volume to the target volume H1, without affecting the application that is
using those volumes.

HyperSwap H2

Triggers a HyperSwap operation where I/0 is redirected from the source
volume to the target volume H2, without affecting the application that is
using those volumes.

HyperSwap H3

Triggers a HyperSwap operation where I/0 is redirected from the source
volume to the target volume H3, without affecting the application that is
using those volumes.

RecoverH1

Recovers the session to the H1 target site. This command makes the target
host volumes consistent and available for access as the new production site.
Upon completion of this command, the session becomes Target Available.

RecoverH2

Recovers the session to the H2 target site. This command makes the target
host volumes consistent and available for access as the new production site.
Upon completion of this command, the session becomes Target Available.

RecoverH3

Recovers the session to the H3 target site. This command makes the target
host volumes consistent and available for access as the new production site.
Upon completion of this command, the session becomes Target Available.

Re-enable Original
Direction

Sets the production site back to the original site and reenables the start
commands in the original direction. You can use this command after you
issue the suspend, recover, and confirm commands.

Refresh States

Refreshes the states of the role pairs that are in the session (if applicable
for the session type) and refreshes the state of the session if it is incorrect.
This command queries the states of the copy sets on the hardware. You
are not required to run this command under typical circumstances; Copy
Services Manager refreshes the states of its sessions through multiple
means. However, if you discover an inconsistency between Copy Services
Manager and the hardware, you can use this command to enable Copy
Services Manager to update itself.

This command triggers multiple queries on the hardware, which can impact
hardware performance. Do not run this command more frequently than
every few minutes in each session.

This command is not available if the session is in the Defined state.

Release I/0

Enables the source volume to receive data after a copy relationship is
suspended. This command is not displayed if the Release I/0 after
Suspend property is selected for the session.

Set Production to Site 1

Establishes Site 1 as the production site while the session is in the Defined
state. After you issue this command, the Start H1->H2 and Start H1->H3
commands become available.
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Table 60. Metro Mirror - Metro Mirror commands (continued)

Command

Action

Set Production to Site 2

Establishes Site 2 as the production site while the session is in the Defined
state. After you issue this command, the Start H2->H1 and Start H2->H3
commands become available.

Set Production to Site 3

Establishes Site 3 as the production site while the session is in the Defined
state. After you issue this command, the Start H3->H1 and Start H3->H2
commands become available.

Start

Establishes Metro Mirror relationships between the volumes on the
production site and the volumes at the other sites in the session, and begins
data replication to those sites. For example, if Site 1 is the production site,
data replication occurs between the H1 and H2 volumes and the H1 and H3
volumes at the same time.

Start H1->H2

Establishes Metro Mirror relationships between the H1 volumes and the H2
volumes, and begins data replication from H1 to H2.

Start H1->H3

Establishes Metro Mirror relationships between the H1 volumes and the H3
volumes, and begins data replication from H1 to H3.

Start H2->H1

Establishes Metro Mirror relationships between the H2 volumes and the H1
volumes and starts data replication from H2 to H1.

Start H2->H3

Establishes Metro Mirror relationships between the H2 volumes and the H3
volumes and starts data replication from H2 to H3.

Start H3->H1

Establishes Metro Mirror relationships between the H3 volumes and the H1
volumes and starts data replication from H3 to H1.

Start H3->H2

Establishes Metro Mirror relationships between the H3 volumes and the H2
volumes and starts data replication from H3 to H2.

StartGC

Establishes Global Copy relationships between the volumes on the
production site and the volumes at the other sites in the session, and begins
asynchronous data replication to those sites. For example, if Site 1 is the
production site, data replication occurs between the H1 and H2 volumes
and the H1 and H3 volumes at the same time.

The session remains in the Preparing state until you issue a Start, Suspend,
or Terminate command.

StartGC H1->H2

Establishes Global Copy relationships between the H1 volumes and the H2
volumes, and begins asynchronous data replication from H1 to H2.

The session remains in the Preparing state until you issue a Start, Suspend,
or Terminate command.

StartGC H1->H3

Establishes Global Copy relationships between the H1 volumes and the H3
volumes, and begins asynchronous data replication from H1 to H3.

The session remains in the Preparing state until you issue a Start, Suspend,
or Terminate command.

StartGC H2->H1

Establishes Global Copy relationships between the H2 volumes and the H1
volumes, and begins asynchronous data replication from H2 to H1.

The session remains in the Preparing state until you issue a Start, Suspend,
or Terminate command.
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Table 60. Metro Mirror - Metro Mirror commands (continued)

Command

Action

StartGC H2->H3

Establishes Global Copy relationships between the H2 volumes and the H3
volumes, and begins asynchronous data replication from H2 to H3.

The session remains in the Preparing state until you issue a Start, Suspend,
or Terminate command.

StartGC H3->H1

Establishes Global Copy relationships between the H3 volumes and the H1
volumes, and begins asynchronous data replication from H3 to H1.

The session remains in the Preparing state until you issue a Start, Suspend,
or Terminate command.

StartGC H3->H2

Establishes Global Copy relationships between the H3 volumes and the H2
volumes, and begins asynchronous data replication from H3 to H2.

The session remains in the Preparing state until you issue a Start, Suspend,
or Terminate command.

Stop Stops updates to all the target volumes of the pairs in a session.
The following information applies to this command and the following Stop
commands:

» Targets are not consistent after the stop.
» You can issue the command at any point during an active session.

StopH1H2 Stops updates from H1 to H2 volumes in a session.

StopH1H3 Stops updates from H1 to H3 volumes in a session.

StopH2H1 Stops updates from H2 to H1 volumes in a session.

StopH2H3 Stops updates from H2 to H3 volumes in a session.

StopH3H1 Stops updates from H3 to H1 volumes in a session.

StopH3H2 Stops updates from H3 to H2 volumes in a session.

Suspend Suspends updates to all the target volumes of the pairs in a session.

The following information applies to this command and the following
Suspend commands:

» You can issue the command at any point during an active session.

« Avoid use of the same LSS pairs for multiple Metro Mirror sessions. Metro
Mirror uses a freeze command on DS8000 storage systems to create the
data-consistent point. If other Metro Mirror sessions overlap the same LSS
pairs as in this session, those sessions are also suspended.

» When a Suspend command is issued to a source volume in an LSS that has
source volumes in another active Metro Mirror session, the other source
volumes are affected only if they have the same target LSS. The primary
volumes are suspended, but volumes in the same source LSS that have
target volumes in a different LSS are not affected because they use a
different PPRC path connection.
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Table 60. Metro Mirror - Metro Mirror commands (continued)

Command Action

SuspendH1H2 Suspends updates from H1 to H2 volumes in a session.

SuspendH1H3 Suspends updates from H1 to H3 volumes in a session.

SuspendH2H1 Suspends updates from H2 to H1 volumes in a session.

SuspendH2H3 Suspends updates from H2 to H3 volumes in a session.

SuspendH3H1 Suspends updates from H3 to H1 volumes in a session.

SuspendH3H2 Suspends updates from H3 to H2 volumes in a session.

Terminate Removes all copy relationships from the hardware during an active session.

If you want the targets to be data consistent before you remove their
relationship, issue the following commands before you issue the Terminate
command:

» Suspend
* RecoverHx

Where x is the site to which you want to recover.

TerminateH1H2 Removes all H1>H2 or H2>H1 relationships from the hardware during an
active session. If you want the target to be data consistent before you
remove their relationship, issue the following commands before you issue
the Terminate command:

» SuspendH1H2
* Recoverx

Where x is the site to which you want to recover.

TerminateH1H3 Removes all H1>H3 or H3>H1 relationships from the hardware during an
active session. If you want the target to be data consistent before you
remove their relationship, issue the following commands before you issue
the Terminate command:

» SuspendH1H3
* Recoverx

Where x is the site to which you want to recover.

TerminateH2H3 Removes all H2>H3 or H3>H2 relationships from the hardware during an
active session.

» SuspendH2H3
* Recoverx

Where x is the site to which you want to recover.
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Metro Mirror - Global Mirror commands

Use this information to learn about commands available for Metro Mirror - Global Mirror sessions.

Table 61. Metro Mirror - Global Mirror commands

Command

Action

Confirm Production at Site
1

Confirms that you want to establish site 1 as the production site after you
issue suspend and recover commands for the session.

Confirm Production at Site
2

Confirms that you want to establish site 2 as the production site after you
issue suspend and recover commands for the session.

Confirm Production at Site
3

Confirms that you want to establish site 3 as the production site after you
issue suspend and recover commands for the session.

FailoverH1

Completes a failover operation to the H1 target site. This command
enables read and write access to the target volumes. At the same time,
a recording of changes to the volumes that prevents a full copy when
the relationship is restarted. You can use this command to practice your
disaster recovery capabilities without initiating a site switch. To switch
sites, the RecoverH1 command is required.

FailoverH2

Completes a failover operation to the H2 target site. This command
enables read and write access to the target volumes. At the same time,
a recording of changes to the volumes that prevents a full copy when
the relationship is restarted. You can use this command to practice your
disaster recovery capabilities without initiating a site switch. To switch
sites, the RecoverH2 command is required.

FailoverH3

Completes a failover operation to the H3 target site. This command
enables read and write access to the target volumes. At the same time,
a recording of changes to the volumes that prevents a full copy when
the relationship is restarted. You can use this command to practice your
disaster recovery capabilities without initiating a site switch. To switch
sites, the RecoverH3 command is required.

HyperSwap H1

Triggers a HyperSwap operation where I/O is redirected from the source
volume to the target volume H1, without affecting the application that is
using those volumes.

HyperSwap H2

Triggers a HyperSwap operation where I/0 is redirected from the source
volume to the target volume H2, without affecting the application that is
using those volumes.

RecoverH1

Recovers the session to the H1 target site. This command makes the
target host volumes consistent and available for access as the new
production site. Upon completion of this command, the session becomes
Target Available.

RecoverH2

Recovers the session to the H2 target site. This command makes the
target host volumes consistent and available for access as the new
production site. Upon completion of this command, the session becomes
Target Available.

RecoverH3

Recovers the session to the H3 target site. This command makes the
target host volumes consistent and available for access as the new
production site. Upon completion of this command, the session becomes
Target Available.
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Table 61. Metro Mirror - Global Mirror commands (continued)

Command

Action

Re-enable Original
Direction

Sets the production site back to the original site and reenables the start
commands in the original direction. You can use this command after you
issue the confirm commands.

Refresh States

Refreshes the states of the role pairs that are in the session (if applicable
for the session type) and refreshes the state of the session if it is
incorrect. This command queries the states of the copy sets on the
hardware. You are not required to run this command under typical
circumstances; Copy Services Manager refreshes the states of its sessions
through multiple means. However, if you discover an inconsistency
between Copy Services Manager and the hardware, you can use this
command to enable Copy Services Manager to update itself.

This command triggers multiple queries on the hardware, which can
impact hardware performance. Do not run this command more frequently
than every few minutes in each session.

This command is not available if the session is in the Defined state.

Release I/0 Enables the source volume to receive data after a copy relationship is
suspended. This command is not displayed if the Release I/0 after
Suspend property is selected for the session.

ResumeGM Resumes the Global Mirror master session on the hardware allowing the

hardware to restart all relationships and consistency group formation. The
command does not do any of the additional checks such as establishing
for logical paths, etc. that are run by issuing the Start command.

This command is only recommended to be used when the session is
suspended for a short amount of time, such as when creating a FlashCopy
or Safeguarded Copy backup at the remote site.

Note: The command does not work for sessions that are suspended and
share the same consistency group on the hardware. When sessions share
a consistency group, the Suspend command removes the volumes of

the suspended session out of the hardware session in order to allow
other sessions to continue to form consistency groups. So the ResumeGM
command will not cause the pairs in the suspended session to be
restarted, you must run the Start command for the same.

Set Production to Site 1

Establishes Site 1 as the production site while the session is in the
Defined state. After you issue this command, the Site 1 Start commands
become available.

Set Production to Site 2

Establishes Site 2 as the production site while the session is in the
Defined state. After you issue this command, the Site 2 Start commands
become available.

Set Production to Site 3

Establishes Site 3 as the production site while the session is in the
Defined state. After you issue this command, the StartGC H3->H1->H2
and StartGC H3->H2->H1 commands become available.

Start H1->H2, H1->H3

Establishes Metro Mirror relationships between H1 and H2 volumes,

and Global Mirror relationships between H1 and H3, and starts forming
consistency groups. This relationship includes the 33 volume to complete
the Global Mirror configuration.
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Table 61. Metro Mirror - Global Mirror commands (continued)

Command

Action

Start H1->H2->H3

Establishes Metro Mirror relationships between H1 and H2, and Global
Mirror relationships between H2 and H3. The Start H1->H2->H3
command can be used to transition from a multi-target configuration to
a cascaded configuration. You can only transition from multi-target to
cascaded if the Global Mirror leg is suspended.

Start H1->H2

Establishes Metro Mirror relationships between the H1 volumes and the
H2 volumes, and begins data replication from H1 to H2.

Start GM H1->H3

Establishes a Global Mirror relationship between H1 and H3, and starts
forming consistency groups. The relationship includes the 33 volume to
complete the Global Mirror configuration.

Start H2->H1, H2->H3

Establishes Metro Mirror relationships between H2 and H1 volumes,

and Global Mirror relationships between H2 and H3, and starts forming
consistency groups. This relationship includes the 33 volume to complete
the Global Mirror configuration.

Start H2->H1

Establishes Metro Mirror relationships between the H2 volumes and the
H1 volumes and starts data replication from H2 to H1.

Start GM H2->H3

Establishes a Global Mirror relationship between H2 and H3, and starts
forming consistency groups. The relationship includes the J3 volume to
complete the Global Mirror configuration.

StartGC H1->H2, H1->H3

Establishes Global Copy relationships between the H1 and H2 volumes
and between H1 and H3 volumes, and begins asynchronous data
replication from H1 to H2 and H1 to H3.

The session remains in the Preparing state until you issue a Start,
Suspend, Stop, or Terminate command.

StartGC H1->H2

Establishes Global Copy relationships between the H1 volumes and the
H2 volumes, and begins asynchronous data replication from H1 to H2.

The session remains in the Preparing state until you issue a Start,
Suspend, or Terminate command.

StartGC H1->H3

Establishes Global Copy relationships between the H1 volumes and the
H3 volumes, and begins asynchronous data replication from H1 to H3.

The session remains in the Preparing state until you issue a Start,
Suspend, or Terminate command.

StartGC H2->H1, H2->H3

Establishes Global Copy relationships between the H2 and H1 volumes
and between H2 and H3 volumes, and begins asynchronous data
replication from H2 to H1 and H2 to H3.

The session remains in the Preparing state until you issue a Start,
Suspend, Stop, or Terminate command.

StartGC H2->H1

Establishes Global Copy relationships between the H2 volumes and the
H1 volumes, and begins asynchronous data replication from H2 to H1.

The session remains in the Preparing state until you issue a Start,
Suspend, Stop, or Terminate command.
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Table 61. Metro Mirror - Global Mirror commands (continued)

Command Action

StartGC H2->H3 Establishes Global Copy relationships between the H2 volumes and the
H3 volumes, and begins asynchronous data replication from H2 to H3.

The session remains in the Preparing state until you issue a Start,
Suspend, Stop, or Terminate command.

StartGC H3->H1->H2 Establishes Global Copy relationships between the H3 volumes, and the
H1 volumes, and H2 volumes, and begins asynchronous data replication
from H3 to H1 and H2.

The session remains in the Preparing state until you issue a Suspend,
Stop, or Terminate command.

StartGC H3->H2->H1 Establishes Global Copy relationships between the H3 volumes, and
the H2 volumes, and the H1 volumes, and begins asynchronous data
replication from H3 to H2 and H1.

The session remains in the Preparing state until you issue a Suspend,
Stop, or Terminate command.

Stop Stops updates to all the target volumes of the pairs in a session.

Targets are not consistent after the stop.

StopH1H2 Stops updates from H1 to H2 volumes in a session.
StopH1H3 Stops updates from H1 to H3 volumes in a session.
StopH2H1 Stops updates from H2 to H1 volumes in a session.
StopH2H3 Stops updates from H2 to H3 volumes in a session.
Suspend Suspends updates to all the target volumes of the pairs in a session.

The following information applies to this command and the following
Suspend commands:

 You can issue the command at any point during an active session.

 Avoid use of the same LSS pairs for multiple Metro Mirror sessions.
Metro Mirror uses a freeze command on DS8000 storage systems
to create the data-consistent point. If other Metro Mirror sessions
overlap the same LSS pairs as in this session, those sessions are also
suspended.

« When a Suspend command is issued to a source volume in an LSS that
has source volumes in another active Metro Mirror session, the other
source volumes are affected only if they have the same target LSS. The
primary volumes are suspended, but volumes in the same source LSS
that have target volumes in a different LSS are not affected because
they use a different PPRC path connection.

Suspend When Drained Suspends the session after all I/O drains to the tertiary site and marks all
volumes at all sites as consistent. All I/O must be quiesced before you
issue this command.

SuspendH1H2 Suspends updates from H1 to H2 volumes in a session.
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Table 61. Metro Mirror - Global Mirror commands (continued)

Command Action

SuspendH1H3 Suspends updates from H1 to H3 volumes in a session.
SuspendH2H1 Suspends updates from H2 to H1 volumes in a session.
SuspendH2H3 Suspends updates from H2 to H3 volumes in a session.
Terminate

Removes all copy relationships from the hardware during an active
session. If you want the targets to be data consistent before you remove
their relationship, issue the following commands before you issue the
Terminate command:

« Suspend
» RecoverHx

Where x is the site to which you want to recover.

TerminateH1H2

Removes all H1>H2 or H2>H1 relationships from the hardware during an
active session. If you want the target to be data consistent before you
remove their relationship, issue the following commands before you issue
the Terminate command:

» SuspendH1H2
« Recoverx

Where x is the site to which you want to recover.

TerminateH1H3

Removes all H1>H3 or H3>H1 relationships from the hardware during an
active session. If you want the target to be data consistent before you
remove their relationship, issue the following commands before you issue
the Terminate command:

« SuspendH1H3
- Recoverx

Where x is the site to which you want to recover.

TerminateH2H3

Removes all H2>H3 or H3>H2 relationships from the hardware during an
active session.

« SuspendH2H3
* Recoverx

Where x is the site to which you want to recover.

Metro Mirror - Global Mirror with Practice commands

Use this information to learn about commands available for Metro Mirror - Global Mirror with Practice

sessions.

Table 62. Metro Mirror - Global Mirror with Practice commands

Command

Action

Confirm Production at Site
1

Confirms that you want to establish site 1 as the production site after you
issue suspend and recover commands for the session.
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Table 62. Metro Mirror - Global Mirror with Practice commands (continued)

Command

Action

Confirm Production at Site
2

Confirms that you want to establish site 2 as the production site after you
issue suspend and recover commands for the session.

Confirm Production at Site
3

Confirms that you want to establish site 3 as the production site after you
issue suspend and recover commands for the session.

FailoverH1

Completes a failover operation to the H1 target site. This command
enables read and write access to the target volumes. At the same time,
a recording of changes to the volumes that prevents a full copy when
the relationship is restarted. You can use this command to practice your
disaster recovery capabilities without initiating a site switch. To switch
sites, the RecoverH1 command is required.

FailoverH2

Completes a failover operation to the H2 target site. This command
enables read and write access to the target volumes. At the same time,
a recording of changes to the volumes that prevents a full copy when
the relationship is restarted. You can use this command to practice your
disaster recovery capabilities without initiating a site switch. To switch
sites, the RecoverH2 command is required.

FailoverH3

Completes a failover operation to the H3 target site. This command
enables read and write access to the target volumes. At the same time,
a recording of changes to the volumes that prevents a full copy when
the relationship is restarted. You can use this command to practice your
disaster recovery capabilities without initiating a site switch. To switch
sites, the RecoverH3 command is required.

HyperSwap H1

Triggers a HyperSwap operation where I/O is redirected from the source
volume to the target volume H1, without affecting the application that is
using those volumes.

HyperSwap H2

Triggers a HyperSwap operation where I/0 is redirected from the source
volume to the target volume H2, without affecting the application that is
using those volumes.

RecoverH1

Recovers the session to the H1 target site. This command makes the
target host volumes consistent and available for access as the new
production site. Upon completion of this command, the session becomes
Target Available.

RecoverH2

Recovers the session to the H2 target site. This command makes the
target host volumes consistent and available for access as the new
production site. Upon completion of this command, the session becomes
Target Available.

RecoverH3

Recovers the session to the H3 target site. This command makes the
target host volumes consistent and available for access as the new
production site. Upon completion of this command, the session becomes
Target Available.
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Table 62. Metro Mirror - Global Mirror with Practice commands (continued)

Command

Action

Flash

This command is available in the following states:

 Prepared state when the active host is H1 and data is copying H1 to I3
 Prepared state when the active host is H2 and data is copying H2 to I3

If you issue a Flash command on a Global Mirror with Practice session

for DS8000°, it temporarily pauses the formation of consistency groups.
Ensure that all I3s are consistent, and then flash the data from I3 to

the H3 volumes. After the flash is complete, the Global Mirror session
automatically restarts, and the session begins forming consistency groups
on I3. You can then use the H3 volumes to practice your disaster recovery
procedures.

Allow Practice Flash

Issued to allow a Flash operation again on a Practice session after it has
been suspended with the Prevent Reflash of Practice volume
after Flash or Recover option.

The Allow Practice Flash command appears in the Preparing or
Prepared states only if it is currently preventing the reflash. If the session
is Preparing, the Flash command does not display until the session gets
to the Prepared state.

See “Prevent a reflash when practicing disaster recovery” on page 225 for
more information on using this command.

Re-enable Original
Direction

Sets the production site back to the original site and reenables the start
commands in the original direction. You can use this command after you
issue the confirm commands.

Refresh States

Refreshes the states of the role pairs that are in the session (if applicable
for the session type) and refreshes the state of the session if it is
incorrect. This command queries the states of the copy sets on the
hardware. You are not required to run this command under typical
circumstances; Copy Services Manager refreshes the states of its sessions
through multiple means. However, if you discover an inconsistency
between Copy Services Manager and the hardware, you can use this
command to enable Copy Services Manager to update itself.

This command triggers multiple queries on the hardware, which can
impact hardware performance. Do not run this command more frequently
than every few minutes in each session.

This command is not available if the session is in the Defined state.

Release I/O

Enables the source volume to receive data after a copy relationship is
suspended. This command is not displayed if the Release I/0 after
Suspend property is selected for the session.
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Table 62. Metro Mirror - Global Mirror with Practice commands (continued)

Command

Action

ResumeGM

Resumes the Global Mirror master session on the hardware allowing the
hardware to restart all relationships and consistency group formation. The
command does not do any of the additional checks such as establishing
for logical paths, etc. that are run by issuing the Start command.

This command is only recommended to be used when the session is
suspended for a short amount of time, such as when creating a FlashCopy
or Safeguarded Copy backup at the remote site.

Note: The command does not work for sessions that are suspended and
share the same consistency group on the hardware. When sessions share
a consistency group, the Suspend command removes the volumes of

the suspended session out of the hardware session in order to allow
other sessions to continue to form consistency groups. So the ResumeGM
command will not cause the pairs in the suspended session to be
restarted, you must run the Start command for the same.

Set Production to Site 1

Establishes Site 1 as the production site while the session is in the
Defined state. After you issue this command, the Site 1 Start commands
become available.

Set Production to Site 2

Establishes Site 2 as the production site while the session is in the
Defined state. After you issue this command, the Site 2 Start commands
become available.

Set Production to Site 3

Establishes Site 3 as the production site while the session is in the
Defined state. After you issue this command, the StartGC H3->H1->H2
and StartGC H3->H2->H1 commands become available.

Start H1->H2, H1->H3

Establishes Metro Mirror relationships between H1 and H2 volumes,

and Global Mirror relationships between H1 and H3, and starts forming
consistency groups. This relationship includes the 33 volume to complete
the Global Mirror configuration.

Start H1->H2->H3

Establishes Metro Mirror relationships between H1 and H2, and Global
Mirror relationships between H2 and H3. The Start H1->H2->H3
command can be used to transition from a multi-target configuration to
a cascaded configuration. You can only transition from multi-target to
cascaded if the Global Mirror leg is suspended.

Start H1->H2

Establishes Metro Mirror relationships between the H1 volumes and the
H2 volumes, and begins data replication from H1 to H2.

Start GM H1->H3

Establishes a Global Mirror relationship between H1 and H3, and starts
forming consistency groups. The relationship includes the 33 volume to
complete the Global Mirror configuration.

Start H2->H1, H2->H3

Establishes Metro Mirror relationships between H2 and H1 volumes,

and Global Mirror relationships between H2 and H3, and starts forming
consistency groups. This relationship includes the J3 volume to complete
the Global Mirror configuration.

Start H2->H1

Establishes Metro Mirror relationships between the H2 volumes and the
H1 volumes and starts data replication from H2 to H1.

Start GM H2->H3

Establishes a Global Mirror relationship between H2 and H3, and starts
forming consistency groups. The relationship includes the 33 volume to
complete the Global Mirror configuration.
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Table 62. Metro Mirror - Global Mirror with Practice commands (continued)

Command

Action

StartGC H1->H2, H1->H3

Establishes Global Copy relationships between the H1 and H2 volumes
and between H1 and H3 volumes, and begins asynchronous data
replication from H1 to H2 and H1 to H3.

The session remains in the Preparing state until you issue a Start,
Suspend, Stop, or Terminate command.

StartGC H1->H2

Establishes Global Copy relationships between the H1 volumes and the
H2 volumes, and begins asynchronous data replication from H1 to H2.

The session remains in the Preparing state until you issue a Start,
Suspend, or Terminate command.

StartGC H1->H3

Establishes Global Copy relationships between the H1 volumes and the
H3 volumes, and begins asynchronous data replication from H1 to H3.

The session remains in the Preparing state until you issue a Start,
Suspend, or Terminate command.

StartGC H2->H1, H2->H3

Establishes Global Copy relationships between the H2 and H1 volumes
and between H2 and H3 volumes, and begins asynchronous data
replication from H2 to H1 and H2 to H3.

The session remains in the Preparing state until you issue a Start,
Suspend, Stop, or Terminate command.

StartGC H2->H1

Establishes Global Copy relationships between the H2 volumes and the
H1 volumes, and begins asynchronous data replication from H2 to H1.

The session remains in the Preparing state until you issue a Start,
Suspend, Stop, or Terminate command.

StartGC H2->H3

Establishes Global Copy relationships between the H2 volumes and the
H3 volumes, and begins asynchronous data replication from H2 to H3.

The session remains in the Preparing state until you issue a Start,
Suspend, Stop, or Terminate command.

StartGC H3->H1->H2

Establishes Global Copy relationships between the H3 volumes, and the
H1 volumes, and H2 volumes, and begins asynchronous data replication
from H3 to H1 and H2.

The session remains in the Preparing state until you issue a Suspend,
Stop, or Terminate command.

StartGC H3->H2->H1

Establishes Global Copy relationships between the H3 volumes, and
the H2 volumes, and the H1 volumes, and begins asynchronous data
replication from H3 to H2 and H1.

The session remains in the Preparing state until you issue a Suspend,
Stop, or Terminate command.

Stop Stops updates to all the target volumes of the pairs in a session.
Targets are not consistent after the stop.
StopH1H2 Stops updates from H1 to H2 volumes in a session.
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Table 62. Metro Mirror - Global Mirror with Practice commands (continued)

Command Action

StopH1H3 Stops updates from H1 to H3 volumes in a session.

StopH2H1 Stops updates from H2 to H1 volumes in a session.

StopH2H3 Stops updates from H2 to H3 volumes in a session.

Suspend Suspends updates to all the target volumes of the pairs in a session.

The following information applies to this command and the following
Suspend commands:

« You can issue the command at any point during an active session.

« Avoid the use of the same LSS pairs for multiple Metro Mirror sessions.
Metro Mirror uses a freeze command on DS8000 storage systems
to create the data-consistent point. If other Metro Mirror sessions
overlap the same LSS pairs as in this session, those sessions are also
suspended.

« When a Suspend command is issued to a source volume in an LSS that
has source volumes in another active Metro Mirror session, the other
source volumes are affected only if they have the same target LSS. The
primary volumes are suspended, but volumes in the same source LSS
that have target volumes in a different LSS are not affected because
they use a different PPRC path connection.

Suspend When Drained Suspends the session after all I/O drains to the tertiary site and marks all
volumes at all sites as consistent. All I/O must be quiesced before you
issue this command.

SuspendH1H2 Suspends updates from H1 to H2 volumes in a session.
SuspendH1H3 Suspends updates from H1 to H3 volumes in a session.
SuspendH2H1 Suspends updates from H2 to H1 volumes in a session.
SuspendH2H3 Suspends updates from H2 to H3 volumes in a session.
Terminate Removes all copy relationships from the hardware during an active

session. If you want the targets to be data consistent before you remove
their relationship, issue the following commands before you issue the
Terminate command:

« Suspend
» RecoverHx

Where x is the site to which you want to recover.

TerminateH1H2 Removes all H1>H2 or H2>H1 relationships from the hardware during an
active session. If you want the target to be data consistent before you
remove their relationship, issue the following commands before you issue
the Terminate command:

» SuspendH1H2
» Recoverx

Where x is the site to which you want to recover.
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Table 62. Metro Mirror - Global Mirror with Practice commands (continued)

Command Action

TerminateH1H3 Removes all H1>H3 or H3>H1 relationships from the hardware during an
active session. If you want the target to be data consistent before you
remove their relationship, issue the following commands before you issue
the Terminate command:

« SuspendH1H3
* Recoverx

Where x is the site to which you want to recover.

TerminateH2H3 Removes all H2>H3 or H3>H2 relationships from the hardware during an
active session.

» SuspendH2H3
* Recoverx

Where x is the site to which you want to recover.

TerminateH3I3 Removes the FlashCopy relationships after a Flash command is issued.
When you use Extent Space Efficient (ESE) volumes for your practice
volumes (H3), it is recommended to set the No Copy option on the H313
role pair. When No Copy is set, data will only be physically written to H3
when a track is updated on I3. If the practice copy of the data is no longer
needed, this command can be run to remove the FlashCopy relationship
from I3 to H3, to prevent the relationship from consuming backend space.

Notes:

« If the command is issued, H3 will no longer hold a consistent logical
copy of the data until the next Flash or Recover is issued.

« This command is only available for DS8000 practice sessions while in
the Preparing, Prepared, or Suspended states. This command is not
available while in the Defined or Target Available states.

Example: Set the production site and starting a Metro Mirror copy to both targets

In this example, the production site is site 1 and H1>H2 and H1>H3 are in the Defined state. To change to
the production site to site 3 and start a Metro Mirror copy to both H1 and H2, issue the commands in the
order that is presented:

1. Set Production to Site 3
2. Start

Example: Set the production site and starting a Global Copy to both targets

In this example, the production site is site 1 and H1>H2 and H1>H3 are in the Defined state. To change to
the production site to site 3 and start a Global Copy to both H1 and H2, issue the commands in the order
that is presented:

1. Set Production to Site 3
2. Start GC
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Example: Set the production site and starting a Metro Mirror copy to a single target

In this example, the production site is site 1 and H1>H2 and H1>H3 are in the Defined state. To change
to the production site to site 3 and start a Metro Mirror copy only to H2, issue the commands in the order
that is presented:

1. Set Production to Site 3
2. Start H3->H2

Example: Set the production site and starting Metro Mirror copy to one target and a Global Copy to
the second target

In this example, the production site is site 1 and H1>H2 and H1>H3 are in the Defined state. To change
the production site to site 3 and start a Metro Mirror copy to H2 and a Global Copy to H1, issue the
commands in the following order:

1. Set Production to Site 3
2. Start H3->H2
3. Start GC H3->H1

Example: Change the production site after you recover to the site

In this example, the production site is site 1 and H1>H2 and H1>H3 are active. To recover to site 2 and
confirm the production site as site 2, issue the following commands:

1. Suspend
2. RecoverH2
3. Confirm Production at Site 2

Example: Reenable the original production site

In this example, the production site is site 2 and H2>H1 and H2>H3 are active after issuing the
commands in the preceding example. To re-enable H1 as the production site, issue the Re-enable
Original Direction command.

Example: Complete a failover to a single target for practice

In this example, the production site is site 1 and H1>H2 and H1>H3 are active. To fail over to site 3, issue
the following commands in the order that is presented:

1. SuspendH1H3
2. FailoverH3

If the production site is site 2 and H2>H1 and H2>H3 are active, issue the following commands to fail
over to site 3:

1. SuspendH2H3
2. FailoverH3

Example: Suspend the copy of data to both target sites

In this example, the production site is site 1 and H1>H2 and H1>H3 are active. To suspend the copy of
data to both target sites, issue the Suspend command.

Example: Suspend the copy of data to a single target site

In this example, the production site is site 1 and H1>H2 and H1>H3 are active. To suspend the copy of
data only from H1 to H3, issue the SuspendH1H3 command.
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Example: Stop the copy of data to both target sites

In this example, the production site is site 1 and H1>H2 and H1>H3 are active. To stop the copy of data to
both target sites, issue the Stop command.

Example: Stop the copy of data to a single target site

In this example, the production site is site 1 and H1>H2 and H1>H3 are active. To stop the copy of data
only from H1 to H3, issue the StopH1H3 command.

Metro Mirror - Global Mirror with Site 3 Global Mirror commands

Use this information to learn about commands available for Metro Mirror - Global Mirror with Site 3 Global

Mirror sessions.

Table 63. Metro Mirror - Global Mirror with Site 3 Global Mirror commands

Command

Action

Confirm Production at Site
1

Confirms that you want to establish site 1 as the production site after you
issue suspend and recover commands for the session.

Confirm Production at Site
2

Confirms that you want to establish site 2 as the production site after you
issue suspend and recover commands for the session.

Confirm Production at Site
3

Confirms that you want to establish site 3 as the production site after you
issue suspend and recover commands for the session.

FailoverH1

Completes a failover operation to the H1 target site. This command
enables read and write access to the target volumes. At the same time,
a recording of changes to the volumes that prevents a full copy when
the relationship is restarted. You can use this command to practice your
disaster recovery capabilities without initiating a site switch. To switch
sites, the RecoverH1 command is required.

FailoverH2

Completes a failover operation to the H2 target site. This command
enables read and write access to the target volumes. At the same time,
a recording of changes to the volumes that prevents a full copy when
the relationship is restarted. You can use this command to practice your
disaster recovery capabilities without initiating a site switch. To switch
sites, the RecoverH2 command is required.

FailoverH3

Completes a failover operation to the H3 target site. This command
enables read and write access to the target volumes. At the same time,
a recording of changes to the volumes that prevents a full copy when
the relationship is restarted. You can use this command to practice your
disaster recovery capabilities without initiating a site switch. To switch
sites, the RecoverH3 command is required.

RecoverH1

Recovers the session to the H1 target site. This command makes the
target host volumes consistent and available for access as the new
production site. Upon completion of this command, the session becomes
Target Available.

RecoverH2

Recovers the session to the H2 target site. This command makes the
target host volumes consistent and available for access as the new
production site. Upon completion of this command, the session becomes
Target Available.

RecoverH3

Recovers the session to the H3 target site. This command makes the
target host volumes consistent and available for access as the new
production site. Upon completion of this command, the session becomes
Target Available.
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Table 63. Metro Mirror - Global Mirror with Site 3 Global Mirror commands (continued)

Command

Action

Re-enable Original
Direction

Sets the production site back to the original site and reenables the start
commands in the original direction. You can use this command after you
issue the confirm commands.

Refresh States

Refreshes the states of the role pairs that are in the session (if applicable
for the session type) and refreshes the state of the session if it is
incorrect. This command queries the states of the copy sets on the
hardware. You are not required to run this command under typical
circumstances; Copy Services Manager refreshes the states of its sessions
through multiple means. However, if you discover an inconsistency
between Copy Services Manager and the hardware, you can use this
command to enable Copy Services Manager to update itself.

This command triggers multiple queries on the hardware, which can
impact hardware performance. Do not run this command more frequently
than every few minutes in each session.

This command is not available if the session is in the Defined state.

Release I/0 Enables the source volume to receive data after a copy relationship is
suspended. This command is not displayed if the Release I/0 after
Suspend property is selected for the session.

ResumeGM Resumes the Global Mirror master session on the hardware allowing the

hardware to restart all relationships and consistency group formation. The
command does not do any of the additional checks such as establishing
for logical paths, etc. that are run by issuing the Start command.

This command is only recommended to be used when the session is
suspended for a short amount of time, such as when creating a FlashCopy
or Safeguarded Copy backup at the remote site.

Note: The command does not work for sessions that are suspended and
share the same consistency group on the hardware. When sessions share
a consistency group, the Suspend command removes the volumes of

the suspended session out of the hardware session in order to allow
other sessions to continue to form consistency groups. So the ResumeGM
command will not cause the pairs in the suspended session to be
restarted, you must run the Start command for the same.

Set Production to Site 1

Establishes Site 1 as the production site while the session is in the
Defined state. After you issue this command, the Site 1 Start commands
become available.

Set Production to Site 2

Establishes Site 2 as the production site while the session is in the
Defined state. After you issue this command, the Site 2 Start commands
become available.

Set Production to Site 3

Establishes Site 3 as the production site while the session is in the
Defined state. After you issue this command, the StartGC H3->H1->H2
and StartGC H3->H2->H1 commands become available.

Start H1->H2, H1->H3

Establishes Metro Mirror relationships between H1 and H2 volumes,

and Global Mirror relationships between H1 and H3, and starts forming
consistency groups. This relationship includes the 33 volume to complete
the Global Mirror configuration.
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Table 63. Metro Mirror - Global Mirror with Site 3 Global Mirror commands (continued)

Command

Action

Start H1->H2->H3

Establishes Metro Mirror relationships between H1 and H2, and Global
Mirror relationships between H2 and H3. The Start H1->H2->H3
command can be used to transition from a multi-target configuration to
a cascaded configuration. You can only transition from multi-target to
cascaded if the Global Mirror leg is suspended.

Start H1->H2

Establishes Metro Mirror relationships between the H1 volumes and the
H2 volumes, and begins data replication from H1 to H2.

Start GM H1->H3

Establishes a Global Mirror relationship between H1 and H3, and starts
forming consistency groups. The relationship includes the 33 volume to
complete the Global Mirror configuration.

Start H2->H1, H2->H3

Establishes Metro Mirror relationships between H2 and H1 volumes,

and Global Mirror relationships between H2 and H3, and starts forming
consistency groups. This relationship includes the 33 volume to complete
the Global Mirror configuration.

Start H2->H1

Establishes Metro Mirror relationships between the H2 volumes and the
H1 volumes and starts data replication from H2 to H1.

Start GM H2->H3

Establishes a Global Mirror relationship between H2 and H3, and starts
forming consistency groups. The relationship includes the J3 volume to
complete the Global Mirror configuration.

StartGC H1->H2, H1->H3

Establishes Global Copy relationships between the H1 and H2 volumes
and between H1 and H3 volumes, and begins asynchronous data
replication from H1 to H2 and H1 to H3.

The session remains in the Preparing state until you issue a Start,
Suspend, Stop, or Terminate command.

StartGC H1->H2

Establishes Global Copy relationships between the H1 volumes and the
H2 volumes, and begins asynchronous data replication from H1 to H2.

The session remains in the Preparing state until you issue a Start,
Suspend, or Terminate command.

StartGC H1->H3

Establishes Global Copy relationships between the H1 volumes and the
H3 volumes, and begins asynchronous data replication from H1 to H3.

The session remains in the Preparing state until you issue a Start,
Suspend, or Terminate command.

StartGC H2->H1, H2->H3

Establishes Global Copy relationships between the H2 and H1 volumes
and between H2 and H3 volumes, and begins asynchronous data
replication from H2 to H1 and H2 to H3.

The session remains in the Preparing state until you issue a Start,
Suspend, Stop, or Terminate command.

StartGC H2->H1

Establishes Global Copy relationships between the H2 volumes and the
H1 volumes, and begins asynchronous data replication from H2 to H1.

The session remains in the Preparing state until you issue a Start,
Suspend, Stop, or Terminate command.
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Table 63. Metro Mirror - Global Mirror with Site 3 Global Mirror commands (continued)

Command

Action

StartGC H2->H3

Establishes Global Copy relationships between the H2 volumes and the
H3 volumes, and begins asynchronous data replication from H2 to H3.

The session remains in the Preparing state until you issue a Start,
Suspend, Stop, or Terminate command.

StartGC H3->H1->H2

Establishes Global Copy relationships between the H3 volumes, and the
H1 volumes, and H2 volumes, and begins asynchronous data replication
from H3 to H1 and H2.

The session remains in the Preparing state until you issue a Suspend,
Stop, or Terminate command.

StartGC H3->H2->H1

Establishes Global Copy relationships between the H3 volumes, and
the H2 volumes, and the H1 volumes, and begins asynchronous data
replication from H3 to H2 and H1.

The session remains in the Preparing state until you issue a Suspend,
Stop, or Terminate command.

StartGM H3->H2->H1

Establishes Global Mirror relationships between the H3 volumes and the
H2 volumes, followed by a cascaded Global Copy relationship from the H2
volumes and the H1 volumes.

This command starts the session from Site 3 with disaster recovery
capabilities by using Global Mirror to ensure that the H2 volumes are
consistent.

StartGM H3->H1->H2

Establishes Global Mirror relationships between the H3 volumes and the
H1 volumes, followed by a cascaded Global Copy relationship from the H1
volumes and the H2 volumes.

This command starts the session from Site 3 with disaster recovery
capabilities by using Global Mirror to ensure that the H1 volumes are
consistent.

Stop Stops updates to all the target volumes of the pairs in a session.
Targets are not consistent after the stop.

StopH1H2 Stops updates from H1 to H2 volumes in a session.

StopH1H3 Stops updates from H1 to H3 volumes in a session.

StopH2H1 Stops updates from H2 to H1 volumes in a session.

StopH2H3 Stops updates from H2 to H3 volumes in a session.
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Table 63. Metro Mirror - Global Mirror with Site 3 Global Mirror commands (continued)

Command

Action

Suspend

Suspends updates to all the target volumes of the pairs in a session.

The following information applies to this command and the following
Suspend commands:

« You can issue the command at any point during an active session.

« Avoid use of the same LSS pairs for multiple Metro Mirror sessions.
Metro Mirror uses a freeze command on DS8000 storage systems
to create the data-consistent point. If other Metro Mirror sessions
overlap the same LSS pairs as in this session, those sessions are also
suspended.

- When a Suspend command is issued to a source volume in an LSS that
has source volumes in another active Metro Mirror session, the other
source volumes are affected only if they have the same target LSS. The
primary volumes are suspended, but volumes in the same source LSS
that have target volumes in a different LSS are not affected because
they use a different PPRC path connection.

Suspend When Drained

Suspends the session after all I/O drains to the tertiary site and marks all
volumes at all sites as consistent. All I/O must be quiesced before you
issue this command.

SuspendH1H2 Suspends updates from H1 to H2 volumes in a session.
SuspendH1H3 Suspends updates from H1 to H3 volumes in a session.
SuspendH2H1 Suspends updates from H2 to H1 volumes in a session.
SuspendH2H3 Suspends updates from H2 to H3 volumes in a session.
Terminate

Removes all copy relationships from the hardware during an active
session. If you want the targets to be data consistent before you remove
their relationship, issue the following commands before you issue the
Terminate command:

« Suspend
« RecoverHx

Where x is the site to which you want to recover.

TerminateH1H2

Removes all H1>H2 or H2>H1 relationships from the hardware during an
active session. If you want the target to be data consistent before you
remove their relationship, issue the following commands before you issue
the Terminate command:

« SuspendH1H2
« Recoverx

Where x is the site to which you want to recover.
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Table 63. Metro Mirror - Global Mirror with Site 3 Global Mirror commands (continued)

Command

Action

TerminateH1H3

Removes all H1>H3 or H3>H1 relationships from the hardware during an
active session. If you want the target to be data consistent before you
remove their relationship, issue the following commands before you issue
the Terminate command:

« SuspendH1H3
* Recoverx

Where x is the site to which you want to recover.

TerminateH2H3

Removes all H2>H3 or H3>H2 relationships from the hardware during an
active session.

» SuspendH2H3
* Recoverx

Where x is the site to which you want to recover.

Metro Mirror - Global Mirror with Site 4 Replication commands

Use this information to learn about commands available for Metro Mirror - Global Mirror with Site 4

Replication sessions.

Table 64. Metro Mirror - Global Mirror with Site 4 Replication commands

Command

Action

Confirm Production at Site
1

Confirms that you want to establish site 1 as the production site after you
issue suspend and recover commands for the session.

Confirm Production at Site
2

Confirms that you want to establish site 2 as the production site after you
issue suspend and recover commands for the session.

Confirm Production at Site
3

Confirms that you want to establish site 3 as the production site after you
issue suspend and recover commands for the session.

Confirm Production at Site
4

Confirms that you want to establish site 4 as the production site after you
issue suspend and recover commands for the session.

FailoverH1

Completes a failover operation to the H1 target site. This command
enables read and write access to the target volumes. At the same time,
a recording of changes to the volumes that prevents a full copy when
the relationship is restarted. You can use this command to practice your
disaster recovery capabilities without initiating a site switch. To switch
sites, the RecoverH1 command is required.

FailoverH2

Completes a failover operation to the H2 target site. This command
enables read and write access to the target volumes. At the same time,
a recording of changes to the volumes that prevents a full copy when
the relationship is restarted. You can use this command to practice your
disaster recovery capabilities without initiating a site switch. To switch
sites, the RecoverH2 command is required.
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Table 64. Metro Mirror - Global Mirror with Site 4 Replication commands (continued)

Command

Action

FailoverH3

Completes a failover operation to the H3 target site. This command
enables read and write access to the target volumes. At the same time,
a recording of changes to the volumes that prevents a full copy when
the relationship is restarted. You can use this command to practice your
disaster recovery capabilities without initiating a site switch. To switch
sites, the RecoverH3 command is required.

FailoverH4

Completes a failover operation to the H4 target site. This command
enables read and write access to the target volumes. At the same time,
a recording of changes to the volumes that prevents a full copy when
the relationship is restarted. You can use this command to practice your
disaster recovery capabilities without initiating a site switch. To switch
sites, the RecoverH4 command is required.

Free Journal Space

Frees up journal space by deleting the FlashCopy relationships from the
hardware.

The Free Journal Space command is only available after a recover
operation is issued on the Global Mirror leg of the selected session.

HyperSwap H1

Triggers a HyperSwap operation where I/0 is redirected from the source
volume to the target volume H1, without affecting the application that is
using those volumes.

HyperSwap H2

Triggers a HyperSwap operation where I/0 is redirected from the source
volume to the target volume H2, without affecting the application that is
using those volumes.

HyperSwap H3

Triggers a HyperSwap operation where I/0 is redirected from the source
volume to the target volume H3, without affecting the application that is
using those volumes.

HyperSwap H4

Triggers a HyperSwap operation where I/0 is redirected from the source
volume to the target volume H4, without affecting the application that is
using those volumes.

RecoverH1

Recovers the session to the H1 target site. This command makes the
target host volumes consistent and available for access as the new
production site. Upon completion of this command, the session becomes
Target Available.

RecoverH2

Recovers the session to the H2 target site. This command makes the
target host volumes consistent and available for access as the new
production site. Upon completion of this command, the session becomes
Target Available.

RecoverH3

Recovers the session to the H3 target site. This command makes the
target host volumes consistent and available for access as the new
production site. Upon completion of this command, the session becomes
Target Available.

RecoverH4

Recovers the session to the H4 target site. This command makes the
target host volumes consistent and available for access as the new
production site. Upon completion of this command, the session becomes
Target Available.
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Table 64. Metro Mirror - Global Mirror with Site 4 Replication commands (continued)

Command

Action

Re-enable Original
Direction

Sets the production site back to the original site and re-enables the start
commands in the original direction. You can use this command after you
issue the confirm commands.

Refresh States

Refreshes the states of the role pairs that are in the session (if applicable
for the session type) and refreshes the state of the session if it is
incorrect. This command queries the states of the copy sets on the
hardware. You are not required to run this command under typical
circumstances; Copy Services Manager refreshes the states of its sessions
through multiple means. However, if you discover an inconsistency
between Copy Services Manager and the hardware, you can use this
command to enable Copy Services Manager to update itself.

This command triggers multiple queries on the hardware, which can
impact hardware performance. Do not run this command more frequently
than every few minutes in each session.

This command is not available if the session is in the Defined state.

Release I/O

Enables the source volume to receive data after a copy relationship is
suspended. This command is not displayed if the Release I/0 after
Suspend property is selected for the session.

Set Production to Site 1

Establishes Site 1 as the production site while the session is in the
Defined state. After you issue this command, the Site 1 Start commands
become available.

Set Production to Site 2

Establishes Site 2 as the production site while the session is in the
Defined state. After you issue this command, the Site 2 Start commands
become available.

Set Production to Site 3

Establishes Site 3 as the production site while the session is in the
Defined state. After you issue this command, the Site 3 Start commands
become available.

Set Production to Site 4

Establishes Site 4 as the production site while the session is in the
Defined state. After you issue this command, the Site 4 Start commands
become available.

Start H1->H2 H1->H3

Establishes Metro Mirror relationships between H1 and H2 volumes,

and Global Mirror relationships between H1 and H3, and starts forming
consistency groups. This relationship includes the 33 volume to complete
the Global Mirror configuration.

Start H1->H2

Establishes Metro Mirror relationships between the H1 volumes and the
H2 volumes, and begins data replication from H1 to H2.

Start GM H1->H3

Establishes a Global Mirror relationship between H1 and H3, and starts
forming consistency groups. The relationship includes the 33 volume to
complete the Global Mirror configuration.

Start H2->H1 H2->H3

Establishes Metro Mirror relationships between H2 and H1 volumes,

and Global Mirror relationships between H2 and H3, and starts forming
consistency groups. This relationship includes the 33 volume to complete
the Global Mirror configuration.

Start H2->H1

Establishes Metro Mirror relationships between the H2 volumes and the
H1 volumes and starts data replication from H2 to H1.
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Table 64. Metro Mirror - Global Mirror with Site 4 Replication commands (continued)

Command

Action

Start H3->H4

Establishes Metro Mirror relationships between the H3 volumes and the
H4 volumes, and starts data replication from H3 to H4.

Start H4->H3

Establishes Metro Mirror relationships between the H4 volumes and the
H3 volumes, and starts data replication from H4 to H3.

StartGM H2->H3

Establishes a Global Mirror relationship between H2 and H3, and starts
forming consistency groups. The relationship includes the 33 volume to
complete the Global Mirror configuration.

StartGM H3->H1

Establishes a Global Mirror relationship between H3 and H1, and starts
forming consistency groups. The relationship includes the J3 volume to
complete the Global Mirror configuration.

StartGM H4->H1

Establishes a Global Mirror relationship between H4 and H1, and starts
forming consistency groups. The relationship includes the J1 volume to
complete the Global Mirror configuration.

StartGC H1->H2 H1->H3

Establishes Global Copy relationships between the H1 and H2 volumes
and between H1 and H3 volumes, and begins asynchronous data
replication from H1 to H2 and H1 to H3.

The session remains in the Preparing state until you issue a Start,
Suspend, Stop, or Terminate command.

StartGC H1->H2

Establishes Global Copy relationships between the H1 volumes and the
H2 volumes, and begins asynchronous data replication from H1 to H2.

The session remains in the Preparing state until you issue a Start,
Suspend, or Terminate command.

StartGC H1->H3

Establishes Global Copy relationships between the H1 volumes and the
H3 volumes, and begins asynchronous data replication from H1 to H3.

The session remains in the Preparing state until you issue a Start,
Suspend, or Terminate command.

StartGC H2->H1 H2->H3

Establishes Global Copy relationships between the H2 and H1 volumes
and between H2 and H3 volumes, and begins asynchronous data
replication from H2 to H1 and H2 to H3.

The session remains in the Preparing state until you issue a Start,
Suspend, Stop, or Terminate command.

StartGC H2->H1

Establishes Global Copy relationships between the H2 volumes and the
H1 volumes, and begins asynchronous data replication from H2 to H1.

The session remains in the Preparing state until you issue a Start,
Suspend, Stop, or Terminate command.

StartGC H2->H3

Establishes Global Copy relationships between the H2 volumes and the
H3 volumes, and begins asynchronous data replication from H2 to H3.

The session remains in the Preparing state until you issue a Start,
Suspend, Stop, or Terminate command.
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Table 64. Metro Mirror - Global Mirror with Site 4 Replication commands (continued)

Command Action

StartGC H3->H1 Establishes Global Copy relationships between the H3 volumes and the
H1 volumes, and begins asynchronous data replication from H3 to H1.

The session remains in the Preparing state until you issue a Start,
Suspend, Stop, or Terminate command.

StartGC H3->H4 Establishes Global Copy relationships between the H3 volumes and the
H4 volumes, and begins asynchronous data replication from H3 to H4.

The session remains in the Preparing state until you issue a Start,
Suspend, Stop, or Terminate command.

StartGC H3->H4 H3->H1 | Estaplishes Global Copy relationships between the H3 and H4 volumes
and between H3 and H1 volumes, and begins asynchronous data
replication from H3 to H4 and H3 to H1.

The session remains in the Preparing state until you issue a Start,
Suspend, Stop, or Terminate command.

StartGC H4->H1 Establishes Global Copy relationships between the H4 volumes and the
H1 volumes, and begins asynchronous data replication from H4 to H1.

The session remains in the Preparing state until you issue a Start,
Suspend, Stop, or Terminate command.

StartGC H4->H3 Establishes Global Copy relationships between the H4 volumes and the
H3 volumes, and begins asynchronous data replication from H4 to H3.

The session remains in the Preparing state until you issue a Start,
Suspend, Stop, or Terminate command.

StartGC H4->H3 H4->H1 Establishes Global Copy relationships between the H4 and H3 volumes
and between H4 and H1 volumes, and begins asynchronous data
replication from H4 to H3 and H4 to H1.

The session remains in the Preparing state until you issue a Start,
Suspend, Stop, or Terminate command.

Stop Stops updates to all the target volumes of the pairs in a session.

Targets are not consistent after the stop.

StopH1H2 Stops updates from H1 to H2 volumes in a session.
StopH1H3 Stops updates from H1 to H3 volumes in a session.
StopH2H1 Stops updates from H2 to H1 volumes in a session.
StopH2H3 Stops updates from H2 to H3 volumes in a session.
StopH3H1 Stops updates from H3 to H1 volumes in a session.
StopH3H4 Stops updates from H3 to H4 volumes in a session.
StopH4H1 Stops updates from H4 to H1 volumes in a session.
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Table 64. Metro Mirror - Global Mirror with Site 4 Replication commands (continued)

Command

Action

StopH4H3

Stops updates from H4 to H3 volumes in a session.

Suspend

Suspends updates to all the target volumes of the pairs in a session.

The following information applies to this command and the following
Suspend commands:

« You can issue the command at any point during an active session.

« Avoid use of the same LSS pairs for multiple Metro Mirror sessions.
Metro Mirror uses a freeze command on DS8000 storage systems
to create the data-consistent point. If other Metro Mirror sessions
overlap the same LSS pairs as in this session, those sessions are also
suspended.

« When a Suspend command is issued to a source volume in an LSS that
has source volumes in another active Metro Mirror session, the other
source volumes are affected only if they have the same target LSS. The
primary volumes are suspended, but volumes in the same source LSS
that have target volumes in a different LSS are not affected because
they use a different PPRC path connection.

SuspendH1H2

Suspends updates from H1 to H2 volumes in a session.

SuspendH1H3

Suspends updates from H1 to H3 volumes in a session.

SuspendH2H1

Suspends updates from H2 to H1 volumes in a session.

SuspendH2H3

Suspends updates from H2 to H3 volumes in a session.

SuspendH3H1

Suspends updates from H3 to H1 volumes in a session.

SuspendH3H4

Suspends updates from H3 to H4 volumes in a session.

SuspendH4H1

Suspends updates from H4 to H1 volumes in a session.

SuspendH4H3

Suspends updates from H4 to H3 volumes in a session.

Terminate

Removes all copy relationships from the hardware during an active
session. If you want the targets to be data consistent before you remove
their relationship, issue the following commands before you issue the
Terminate command:

« Suspend
» RecoverHx

Where x is the site to which you want to recover.
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Table 64. Metro Mirror - Global Mirror with Site 4 Replication commands (continued)

Command Action

TerminateH1H2 Removes all H1>H2 or H2>H1 relationships from the hardware during an
active session. If you want the target to be data consistent before you
remove their relationship, issue the following commands before you issue
the Terminate command:

« SuspendH1H2
* Recoverx

Where x is the site to which you want to recover.

TerminateH1H3 Removes all H1>H3 or H3>H1 relationships from the hardware during an
active session. If you want the target to be data consistent before you
remove their relationship, issue the following commands before you issue
the Terminate command:

» SuspendH1H3
* Recoverx

Where x is the site to which you want to recover.

TerminateH2H1 Removes all H2>H1 or H1>H2 relationships from the hardware during an
active session.

« SuspendH2H1
» Recoverx

Where x is the site to which you want to recover.

TerminateH2H3 Removes all H2>H3 or H3>H2 relationships from the hardware during an
active session.

» SuspendH2H3
* Recoverx

Where x is the site to which you want to recover.

TerminateH3H4 Removes all H3>H4 or H4>H3 relationships from the hardware during an
active session.

« SuspendH3H4
« Recoverx

Where x is the site to which you want to recover.

TerminateH3H1 Removes all H3>H1 or H1>H3 relationships from the hardware during an
active session.

« SuspendH3H1
« Recoverx

Where x is the site to which you want to recover.
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Table 64. Metro Mirror - Global Mirror with Site 4 Replication commands (continued)

Command

Action

TerminateH4H3

Removes all H4>H3 or H3>H4 relationships from the hardware during an
active session.

« SuspendH4H3
* Recoverx

Where x is the site to which you want to recover.

TerminateH4H1

Removes all H4>H3 or H3>H4 relationships from the hardware during an
active session.

» SuspendH4H3
* Recoverx

Where x is the site to which you want to recover.

Metro Mirror - Metro Mirror with Site 4 Replication commands

Use this information to learn about commands available for Metro Mirror - Metro Mirror with Site 4

Replication sessions.

Table 65. Metro Mirror - Metro Mirror with Site 4 Replication commands

Command

Action

Confirm Production at Site
1

Confirms that you want to establish site 1 as the production site after you
issue suspend and recover commands for the session.

Confirm Production at Site
2

Confirms that you want to establish site 2 as the production site after you
issue suspend and recover commands for the session.

Confirm Production at Site
3

Confirms that you want to establish site 3 as the production site after you
issue suspend and recover commands for the session.

Confirm Production at Site
4

Confirms that you want to establish site 4 as the production site after you
issue suspend and recover commands for the session.

FailoverH1

Completes a failover operation to the H1 target site. This command
enables read and write access to the target volumes. At the same time,
a recording of changes to the volumes that prevents a full copy when
the relationship is restarted. You can use this command to practice your
disaster recovery capabilities without initiating a site switch. To switch
sites, the RecoverH1 command is required.

FailoverH2

Completes a failover operation to the H2 target site. This command
enables read and write access to the target volumes. At the same time,
a recording of changes to the volumes that prevents a full copy when
the relationship is restarted. You can use this command to practice your
disaster recovery capabilities without initiating a site switch. To switch
sites, the RecoverH2 command is required.

FailoverH3

Completes a failover operation to the H3 target site. This command
enables read and write access to the target volumes. At the same time,
a recording of changes to the volumes that prevents a full copy when
the relationship is restarted. You can use this command to practice your
disaster recovery capabilities without initiating a site switch. To switch
sites, the RecoverH3 command is required.
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Table 65. Metro Mirror - Metro Mirror with Site 4 Replication commands (continued)

Command

Action

FailoverH4

Completes a failover operation to the H4 target site. This command
enables read and write access to the target volumes. At the same time,
a recording of changes to the volumes that prevents a full copy when
the relationship is restarted. You can use this command to practice your
disaster recovery capabilities without initiating a site switch. To switch
sites, the RecoverH4 command is required.

HyperSwap H1

Triggers a HyperSwap operation where I/0 is redirected from the source
volume to the target volume H1, without affecting the application that is
using those volumes.

HyperSwap H2

Triggers a HyperSwap operation where I/0 is redirected from the source
volume to the target volume H2, without affecting the application that is
using those volumes.

HyperSwap H3

Triggers a HyperSwap operation where I/0 is redirected from the source
volume to the target volume H3, without affecting the application that is
using those volumes.

HyperSwap H4

Triggers a HyperSwap operation where I/0 is redirected from the source
volume to the target volume H4, without affecting the application that is
using those volumes.

RecoverH1

Recovers the session to the H1 target site. This command makes the
target host volumes consistent and available for access as the new
production site. Upon completion of this command, the session becomes
Target Available.

RecoverH2

Recovers the session to the H2 target site. This command makes the
target host volumes consistent and available for access as the new
production site. Upon completion of this command, the session becomes
Target Available.

RecoverH3

Recovers the session to the H3 target site. This command makes the
target host volumes consistent and available for access as the new
production site. Upon completion of this command, the session becomes
Target Available.

RecoverH4

Recovers the session to the H4 target site. This command makes the
target host volumes consistent and available for access as the new
production site. Upon completion of this command, the session becomes
Target Available.

Re-enable Original
Direction

Sets the production site back to the original site and re-enables the start
commands in the original direction. You can use this command after you
issue the confirm commands.
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Table 65. Metro Mirror - Metro Mirror with Site 4 Replication commands (continued)

Command

Action

Refresh States

Refreshes the states of the role pairs that are in the session (if applicable
for the session type) and refreshes the state of the session if it is
incorrect. This command queries the states of the copy sets on the
hardware. You are not required to run this command under typical
circumstances; Copy Services Manager refreshes the states of its sessions
through multiple means. However, if you discover an inconsistency
between Copy Services Manager and the hardware, you can use this
command to enable Copy Services Manager to update itself.

This command triggers multiple queries on the hardware, which can
impact hardware performance. Do not run this command more frequently
than every few minutes in each session.

This command is not available if the session is in the Defined state.

Release I/0 Enables the source volume to receive data after a copy relationship is
suspended. This command is not displayed if the Release I/0 after
Suspend property is selected for the session.

ResumeGM Resumes the Global Mirror master session on the hardware allowing the

hardware to restart all relationships and consistency group formation. The
command does not do any of the additional checks such as establishing
for logical paths, etc. that are run by issuing the Start command.

This command is only recommended to be used when the session is
suspended for a short amount of time, such as when creating a FlashCopy
or Safeguarded Copy backup at the remote site.

Note: The command does not work for sessions that are suspended and
share the same consistency group on the hardware. When sessions share
a consistency group, the Suspend command removes the volumes of

the suspended session out of the hardware session in order to allow
other sessions to continue to form consistency groups. So the ResumeGM
command will not cause the pairs in the suspended session to be
restarted, you must run the Start command for the same.

Set Production to Site 1

Establishes Site 1 as the production site while the session is in the
Defined state. After you issue this command, the Site 1 Start commands
become available.

Set Production to Site 2

Establishes Site 2 as the production site while the session is in the
Defined state. After you issue this command, the Site 2 Start commands
become available.

Set Production to Site 3

Establishes Site 3 as the production site while the session is in the
Defined state. After you issue this command, the Site 3 Start commands
become available.

Set Production to Site 4

Establishes Site 4 as the production site while the session is in the
Defined state. After you issue this command, the Site 4 Start commands
become available.

Start H1->H2 H1->H3

Establishes Metro Mirror relationships between H1 and H2 volumes, and
Metro Mirror relationships between H1 and H3.

Start H1->H2

Establishes Metro Mirror relationships between the H1 volumes and the
H2 volumes, and begins data replication from H1 to H2.

Start H1->H3

Establishes a Metro Mirror relationship between H1 and H3.
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Table 65. Metro Mirror - Metro Mirror with Site 4 Replication commands (continued)

Command Action

Start H2->H1 H2->H3 Establishes Metro Mirror relationships between H2 and H1 volumes, and
Metro Mirror relationships between H2 and H3.

Start H2->H1 Establishes Metro Mirror relationships between the H2 volumes and the
H1 volumes and starts data replication from H2 to H1.

Start H3->H4 Establishes Metro Mirror relationships between the H3 volumes and the
H4 volumes, and starts data replication from H3 to H4.

Start H4->H3 Establishes Metro Mirror relationships between the H4 volumes and the
H3 volumes, and starts data replication from H4 to H3.

Start H2->H3 Establishes a Metro Mirror relationship between H2 and H3.
Start H3->H1 Establishes a Metro Mirror relationship between H3 and H1.
Start H4->H1 Establishes a Metro Mirror relationship between H4 and H1.

StartGC H1->H2 H1->H3 [ Egtaplishes Global Copy relationships between the H1 and H2 volumes
and between H1 and H3 volumes, and begins asynchronous data
replication from H1 to H2 and H1 to H3.

The session remains in the Preparing state until you issue a Start,
Suspend, Stop, or Terminate command.

StartGC H1->H2 Establishes Global Copy relationships between the H1 volumes and the
H2 volumes, and begins asynchronous data replication from H1 to H2.

The session remains in the Preparing state until you issue a Start,
Suspend, or Terminate command.

StartGC H1->H3 Establishes Global Copy relationships between the H1 volumes and the
H3 volumes, and begins asynchronous data replication from H1 to H3.

The session remains in the Preparing state until you issue a Start,
Suspend, or Terminate command.

StartGC H2->H1 H2->H3 Establishes Global Copy relationships between the H2 and H1 volumes
and between H2 and H3 volumes, and begins asynchronous data
replication from H2 to H1 and H2 to H3.

The session remains in the Preparing state until you issue a Start,
Suspend, Stop, or Terminate command.

StartGC H2->H1 Establishes Global Copy relationships between the H2 volumes and the
H1 volumes, and begins asynchronous data replication from H2 to H1.

The session remains in the Preparing state until you issue a Start,
Suspend, Stop, or Terminate command.

StartGC H2->H3 Establishes Global Copy relationships between the H2 volumes and the
H3 volumes, and begins asynchronous data replication from H2 to H3.

The session remains in the Preparing state until you issue a Start,
Suspend, Stop, or Terminate command.
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Table 65. Metro Mirror - Metro Mirror with Site 4 Replication commands (continued)

Command

Action

StartGC H3->H1

Establishes Global Copy relationships between the H3 volumes and the
H1 volumes, and begins asynchronous data replication from H3 to H1.

The session remains in the Preparing state until you issue a Start,
Suspend, Stop, or Terminate command.

StartGC H3->H4

Establishes Global Copy relationships between the H3 volumes and the
H4 volumes, and begins asynchronous data replication from H3 to H4.

The session remains in the Preparing state until you issue a Start,
Suspend, Stop, or Terminate command.

StartGC H3->H4 H3->H1

Establishes Global Copy relationships between the H3 and H4 volumes
and between H3 and H1 volumes, and begins asynchronous data
replication from H3 to H4 and H3 to H1.

The session remains in the Preparing state until you issue a Start,
Suspend, Stop, or Terminate command.

StartGC H4->H1

Establishes Global Copy relationships between the H4 volumes and the
H1 volumes, and begins asynchronous data replication from H4 to H1.

The session remains in the Preparing state until you issue a Start,
Suspend, Stop, or Terminate command.

StartGC H4->H3

Establishes Global Copy relationships between the H4 volumes and the
H3 volumes, and begins asynchronous data replication from H4 to H3.

The session remains in the Preparing state until you issue a Start,
Suspend, Stop, or Terminate command.

StartGC H4->H3 H4->H1

Establishes Global Copy relationships between the H4 and H3 volumes
and between H4 and H1 volumes, and begins asynchronous data
replication from H4 to H3 and H4 to H1.

The session remains in the Preparing state until you issue a Start,
Suspend, Stop, or Terminate command.

Stop Stops updates to all the target volumes of the pairs in a session.
Targets are not consistent after the stop.
StopH1H2 Stops updates from H1 to H2 volumes in a session.
Targets are not consistent after the stop.
StopH1H3 Stops updates from H1 to H3 volumes in a session.
Targets are not consistent after the stop.
StopH2H1 Stops updates from H2 to H1 volumes in a session.
Targets are not consistent after the stop.
StopH2H3 Stops updates from H2 to H3 volumes in a session.

Targets are not consistent after the stop.
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Table 65. Metro Mirror - Metro Mirror with Site 4 Replication commands (continued)

Command

Action

StopH3H1

Stops updates from H3 to H1 volumes in a session.

Targets are not consistent after the stop.

StopH3H4

Stops updates from H3 to H4 volumes in a session.

Targets are not consistent after the stop.

StopH4H1

Stops updates from H4 to H1 volumes in a session.

Targets are not consistent after the stop.

StopH4H3

Stops updates from H4 to H3 volumes in a session.

Targets are not consistent after the stop.

Suspend

Suspends updates to all the target volumes of the pairs in a session.

The following information applies to this command and the following
Suspend commands:

 You can issue the command at any point during an active session.

- Avoid use of the same LSS pairs for multiple Metro Mirror sessions.
Metro Mirror uses a freeze command on DS8000 storage systems
to create the data-consistent point. If other Metro Mirror sessions
overlap the same LSS pairs as in this session, those sessions are also
suspended.

« When a Suspend command is issued to a source volume in an LSS that
has source volumes in another active Metro Mirror session, the other
source volumes are affected only if they have the same target LSS. The
primary volumes are suspended, but volumes in the same source LSS
that have target volumes in a different LSS are not affected because
they use a different PPRC path connection.

- If the Suspend command is issued to a pair that is running in Global
Copy mode, the pair is driven to Metro Mirror, and then suspended
consistently.

SuspendH1H2

Suspends updates from H1 to H2 volumes in a session.

If the Suspend command is issued to a pair that is running in Global Copy
mode, the pair is driven to Metro Mirror, and then suspended consistently.

SuspendH1H3

Suspends updates from H1 to H3 volumes in a session.

If the Suspend command is issued to a pair that is running in Global Copy
mode, the pair is driven to Metro Mirror, and then suspended consistently.

SuspendH2H1

Suspends updates from H2 to H1 volumes in a session.

If the Suspend command is issued to a pair that is running in Global Copy
mode, the pair is driven to Metro Mirror, and then suspended consistently.

SuspendH2H3

Suspends updates from H2 to H3 volumes in a session.

If the Suspend command is issued to a pair that is running in Global Copy
mode, the pair is driven to Metro Mirror, and then suspended consistently.

Chapter 7. Setting up data replication 171



Table 65. Metro Mirror - Metro Mirror with Site 4 Replication commands (continued)

Command Action
SuspendH3H1 Suspends updates from H3 to H1 volumes in a session.
If the Suspend command is issued to a pair that is running in Global Copy
mode, the pair is driven to Metro Mirror, and then suspended consistently.
SuspendH3H4 Suspends updates from H3 to H4 volumes in a session.
If the Suspend command is issued to a pair that is running in Global Copy
mode, the pair is driven to Metro Mirror, and then suspended consistently.
SuspendH4H1 Suspends updates from H4 to H1 volumes in a session.
If the Suspend command is issued to a pair that is running in Global Copy
mode, the pair is driven to Metro Mirror, and then suspended consistently.
SuspendH4H3 Suspends updates from H4 to H3 volumes in a session.
If the Suspend command is issued to a pair that is running in Global Copy
mode, the pair is driven to Metro Mirror, and then suspended consistently.
Terminate

Removes all copy relationships from the hardware during an active
session. If you want the targets to be data consistent before you remove
their relationship, issue the following commands before you issue the
Terminate command:

« Suspend
* RecoverHx

Where x is the site to which you want to recover.

TerminateH1H2

Removes all H1>H2 or H2>H1 relationships from the hardware during an
active session. If you want the target to be data consistent before you
remove their relationship, issue the following commands before you issue
the Terminate command:

» SuspendH1H2
» Recoverx

Where x is the site to which you want to recover.

TerminateH1H3

Removes all H1>H3 or H3>H1 relationships from the hardware during an
active session. If you want the target to be data consistent before you
remove their relationship, issue the following commands before you issue
the Terminate command:

« SuspendH1H3
« Recoverx

Where x is the site to which you want to recover.

TerminateH2H1

Removes all H2>H1 or H1>H?2 relationships from the hardware during an
active session.

« SuspendH2H1
« Recoverx

Where x is the site to which you want to recover.
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Table 65. Metro Mirror - Metro Mirror with Site 4 Replication commands (continued)

Command

Action

TerminateH2H3

Removes all H2>H3 or H3>H2 relationships from the hardware during an
active session.

« SuspendH2H3
* Recoverx

Where x is the site to which you want to recover.

TerminateH3H4

Removes all H3>H4 or H4>H3 relationships from the hardware during an
active session.

« SuspendH3H4
* Recoverx

Where x is the site to which you want to recover.

TerminateH3H1

Removes all H3>H1 or H1>H3 relationships from the hardware during an
active session.

« SuspendH3H1
» Recoverx

Where x is the site to which you want to recover.

TerminateH4H3

Removes all H4>H3 or H3>H4 relationships from the hardware during an
active session.

» SuspendH4H3
» Recoverx

Where x is the site to which you want to recover.

TerminateH4H1

Removes all H4>H3 or H3>H4 relationships from the hardware during an
active session.

« SuspendH4H3
« Recoverx

Where x is the site to which you want to recover.

Safeguarded Copy commands

Use this information to learn about commands available for Safeguarded Copy sessions.

Table 66. Safeguarded Copy commands

Command

Action

Backup

Creates a safeguarded backup for all volumes in the session, which is a
point-in-time copy of the data on the safeguarded source volumes.
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Table 66. Safeguarded Copy commands (continued)

Command

Action

Recover Backup

Recovers the data in the designated safeguarded backup to the recovery
volumes, for all source volumes that were part of the backup. If the
Recover Backup command is issued without specifying a backup ID, the
latest recoverable backup is used.

Important: The hardware might not support recovery of the last
recoverable backup. If the hardware does not support it, Copy Services
Manager allows you to recover the last recoverable backup, but
automatically takes a new backup so that the recover can complete.

If additional backup capacity is used, it might cause older backups to
automatically expire on the hardware due to a lack of space. However, if
the hardware supports it, the last backup can be recovered without the
need for an additional backup.

Restore Backup

For Spectrum Virtualize, this command restores the data of the source
volumes to the data of the selected backup.

For DS8000 this command restores the last backup recovered, to the
R1 volumes in the Safeguarded Copy session, to the specified role in
the associated remote copy session. This will remove all data on the
specified volume, in the associated session, and replace it with the
backup data, without requiring a full copy of the data. The associated
session must be in a suspended or failed-over state to run the Restore
Backup command.

InitiateBackgroundCopy

Copies all tracks from the source to the target immediately, instead of
waiting until the source track is written to. The Initiate Background Copy
command is only available after a Recover.

Note: This command only applies to DS8000.

Expire Backup

Removes the designated safeguarded backup and all earlier safeguarded
backups for the safeguarded source volumes in the session.

TerminateH1R1

Removes the H1R1 relationship that was created with the Recover
command.
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Table 66. Safeguarded Copy commands (continued)

Command

Action

Refresh States

Refreshes the list of Safeguarded Copy backups on the session, and
their recoverability status. The command queries all source volumes
in the session for the list of existing Safeguarded Copy backups, as
well as querying the latest state on the hardware for HLR1 recovery
relationships.

You are not required to run this command under typical circumstances.
Copy Services Manager refreshes the states of its sessions through
multiple means. However, if you discover an inconsistency between Copy
Services Manager and the hardware, you can use this command to enable
Copy Services Manager to update itself.

Important: This command triggers multiple queries on the hardware,
which can impact hardware performance. Do not run this command more
frequently than every few minutes in each session.

Note: When adding new copy sets into a Safeguarded Copy session, the
Refresh States command can be used to query the hardware for any
existing backups that are associated with the source volumes. This action
might result in the session going from a Defined state to a Protected state
before a Backup command is issued.

Terminate

Removes all active physical copies and relationships from the hardware
during an active session.

If you want the targets to be data consistent before removing their
relationship, you must issue the InitiateBackgroundCopy command
if NOCOPY was specified, and then wait for the background copy to
complete by checking the copying status of the pairs.

Terminate H1R1 Keep R1

Terminates the H1R1 recovery relationship but keeps the R1 volumes
permanently.

Note: This command only applies to IBM Spectrum Virtualize.

After running this command Copy Services Manager stops managing the
R1 volumes. If the volumes are no longer needed in the future, you must
delete them from the IBM Spectrum Virtualize command-Lline interface
and GUI.
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Migration commands

Use this information to learn about commands available for Migration sessions.

Table 67. Migration commands

Command Action

Refresh States Refreshes the states of the role pairs that are in the session (if
applicable for the session type) and refreshes the state of the session

if it is incorrect. This command queries the states of the copy sets

on the hardware. You are not required to run this command under
typical circumstances; Copy Services Manager refreshes the states

of its sessions through multiple means. However, if you discover an
inconsistency between Copy Services Manager and the hardware, you
can use this command to enable Copy Services Manager to update itself.

This command triggers multiple queries on the hardware, which can
impact hardware performance. Do not run this command more frequently
than every few minutes in each session.

This command is not available if the session is in the Defined state.

Recover Issues the Recover command to suspended sessions. This command
performs the steps necessary to make the target available to writes from
an attached host as the new primary site.

Stop Inconsistently suspends updates to all the targets of pairs in a session.
This command can be issued at any point during the copying of an active
session.

Note: Targets after the suspend are not considered to be consistent.

StartGC H1->H2 Establishes Global Copy relationships between site 1 and site 2 and
begins asynchronous data replication from H1 to H2. To change the
session state from Preparing to Prepared, you must issue the Start H1-
>H2 command and the session must begin to form consistency groups.

There is no disaster recovery protection for Global Copy relationships. If
a disaster such as the loss of a primary storage system or a link failure
between the sites occurs, the session might be inconsistent when you
issue the Recovexr command.

This command is available for the DS8000 storage system.

Stop When Drained After a StartGC command, the session is in a Preparing and Global Copy
mode. The Stop When Drained command starts a thread that queries
all pairs until zero pairs are out-of-sync (00S). After the OQOS for the pairs
goes to zero, the Stop command is issued.

Note: The Stop command is issued, rather than Suspend, so that this
procedure can be used in cascaded environments. Suspend puts the
pairs in Metro Mirror mode, which is not allowed if the source of the
session is the target of another relationship.
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Table 67. Migration commands (continued)

Command

Action

Suspend

Causes all target volumes to remain at a data-consistent point and stops
all data that is moving to the target volumes. This command can be
issued at any point during a session when the data is actively being
copied.

Note: Avoid using the same LSS pairs for multiple Metro Mirror sessions.
Metro Mirror uses a freeze command on DS8000 storage systems to
create the data-consistent point. If there are other Metro Mirror sessions
overlapping the same LSS pairs as in this session, those sessions are also
suspended.

When a Suspend command is issued to a source volume in an LSS that
has source volumes in another active Metro Mirror session, the other
source volumes are affected only if they have the same target LSS. The
primary volumes are suspended, but volumes in the same source LSS
that have target volumes in a different LSS are not affected because they
use a different PPRC path connection.

Terminate

Removes all copy relationships from the hardware during an active
session. If you want the targets to be data consistent before removing
their relationship, you must issue the Suspend command, then the
Recover command, and then the Terminate command.

ESE Sizer commands

Use this information to learn about commands available for ESE Sizer sessions.

Table 68. ESE Sizer commands

Command

Action

Start Monitor

This command is used to start the data collection for all volumes in
the session, based on the query interval time defined in the session
properties. After the session starts, it will go into the Prepared state.

Note: The start command will clear any previous historical data for the
session.

Stop Monitor

This command will stop the data collection for all volumes in the session.
After stopping the session it will go into the Defined state, however,

data can still be exported for the session until the session is deleted or
restarted.

Reset Monitor

This command is used to manually reset the hardware information for
the data collected. The data automatically resets based on the reset time
specified in the properties of the session. Manually resetting the session
should only be done by a knowledgeable user or when directed by IBM
support.

Export->Export ESE Box
Data

After the session is started and is in the Prepared state, select Export
ESE Box Data to export the data collected, summarized for each storage
system in the session, to a CSV (comma separate value) file. The CSV

file can be used in an external tool or spreadsheet to help in calculating
the necessary capacity for a SafeGuarded Copy implementation based on
volume usage.
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Table 68. ESE Sizer commands (continued)

Command Action

Export->Export ESE Volume | After the session is started and is in the Prepared state, select Export
Data ESE Volume Data to export the data collected for each volume in

the session, to a CSV (comma separate value) file. The CSV file can

be used in an external tool or spreadsheet to help in calculating the
necessary capacity for a SafeGuarded Copy implementation based on
volume usage.

Site awareness

You can associate a location with each storage system and each site in a session. This site awareness
ensures that only the volumes whose location matches the location of the site are allowed for selection
when you add copy sets to the session. This prevents a session relationship from being established in the
wrong direction.

Note: To filter the locations for site awareness, you must first assign a site location to each storage
system.

Copy Services Manager does not perform automatic discovery of locations. Locations are user-defined
and specified manually.

You can change the location associated with a storage system that has been added to the Copy Services
Manager configuration. You can choose an existing location or add a new one. Locations are deleted when
there is no longer a storage system with an association to that location.

When adding a copy set to a session, a list of candidate storage systems is presented, organized by
location. Storage systems that do not have a location are displayed and available for use when you create
a copy set.

You can also change the location for any site in a session. Changing the location of a session does not
affect the location of the storage systems that are in the session.

Changing the location of a storage system might have consequences. When a session has a volume role
with a location that is linked to the location of the storage system, changing the location of the storage
system could change the session's volume role location. For example, if there is one storage system with
the location of A_Location and a session with the location of A_Location for its H1 role, changing the
location of the storage system to a different location, such as B_Location, also changes the session's H1
location to Site 1. However, if there is a second storage system that has the location of A_Location, the
session's role location is not changed.

Important: Location matching is enabled only when adding copy sets. If you change the location of a
storage system or volume role, Copy Services Manager does not audit existing copy sets to confirm or
deny location mismatches.

Preserve Mirror option

This topic presents recommendations for using the Preserve Mirror option in FlashCopy and Metro Mirror
sessions.

When the source of the FlashCopy relationship is a source of a Metro Mirror relationship, and the target

of the FlashCopy relationship is the source of a Metro Mirror relationship, the Preserve Mirror option
attempts to preserve the consistency of the Metro Mirror relationship at the target of the FlashCopy
relationship, preventing a full copy from being performed over the Metro Mirror link. Instead, parallel
flashes are performed (if possible) on both sites. If the consistency cannot be preserved, the Flash for the
FlashCopy relationships fails, and the data of the Metro Mirror relationship at the target of the FlashCopy
relationship is not changed.

Note: This option is available only on DS8000 storage devices with the required code levels installed.
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When you use Preserve Mirror, where the sources of the FlashCopy relationships are sources in a multi-
target Metro Mirror relationship, you must currently specify which of the Metro Mirror relationships

for the Preserve Mirror feature to use. To make this specification, add the following property to

the rmserver.properties file: com.ibm.csm.<sessionName>.<rolepair>.usexpfc. When the
Metro Mirror pairs are established, any pairs that are marked with this property are set up so that when
the source is flashed the Preserve Mirror feature knows to use these pairs. For more information, see the
“rmserver.properties file” on page 326.

Notes:

« This property default is set to false. It must be set to true to enable the option on the role pair.

« This property is only used when establishing the Metro Mirror relationships. If the relationships are
already established on the hardware, they need to be suspended and restarted to set up for Preserve
Mirror. Alternatively, the DSCLI can be used to mark the pairs for Preserve Mirror. Use the DSCLI chppxc
command with the -action enable option (to turniton), and -action disable (to turn it off).

« When a pair is set up for Preserve Mirror in Copy Services Manager, there is currently no way to unset
the pair. If there is a requirement to switch Preserve Mirror between the two Metro Mirror multi-target
relationships, use the DSCLI to unset the current pair before you change the property to handle the
other pair. Alternatively the Metro Mirror pair can be terminated, which removes the association on the
DS8000.

However, in some instances, the Preserve Mirror option can cause a Metro Mirror session to go into a
Preparing state, or even a Suspended state. This topic describes the recommended usage of the Preserve
Mirror feature. Using this feature in other ways might lead a Metro Mirror session to go into a Preparing or
Suspended state.

FlashCopy session

You can use the Preserve Mirror option in FlashCopy sessions in two different methods:

Perform an incremental resynchronization
To perform an incremental resynchronization, select the Incremental and Persistent options in the
FlashCopy session: do not select the No Copy option.

Perform a single full copy
To perform a single full copy, ensure that the Incremental, Persistent, and No Copy options are not
selected before you issue a Flash command. If you use the No Copy option, issue either an Initiate
Background Copy command or Terminate command before you issue the Flash command.

See your DS8000 documentation for more information about the Preserve Mirror function.

Metro Mirror session

You can set up your Metro Mirror pairs in two different ways, depending on the level of consistency you
need, and your preferences.

Note: For the examples in this section, the source pair is Hla->H2a and the target pair is Hlb->H2b. The
source pair contains volumes that are the source of the FlashCopy relationship and the target pair always
contains volumes that are the target of the FlashCopy relationship.

Create one Metro Mirror session, and add the Metro Mirror pairs as copy sets to that session
The benefit to this approach is that you do not need to worry about whether the host considers the
H1la->H2a and H1b->H2b volumes to be consistent with one another. Copy Services Manager ensures
that all of the volumes remain consistent.

A drawback to this approach is that when you use the Attempt to preserve Metro Mirror consistency,
but fail FlashCopy if Metro Mirror target consistency cannot be preserved option (Preserve Mirror
Required), there is a chance that the target pair (H1b->H2b) might suspend unexpectedly. This
situation causes all other pairs in the Metro Mirror session to suspend (including Hla->H2a). This can
occur when a FlashCopy establish or withdraw fails unexpectedly on the remote (H1b->H2b) site. If
the host requires the Hla->H2a and H1b->H2b volumes to be consistent, then you should suspend all
other volumes.
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Create one Metro Mirror session for the H1la->H2a volumes, and another Metro Mirror session for the

Hab->H2b volumes
Use this option when the hosts and applications do not require the Hla->H2a and H1b->H2b volumes
to be consistent with one another. In this case, you should create one Metro Mirror session for all of
the Hla->H2a volumes, and another Metro Mirror session for the H1b->H2b volumes. The Hla->H2a
pair is added to the first session, while the H1b->H2b pair is added to the second Metro Mirror
session. If the host does not require consistency between the Hla and H1b volumes, this option
benefits you when you use the Attempt to preserve Metro Mirror consistency, but fail FlashCopy if
Metro Mirror target consistency cannot be preserved option (Preserve Mirror Required). The benefit
is that if one pair is suspended (such as Hla->H2a), the pairs in the other session are not affected,
since it is in a different Metro Mirror session. Using this method, you can avoid the situation in which
a critical application is writing to the source pair (H1a->H2a), while a batch job is writing to the target
pair (H1b->H2b), and both pairs are in the same Copy Services Manager session. These factors cause
both applications to receive extended long busy signals, instead of just the batch job.

Creating sessions and adding copy sets

A session completes a specific type of data replication for a specific set of volumes. During data
replication, data is copied from a source volume to one or more target volumes, depending on the session
type. The source volume and target volumes that contain copies of the same data are collectively referred
to as a copy set. A session can contain one or more copy sets.

Creating a FlashCopy session and adding copy sets

FlashCopy replication creates a point-in-time copy in which the target volume contains a copy of the data
that was on the source volume when the FlashCopy session was established.

When you create a FlashCopy session for Global Mirror or Metro Global Mirror space-efficient target
volumes, you must select No Copy for the FlashCopy session. With space-efficient volumes, you can
use your FlashCopy repository more efficiently. Instead of requiring an equal amount of space to write
data to, you can set aside a smaller amount of space in which to write data, where only the tracks that
are changed are recorded. When your pool of storage is full, you can no longer perform a FlashCopy
operation, and your session goes into a Severe state.

To add a FlashCopy session, you create the session, add copy sets to the session, and then select the
properties for the session.

1. Follow these steps to create a FlashCopy session:
a) In the menu bar, click Sessions.
b) On the Sessions page, click Create Session.
c) In the Create Session window, select the following options:

Hardware type
Select the type of storage system for the session:
- DS8000
« FlashSystem/IBM Spectrum Virtualize
« SAN Volume Controller
Session type
Select FlashCopy.
Session name
Enter a name to identify the session.

Note: For sessions that contain a SAN Volume Controller or FlashSystem/IBM Spectrum
Virtualize storage system, it is recommended that you create a session name that contains

15 alphanumeric characters or less. By doing so, the consistency group name that is created on
the hardware matches the session name. Session names with more than 15 characters cause a
random consistency group name to be generated on the hardware.
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For sessions that contain other storage system types, the session name can be up to 250
alphanumeric characters. The default name for a new session is newsession.

Site 1 Location
For each site that is in the session, select the location for the site or None. The site location, if
available, is set by storage system on the Storage Systems page.

You can associate a location with each storage system and each site in a session. This site
awareness ensures that you can select only storage systems that have either a matching site
location for each role or have no defined location when you add copy sets to a session.

Session image
Shows an image that represents the session. The session image is displayed when you select a
session type. The image is a visual aid to help you create your session. The lightning bolt in the
image represents FlashCopy replication.

If you selected a location for the site that is in the session, the site is labeled with the site
location. If you did not select site locations, the sites are labeled with Site x, where x is the
site number. You can hover the mouse pointer over the site location to view the text in a larger
format.

d) Click OK.

e) If the session was successfully created, click Launch Add Copy Sets Wizard and continue to the
next step.

If the session was not created, refer to the displayed message text to fix the problem.
2. Follow these steps to add copy sets to the session:

a) On the Select Hostl page of the Add Copy Sets wizard, complete the following information.
The field names that are displayed depend on the storage system type. When you complete the
information, click Next.

Storage system
Select a storage system. If the volume role has a site location that is assigned to it, you can
select a storage system that is assigned to the same location as the role or a storage system
that is not assigned to a location. Storage systems that have a location are listed under the
location. Storage systems that do not have a location are listed under None. If the role does not
have a site location, you can select any storage system.

Logical storage system or I/0 Group
Select a logical subsystem (LSS) or I/0 group.

Volume
Select one volume or all volumes. The volumes are limited to the volumes within the LSS or I/O
group that you selected.

The use of extent space-efficient volumes in volume roles depends on the capabilities of the
storage system.

Session image
Shows an image that represents the session in which the role for which you are selecting
volumes is highlighted. This image shows how many roles are in the session and how the roles
are distributed between the sites.

Volume Details
Shows information about the selected volume, including the volume name, full name, type,
capacity, and whether the volume is protected and space-efficient.

Use a CSV file to import copy sets
Select this option to import copy sets from a comma-separated value (CSV) file. Click Browse to
select the CSV file.

b) On the Choose Targetl page, select the target storage system, LSS or I/0 group, and volume. Click
Next.

¢) On the Select Copy Sets page, select from the following options and click Next:
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Select All
Click this button to select all of the copy sets in the table.

Deselect All
Click this button to clear all of the copy sets in the table.

Add More
Click this button to add another copy set to the list of copy sets to be created.

When you click Add More, you are returned to the Choose Hostl page of the wizard. On this
page, the Storage system and Logical storage system or I/O Group lists are populated with
the values from the previously selected copy set. Repeat the previous steps to complete the
Choose Host1 and Choose Targetl pages and add more copy sets.

Selection check boxes
Select one or more copy sets that you want to create.

Host 1
Lists the volume IDs that are associated with the Host1 role. You can click the link to display
information about the volume, including the full name, type, capacity, and whether the volume
is protected and space efficient.

Copy Set
Displays the copy set information for the specified copy sets and any warning or error messages
that are associated with the copy set.

A warning or icon next to the Show button indicates that you cannot create a copy set for the
H1 volume. Click Show to view the message.

d) On the Confirm page, the number of copy sets to be added is displayed. Click Next.

e) A progress bar is displayed. When the copy sets are added, review the results and click Finish.
3. Follow these steps to add properties for the session:

a) On the Sessions page, select the session.

b) From the Session Actions list, select View/Modify > Properties.

¢) In the View/Modify Properties notebook, select the options that you want. For a description of the
options, see “Viewing session properties” on page 239.

d) Click OK.

Creating a Snapshot session and adding copy sets

A Snapshot session is a session type that creates a point-in-time copy of a volume or set of volumes
without having to define a specific target volume. Snapshot sessions are available only for the
FlashSystem/IBM Spectrum Accelerate.

To add a Snapshot session, you create the session and then add copy sets to the session.

1. Follow these steps to create a Snapshot session:
a) In the menu bar, click Sessions.
b) On the Sessions page, click Create Session.
¢) In the Create Session window, select the following options:

Hardware type
Select FlashSystem/IBM Spectrum Accelerate.

Session type
Select Snapshot.

Session name
Enter a name to identify the session. The session name can be up to 58 alphanumeric
characters. The default name for a new session is newsession.
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Site 1 Location
For each site that is in the session, select the location for the site or None. The site location, if
available, is set by storage system on the Storage Systems page.

You can associate a location with each storage system and each site in a session. This site
awareness ensures that only storage systems that have either a matching site location for each
role or have no defined location are displayed in the copy set wizard.

Session image
Shows an image that represents the session. The session image is displayed when you select a
session type. The image is a visual aid to help you create your session.

If you selected a location for the site that is in the session, the site is labeled with the site
location. If you did not select site locations, the sites are labeled with Site x, where x is the
site number. You can hover the mouse pointer over the site location to view the text in a larger
format.

d) Click OK.

e) If the session was successfully created, click Launch Add Copy Sets Wizard and continue to the
next step.

If the session was not created, refer to the displayed message text to fix the problem.
2. Follow these steps to add copy sets to the session:

a) From the Host1 storage system list, select the storage system that contains the volumes that you
want to add.

If the H1 role has an assigned location, only those storage systems that have the same location as
the H1 role, or storage systems that do not have a set location, are displayed for selection.

If the H1 role does not have an assigned location, all storage systems are displayed for selection.

Storage systems that are assigned to a location are listed under the location name. Storage systems
that are not assigned to a location are listed under the None. column.

b) From the Hostl pool list, select the pool that contains the volumes.
¢) From the Hostl volume list, select the volumes.
To select multiple volumes, press Ctrl or Shift and click the volumes in the list.

d) If you want to import copy sets from a comma-separated value (CSV) file, click Use a CSV file to
import copy sets. Click Browse to select the CSV file and click Next.

e) On the Matching Results page, click Next if the match was successful.
f) On the Select Copy Sets page, select from the following options and click Next.

Select All

Click this button to select all of the copy sets in the table.
Deselect All

Click this button to clear all of the copy sets in the table.
Add More

Click this button to add another copy set to the list of copy sets to be created.

When you click Add More, you are returned to the Choose Hostl page of the wizard. The lists
on this page are populated with the values from the previously selected copy set. Repeat the
previous steps to complete the Choose Hostl page and add more copy sets.

Selection check boxes
Select one or more copy sets that you want to create.

Host 1
Lists the volume IDs that are associated with the Host1 role. You can click the link to display
information about the volume, including the full name, type, capacity, and whether the volume
is protected and space efficient.
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Copy Set

Displays the copy set information for the specified copy sets and any warning or error messages
that are associated with the copy set.

A warning or icon next to the Show button indicates that you cannot create a copy set for the
H1 volume. Click Show to view the message.

g) On the Confirm page, the number of copy sets to be added is displayed. Click Next.
h) A progress bar is displayed. When the copy sets are added, review the results and click Finish.

If you want to add a description for the session, select the session on the Sessions page. From the
Session Actions list, select View/Modify > Properties.

Creating a Metro Mirror session and adding copy sets

A Metro Mirror session is a method of synchronous, remote data replication that operates between two
sites that are up to 300 KM apart.

To add a Metro Mirror session, you create the session, add copy sets to the session, and then select the
properties for the session.
1. Follow these steps to create a Metro Mirror session:

a) In the menu bar, click Sessions.

b) On the Sessions page, click Create Session.

¢) In the Create Session window, select the following options:

Hardware type
Select the type of storage system for the session:

- DS8000

« FlashSystem/IBM Spectrum Virtualize
« SAN Volume Controller

» FlashSystem/IBM Spectrum Accelerate

Session type
Select a Metro Mirror session type.

Session name
Enter a name to identify the session.

Note: For sessions that contain a SAN Volume Controller or FlashSystem/IBM Spectrum
Virtualize storage system, it is suggested that you create a session name that contains 15
alphanumeric characters or less. By doing so, the consistency group name that is created on
the hardware matches the session name. Session names with more than 15 characters cause a
random consistency group name to be generated on the hardware.

For sessions that contain a FlashSystem/IBM Spectrum Accelerate, the session name can be
up to 58 alphanumeric characters. For sessions that contain other storage system types, the
session name can be up to 250 alphanumeric characters. The default name for a new session is
newsession.

Site x Location
For each site that is in the session, select the location for the site or None. The site location, if
available, is set by storage system on the Storage Systems page.

You can associate a location with each storage system and each site in a session. This site
awareness ensures that you can select only storage systems that have either a matching site
location for each role, or have no defined location when you add copy sets to a session.

Session image
Shows an image that represents the session. The session image is displayed when you select a
session type. The image is a visual aid to help you create your session.
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This image shows the number of roles in the session and how the roles are distributed between
the sites. The arrows indicate the type of copy between roles:

- Straight arrows = synchronous replication
- Straight arrows with an asynchronous replication symbol = asynchronous replication
« Lightning bolts = FlashCopy replication

If you selected a location for the sites that are in the session, the sites are labeled with the site
location. If you did not select site locations, the sites are labeled with Site x, where x is the
site number. You can hover the mouse pointer over the site location to view the text in a larger
format.

d) Click OK.

e) If the session was successfully created, click Launch Add Copy Sets Wizard and continue to the
next step.

If the session was not created, see the displayed message text to fix the problem.
2. Follow these steps to add copy sets to the session:

a) In the Add Copy Sets wizard, enter the following information for the choose volume pages. The field
names that are displayed depend on the storage system type. When you complete the information
on each page, click Next.

Storage system
Select a storage system. If the volume role has a site location that is assigned to it, you can
select a storage system that is assigned to the same location as the role. Or you can select a
storage system that is not assigned to a location. Storage systems that have a location are listed
under the location. Storage systems that do not have a location are listed under None. If the
role does not have a site location, you can select any storage system.

Logical storage system, I/0 Group, or Pool
Select a logical subsystem (LSS), I/O group, or pool.
Volume

Select one volume or all volumes. The volumes are limited to the volumes within the LSS, I/0
group, or pool that you selected.

The use of extent space-efficient volumes in volume roles depends on the capabilities of the
storage system.

Session image
Shows an image that represents the session in which the role for which you are selecting
volumes is highlighted. This image shows how many roles are in the session and how the roles
are distributed between the sites.

Volume Details
Shows information about the selected volume, including the volume name, full name, type,
capacity, and whether the volume is protected and space-efficient.

Use a CSV file to import copy sets
Select this option to import copy sets from a comma-separated value (CSV) file, click Use a CSV

file to import copy sets. Type the full path name of the CSV file or click Browse to select the
CSV file.

b) On the Select Copy Sets page, select from the following options and click Next:

Select All

Click this button to select all of the copy sets in the table.
Deselect All

Click this button to clear all of the copy sets in the table.

Add More
Click this button to add another copy set to the list of copy sets to be created.

When you click Add More, you are returned to the Choose Hostl page of the wizard. On this
page, the Storage system and Logical storage system, I/0 Group, or Pool lists are populated
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with the values from the previously selected copy set. Repeat the previous steps to complete
the choose volume pages and add more copy sets.

Selection check boxes
Select one or more copy sets that you want to create.

Host 1
Lists the volume IDs that are associated with the Host1 role. You can click the link to display
information about the volume, including the full name, type, capacity, and whether the volume
is protected and space efficient.

Copy Set
Displays the copy set information for the specified copy sets and any warning or error messages
that are associated with the copy set.

A warning or icon next to the Show button indicates that you cannot create a copy set for the
H1 volume. Click Show to view the message.

¢) On the Confirm page, the number of copy sets to be added is displayed. Click Next.

d) A progress bar is displayed. When the copy sets are added, review the results and click Finish.
3. Follow these steps to add properties for the session:

a) On the Sessions page, select the session.

b) From the Session Actions list, select View/Modify > Properties.

c) In the View/Modify Properties notebook, select the options that you want. For a description of the
options, see “Viewing session properties” on page 239.

d) Click OK.

Creating a Global Mirror session and adding copy sets

A Global Mirror session is a method of asynchronous, remote data replication between two sites that are
over 300 KM apart.

To add a Global Mirror session, you create the session, add copy sets to the session, and then select the
properties for the session.

1. Follow these steps to create a Global Mirror session:
a) In the menu bar, click Sessions.
b) On the Sessions page, click Create Session.
c) In the Create Session window, select the following options:

Hardware type
Select the type of storage system for the session:

- DS8000

« FlashSystem/IBM Spectrum Virtualize
= SAN Volume Controller

« FlashSystem/IBM Spectrum Accelerate

Session type
Select a Global Mirror session type.

Session name
Enter a name to identify the session.

Note: For sessions that contain a SAN Volume Controller or FlashSystem/IBM Spectrum
Virtualize storage system, it is suggested that you create a session name that contains 15
alphanumeric characters or less. By doing so, the consistency group name that is created on
the hardware matches the session name. Session names with more than 15 characters cause a
random consistency group name to be generated on the hardware.
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For sessions that contain a FlashSystem/IBM Spectrum Accelerate, the session name can be
up to 58 alphanumeric characters. For sessions that contain other storage system types, the
session name can be up to 250 alphanumeric characters. The default name for a new session is
newsession.

Site x Location
For each site that is in the session, select the location for the site or None. The site location, if
available, is set by storage system on the Storage Systems page.

You can associate a location with each storage system and each site in a session. This site
awareness ensures that you can select only storage systems that have either a matching site
location for each role, or have no defined location when you add copy sets to a session.

Session image
Shows an image that represents the session. The session image is displayed when you select a
session type. The image is a visual aid to help you create your session.

This image shows the number of roles in the session and how the roles are distributed between
the sites. The arrows indicate the type of copy between roles:

- Straight arrows = synchronous replication
- Straight arrows with an asynchronous replication symbol = asynchronous replication
« Lightning bolts = FlashCopy replication

If you selected a location for the sites that are in the session, the sites are labeled with the site
location. If you did not select site locations, the sites are labeled with Site x, where x is the
site number. You can hover the mouse pointer over the site location to view the text in a larger
format.

d) Click OK.

e) If the session was successfully created, click Launch Add Copy Sets Wizard and continue to the
next step.

If the session was not created, refer to the displayed message text to fix the problem.
2. Follow these steps to add copy sets to the session:

a) In the Add Copy Sets wizard, enter the following information for the choose volume pages. The field
names that are displayed depend on the storage system type. When you complete the information
on each page, click Next.

Storage system
Select a storage system. If the volume role has a site location that is assigned to it, you can
select a storage system that is assigned to the same location as the role. Or you can select a
storage system that is not assigned to a location. Storage systems that have a location are listed
under the location. Storage systems that do not have a location are listed under None. If the
role does not have a site location, you can select any storage system.

Logical storage system, I/0 Group, or Pool
Select a logical subsystem (LSS), I/O group, or pool.

Volume
Select one volume or all volumes. The volumes are limited to the volumes within the LSS, I/0
group, or pool that you selected.

The use of extent space-efficient volumes in volume roles depends on the capabilities of the
storage system.

Session image
Shows an image that represents the session in which the role for which you are selecting
volumes is highlighted. This image shows how many roles are in the session and how the roles
are distributed between the sites.

Volume Details
Shows information about the selected volume, including the volume name, full name, type,
capacity, and whether the volume is protected and space-efficient.
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Use a CSV file to import copy sets
Select this option to import copy sets from a comma-separated value (CSV) file, click Use a CSV
file to import copy sets. Type the full path name of the CSV file or click Browse to select the
CSV file.

b) On the Select Copy Sets page, select from the following options and click Next:
Select All
Click this button to select all of the copy sets in the table.

Deselect All
Click this button to clear all of the copy sets in the table.

Add More
Click this button to add another copy set to the list of copy sets to be created.

When you click Add More, you are returned to the Choose Hostl page of the wizard. On this
page, the Storage system and Logical storage system, I/0 Group, or Pool lists are populated
with the values from the previously selected copy set. Repeat the previous steps to complete
the choose volume pages and add more copy sets.

Selection check boxes
Select one or more copy sets that you want to create.

Host 1
Lists the volume IDs that are associated with the Host1 role. You can click the link to display
information about the volume, including the full name, type, capacity, and whether the volume
is protected and space efficient.

Copy Set
Displays the copy set information for the specified copy sets and any warning or error messages
that are associated with the copy set.

A warning or icon next to the Show button indicates that you cannot create a copy set for the
H1 volume. Click Show to view the message.

c) On the Confirm page, the number of copy sets to be added is displayed. Click Next.

d) A progress bar is displayed. When the copy sets are added, review the results and click Finish.
3. Follow these steps to add properties for the session:

a) On the Sessions page, select the session.

b) From the Session Actions list, select View/Modify > Properties.

c) In the View/Modify Properties notebook, select the options that you want. For a description of the
options, see “Viewing session properties” on page 239.

d) Click OK.

Creating a Metro Global Mirror session and adding copy sets

A Metro Global Mirror session is a method of continuous, remote data replication that operates between
three sites of varying distances apart. Metro Global Mirror combines Metro Mirror synchronous copy and
Global Mirror asynchronous copy into a single session, where the Metro Mirror target is the Global Mirror
source.

To add a Metro Global Mirror session, you create the session, add copy sets to the session, and then
select the properties for the session.

1. Follow these steps to create a Metro Global Mirror session:
a) In the menu bar, click Sessions.
b) On the Sessions page, click Create Session.
¢) In the Create Session window, select the following options:

Hardware type
Select the hardware type DS8000.
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Session type
Select a Metro Global Mirror session type.

Session name
Enter a name to identify the session. The session name can be up to 250 alphanumeric
characters. The default name for a new session is newsession.

Site x Location
For each site that is in the session, select the location for the site or None. The site location, if
available, is set by storage system on the Storage Systems page.

You can associate a location with each storage system and each site in a session. This site
awareness ensures that you can select only storage systems that have either a matching site
location for each role or have no defined location when you add copy sets to a session.

Session image
Shows an image that represents the session. The session image is displayed when you select a
session type. The image is a visual aid to help you create your session.

This image shows the number of roles in the session and how the roles are distributed between
the sites. The arrows indicate the type of copy between roles:

« Straight arrows = synchronous replication
- Straight arrows with an asynchronous replication symbol = asynchronous replication
- Lightning bolts = FlashCopy replication

If you selected a location for the sites that are in the session, the sites are labeled with the site
location. If you did not select site locations, the sites are labeled with Site x, where x is the
site number. You can hover the mouse pointer over the site location to view the text in a larger
format.

d) Click OK.

e) If the session was successfully created, click Launch Add Copy Sets Wizard and continue to the
next step.

If the session was not created, refer to the displayed message text to fix the problem.
2. Follow these steps to add copy sets to the session:

a) In the Add Copy Sets wizard, enter the following information for the choose volume pages. The field
names that are displayed depend on the storage system type. When you complete the information
on each page, click Next.

Storage system
Select a storage system. If the volume role has a site location that is assigned to it, you can
select a storage system that is assigned to the same location as the role or a storage system
that is not assigned to a location. Storage systems that have a location are listed under the
location. Storage systems that do not have a location are listed under None. If the role does not
have a site location, you can select any storage system.

Logical storage system
Select a logical subsystem (LSS).

Volume
Select one volume or all volumes. The volumes are limited to the volumes within the LSS, I/0
group, or pool that you selected.

The use of extent space-efficient volumes in volume roles is dependent on the capabilities of
the storage system.

Session image
Shows an image that represents the session in which the role for which you are selecting
volumes is highlighted. This image shows how many roles are in the session and how the roles
are distributed between the sites.

Volume Details
Shows information about the selected volume, including the volume name, full name, type,
capacity, and whether the volume is protected and space-efficient.
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Use a CSV file to import copy sets
Select this option to import copy sets from a comma-separated value (CSV) file. Click Browse to
select the CSV file.

b) On the Select Copy Sets page, select from the following options and click Next:

Select All

Click this button to select all of the copy sets in the table.
Deselect All

Click this button to clear all of the copy sets in the table.
Add More

Click this button to add another copy set to the list of copy sets to be created.

When you click Add More, you are returned to the Choose Hostl page of the wizard. On this
page, the Storage system and Logical storage system, I/0 Group, or Pool lists are populated
with the values from the previously selected copy set. Repeat the previous steps to complete
the choose volume pages and add additional copy sets.

Selection check boxes
Select one or more copy sets that you want to create.

Host 1
Lists the volume IDs that are associated with the Host1 role. You can click the link to display
information about the volume, including the full name, type, capacity, and whether the volume
is protected and space efficient.

Copy Set
Displays the copy set information for the specified copy sets and any warning or error messages
that are associated with the copy set.

A warning or icon next to the Show button indicates that you cannot create a copy set for the
H1 volume. Click Show to view the message.

c) On the Confirm page, the number of copy sets to be added is displayed. Click Next.

d) A progress bar is displayed. When the copy sets are added, review the results and click Finish.
3. Follow these steps to add properties for the session:

a) On the Sessions page, select the session.

b) From the Session Actions list, select View/Modify > Properties.

c) In the View/Modify Properties notebook, select the options that you want. For a description of the
options, see “Viewing session properties” on page 239.

d) Click OK.

Creating a Safeguarded Copy session and adding copy sets

Safeguarded Copy sessions capture many point-in-time images of a production environment with
optimized capacity usage.

You can create a Safeguarded Copy session to capture multiple point-in-time images of a set of
production volumes to prevent them from being compromised, either accidentally or deliberately.

You cannot create Safeguarded Copy sessions for IBM Spectrum Virtualize, the sessions are automatically
created.

Note: The Safeguarded Copy session should not contain both the Metro Mirror source and target volumes.

To add a Safeguarded Copy session, you create the session, add copy sets to the session, and then select
the properties for the session.

1. Follow these steps to create a Safeguarded Copy session:
a) In the menu bar, click Sessions.
b) On the Sessions page, click Create Session.
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¢) In the Create Session window, select the following options:

Hardware type
Select the type of storage system for the session:

Note: Safeguarded Copy sessions are currently only available on the DS8000 storage system.

Session type
Select Safeguarded Copy.

Session name
Enter a name to identify the session.

The session name can be up to 250 alphanumeric characters. The default name for a new
session is newsession.

Site 1 Location
For each site that is in the session, select the location for the site or None. The site location, if
available, is set by storage system on the Storage Systems page.

You can associate a location with each storage system and each site in a session. This site
awareness ensures that you can select only storage systems that have either a matching site
location for each role or have no defined location when you add copy sets to a session.

d) Click OK.

e) If the session was successfully created, click Launch Add Copy Sets Wizard and continue to the
next step.

If the session was not created, refer to the displayed message text to fix the problem.
2. Follow these steps to add copy sets to the session:

a) On the Select Hostl page of the Add Copy Sets wizard, complete the following information.
The field names that are displayed depend on the storage system type. When you complete the
information, click Next.

Note: Only storage systems that support Safeguarded Copy are displayed in the drop down for
selection.

Storage system
Select a storage system. If the volume role has a site location that is assigned to it, you can
select a storage system that is assigned to the same location as the role or a storage system
that is not assigned to a location. Storage systems that have a location are listed under the
location. Storage systems that do not have a location are listed under None. If the role does not
have a site location, you can select any storage system.

Logical storage system
Select a logical subsystem (LSS).

Volume
Select one volume or all volumes. The volumes are limited to the volumes within the LSS that
you selected.

The use of extent space-efficient volumes in volume roles depends on the capabilities of the
storage system.

Note: Safeguarded capacity needs to added on the DS8000 storage system for each source that
you want to use.

Session image
Shows an image that represents the session in which the role for which you are selecting
volumes is highlighted. This image shows how many roles are in the session and how the roles
are distributed between the sites.

Volume Details
Shows information about the selected volume, including the volume name, full name, type,
capacity, and whether the volume is protected and space-efficient.
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Use a CSV file to import copy sets
Select this option to import copy sets from a comma-separated value (CSV) file. Click Browse to
select the CSV file.

Note: If a copy set is added to a session such that the source volume already contains backups,
those backups will be assimilated into that session regardless of the session state. Therefore,
backups might be assimilated into a session in the defined state, which causes the session to
change to the protected state if valid backups are found on the newly added volume.

b) On the Choose Recoverl page, select the target storage system, LSS, and volume. Click Next.

Note: Recovery volumes must reside on an even-numbered or odd-numbered LSS, depending
on the location of the source volume. If a source volume is on an even-numbered LSS, then

its recovery volume must reside on an even-numbered LSS. If the source volume is on an odd-
numbered LSS, then its recovery volume must reside on an odd-numbered LSS.

¢) On the Select Copy Sets page, select from the following options and click Next:

Select All

Click this button to select all of the copy sets in the table.
Deselect All

Click this button to clear all of the copy sets in the table.
Add More

Click this button to add another copy set to the list of copy sets to be created.

When you click Add More, you are returned to the Choose Host1 page of the wizard. On this
page, the Storage system and Logical storage system lists are populated with the values from
the previously selected copy set. Repeat the previous steps to complete the Choose Host1 and
Choose Recoverl pages and add more copy sets.

Selection check boxes
Select one or more copy sets that you want to create.

Host 1
Lists the volume IDs that are associated with the Host1 role. You can click the link to display
information about the volume, including the full name, type, capacity, and whether the volume
is protected and space efficient.

Copy Set
Displays the copy set information for the specified copy sets and any warning or error messages
that are associated with the copy set.

A warning or icon next to the Show button indicates that you cannot create a copy set for the
H1 volume. Click Show to view the message.

d) On the Confirm page, the number of copy sets to be added is displayed. Click Next.

e) A progress bar is displayed. When the copy sets are added, review the results and click Finish.
3. Follow these steps to add properties for the session:

a) On the Sessions page, select the session.

b) From the Session Actions list, select View/Modify > Properties.

c) In the View/Modify Properties notebook, select the options that you want. For a description of the
options, see “Viewing session properties” on page 239.

d) Click OK.

Creating a Migration session and adding copy sets
A Migration session can be used to migrate data from one set of volumes to another, regardless of size.

To add a Migration session, you create the session, add copy sets to the session, and then select the
properties for the session.

1. Follow these steps to create a Migration session:
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a) In the menu bar, click Sessions.
b) On the Sessions page, click Create Session.
¢) In the Create Session window, select the following options:

Hardware type
Select the type of storage system for the session:

- DS8000, DS6000, ESS
Note: The Migration session type is currently only available for DS8000 storage systems.

Session type
Select the Migration session type.

Session nhame
Enter a name to identify the session.

Site x Location
For each site that is in the session, select the location for the site or None. The site location, if
available, is set by storage system on the Storage Systems page.

You can associate a location with each storage system and each site in a session. This site
awareness ensures that you can select only storage systems that have either a matching site
location for each role, or have no defined location when you add copy sets to a session.

Session image
Shows an image that represents the session. The session image is displayed when you select a
session type. The image is a visual aid to help you create your session.

This image shows the number of roles in the session and how the roles are distributed between
the sites. The arrows indicate the type of copy between roles:

« Straight arrows = synchronous replication
- Straight arrows with an asynchronous replication symbol = asynchronous replication
« Lightning bolts = FlashCopy replication

If you selected a location for the sites that are in the session, the sites are labeled with the site
location. If you did not select site locations, the sites are labeled with Site x, where x is the
site number. You can hover the mouse pointer over the site location to view the text in a larger
format.

d) Click OK.

e) If the session was successfully created, click Launch Add Copy Sets Wizard and continue to the
next step.

If the session was not created, see the displayed message text to fix the problem.
2. Follow these steps to add copy sets to the session:

a) In the Add Copy Sets wizard, enter the following information for the choose volume pages.
The field names that are displayed depend on the storage system type. When you complete the
information on each page, click Next.

Storage system
Select a storage system. If the volume role has a site location that is assigned to it, you can
select a storage system that is assigned to the same location as the role. Or you can select a
storage system that is not assigned to a location. Storage systems that have a location are listed
under the location. Storage systems that do not have a location are listed under None. If the
role does not have a site location, you can select any storage system.

Logical storage system, I/0 Group, or Pool
Select a logical subsystem (LSS), I/0 group, or pool.

Volume
Select one volume or all volumes. The volumes are limited to the volumes within the LSS, I/0
group, or pool that you selected.

Chapter 7. Setting up data replication 193



The use of extent space-efficient volumes in volume roles depends on the capabilities of the
storage system.

Session image
Shows an image that represents the session in which the role for which you are selecting
volumes is highlighted. This image shows how many roles are in the session and how the roles
are distributed between the sites.

Volume Details
Shows information about the selected volume, including the volume name, full name, type,
capacity, and whether the volume is protected and space-efficient.

Use a CSV file to import copy sets
Select this option to import copy sets from a comma-separated value (CSV) file, click Use a CSV
file to import copy sets. Type the full path name of the CSV file or click Browse to select the
CSV file.

b) Repeat step “2.a” on page 193 for Host 2.

¢) On the Select Copy Sets page, select from the following options and click Next:

Select All

Click this button to select all of the copy sets in the table.
Deselect All

Click this button to clear all of the copy sets in the table.
Add More

Click this button to add another copy set to the list of copy sets to be created.

When you click Add More, you are returned to the Choose Host1 page of the wizard. On this
page, the Storage system and Logical storage system, I/0 Group, or Pool lists are populated
with the values from the previously selected copy set. Repeat the previous steps to complete
the choose volume pages and add more copy sets.

Selection check boxes
Select one or more copy sets that you want to create.

Host 1
Lists the volume IDs that are associated with the Host1 role. You can click the link to display
information about the volume, including the full name, type, capacity, and whether the volume
is protected and space efficient.

Copy Set
Displays the copy set information for the specified copy sets and any warning or error messages
that are associated with the copy set.

A warning or icon next to the Show button indicates that you cannot create a copy set for the
H1 volume. Click Show to view the message.

d) On the Confirm page, the number of copy sets to be added is displayed. Click Next.

e) A progress bar is displayed. When the copy sets are added, review the results and click Finish.
3. Follow these steps to add properties for the session:

a) On the Sessions page, select the session.

b) From the Session Actions list, select View/Modify > Properties.

c) In the View/Modify Properties notebook, select the options that you want. For a description of the
options, see “Viewing session properties” on page 239.

d) Click OK.

Creating an ESE Sizer session and adding copy sets

The ESE Sizer session supports analyzing space requirements for DS8000 Extent Space Efficient (ESE)
FlashCopy and Safeguarded Copy.

To add a ESE Sizer session, you create the session and then add copy sets to the session.
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1. Follow these steps to create a ESE Sizer session:
a) In the menu bar, click Sessions.
b) On the Sessions page, click Create Session.
¢) In the Create Session window, select the following options:

Hardware type
Select IBM DS8000.

Session type
Select ESESizer.

Session name
Enter a name to identify the session. The session name can be up to 58 alphanumeric
characters. The default name for a new session is newsession.

Site 1 Location
For each site that is in the session, select the location for the site or None. The site location, if
available, is set by storage system on the Storage Systems page.

You can associate a location with each storage system and each site in a session. This site
awareness ensures that only storage systems that have either a matching site location for each
role or have no defined location are displayed in the copy set wizard.

Session image
Shows an image that represents the session. The session image is displayed when you select a
session type. The image is a visual aid to help you create your session.

If you selected a location for the site that is in the session, the site is labeled with the site
location. If you did not select site locations, the sites are labeled with Site x, where x is the
site number. You can hover the mouse pointer over the site location to view the text in a larger
format.

d) Click OK.

e) If the session was successfully created, click Launch Add Copy Sets Wizard and continue to the
next step.

If the session was not created, refer to the displayed message text to fix the problem.
2. Follow these steps to add copy sets to the session:

a) From the Hostl storage system list, select the storage system that contains the volumes that you
want to add.

If the H1 role has an assigned location, only those storage systems that have the same location as
the H1 role, or storage systems that do not have a set location, are displayed for selection.

If the H1 role does not have an assigned location, all storage systems are displayed for selection.

Storage systems that are assigned to a location are listed under the location name. Storage systems
that are not assigned to a location are listed under the None. column.

b) From the Host1 LSS list, select the LSS that contains the volumes.

c) From the Host1 volume list, select the volumes.
To select multiple volumes, press Ctrl or Shift and click the volumes in the list.

d) If you want to import copy sets from a comma-separated value (CSV) file, click Use a CSV file to
import copy sets. Click Browse to select the CSV file and click Next.

e) On the Matching Results page, click Next if the match was successful.
f) On the Select Copy Sets page, select from the following options and click Next.

Select All
Click this button to select all of the copy sets in the table.

Deselect All
Click this button to clear all of the copy sets in the table.
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Add More
Click this button to add another copy set to the list of copy sets to be created.

When you click Add More, you are returned to the Choose Hostl page of the wizard. The lists
on this page are populated with the values from the previously selected copy set. Repeat the
previous steps to complete the Choose Hostl page and add more copy sets.

Selection check boxes
Select one or more copy sets that you want to create.

Host 1
Lists the volume IDs that are associated with the Host1 role. You can click the link to display
information about the volume, including the full name, type, capacity, and whether the volume
is protected and space efficient.

Copy Set
Displays the copy set information for the specified copy sets and any warning or error messages
that are associated with the copy set.

A warning or icon next to the Show button indicates that you cannot create a copy set for the
H1 volume. Click Show to view the message.

g) On the Confirm page, the number of copy sets to be added is displayed. Click Next.
h) A progress bar is displayed. When the copy sets are added, review the results and click Finish.

If you want to add a description for the session, select the session on the Sessions page. From the
Session Actions list, select View/Modify > Properties.

Managing space

You have methods for managing space in Copy Services Manager, including the Reflash Aftex
Recover option and the Free Journal Space command for sessions that contain Global Mirror
relationships. You can also release space for FlashCopy targets after you terminate a session with space-
efficient volumes.

The following two methods can assist with space management in Copy Services Manager on DS8000
storage systems for sessions that contain Global Mirror relationships:

Reflash After Recover option
Keeps a consistent copy of the data during a resync from the original site. This option is available
when you create sessions and add properties to them. If you do not set the Reflash Aftexr
Recover option, then the space is not used up.

See “Using the Reflash After Recover option” on page 197 for more information.

Free Journal Space command
This command is available after a recover operation is performed for Global Mirror relationships.
When the Reflash Aftex Recover option is set, a FlashCopy relationship exists on the hardware.
If the journal volume is a space-efficient volume, then the resync process might take up unnecessary
back-end space, and fill up the repository. Use this command to delete the FlashCopy relationships
from the hardware, which frees up the space.

See “Using the Free Journal Space command” on page 197 for more information.

Note: The two options listed previously are not limited to Extent Space Efficient (ESE) volumes.

In addition, you have another option for managing space for any DS8000 sessions with FlashCopy
relationships:

Releasing space if a Texminate or Remove Copy Set action does not automatically release the
space:
Starting with V6.2.7, when you issue a Texrminate command to the entire practice session, the
session no longer automatically frees up space for FlashCopy targets for which the background copy
has completed. This design helps prevent an accidental deletion of the FlashCopy target data if the
copy had completed.
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If you need to free the space after a Texrminate, you can use the following DSCLI command to
release the back-end repository:

dscli > init<fb|ckd>vol -action releasespace <volid>

where <volid> is the 4 digit volume ID.

Attention: The Copy Services Manager TexrminateHxIx command will free the space even if
the background copy has completed. If you issue the init or TexminateHxIx commands to
free up the space, the data will no longer be accessible.

Using the Reflash After Recover option

You can use the Reflash Aftex Recover option from either the Copy Services Manager GUI or CLI.

Using the Reflash After Recover option from the GUI

To choose the Reflash After Recover option from the GUI, complete the following steps:

1. Create a Copy Services Manager session and add copy sets to the session.
2. On the Journal Options tab, select Reflash After Recover.
After you set this option, a consistent copy of the data is kept during a resync from the original site.

However, this action uses up journal space. Therefore, to free up journal space after the recover operation,
see “Using the Free Journal Space command” on page 197.

Using the Reflash After Recover option from the CLI

You can also set the Reflash Aftexr Recover option from the CLI.

« Tosetthe Reflash After Recover option through the CLI, issue one of the following commands:
chsess -reflash yes <sessionName>
chsess -reflash no <sessionName>

For more information, see the chsess command help topic in the Copy Services Manager online help
documentation at https://www.ibm.com/support/knowledgecenter/SSESK4.

After you set this option, a consistent copy of the data is kept during a resync from the original site.
However, this action uses up journal space. Therefore, to free up journal space after the recover operation,
see “Using the Free Journal Space command” on page 197.

Using the Free Journal Space command

You can use the Free Journal Space command from either the Copy Services Manager GUI or CLI.

Using the Free Journal Space command from the GUI
To use the Free Journal Space command from the GUI, complete the following steps:

1. Log in to the Copy Services Manager GUI as a user with administrative privileges.
2. On the Sessions details page, select a session for which you want to free up the journal space.
3. Click Session Actions > Commands > Free Journal Space.

Note: The Free Journal Space command is only available after a recover operation is issued on
the Global Mirror leg of the selected session.

The FlashCopy relationships are deleted from the hardware, which frees up the journal space.

Using the Free Journal Space command from the CLI
You can also issue the Free Journal Space command from the CLI.

« To free the journal space through the CLI, issue the following command:
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cmdsess -action free_journal_space <sessionName>
For more information, see the cmdsess command help topic in the Copy Services Manager online help
documentation at https://www.ibm.com/support/knowledgecenter/SSESK4.

The FlashCopy relationships are deleted from the hardware, which frees up the journal space.

Working with user-defined consistency groups

A consistency group is a set of target volumes that are updated to preserve write order, and are therefore
recoverable. You can define the name of a consistency group and use that name to assign multiple Global
Mirror or Metro Global Mirror sessions to the same consistency group.

For Global Mirror role pairs on Copy Services Manager sessions with DS8000 volumes, you can define a
2-digit hex number that represents the Global Mirror session ID used on the DS8000 storage system. You
can use this ID for the following reasons:

- To ensure that a Copy Services Manager session uses only the specified session ID, when it is
managing a Global Mirror session on a DS8000 storage system. If not specified, Copy Services Manager
automatically picks a session ID that is not currently in use.

« To assign multiple Global Mirror role pairs in separate sessions to use the same DS8000 session ID.
DS8000 allows only a single session ID per logical subsystem (LSS). By setting the same session ID on
multiple Copy Services Manager sessions that use the same DS8000 storage system, you can manage
each Copy Services Manager session separately (suspend and recover each individually). You can also
go beyond the hardware limits on the number of Global Mirror sessions that DS8000 can manage.

When a Suspend command is issued to a session that is sharing the consistency group ID, Copy
Services Manager suspends the volumes in that session but automatically restarts any other sessions
that use the same session ID. If you want to suspend all the sessions with the Suspend command,
specify the following property in the server properties:

csm.server.suspend_all_shared_gm_sessions=true

Note: For more information, see “rmserver.properties file” on page 326.

For Metro Mirror role pairs on Copy Services Manager session with DS8000 volumes, you can define a
consistency group name of up to 12 alphanumeric characters. You can use the consistency group name
for the following reasons:

« When multiple sessions with HyperSwap or Hardened Freeze configurations, have the same user-
defined consistency group name on a role pair, and the sessions are associated to the same z/0S
Sysplex, Copy Services Manager loads the HyperSwap or Hardened Freeze configuration onto the
Sysplex. Copy Services Manager uses all the volumes across all sessions that share user-defined
consistency group name. You can manage HyperSwap across multiple replication configurations that
include Metro Mirror and Metro Global Mirror.

« For sessions that do not have HyperSwap or Hardened Freeze that is enabled, the user-defined
consistency group name can be used to ensure Metro Mirror consistency across multiple sessions.
When a planned or unplanned freeze occurs, Copy Services Manager issues a hardware freeze
command across all sessions that have the same user-defined consistency group name. The Release
I/0 command is issued after the hardware freeze command has been issued.

Follow these steps to assign a new user-defined consistency group name for one or more Global Mirror or
Metro Global Mirror sessions:

1. In the menu bar, click Sessions.

2. On the Sessions page, select one or more sessions.

3. From the Session Actions list, select View/Modify > Set Consistency Group Name.

4

. In the Set Consistency Group Name window, enter the new consistency group name that you want to
assign to each role pair.

5. Click OK.
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Completing session administration tasks

Use session commands to complete session tasks such as starting, stopping, suspending, or terminating
sessions.

You can issue session commands by using the GUI, as described in this topic, or you can use the CLI to
issue commands. For a description of the CLI session commands, see the IBM Copy Services Manager
online product documentation (http://www-01.ibm.com/support/knowledgecenter/SSESK4).

To issue a command for a session, complete the following steps:

1. In the menu bar, click Sessions.
2. On the Sessions page, select the session for which you want to issue a command.
3. Click Session Actions > Commands.

If the session is a single-target session type, all available commands are displayed under Commands.
Click the command that you want to issue.

If the session is a multi-target session type, some of the commands are grouped by overall function.
For example, Start, Stop, or Suspend. When you click a command, a window is displayed that
provides specific commands for that function. For example, for Metro Mirror - Metro Mirror sessions, if
you select Start, a window is displayed that contains the specific start commands that you can select.
Select the command that you want, review the message text for that command, and then click Yes if
you want the command to run.

Setting a user-defined group name for one or more sessions

You can assign one or more sessions to a user-defined group.

If you assign one or more sessions into defined groups, you can easily sort them.
Follow these steps to set a user-defined name for one or more sessions:
1. In the menu bar, click Sessions.

2. On the Sessions page, click the session name to select one or more sessions that you want to assign to
a group.

3. Select Session Actions > View/Modify > Set User-Defined Group Name.

Note: You can also set a group name from the Session details page by selecting a session, then
clicking Session Actions > View/Modify > View Details. Then, you can follow the actions that start at
step 3.

4. In the Set User-Defined Group Name window, you can either select an existing group name from the
pull-down menu, or enter a new group name to assign to the selected session or sessions.

Note: Group names must not exceed 250 alphanumeric characters.
5. Click OK.

A user-defined group name is assigned to the selected session or sessions.

Setting a name for a user-defined consistency group

You can set a name to a user-defined consistency group.

You can set a name to a user-defined consistency group.

For Metro Mirror session types, adding a name for a user-defined consistency group provides the
following advantages:

« Ability to load multiple sessions under a single HyperSwap configuration for a Sysplex.
« Ability to suspended multiple role pairs across sessions consistently.

For Global Mirror sessions, adding a user-defined consistency group name enables multiple role pairs
across different sessions to share the same Global Mirror Master session ID. With the same Global Mirror

Chapter 7. Setting up data replication 199


http://www-01.ibm.com/support/knowledgecenter/SSESK4
http://www-01.ibm.com/support/knowledgecenter/SSESK4

master session ID you can manage multiple Global Mirror environments separately, without exceeding the
limits on the number of master sessions allowed on the DS8000.

For multi-target Metro Mirror-Metro Mirror and 4-Site Metro Mirror-Metro Mirror session types, adding
a user-defined consistency group name ensures that the configuration name is unique across other
sessions. The configuration name is added in the Input/Output Supervisor (I0S) when a HyperSwap or
Hardened Freeze configuration is loaded on z/OS.

Follow these steps to set a name to a user-defined consistency group:

1. In the menu bar, click Sessions.

2. On the Sessions page, click the session name to select one or more sessions that you want to assign to
a group.

3. Select Session Actions > View/Modify > Set Consistency Group Names.

Note: You can also set a group name from the Session details page by selecting a session, then
clicking Session Actions > View/Modify > View Details. Then, you can follow the actions that start at
step 3.

4. In the Set Consistency Group Name window, you can either select an existing group name from the
pull-down menu, or enter a new group name to assign to the selected session or sessions.

Note: Group names must not exceed 250 alphanumeric characters.
5. Click OK.

A user-defined consistency group name is assigned to the selected session or sessions.

Removing a user-defined group name from one or more sessions

You can remove the group name assignment from one or more sessions.

Follow these steps to remove the group name that is assigned to one or more sessions:
1. In the menu bar, click Sessions.
2. On the Sessions page, select the session or sessions that you want to remove from an assigned group.
3. Select Session Actions > View/Modify > Set User-Defined Group Name.
Note: You can also remove a group name from the Session details page by selecting a session, then

clicking Session Actions > View/Modify > View Details. Then, you can follow the actions that start at
step 3.

4. In the Set User-Defined Group Name window, use the pull-down menu to select No group name
defined to remove the existing group name from the selected session or sessions.

5. Click OK.

The group name assignment is removed from the selected session or sessions.

Restore FlashCopy session

A FlashCopy session can be restored such that the direction of a persistent FlashCopy relationship is
reversed.

In performing a FlashCopy restore, the volume that was previously defined as the target becomes the
source for the volume that was previously defined as the source (and is now the target). The changed data
is copied to the volume that was previously defined as the source.

Note: Copy Services Manager can currently only perform a FlashCopy session restore operation on
DS8000 and SAN Volume Controller systems.

You can restore a FlashCopy session if you want to restore a source volume (Volume A) to the point in
time of the last flash operation. In effect, you are restoring the data on the source volume to the time of
the last flash, which overwrites any updates since the last flash.

For DS8000 only: If the background copy process of a FlashCopy operation is not complete, a Fast
Reverse Restore is done, which causes the original target volume to be unusable. Also, if the incremental
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option is not specified for the session, a Fast Reverse Restore is done. The Fast Reverse Restore operation
does not exist for SAN Volume Controller.

There might be circumstances when you want to restore an original FlashCopy session. For example,
suppose that you create a FlashCopy relationship between source volume A and target volume B. Data

loss occurs on source volume A. To keep applications running, you can restore the FlashCopy session so
that volume B is copied to volume A.

Restoring a FlashCopy session
You can restore a FlashCopy session on a storage system.

The restore command restores the point-in-time relationships from the target volumes to the source
volumes of the FlashCopy session, and overwrites any data on the source volumes.

Follow these steps to restore a FlashCopy session:

1. Log in to the Copy Services Manager GUI as a user with administrative privileges.
2. Click Sessions.

3. From the Sessions overview page, select the FlashCopy session that you want to restore.

Note: Copy Services Manager can currently only perform a FlashCopy session restore operation on
DS8000 and SAN Volume Controller systems.

4. Select Session Actions > Commands > Restore.

Notes:

- If Restore is not a command option, a flash operation has not been done. You must perform a flash
at least one time before you can do a restore.

« For DS8000 only: The Restore command is only available if incremental or persistent is set.
Incremental implies persistent. You can only restore if you have a persistent relationship.

The FlashCopy session is restored in the opposite direction.

When the session is in a new restored state, you can Restore it again, Flash back, or Terminate the
session.

Restoring Safeguarded Copy backups to Remote Copy source
volumes

You can integrate Safeguarded Copy with any of your existing remote copy sessions and solutions. These
remote copy sessions can be Metro Mirror - Global Mirror sessions, or three-site sessions such Metro
Mirror - Global Mirror and Global Mirror multiple-target sessions.

Starting with Copy Services Manager 6.3.0 and DS8000 9.2, you can use the Restore Backup command
to restore the source volume in the remote copy session to one of the Safeguarded Copy backups, without
a full copy. To use the Restore Backup command, you must configure a Safeguarded Copy session for a
target volume through their remote copy sessions.

To restore a Safeguarded Copy backup to the source of a different remote copy session, you must first
associate the Safeguarded Copy session to the remote copy session.

1. Follow these steps to associate a Safeguarded Copy session to a remote copy session.

a. From the Session Overview panel click the Safeguarded Copy session that you want to associate to
another session.

b. On the Session Details panel for the Safeguarded Copy session, click Session Actions >View/
Modify>Session Associations>Add/Update Associations. The Add/Update association box is
displayed.

c. Select a value for each of the following questions.
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i) Which session should be associated to this Safeguarded Copy session? - select the remote
copy session that is being used to create the Safeguarded Copy backups.

i) Which role pair in the session selected above should be associated to the session? - select
the role pair in the session that is selected in step i, where the target of role pair contains the H1
volumes of the Safeguarded Copy session.

iii) Which role in the selected role pair is the H1 volume in the Safeguarded Copy session? -
select the role in the role pair that is selected in step ii, which contains the same volumes as the
H1 volumes of the Safeguarded Copy session.

iv) Which role in the selected role pair do you want to restore from a Safeguarded backup? -
select the role in the role pair that is selected in step ii, which contains the volumes that are
restored when the Restore Backup command is issued.

Note: This must be a different role than the role selected in step iii and must be the source of
the remote copy relationship.

d. Click OK.

Note: After the Safeguarded Copy session is associated to another session, the server compares
the H1 volumes of the Safeguarded Copy session to the volumes in the role selected in step iii of
the associated session. If the volumes do not match, both the Safeguarded Copy session and the
associated session display a warning message.

After a session is associated to the Safeguarded Copy session, any recoverable backup on the
Safeguarded Copy session can be used to restore the source volume on the associated session.

2. Follow these steps to restore a backup to the volumes in the selected role on the associated session.
a. Run the Recover Backup command and in the Recover Backup dialog box, choose backup you
want to recover. This recovers the selected backup to the R1 volumes in the session.
b. Validate the R1 volumes.
Note: It is important to validate the data on the R1 volumes before you restore the production

volumes in the associated session. Ensure that the backup is not corrupted and contains the data
that is to be restored on the associated session.

c. Ensure that the associated role pair in the associated session is in a Suspended or Target
Available state.

Note: For more information on how to suspend a role pair, see commands for relevant session
types under the Sessions command section.

d. Run the Restore Backup command. The Restore Backup command appears only in the Target
Available state after a Recover Backup command is run.

The Restore Backup command does not prompt for a backup but uses the backup that is specified

on the Recover Backup command. After running the Restore Backup command, the session goes into
a Restoring state. Progress messages are displayed on the session which indicate the steps that are
being run throughout the restore process. Data is recovered to R1 and then replicated from R1 back to
the selected role in the associated role pair on the associated session.

The session automatically goes back to a Prepared state after the restore is complete. The R1 volumes
no longer have a valid copy of the backup data when the restore is complete. All data from the backup
is now on the selected role in the associated role pair on the associated session.
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Assimilate FlashCopy relationships

Copy Services Manager can assimilate FlashCopy relationships on several storage systems, including
DS8000 and those that are based on Spectrum Virtualize technology.

Assimilate FlashCopy pairs on DS8000 storage systems

Starting with Copy Services Manager 6.2.9, you can assimilate existing hardware relationships in a Copy
Services Manager FlashCopy session on DS8000 storage systems.

Copy Services Manager has a Discovexr command on the FlashCopy session type for DS8000 sessions.
When the Discover command is issued, Copy Services Manager queries the hardware for any existing
relationships on defined pairs. If a defined pair is determined to be established on the hardware, then the
pair is set to Target Available and consistent.

The Discover command behaves in the following ways:

« The Discovexr command can be run from the Defined or Target Available state. Defined pairs are set to
consistent and Target Available if a relationship is found on the hardware. However, they do not indicate
a time of the flash.

- Although discovered pairs are set consistent, the session is not able to validate that they are consistent
to the time of all other pairs in the session.

Remember: Be careful when using the feature, and keep this situation in mind if a restore has to be
performed.

« If the FlashCopy session is set with the Incremental option turned off, even if the Discover
command assimilated an incremental relationship, the flash always terminates and reflashes the
relationship.

« If the FlashCopy session is set with the Incremental option turned on, if the Discovexr command
finds an incremental relationship on the hardware for a logical subsystem (LSS), the Flash command to
the session attempts an incremental reflash for all pairs on that LSS.

- After the Discovexr command is run, if you have a situation where some pairs on an LSS were flashed
with incremental and some were not, the session still attempts an incremental reflash, which fails on
the pairs that have not been flashed with incremental.

Tip: When this situation occurs, you need to remove the copy sets that were not flashed with
incremental. You can then flash the copy sets with incremental outside the session before adding them
back in.

Assimilate FlashCopy pairs on Spectrum Virtualize based storage systems

Starting with Copy Services Manager 6.2.11, you can assimilate FlashCopy pairs for Spectrum Virtualize
based storage systems.

Important: Pairs for Spectrum Virtualize FlashCopy based sessions can only be assimilated if they are in
a consistency group. Although other Spectrum Virtualize session types can only assimilate pairs if they
are not in a consistency group, the Spectrum Virtualize FlashCopy session requires that they be in a
consistency group. This design ensures that the assimilated relationships are in the same state as the
existing FlashCopy relationships in the session, thereby preventing any issues in attempting to add the
new relationships.

Note: Because the relationships are part of a consistency group, it is assumed that the relationships are
flashed and consistent across all pairs in the session.

When the Discovexr command is issued, Copy Services Manager queries the hardware for any existing
relationships on defined pairs.

The Discover command for Spectrum Virtualize systems behaves in the following ways:
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« The Discover command can be run from the Defined, Prepared, or Target Available state. Defined pairs
are set to consistent and Target Available if a relationship is found on the hardware that is part of a
consistency group.

Note: It is assumed that the relationships are flashed and consistent.

« For DS8000 and Spectrum Virtualize systems, although discovered pairs are set consistent, the session
is not able to validate that they are consistent to the time of all other pairs in the session.

Remember: Be careful when using the feature, and keep this situation in mind if a restore has to be
performed.

- If a consistency group is not yet established for the session, the Discovexr command assimilates the
consistency group for the first pair found into the session.

« If the hardware relationship found for a pair is not part of a consistency group, the Discovexr command
fails and error message IWNR2096E is set for the pair.

« If the hardware relationship found for a pair is not in the correct state (that is, flashed), the Discover
command fails and error message IWNR2096E is set for the pair.

- If the hardware relationship found for a pair is part of a different consistency group than that
established for or assimilated into the session, the Discovexr commands fails and error message
IWNR2096E is set for the pair.

« If the FlashCopy session is set with the Incremental option turned off, even if the Discovexr command
assimilated an incremental relationship, the flash always terminates and reflashes the relationship.

Using the Metro Mirror heartbheat

This topic provides information about Metro Mirror heartbeat, including how to enable and disable the
heartbeat.

Metro Mirror heartbheat

The heartbeat is a Metro Mirror function. When the Metro Mirror heartbeat is disabled, data consistency
across multiple storage systems is not guaranteed if the Copy Services Manager management server
cannot communicate with one or more storage systems. The problem occurs as a result of the Hardware
Freeze Timeout Timer function within the storage system. If the controlling software loses connection to
a storage system, the Metro Mirror relationships that it is controlling remains established and there is

no way to freeze those pairs to create consistency across the multiple storage systems. When the freeze
times out, dependent I/0 is written to the target storage systems, which might corrupt data consistency.
Freeze refers to a Metro Mirror (peer-to-peer remote copy [PPRC]) freeze function.

When determining whether to use the Metro Mirror heartbeat, analyze your business needs. Disabling the
Metro Mirror heartbeat might result in data inconsistency. If you enable the Metro Mirror heartbeat and a
freeze occurs, your applications will be unable to write during the freeze.

Metro Mirror heartbeat is disabled by default.

Metro Mirror heartbeat is not available for Metro Mirror with HyperSwap or Metro Global Mirror with
HyperSwap.

There are two cases where lost communication between the coordination software (controller) and one or
more storage systems can result in data consistency loss:

Freeze event not detected by a disconnected storage system
Consider a situation with four storage system machines in a primary site and four in a secondary site.
One of the four storage systems on the primary loses the connection to the target site. This causes
the affected storage system to prevent any writes from occurring, for a period determined by the
Freeze timeout timer. At the same time, the affected storage controller loses communication with the
controlling software and cannot communicate the Freeze event to the software.

Unaware of the problem, the controlling software does not issue the Freeze command to the
remaining source storage systems. The freeze will stop dependent writes from being written to
connected storage systems. However, once the Freeze times out and the long-busy is terminated,
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dependent write I/Os continue to be copied from the storage systems that did not receive the Freeze
command. The Metro Mirror session remains in a state where one storage system has suspended
copying while the other three storage systems are still copying data. This state causes inconsistent
data on the target storage systems.

Freeze event detected, but unable to propagate the Freeze command to all storage systems
Consider a situation with four storage system machines in a primary site and four in a secondary site.
One of the four storage systems on the primary loses the connection to the target site. This causes the
affected storage system to issue long-busy to the applications for a period determined by the Freeze
timeout timer. At the same time, one of the remaining three source systems loses communications
with the controlling software.

The storage system that had an error writing to its target cannot communicate the Freeze event to the
controlling software. The controlling software issues the Freeze command to all but the disconnected
storage system (the one that lost communication with the software). The long-busy stops dependent

writes from being written to the connected storage systems.

However, once the Freeze times out on the frozen storage system and the long-busy is terminated,
dependent write I/Os continue to the target storage system from the source storage system that lost
communication and did not receive the Freeze command. The Metro Mirror session remains in a state
where three storage systems have suspended copying and one storage system is still copying data.
This state causes inconsistent data on the target storage systems.

Before Copy Services Manager V3.1, if the controlling software within a Metro Mirror environment
detected that a managed storage system lost its connection to its target, the controlling software stopped
all the other source systems to ensure consistency across all the targets. However, if the controlling
software lost communication with any of the source subsystems during the failure, it could not notify
those storage systems of the freeze event or ensure data consistency. The Metro Mirror heartbeat helps to
overcome this problem. In a high-availability configuration, the Metro Mirror heartbeat is continued by the
standby server after the Takeover command is issued on the standby, enabling you to perform actions on
the standby server without causing a freeze.

Copy Services Manager registers with the managed DS8000 storage system within a Metro Mirror session
when the start command is issued to the session. After this registration occurs, a constant heartbeat is
sent to the storage system. If the storage system does not receive a heartbeat from the Copy Services
Manager management server within the allotted time (a subset of lowest LSS timeout value across all
the source LSSs), the storage system initiates a freeze. If Copy Services Manager did not successfully
communicate with the storage system, it initiates a freeze on the remaining storage system after the
allotted time is expired.

Note: Avoid using the same LSS pairs for multiple Metro Mirror sessions. Metro Mirror uses a freeze
command on DS8000 storage systems to create the data-consistent point. If there are other Metro Mirror
sessions overlapping the same LSS pairs as in this session, those sessions are also suspended.

When you are using the Metro Mirror heartbeat, be aware that:

- The Metro Mirror heartbeat can cause a single point of failure: if an error occurs on just the management
server and not the storage system, a freeze might occur.

« When the Metro Mirror heartbeat timeout occurs, the storage system remains in a long busy state for
the duration of the LSS freeze timeout.

Note: If Metro Mirror heartbeat is enabled for storage systems that are connected through a HMC
connection, a connection loss might cause lost heartbeats, resulting in Freeze actions with application
I/0 impact for configured Extended Long Busy timeout.

The Metro Mirror heartbeat is supported on storage systems connected though a TCP/IP (direct connect
or HMC) connection. It is not supported on storage systems connected though a z/OS connection.
Enabling the Metro Mirror heartbeat with a z/OS connection does not fail; however, a warning message
is displayed specifying that the Metro Mirror heartbeat function does not work unless you have an IP
connection.
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If Metro Mirror heartbeat is enabled for storage systems that are connected through a TCP/IP (either
direct connect or HMC) connection and z/OS connection, and the TCP/IP connection fails, Copy Services
Manager suspends the Metro Mirror session because there is no heartbeat through the z/OS connection.

If Metro Mirror heartbeat is enabled for storage systems that are connected through a TCP/IP connection
and z/0S connection and you remove all TCP/IP connections, Copy Services Manager suspends the Metro
Mirror sessions and the applications using those volume will be in Extended Long Busy timeout until the
storage system's internal timeout timer expires. Ensure that you disable the Metro Mirror heartbeat for
all Metro Mirror sessions before removing the last TCP/IP connection to avoid the Extended Long Busy
timeout.

Enabling and disabling the Metro Mirror heartbeat

The Metro Mirror heartbeat guarantees data consistency across multiple storage systems when the Copy
Services Manager management server cannot communicate with one or more storage systems. The Metro
Mirror heartbeat is disabled by default.

To enable the Metro Mirror heartbeat, perform the following steps:

1. In the menu bar, click Settings > Advanced Tools.
2. To enable the Metro Mirror heartbeat, click Enable Heartbeat.
3. To disable the Metro Mirror heartbeat, click Disable Heartbeat.

Exporting copy set data

You can export data about all copy sets in a specific session to maintain a backup copy that can be used to
recover if you lose your session or upgrade to a different server.

Complete these steps to export the copy sets in a specific session:

1. In the menu bar, click Sessions.
2. On the Sessions page, select the session for which you want to export copy sets.

3. From the Session Actions list, select Export > Export Copy Sets. The Export Copy Sets window
displays the status of the export and a link to the exported file if the export completed.

4. Right-click the link and save the file to a local system.

Importing copy set data

You can import copy set data that was previously exported to a comma separated value (CSV) file.

Perform the following steps to import copy sets into an existing session:

1. In the menu bar, click Sessions.
2. On the Sessions page, select the session for which you want to import copy sets.

3. From the Session Actions list, select View/Modify > Add Copy Sets. The Add Copy Sets wizard is
displayed.

. Select Use a CSV file to import copy sets.

. Click Browse, select the CSV file, and then click Next.

. Verify that the matching results were successful, and then click Next.

. Select the copy sets that you want to add, and then click Next.

. Confirm the number of copy sets that you want to create, and then click Next.
. View the information on the Results page of the wizard, and then click Finish.
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Exporting historical data for Global Mirror role pairs

You can export data for a Global Mirror role pair that is in a IBM DS8000 session to a comma-separated
value (CSV) file. You can then use the data in the CSV file to analyze trends in your storage environment
that affect your recovery point objective (RPO).

Complete these steps to export data to a CSV file:

1. In the menu bar, click Sessions.
2. On the Sessions page, click the Global Mirror session for which you want to export data.
3. From the Session Actions list, select Export > Export Global Mirror Data.

4. In the Export Historical Data for Global Mirror window, complete the following information, and then
click OK:

Select the role pair
Select the role pair for the data that you want to show in the CSV file.

Select the type of data
Select the type of data that you want to export to a CSV file. Depending on the data type that you

select, the CSV file contains data about the RPO or data about logical subsystem (LSS) out-of-sync
tracks.

To better analyze trends, you can create a CSV file with one data type and then create a file with
the other data type. For example, the file that contains data for the RPO might show that the RPO
threshold is often exceeded on a particular day and time. You can then view the file that contains
data for LSS out-of-sync tracks to see whether a particular LSS or set of LSSs have high out-of-sync
track values for that day and time.

RPO
Select this option to export data for the RPO. The data that is shown in the export file includes
the average RPO for the dates that you select and information related to the formation of
consistency groups.

LSS Out-of-Sync Tracks
Select this option to export data for the out-of-sync tracks that are in the LSSs.

Start date
Select the start date for the data that you want to show in the export file.

By default, the date range maximum for RPO files is 31 days of data and the maximum for LSS
out-of-sync track files is 7 days of data.

End date
Select the end date for the data that you want to show in the export file.

After you click OK to export the file, a results window displays the status of the export and a link to the
exported file if the export completed. Download and save the file to a local system.

Exporting historical RPO data for SAN Volume Controller Global
Mirror with Change Volume sessions

You can use the GUI or the CLI to export historical RPO data for SAN Volume Controller Global Mirror with
Change Volume sessions.

You can store and export historical records for recovery point objective (RPO) values on SAN Volume
Controller Global Mirror with Change Volume sessions. Every time the actual RPO is calculated, the value
is maintained in the internal data store. You can export the values to a CSV file, over a one-month time
period.

You can use either the Copy Services Manager GUI or CLI to export RPO data.
Format of the CSV file for SAN Volume Controller Global Mirror with Change Volumes history

The CSV file is generated with the following values that are separated by a comma:
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Table 69. SAN Volume Controller Global Mirror with Change Volumes history CSV file output values

CsV file value Description

Query Time Time that the actual RPO value was calculated.

Session Name Name of the Copy Services Manager session.

Role Pair Name Name of the role pair that is represented in the
data.

Consistency Group Name Name of the consistency group on the hardware.

Query Interval (in seconds) Query interval setting to determine actual RPO.

Data Exposure (in hours:minutes:seconds format) [RPO data exposure is displayed in a readable
format.

Data Exposure (in milliseconds) RPO data exposure to provide for graphing and
charting.

Example CSV file output

#Generated at:,"Feb 23, 2016 4:14:55 PM"
#Session Name:,CSM-GMCV

{#fRole Pair:,H1-H2

#Start Date:,"Nov 1, 2015"

#End Date:,"Feb 23, 2016"

#Query Time,Session Name,Role Pair Name,Consistency Group Name,Query
Interval (secs),Data Exposure(hh:mm:ss),Data Exposure(milliseconds),
2015-11-23 11:56:05.0,CSM-GMCV,H1-H2,CSM-GMCV,30,0:03:19,1996000

Exporting RPO history by using the GUI
Follow these steps to export RPO history through the GUI:

1. Log in to the Copy Services Manager GUI as a user with administrator privileges.

2. From the Overview panel, click Session Overview. Or, from the menu bar, click Sessions to get to the
Sessions Details panel.

3. From the Session Actions menu, select Export > Export Global Mirror Data. A pop-up window is
displayed.

4. Select the role pair.

5. Ensure that the RPO option is selected for the type of data.

6. Enter a valid date range that spans no longer than a 31-day period for the start and end dates for the
export.

7. Click OK to confirm, or click Cancel to exit.

A CSV file is created with the historical RPO data. A link is also provided to download the file to your local
system.

Exporting RPO history by using the CLI
Follow these steps to export RPO history through the CLI:

1. Log in to the Copy Services Manager CLI as a user with administrator privileges.
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2. Use the expoxrtgmdata command with the -rpohistoxry option to indicate that you want to export
the RPO history. Then use the =xrpo_start and -xpo_end parameters to specify the date range,
which must span within a 31-day period.

A message is displayed, which indicates the location of the newly created CSV file. This file now contains
the historical RPO data for the specified dates.

Customizing settings in the rmsexver.properties file

You can customize some of the settings for the historical RPO reporting in the rmserver.properties
file, including the retention period, the query interval, and the reserved disk space.

« Retention period: The default retention for RPO data is set to 91 days. After 90 days, RPO data is
removed from the internal data store. The db.svcgmsessionrpo.retention.days property can be
created and set in the rmserver.propexrties file to change the default retention value. Change this
value to indicate how many days of data to keep in the internal data store.

« Query interval: During the 30-second default query interval, the actual RPO is calculated and an
entry for the session is added to the internal data store. You can modify the query interval in the
hw.svc.gmcv.dataExposureInterval property in the xmserver.properties file. The value is in
seconds. Change the value of this property to the number of seconds that you want to determine the
actual RPO.

- Reserved disk space: You can determine the amount of space that is needed for historical reporting.
With the default query interval set to 30 seconds, a year of data for a single session is estimated at
around 200 MB of disk space. If you increase values for retention or query interval, you must ensure
that there is enough disk space to accommodate the changes.

Modifying the location of session sites

You can change the location that is associated with each site in session.

Prerequisites: You must have Administrator privileges or Operator privileges for the session to modify the
location of a site in a session.

Changing the location of a site in a session does not affect the location of the storage systems that are
associated with that site.

Complete the following steps to modify the location of a site:

1. In the menu bar, click Sessions.
2. On the Sessions page, select the session whose site locations you want to change.
3. From the Session Actions list, select View/Modify > Site Location(s).

4. In the Modify Site Locations window, select a site location or None for each site that you want to
change.

An image that represents the sites in the session is displayed. If you selected locations for the sites
that are in the session, the sites are labeled with the site location. If you did not select site locations,
the sites are labeled with Site n, where n is the site number. You can hover the mouse pointer over the
site name to view the name in a larger format.

5. Click OK.

Removing sessions

This topic describes how to remove sessions.

Important: You can remove only sessions that are in the Defined state.
Complete these steps to remove a session:

1. In the menu bar, click Sessions.
2. On the Sessions page, select the session that you want to remove.
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3. From the Session Actions list, select Remove Session.
4. Click Yes to confirm that you want to remove the session.

Removing copy sets

This topic describes how to remove copy sets.
Complete these steps to remove a copy set:

1. In the menu bar, click Sessions.
2. On the Sessions page, select the session that you want to remove copy sets from.

3. From the Session Actions list, select View/Modify > Remove Copy Sets. This action starts the
Remove Copy Sets wizard.

4. From the drop-down menus in the Remove Copy Sets wizard, select the Host 1 storage system, and
logical storage subsystem.

Note: If you select All Storage Systems, and then All Logical Subsystems, no table appears.
However, the Next button is available so that all copy sets in the session can be deleted.

5. From the table on the same page, select the Host 1 volume. You can view the volumes by filtering on
the user name or full name. You can select one or more volumes, or you can choose to Select All or
Deselect All. Select the volumes that you want, and click Next.

6. On the Select Copy Sets page, choose which copy sets to remove. You can select them individually, or
choose to Select All or Deselect All.

Note: Alternatively, you can select Use a CSV file to import copy sets. All the copy sets from this CSV
file listing will be selected.

7. After you select which copy sets to remove, click Next.

8. The number of copy sets to be removed is displayed. Select the following options for removing the
copy sets and click Next:

« Do you want to keep the base relationships on the hardware, but remove the copy sets from the
session?

— No. This option specifies that all relationships for the copy sets are removed from the hardware
and from the Copy Services Manager session. This option is the default.

— Yes. This option specifies that the base relationships remain on the hardware, but the copy sets
are removed from the Copy Services Manager session. This option supports scenarios in which
it might be best to leave the relationship on the hardware to avoid performing a full copy. For
example, when you migrate from one session type to another.

Only the base relationships (Metro Mirror, Global Copy, Snapshot, and FlashCopy) remain on the
hardware. The relationships are removed from any consistency groups that are defined on the
storage system.

« If there are errors removing relationships on the hardware, do you want to force the copy sets to
be removed from the session?
— No. This option does not force the removal of copy sets. This option enables you to correct the
errors and try to remove the copy sets again. This option is the default.

— Yes. This option forces the removal of copy sets despite any errors that occur when the
relationships are removed from the storage system. After a forced removal is complete, any
relationships that remain on the storage system for that copy set must be removed manually by
using the storage system interface.

9. After the copy sets are removed, click Finish.
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Removing a storage system from an active Global Mirror
configuration running on a Copy Services Manager session

During hardware migration that involves equipment that is running Copy Services Manager sessions, there
is a manual process to remove a storage system from an active Global Mirror configuration.

When DS8000 sets up a Global Mirror relationship, it can span multiple source (H1) storage systems and
creates a master/subordinate topology. The master source storage system coordinates the consistency
group formation with the other subordinate source storage systems.

When you remove a storage system from a Global Mirror configuration, steps need to be taken to update
the master/subordinate topology on the DS8000.

To modify the topology on the hardware, consistency group formation needs to be stopped. The Copy
Services Manager session does not automatically stop consistency group formation when removing the
last copy set from the storage system that is being removed.

Before removing the storage system completely from the environment, the following steps should be
performed when consistency group formation can be temporarily stopped.

Complete these steps to remove a storage system from an active Global Mirror configuration running on a
Copy Services Manager session:

Note: Do not attempt this manual process of removing a storage system during a highly active or sensitive
time frame in your storage environment.

1. Add in new copy sets to replace the old source storage system, and populate the copy sets with the old
source storage system data with a product such as TDMF.

2. After all data is migrated and you are ready to remove the source storage system from the
environment, remove the copy sets from the Copy Services Manager session.

3. Suspend the Global Mirror session or the Global Mirror leg of a 3 or 4 site session.
Note: If the Suspend operation fails, you need to issue the Stop command to reach a suspended

Global Mirror leg. If a Stop is processed, it will remove the Global Mirror Master configuration from the
hardware.

4. Issue a Recover to the Global Mirror session, or Failover to the Global Mirror target in a 3 or 4 site
multi-target session.

Note: For Metro Global Mirror with Practice (MGMP) sessions, you cannot issue the Recover H3
command. You need to ensure that you issue the Stop command while the Session is in Suspending
Hx-H3 state.

5. Restart the Global Mirror session or the Global Mirror leg of a 3 or 4 site session.

Note: During the restart, Copy Services Manager detects that the old source storage system is no
longer in the session, and builds the new master/subordinate topology.

6. Remove the connection for the old source storage system.

Renaming a session

You can rename a session.

Note: Only users with administrator privileges can rename a session.
Important: Do not rename a session under the following conditions:

« If the session is running.

- If the session is scheduled to run before renaming can be completed.
Complete the following steps to rename a session.

Note: Renaming a session is not supported under the following conditions:

« If HyperSwap or Hardened Freeze is enabled for the session.
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- Ifthe session is an ESE Sizer session type, a Safeguarded Copy for Spectrum Virtualize session type, an
XIV or a FlashSystem A9000 session type, or a basic HyperSwap session type.

- If the session is in a transitioning state.

Renaming a session is supported only when the session is in these states: Defined, Prepared,
Suspended, and Protected. A FlashCopy session can also be renamed when it is in the Target Available
state.

1. In the menu bar, click Sessions.

2. On the Sessions page, select the session that you want to rename.

3. From the Session Actions list, select View/Modify.

4. From the View/Modify list, select Change Session Name.

5. Enter the new name of the session you want.

6. Click Ok to rename the session.

After a session is renamed, operators that previously had access to the session, will no longer have access
to the session with the new session name. You must provide access to the newly renamed session on
both local and standby servers, to all Operator users and groups who previously had access to it. For more

information on how to modify access privileges, see “Modifying access privileges for a user or group” on
page 311.

Creating scheduled tasks

You can schedule tasks for Copy Services Manager.

Starting with Copy Services Manager Version 6.2.1, you can use a GUI wizard to schedule tasks.

The scheduled tasks can consist of one or more actions, including issuing commands, and waiting for
states.

The Wait for State action ensures that the next action in the list does not occur until the session is in the
right state. The list of actions that you create in the wizard occur sequentially, one after the other. So the

Wait for State action delays the next action in the task from running until the specified state is reached.

The task fails if the state is not reached.

Perform the following steps to schedule a task:

1. Log in to the Copy Services Manager GUI as a user with administrator privileges.
2. Click Settings > Scheduled Tasks.
3. Click Create Task. The Scheduled Task wizard is displayed.
a) Type a name for the scheduled task in the Task Name field.
b) Optional: You can enter a Description for the scheduled task.
¢) You can also set the option to Create a PE package if error occurs running the task.

Tip: The information in a PE package can be helpful when troubleshooting.

d) Click Next.

4. On the next page of the wizard, select whether you want the task to run Hourly or Daily/Weekly. You
can also select No schedule if you do not want the task to run on a set schedule.

Notes:

« The task does not start running on the schedule until it is enabled.

« If you select No schedule, you cannot enable the task because it does not have a schedule. You can
run the task manually, but you must set a schedule to enable it.

« Ifyou select Hourly, indicate how often (for example, every 3 hours). The task is scheduled to
start at the top of the hour at the selected interval.
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Note: The hourly scheduling is set by dividing a 24-hour day into the number of intervals that you
want. For example, if wanted to run the task every 3 hours, that would equal eight times per day.
In this example, starting at midnight, the day is divided into eight intervals.

If you require a specific time of the day for the task to start, use the Daily/Weekly schedule.
- If you select Daily/Weekly, select which day or days of the week, and a Time of day to start.

Note: The start time is based on the browser, which uses the local system time. The Copy Services
Manager server might not be located in the same time zone as the browser. Keep this fact in mind
when you select the Time option.

a) Click Next.

5. Click Add Action.

6. On the next page of the wizard, make the following selections:
a) Choose the action Type from one of the following options:

Command
Runs a selected command on the selected session at the selected time interval. You select the
command and session in a later step.

Wait For State
Waits until the selected session reaches a specified state before the next action is performed.
You select the state and session in a later step.

Wait For Percent Complete
Waits until the selected role pair in the session reaches a certain percentage of completion
before the next action is performed. You select the session in a later step.

Validate Role Pair Consistency
Checks the current consistency for the role pair. If it is not consistent, the task fails. You select
the session in a later step.

Validate Data Exposure
Checks whether the data exposure is below the limit that you have specified, in terms of time
in seconds. If the data exposure is greater than the specified time, the action continues to
check the data exposure value until the specified timeout duration. When the data exposure
is below the specified time, the action completes and the next action in the scheduled task
follows. You select the session in a later step.

Note: This action applies to DS8000 sessions and Global Mirror role pairs only.
Run External Script

To access a remote server using SSH and issue a specified command. This action type can be
used for external actions such as quiescing an application before creating a FlashCopy or a
Safeguarded Copy backup.

b) From the table, select the session for which you want to schedule the action. Only sessions for
which the selected action can be performed are displayed.

Note: Currently, you can only schedule an action against one session at a time. This step does not
apply to a Run External Script action type.

The following information is provided about each session that you can choose from for scheduling
a task:

Name
The session name.

Type
Indicates the type of session.

You can customize the session list by filtering information, resizing columns, reordering columns,
sorting rows, and hiding columns. All changes that you make to the sorting, column sizing, column
order, and table filters persist for each user on a browser across logins.
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- To filter the list by session name or type, enter the filter text in the Filter field. You can enter
complete text or partial text. To remove the filtering for the list, click the X icon in the Filter field.

« To resize a column, drag the column heading border until the column is at the width that you
want.

 To sort the rows in the list, click the heading for the column that contains the value that you
want to use for sorting. For example, if you want to sort by the session type, click the Type
heading. The list sorts by the value in that column. You can choose an ascending or descending
sort order by clicking the column heading.

 To reorder columns, left click and drag a column from the current location in the table to the new
preferred location.

- To hide columns or make columns visible, right-click on the table header. This action gives you
a list of possible columns for the table. Or you can left-click on the icon in the upper right of the
table header. Clear the check from any column to hide it from the table. Check any column to
make it visible in the table.

c) For Command, Wait For State, Wait For Percent Complete, Validate Role Pair Consistency,
Validate Data Exposure, and Run External Script actions, you need to make more selections.

For a Command action:
» Select the command that you want to issue.
Note: The commands that are available depend on the type of session that you select.
For the Wait For State action:
« Select which state to wait for before the next action is performed.

Note: The states that are available depend on the type of session that you select.
« Select a time, in minutes, to wait before the action times out.

For the Wait For Percent Complete action:

- Select the role pair. All of the Metro Mirror, Global Copy, FlashCopy, or Safeguarded Copy role
pairs are listed for the selected session.

 You can specify the percent complete, from 1% to 100%. The default setting is 100%.
« Choose how long to wait (in minutes) for the action to reach the chosen percent complete before
timing out.

Note: If the command fails, or the state, or percent complete is not reached before the timeout
time that you selected, the entire task fails and no other actions run.

For the Validate Role Pair Consistency action:
 Select the role pair.

For the Validate Data Exposure action:
 Select the role pair.

Note: Only Global Mirror role pairs are displayed.

« Specify the time limit in seconds. This action checks whether the data exposure is below the
specified limit. When the data exposure is below the specified time, the action completes and
the next action in the scheduled task follows.

« Specify the time up to which the action will wait before timing out. If the data exposure is
greater than the specified time, the action continues to check the data exposure value until the
specified timeout duration.

For the Run External Script action:

Hostname
Enter the hostname or IP address of the server to SSH into in order to run the script.
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Note: If the specified server has disabled some of the older key exchange algorithms, the
connection to the server might fail and you need to re-enable the older algorithms on the SSH
server.

Optional: Port
Enter the port number for the SSH connection. If no port number is entered, default SSH port
22 is used.

user ID
Enter the user ID that is used to create the SSH connection to the server specified by the
hostname field. This user needs to exist on the server that is specified under hostname and
have the authority to run the specified Command.

Password
Enter the password for the specified user ID.

Command
Enter the command to be run after the SSH connection is established.

Note: This field does not validate the command that is entered and runs the command as
entered. This would include most actions that can be run through an SSH connection. Be
cautions when entering the command that is sent to the server.

Time
Enter the time in minutes. This is the time before the action times out.

Success String
Enter a success string that the action uses to compare to the stdout from the command that is
issued through SSH to the server.

- If a success string is entered, then the action is considered successful if the string is found in
the stdout.

- If a success string is not entered, then the action is considered successful only if nothing
returns in stderr.

d) Click OK to save your changes for the scheduled task action, or click Cancel to exit without saving
changes.

7. You can run a scheduled task on success or failure of this task. Find the fields below the task table
that provide those options. From the pull down lists beside each option, you can choose an existing
scheduled task to run on success (Run the following task if successful), or on failure (Run the
following task on failure) of the current scheduled task.

Note: The default for both options is Do not run a Task.
8. Repeat steps 5 and 6 for every action that you want to perform in the scheduled task.

Example:

You might have two sessions: a Global Mirror Failover/Failback (GM) session and a Metro Mirror
Failover/Failback (MM) session. In this example, the MM session is running in Global Copy mode

and is cascaded off the GM session's Global Copy target volumes to a third site. You might want to
periodically schedule a set of actions so that the targets of the MM session that is running in GC mode
get a consistent image.

You can schedule this set of actions as follows:

a. Create a new task.
b. Choose a schedule when the task runs (such as daily at midnight).

c. Add a Command action that issues a Suspend command to the GM session. This action suspends
the GM session consistently if the DS8000 supports Pause with Consistency.

d. Add a Wait for State action that waits until the GM session is in a Suspended state.
e. Add a Command action that issues a Suspend command to the MM session.
f. Add a Wait for State action that waits until the MM session is in a Suspended state.
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g. Add a Command action that issues a Start H1->H2 command to the GM session. This command
restarts the GM session so that replication is running again to the second site.

9. You can change the order in which the actions are performed by clicking Up or Down. You can
also delete actions by selecting them from the table and clicking Remove Action. Or you can make
changes to actions by clicking Modify Action.

10. On the next page, review the summary for the scheduled task actions. If everything is correct, click
Finish. If you need to make changes, click Back to return to any pages in the wizard where changes
need to be made.

11. If you click Finish, a message indicates whether the task was created successfully.
The scheduled task appears in the Scheduled Tasks table.

Note: Tasks are initially in a disabled state. You must use either the Enable command to start them
according to the preset schedule, or the Run command to execute them immediately, including in a
disabled state. For more information, see “Enabling a scheduled task” on page 217 and “Running a
scheduled task” on page 218.

The following information is provided about each scheduled task:
Name

The scheduled task name.
Type

Indicates the type of the scheduled task.

Affected Sessions
The sessions that are used for the scheduled task to run.

Status
Indicates whether the task is enabled, disabled, or running.

Schedule
The time and days of week that this task is scheduled to run.

Next Run Time
Shows the date and time of when the scheduled task will run next. When you use an hourly schedule,
the scheduling is set by dividing a 24-hour day into the number of intervals that you want. For
example, if you wanted to run the task every 3 hours, that would equal eight times per day. In this
example, starting at midnight, the day is divided into eight intervals. If you require a specific time of
the day for the task to start, use the Daily/Weekly schedule.

Last Run Time
The date and time of when the scheduled task ran the last time.

Last message

Shows the message ID of the status from the last run. To see more details, click the message to open
the Help page.

You can filter and customize the scheduled tasks list as previously described for the session table in the
scheduled tasks wizard.

Modifying a scheduled task
You can modify scheduled tasks.
Modifying a scheduled task brings up the schedule task wizard for you to make changes.
Note: You can only modify one task at a time.
Follow these steps to modify a scheduled task:

1. Log in to the Copy Services Manager GUI as a user with administrator privileges.
2. Click Settings > Scheduled Tasks.
3. From the table, select the scheduled task that you want to modify.

Note: You can only select one task at a time to modify.
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4. Click Actions > Modify Task.
5. Change any of the wizard settings for the scheduled task, as required.

Note: If a schedule is already running, a change in the scheduled time takes effect after the next

already scheduled run completes. To update to the new scheduled time immediately, disable and then
re-enable the schedule.

6. On the final page of the wizard, review the summary for the scheduled task. If everything is correct,

click Finish. If you need to make changes, click Back to return to any pages in the wizard where
changes need to be made.

7. If you click Finish, a message indicates whether the task was modified successfully.

The modified scheduled task appears in the Scheduled Tasks table.

Removing a scheduled task
You can remove a scheduled task.
You can select multiple scheduled tasks to remove.
Follow these steps to remove one or more scheduled tasks:
1. Log in to the Copy Services Manager GUI as a user with administrator privileges.

. Click Settings > Scheduled Tasks.

. From the table, select the scheduled task or tasks that you want to remove.
. Click Actions > Remove Task.

. Awarning message is displayed for confirmation. Click Yes to remove the selected task or tasks. Click
No to exit without removing the selected task or tasks.

6. If you click Yes, a message appears indicating that the selected task or tasks have been removed.

a b 0N

Any scheduled task that you chose to remove no longer appears in the Scheduled Tasks table.

Enabling a scheduled task

You can enable a scheduled task to run according to the preset schedule.

You can select multiple scheduled tasks to enable.

When a task is initially created, it is put into a disabled state. The Enable command starts the task so that
the timer begins running. The task executes based on the schedule that you set for it.

Follow these steps to enable one or more scheduled tasks:
1. Log in to the Copy Services Manager GUI as a user with administrator privileges.
2. Click Settings > Scheduled Tasks.
3. From the table, select the scheduled task or tasks that you want to enable.
4. Click Actions > Enable Task. You then select from two options for when you want the task to run:
a) Enable the task to run Now. The task will start immediately after you confirm at the next step.
b) Or, enable the task to run At a specified time.
Note: The At a specified time option is only available if the schedule that you selected was
Hourly. If you selected Weekly or No Schedule, then only the run Now option is available.

5. A warning message is displayed for confirmation. Click Yes to enable the task to either run now, or at
the specified time. Click No to exit without enabling the task.

6. If you click Yes, a message appears indicating that the selected task or tasks were enabled.

The scheduled task or tasks are enabled, and start running according to the option that you selected,
either immediately, or at the later time as indicated.
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Disabling a scheduled task

You can disable a scheduled task that has been started with the Enable command.

You can select multiple scheduled tasks to disable.

When a task is initially created, it is put into a disabled state. The Enable command starts the task so
that the timer begins running. The task executes based on the schedule that you set for it. The Disable
command can be used to stop an enabled, scheduled task.

Follow these steps to disable one or more enabled, scheduled tasks:

1. Log in to the Copy Services Manager GUI as a user with administrator privileges.
2. Click Settings > Scheduled Tasks.

3. From the table, select the enabled, scheduled task or tasks that you want to disable.
4. Click Actions > Disable Task.

5. A warning message is displayed for confirmation. Click Yes to disable the task. Click No to exit without
disabling the task.

6. If you click Yes, a message appears indicating that the selected task or tasks were disabled.
The scheduled task or tasks are disabled, and stop running.

Running a scheduled task
You can run a scheduled task.
You can select multiple scheduled tasks to run.

The Run command is different from the Enable command. It forces the task to run immediately without
regard to the schedule. The task can also be run from a disabled state.

Follow these steps to run one or more scheduled tasks:
1. Log in to the Copy Services Manager GUI as a user with administrator privileges.
. Click Settings > Scheduled Tasks.

. From the table, select the scheduled task or tasks that you want to run.
. Click Actions > Run Task.

. A warning message is displayed for confirmation. Click Yes to run the task. Click No to exit without
running the task.

6. If you click Yes, a message appears indicating that the selected task or tasks will start running.
The scheduled task or tasks start running immediately.

o b~ WN

Migrating existing hardware relationships to Copy Services
Manager

You can convert existing hardware relationships for copy services to a Copy Services Manager session.

For session types other than multi-target sessions, you can either complete this action manually, as

described, or use the data migration utility for Copy Services Manager. The data migration utility is not
available for multi-target sessions.

To download the data migration utility, go to http://www.ibm.com/support/docview.wss?
uid=swg24000625. The data migration utility produces the Copy Services Manager CLI command script
files and DSCLI script files that necessary to migrate the configuration to Copy Services Manager.

To manually migrate role pairs in a hardware relationship, complete the following steps:

1. Identify the hardware relationships that you want to migrate.
2. Create a Copy Services Manager session and add copy sets to the session.
3. If you are migrating from one of the following storage systems, complete the applicable step:
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a. For DS8000 storage systems with Global Mirror relationships, terminate the Global Mirror master.

b. For FlashSystem/IBM Spectrum Virtualize, SAN Volume Controller, or the FlashSystem/IBM
Spectrum Accelerate storage systems, remove all volumes from the consistency group.

4. Issue a start command to start the Copy Services Manager session.

Converting from multi-target to Cascaded replication in a three site
session type

The session types Metro Mirror — Global Mirror, Metro Mirror — Global Mirror with Practice, and Metro
Mirror — Global Mirror with three Site Global Mirror, now support the ability to convert from a multi-target
configuration to a cascaded configuration and back. Cascaded configurations change the session so that
the Global Mirror relationship is cascaded off of the Metro Mirror relationship and behave similar to the
Metro Global Mirror session type.

When in a supported state, the Start H1->H2->H3 or Start H2->H1->H3 command is available which
converts the session from a multi-targeted to cascaded configuration.

To convert from a cascaded configuration back to a multi-target configuration, the Start H1->H2 H1->H3,
or Start H2->H1 H2->H3, command is available in supported states.

1. Conversion between multi-target and cascaded modes, and vice versa, is done without a full copy.
However, full three site protection is not available until the conversion is complete, so the change
should be scheduled for an appropriate time.

Note: If HyperSwap is enabled, during the conversion from multi-target to cascaded mode,
HyperSwap is temporarily disabled at a point during the conversion to establish the pairs for cascaded
incremental resync capabilities.

2. The session must be in Suspended or Suspended Partial state to transition from multi-target to
cascaded mode

Note: The session does not need to be in suspended state to go from cascaded mode back to
multi-target.

3. After recovering the session to H3, from being in a cascaded H1->H2->H3 or H2->H1->H3 mode. The
options for starting at H3 are limited to commands which avoids a full copy.

4. While running the session in the cascaded H1->H2->H3 or H2->H1->H3 mode, if the intermediate site
is lost, an incremental start from the primary site to the remote site is available as it is in a Metro
Global Mirror session.

Note: In the event that a disaster occurs while in a two site Global Mirror configuration, after losing the
intermediate site, any Start command from Site 3 results in a full copy of the remote Global Copy leg.
This case is rare and occurs only after first losing the intermediate site and then the primary site.

Migrating from the Metro Global Mirror session type to multi-target
Metro Mirror — Global Mirror session type running in the cascading
mode

If you are running a Metro Global Mirror cascaded session or Metro Global Mirror with Practice session,
you might want to migrate to a multi-target Metro Mirror — Global Mirror session or Metro Mirror — Global
with Practice session.

The following are the advantages of migrating from a Metro Global Mirror or Metro Global Mirror with
Practice session to a multi-target Metro Mirror — Global Mirror or multi-target Metro Mirror Global Mirror
with Practice session type:

1. The multi-target session types support DS8000 multi-target capabilities, simplifying some of the
transitions between the sites.
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For example: : When the session is running H1->H2->H3 and a Recover H2 is issued, the cascaded
Metro Global Mirror solution today copies data from H2->H3->H1 in order to get back to an H2->H1-
>H3 configuration. With the multi-target solution this is no longer necessary and the session can
failback directly to a H2->H1->H3 configuration after the recover to H2.

2. All the features of the Metro Global Mirror and Metro Global Mirror with Practice session are available
in the multi-target session types.

Note: Some transitions between sites are slightly different due to using the multi-target capabilities of
the hardware.

3. Starting from site three on the Metro Global Mirror session type requires a full copy. The new multi-
target sessions use DS8000 multi-target technology to avoid full copies from site three.

Note: The multi-target Metro Mirror — Global Mirror with Practice session still requires a full copy after
starting at site three and the recovering back to either site 1 or site 2, for the replication back to site
3. This is because the volumes used in the practice session for the host at site 3 are different than the
volumes used to replicate from site 1 or 2 to site 3. The Metro Mirror relationships does not require a
full copy so there will still be Metro Mirror protection while the copy to site 3 occurs.

1. Ensure that the existing Metro Global Mirror or Metro Global Mirror with Practice session is in a
Prepared and normal state before migrating session to the new multi-target session type.
Important: Do not migrate the session when the session is not in a full three site configuration.

2. Export all copy sets from the existing Metro Global Mirror or Metro Global Mirror with Practice session
(Refer “Exporting copy set data” on page 31).

3. Create a multi-target Metro Mirror — Global Mirror or multi-target Metro Mirror — Global Mirror with
Practice session.

4. Set the Consistency Group for all Global Mirror role pairs on the new session to match the consistency
group number, used on the existing cascaded session.

5. Import the copy sets from step 2 into the new multi-target session (Refer “Importing copy set data” on
page 31).

6. Remove all copy sets from the Metro Global Mirror or Metro Global Mirror with Practice session using
the Keep existing relationships on the hardware option.

Note: Make sure to use the Keep existing relationships on the hardware option or the procedure
results in a full copy.

7. Issue Start H1->H2->H3 from the new session to start the session in cascaded mode. This method
assimilates the existing relationships on the hardware.

Note: If the cascaded session was in H2->H1->H3 mode then you can issue the Set Production to Site
2 command followed by the Start H2->H1->H3 command.

Migrating a secondary storage system to a newer DS8000

You can migrate a secondary storage system to a newer storage system in several ways, including the use
of an external application. Use the information in this topic to migrate a secondary storage system to a
newer DS8000 by using DS8000 copy services. You do not require a Copy Services Manager license as the
migration can be done by using the preinstalled version of Copy Services Manager.

The following steps are used to migrate a secondary storage system to a newer DS8000 storage system.
Migration works whether Copy Services Manager, DSCLI, or GDPS is managing the relationships.

The information in this topic can be used to migrate Global Copy, Metro Mirror, and Global Mirror
targets, including when the relationship is a multi-target relationship. The information in this topic is
not supported for cascaded Metro Global Mirror solution. You can convert the cascaded solution into
a multi-target solution by using Copy Services Manager to use the following procedure to migrate the
secondary volumes.

Note: This feature uses the Copy Services Manager Migration session type and can be used on the
preinstalled version of Copy Services Manager on the DS8000 HMC, without the need for a Copy Services
Manager license.
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You need to complete the following steps before you start the migration.

All the old and the new storage systems must be added to the Copy Services Manager server that
performs the migration. For more information, see “Adding a storage connection” on page 46.

All the target volumes must be created on the new storage system, otherwise the volumes cannot be
added to the migration session. The target volumes must have identical size as the source volumes.
While identical size is not enforced by the Migration session, the final replication topology requires all
the volumes to have identical sizes.

Fibre Channel Protocol (FCP) links need to be configured for the copy services migration:

1. Old secondary to new secondary storage system, used as temporary links for the migration.
2. Primary to new secondary storage system, used as permanent new links during and after migration.

PPRC paths must be established for the migration. Copy Services Manager can do that automatically,
but it uses only one path on one of the links per logical subsystem pair. To use more and dedicated FCP
link port pairs for the PPRC path, update the DS8000 Port Pairing CSV file with both the temporary and
new permanent PPRC link port pairs. For more information, see “Adding logical paths by using a CSV
file” on page 63.

Validate that the new links can be used to establish PPRC paths. For more information, see “Viewing

logical paths” on page 63. Establish logical path across all the new PPRC links for at least one logical

subsystem pair each. If required, the remaining paths are automatically established by Copy Services
Manager by using the DS8000 Port Pairing definitions.

1. Create a Migration session with the H1 volumes same as the targets for an existing Global Copy/
Metro Mirror relationship that is managed by Copy Services Manager or GDPS. For more information
about how to create a Migration session, see “Creating a Migration session and adding copy sets” on
page 192.

2. From the Session Actions list, select Commands and issue the StartGC H1->H2 command. This
command creates a cascaded relationship from the existing Global Copy/Metro Mirror targets to the
new set of target volumes on the new secondary storage system.

3. Optional: From the Session Actions list, select Commands and issue the Validate for
Secondary Migration command after you set up the Migration session and before starting the
migration.

« This step is highly recommended to validate that all the H1 volumes in the Migration session that is
created in step “1” on page 221 are targets to existing Global Copy/Metro Mirror relationships. The
relationships must be in an active state and not in a suspended or failed over state.

- After you issue this command, Copy Services Manager will query the hardware to determine
whether all the H1 volumes in the Migration session are targets of a Global Copy/Metro Mirror
relationship on the hardware. If any of the H1 volumes are not active targets, the command fails
and the session remains in the same state. If the command fails, determine which H1 volumes are
not active targets, and remove them from the session or add additional copy sets to the session and
retry the command.

4. When you are ready to perform the migration and more than 99% of the data has been copied to the
new cascaded secondary volumes, from the Session Actions list, select Commands and issue the
Prepare for Secondary Migration command. Internally the command performs the following
actions:

a. The session again queries the hardware to ensure that all the H1 volumes are targets of an
existing Global Copy/Metro Mirror relationship as it did when the Validate for Secondary
Migration command was issued. If any error is detected, the command fails and the session
remains in the same state.

b. If all the existing Global Copy/Metro Mirror pairs are not managed by an active Copy Services
Manager session on the same server, a new Copy Services Manager Migration session is created
to manage the existing pairs. The new session is named as migrate_from_<migration session
name>, where <migration session name> is the name of the Migration session that is created in
step “1” on page 221. If a Copy Services Manager session is managing the existing Global Copy/
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Metro Mirror pairs on the same server, then that session is internally associated to the Migration
session created in step “1” on page 221.

c. A new Migration session is automatically created and copy sets are added with the H1 volumes as
sources of the existing discovered pairs and the H2 volumes as the H2 volumes in the Migration
session created in step “1” on page 221. The new session is named as migrate_to_<migration
session name>, where the <migration session name> is either the Copy Services Manager session
name that is managing the existing pairs or the session name that is prefixed by migrate_from_
that was created to manage the existing pairs. This new Migration session is internally associated
to the Migration session created in step “1” on page 221.

d. The source to old target volume relationship is reestablished to prepare for an incremental
resynchronization from the source to the new target volumes by tracking changes on the source
volume.

Note: This reestablish operation does not involve any extra data copy on the existing pairs.
e. The Migration Session that is created in step “1” on page 221 goes into a Ready to Migrate state.

5. If the existing relationships are Metro Mirror pairs with HyperSwap enabled, you must disable
HyperSwap before proceeding with the following steps. In addition, before performing the migration
to the new secondary volumes, you can consistently suspend the existing source to target
relationships by using either Copy Services Manager or the management software that is managing
the relationships. A consistent suspend is not necessary to perform the migration, but it is
recommended so that:

« If anissue occurs during the migration, then current target volumes have a consistent copy of the
data.

- To prevent undesired freeze impacts during the next migrations steps if the existing pairs are Metro
Mirror pairs that are managed by either another Copy Services Manager or GDPS. If the existing
Metro Mirror pairs are managed with a freeze and Stop policy, make sure to Release I/O to prevent
the production source volumes from being impacted by Extended Long Busy or SCSI Queue Full
conditions.

6. When the session is in the Ready to Migrate state, from the Session Actions list, select Commands
and issue the Migrate Secondary command on the Migration session that is created in step “1” on
page 221. Internally the command performs the following actions:

a. If the existing Global Copy/Metro Mirror relationships are not suspended by step “5” on page 222,
then the relationships are suspended.

Important: This can trigger freeze events if the active Metro Mirror pairs are managed by another
Copy Services Manager, GDPS, or HyperSwap solution.

b. Once the Migration session determines that the progress is 100% synchronized indicating that all
the data is drained to the new cascaded target volumes, all the pairs in the Migration session are
suspended followed by a failover.

c. An incremental resynchronization establish is issued from the sources to the new targets. The
pairs are managed by migrate_to_ session and are running in Global Copy mode. The migrate_to_
session remains in a Preparing state that is indicated by a yellow Warning state.

Note: When an incremental resynchronization establish is complete, the relationships from the
sources to the old target volumes no longer exist on the hardware. If the old pairs were managed
by another Copy Services Manager or GDPS solution, the solution might report that the original
pairs were deleted unexpectedly. This is not an issue as the source volumes are now replicating to
the new targets that are not yet configured in the existing solution.

d. The Migration session that is created in step “1” on page 221 goes into a Target Available and
Severe state.

Note: The Migration session is in a Severe state because the pairs were not suspended on the
session using a hardware £reeze command. This is not an issue as the targets are now targets of
a new relationship.
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7.

10.

11.

12.

e. Handling errors during Migrate Secondary command: If errors occur during the Migrate
Secondary command, and if the session remains in the Ready to Migrate state, then the issue
can be resolved and the Migrate Secondary command can be reissued.

Trouble: If resolving the issue takes time, perform the following steps before performing
the migration:

i) If already not suspend, suspend the existing source and target relationships by using the
management software that is managing the pairs.

ii) Reestablish the existing source and target relationships by using the management software
that is managing the pairs.

Note: The steps “6.e.i” on page 223 and “6.e.ii” on page 223 are necessary to reset the change
recording to prevent the new establish from having to replicate more data.

iii) From the Session Actions list, select Commands and issue the Stop command to the
Migration session. This causes the session to go into a Suspended state and removes the
migrate_to_ session to restart the migration process.

iv) From the Session Actions list, select Commands and issue the StartGC H1->H2 command
to the Migration session to restart the replication.

v) Wait until the Migration session is resynchronized (a progress of 99% or greater), and then
repeat the migration steps.

The migration is now complete and the new relationships need to be set up in the existing
management solution. You can manage the copy sets as follows:

« If migrated pairs are managed by GDPS, you can remove the copy sets from the migrate_to_ and
migrate_from_ sessions and choose to keep the base relationship on the hardware. For more
information, see “Removing copy sets” on page 210. Then, update the GDPS configuration so that
it can start managing the new Global Copy pairs and convert them into the Metro Mirror or Global
Mirror mode.

 If migrated pairs are managed by Copy Services Manager, you can export the copy sets and import
into the correct session type to manage or clean up the original session. For more information,
see “Exporting copy set data” on page 31 and “Importing copy set data” on page 31. After the
export and import of copy sets is completed, you can remove the copy sets from the migrate_to_
and migrate_from_ sessions and choose to keep the base relationship on the hardware. For more
information, see “Removing copy sets” on page 210. Finally, start the new or updated session to
assimilate the existing Global Copy pairs and convert them into the Metro Mirror or Global Mirror
mode.

- If HyperSwap was originally enabled on the old pairs, it can now be enabled on the new pairs after
the pairs are converted into Metro Mirror Full Duplex state.

. After the migration is completed, from the Session Actions list, select Commands and issue the

Texrminate command to the Migration session that is created in step “1” on page 221 to clean up
the relationships.

. From the Session Actions list, select Remove Session to remove the Migration session that is

created in step “1” on page 221.

Click Yes to confirm that you want to remove the Migration session that is created in step “1” on page
221

Repeat step “9” on page 223 and step “10” on page 223 to remove the empty, inactive migrate_to_
session, and if needed remove migrate_from_ sessions.
Optional: After the migration, if the old PPRC paths from or to the old secondary storage system are

no longer needed, you can remove them. For more information, see “Removing logical paths” on page
68.
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Chapter 8. Practicing disaster recovery

You can use practice volumes to test your disaster recovery actions while maintaining disaster recovery
capability. Practice volumes are available in Metro Mirror Failover and Failback sessions, Global Mirror
Failover and Failback, Global Mirror Either Direction sessions, and Metro Global Mirror with Practice
sessions.

Practice volumes

You can use a practice volume to practice what you would do in the event of a disaster, without
interrupting current data replication. Practice volumes are available in Metro Mirror, Global Mirror, Metro
Global Mirror, and Metro Mirror - Global Mirror sessions.

To use the practice volumes, the session must be in the prepared state. Issuing the Flash command
against the session while in the Prepared state creates a usable practice copy of the data on the target
site.

Note: You can test disaster-recovery actions without using practice volumes. However, without practice
volumes, you cannot continue to copy data changes between volumes while testing disaster-recovery
actions.

Prevent a reflash when practicing disaster recovery

Starting with Copy Services Manager 6.2.7, there is a new property for DS8000 practice sessions to
prevent a reflash of the practice volume after a Flash or Recover operation.

When you manage practice sessions, you might have a batch job that runs on a schedule and issues a
Flash to the practice session. It is useful to have the ability to prevent the session from allowing a reflash
while the batch tests are running.

You do not want the automated Flash to reflash the practice volumes until all practice testing is
complete from the last flash, because these are two non-coordinated activities.

This new property can be used on the following session types for DS8000 only:
« Metro Mirror with Practice

 Global Mirror with Practice

« Global Mirror Either Direction with Two-Site Practice

« Metro Global Mirror with Practice

 Multi-target Metro Mirror - Global Mirror with Practice

This property can be set using either the GUI or the CLI.

In the GUI, the option is called Pxrevent Reflash of Practice volume after Flash or
Recover.

See the 1ssessdetails and chess commands in the IBM Copy Services Manager online product
documentation (http://www.ibm.com/support/knowledgecenter/SSESK4) for more information about
setting this property in the CLI.

Practicing disaster recovery for a Metro Mirror Failover/Failback
with Practice session

A Metro Mirror Failover and Failback session with Practice combines Metro Mirror and FlashCopy to
provide a point-in-time copy of the data on the remote site. You can use this to practice what you might do
if a disaster occurred, without losing your disaster recovery capability.

This function is available on the following storage systems:
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- IBM DS8000
« Systems running IBM Spectrum Virtualize

Perform these steps to practice disaster recover actions for a Metro Mirror Failover/Failback with Practice
session:

1. Start a Metro Mirror with Practice session.

2. When the Metro Mirror session reaches the Prepared state, issue a Flash command to make a point-
in-time copy of the data on H2. This creates a consistent point-in-time copy of your data on the
H2 volume and then restarts the session so the copying from H1 to I2 continues. This temporarily
stops copying of the data from site 1 to site 2, and creates a consistent point-in-time copy. The data
replication from H1 to I2 is then restarted.

Note: For DS8000 storage systems, the Flash command uses the freeze and thaw processing to
create a data consistent point for the FlashCopy. If there is another Metro Mirror session overlapping
on one or more of the same LSS pairs, that session will be suspended. It is also possible that the
suspension of the other session might cause the Metro Mirror session to remain suspended after the
flash command is issued instead of returning to Prepared state. Avoid using the same LSS pairs for
multiple Metro Mirror sessions if possible.

3. Practice the same actions you would take in an actual disaster, using H2 as your new host volume,
while running the real application on H1.

Practicing disaster recovery for a Global Mirror either Direction
with two-site Practice session

A Global Mirror (either direction) with two-site Practice combines Global Mirror and FlashCopy to provide
a point-in-time copy of the data on a remote site at a distance over 300 km away from your first site. You
can use this to practice what you might do if a disaster occurred, without losing your disaster recovery
capability.

Note: This function is available only on DS8000 storage systems.

Perform these steps to practice disaster recover actions for a Global Mirror either Direction with two-site
Practice session:
1. Start a Global Mirror with Practice session.

2. When the session reaches the Prepared state, issue a Flash command to restore consistent data on
12 and make a point-in-time copy of the data on H2. This creates a consistent point-in-time copy of
your data on the H2 volume and then restarts the session so the copying from H1 to I2 continues. This
temporarily stops copying of the data from site 1 to site 2, and creates a consistent point-in-time copy.
The data replication from H1 to I2 is then restarted.

3. Practice the same actions you would take in an actual disaster, using H2 as your new host volume,
while running the real application on H1.

Note: With two directions, you can reverse the direction of your data flow.

Practicing disaster recovery for a Global Mirror Failover/Failback
with Practice session

A Global Mirror Failover and Failback with Practice combines Global Mirror and FlashCopy to provide a
point-in-time copy of the data on a remote site at a distance over 300 km away from your first site. You
can use this to practice what you might do if a disaster occurred.

You can do this practice without losing your disaster recovery capability. The number of volumes used
for the device varies, but the steps to conduct a Global Mirror Failover and Failback with Practice are the
same for both devices.

This function is available on the following storage systems:
- IBM DS8000
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« Systems running IBM Spectrum Virtualize

Perform these steps to practice disaster recover actions for a Global Mirror Failover/Failback with Practice
session:

1. Start a Global Mirror with Practice session.

2. When the session reaches the Prepared state, issue a Flash command to restore consistent data on
I2 and make a point-in-time copy of the data on H2. This creates a consistent point-in-time copy of
your data on the H2 volume and then restarts the session so the copying from H1 to I2 continues. This
temporarily stops copying of the data from site 1 to site 2, and creates a consistent point-in-time copy.
The data replication from H1 to I2 is then restarted.

3. Practice the same actions you would take in an actual disaster, using H2 as your new host volume,
while running the real application on H1.

Practicing disaster recovery for a Metro Global Mirror Failover/
Failback with Practice session

A Metro Global Mirror Failover/Failback with Practice session combines Metro Mirror, Global Mirror and
FlashCopy across three sites to provide a point-in-time copy of the data on the third site. You can use this
to practice what you might do if a disaster occurred without losing your disaster recovery capability.

Note: This function is available on DS8000 storage systems.

The intermediate volume is on the third site (I3). This maintains disaster recovery capability while a copy
is kept on the H3 volume for practice purposes.

Perform these steps to practice disaster recover actions for a Metro Global Mirror Failover/Failback with
Practice session:

1. Start a Metro Global Mirror with Practice session.

2. When the session reaches the Prepared state, issue a Flash command to take a point-in-time copy
of the data that is on I3, on H3. This creates a consistent point-in-time copy of your data on the H3
volume, and then automatically restarts the session so that copying from H1 to H2 to I3 continues. The
Flash command temporarily stops copying the data from site 2 to site 3, in order to create a consistent
point-in-time copy on I3, while maintaining disaster recovery capabilities on site 2 using the Metro
Mirror portion of the session. Then, data replication from H2 to I3 is restarted.

3. Practice the same actions you would take in an actual disaster, using H3 as your practice host volume,
while you run the real application on H1. This enables you to use the same scripts and commands to
run on H3 that you would use in an actual disaster.
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Chapter 9. Monitoring health and status

There are several options within Copy Services Manager for monitoring the health and status of sessions,
storage systems, host systems, and management servers.

Viewing the health summary

Use the Overview page to view overall health and status of sessions, storage systems, host systems, and
management servers.

The Overview page is the first page that you see after you log on. You can display this page by selecting
Overview in the Copy Services Manager menu bar. This panel provides the following information:

Overall session status
Indicates session status, which can be normal, warning, or severe. The status can also be inactive, if
all sessions are defined or if no sessions exit.

Overall storage system status
Indicates the connection status of storage systems.

Overall host system status
Indicates the connection status of host systems.

Management server status
Indicates the status of the standby server if you are logged on to the local server. If you are logged on
to the standby server, this status indicates the status of the local server.

Viewing sessions

The Copy Services Manager GUI includes icons, images, messages, and other visual and informational
aids to help you to determine the status and state of your sessions.

Customizing the session list

The Session page provides a list of created sessions. This list is organized in columns and rows. There is

a row for each session and columns for information that is related to that session, such as the session
name, status, state, and type. You can customize the session list by filtering information, resizing columns,
and sorting rows.

Filtering the session list

Use filtering when you want to limit the rows that are shown in the session list based on the session
name or type. To apply a filter, enter the filter text in the Filter field on the Session page. You can enter
complete text or partial text. Only those rows that contain matching text in the Name or Type column are
displayed in the list.

To remove the filtering for the list, click the X icon in the Filter field.

Resizing the columns in the session list

You can resize columns to more easily view the information in the list. To resize a column, drag the column
heading border until the column is at the width that you want.

Sorting the session list

By default, the sessions in the list are sorted by session name in ascending order. You can change the
value that is used for sorting by clicking the appropriate column heading. For example, if you want to sort
by the session type, click the Type heading. The list sorts by the value in that column. You can choose an
ascending or descending sort order by clicking the column heading.
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Session status icons
The Copy Services Manager GUI uses icons to represent the status of each session.

The following table describes each session status icon.

Table 70. Session status icons

Icon Meaning Description
Inactive The session is in a defined state, with no activity on the
hardware.
Normal A consistent copy of the data either exists or is being
maintained.
I Warning For Metro Mirror, Global Mirror, and Metro Global Mirror, the

session might have volumes that are being synchronized or
are about to be synchronized, with no suspended volumes.
For FlashCopy, the warning status is valid only after the start
command is issued and before the flash. This warning status
means that the session is either preparing or is ready for a
flash command but targets do not yet have a consistent copy.

If a HyperSwap session is degraded, which means it is
enabled on one or more sysplex members and disabled on

at least one sysplex member, then the session is in a warning
state.

(] Severe One or more errors must be dealt with immediately. Possible
causes include the following:

« One or more volumes are suspended
« A session is suspended
« Avolume is not copying correctly

Session images

The Copy Services Manager GUI provides a visual aid to help you create and manage your sessions. The
visual aid shows the number of volume roles in the session and how the roles are distributed between the
sites. It also shows the copy method and direction.

Volume role symbols

The volume role symbols represent the replication status on the volumes.

Table 71. Volume role symbols

Symbol Description Meaning

Active host volumes This symbol represents volumes that contain
the source of updated tracks to which the
application is actively issuing read and write
input/output (1/0).
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Table 71. Volume role symbols (continued)

Symbol

Description

Meaning

Active host volumes
with change volumes
or Safeguarded Copy
volumes

This symbol represents volumes that contain
the source of updated tracks to which the
application is actively issuing read and write
I/0 and change volumes.

Recoverable volumes

This symbol represents volumes that contain a
consistent copy of the data.

Recoverable volumes
with change volumes

This symbol represents volumes and change
volumes that contain a consistent copy of the
data.

Inconsistent volumes

This symbol represents the volumes that do
not contain a consistent copy of the data.
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Table 71. Volume role symbols (continued)
Symbol Description Meaning
Inconsistent volumes This symbol represents the volumes and
with change volumes change volumes that do not contain a
consistent copy of the data.
Data copying symbols

The data copying symbols indicate the type of copy that occurs between the volume roles. The direction
that the symbol is displayed in the Copy Services Manager GUI depends on the direction of the copy.

Table 72. Data copying symbols

Symbol

Type of Copy

Meaning

FlashCopy

This symbol represents a FlashCopy
operation.

FlashCopy with errors

This symbol represents a FlashCopy operation
with errors on one or more pair.

FlashCopy inactive

This symbol represents an inactive FlashCopy
operation.

FlashCopy inactive with
errors

This symbol represents an inactive FlashCopy
operation with errors on one or more pair.

Synchronous

This symbol represents a synchronous copy.

Synchronous with errors

This symbol represents a synchronous copy
with errors on one or more pairs.

Synchronous inactive

This symbol represents an inactive
synchronous copy.

Synchronous inactive
with errors

This symbol represents an inactive
synchronous copy with errors on one or more
pair.

Asynchronous (Global
Copy)

This symbol represents an asynchronous copy
in Global Copy mode.

Asynchronous (Global
Copy) with errors

This symbol represents an asynchronous copy
in Global Copy mode with errors on one or
more pair.

Asynchronous (Global
Copy) inactive

This symbol represents an inactive
asynchronous copy in Global Copy mode.
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Table 72. Data copying symbols (continued)

Symbol Type of Copy Meaning

Asynchronous (Global This symbol represents an asynchronous
Copy) inactive with error | inactive copy in Global Copy mode with an
error.

Global Mirror This symbol represents an asynchronous
consistent copy in Global Mirror mode.

Global Mirror with error | This symbol represents an asynchronous
consistent copy in Global Mirror mode with an
error.

HyperSwap This symbol indicates that the HyperSwap
feature is enabled for the relationship. If a
failure occurs when I/0 is being written to
the primary storage system, these features
automatically swap the I/0 to the secondary
site with no user interaction and little or no
application impact.

Suspended This symbol represents a suspended copy
relationship.

Failed over This symbol represents a failover copy
relationship.

Session states
You can view the health and status of a session in the Copy Services Manager GUI.

Attention: Use only the Copy Services Manager graphical user interface (GUI) or command-line interface
CLI to manage session relationships, such as volume pairs and copy sets. Do not modify session
relationships through other interfaces such as the System Storage DS CLI. If you modify relationships
through other interfaces, a loss of consistency can occur across the relationships that are managed

by the session. The exceptions to this requirement are failover operations that are managed by

external applications for certain session and storage system types as described in “Failover and failback
operations” on page 74.

The Refresh States command is used to refresh the states of the role pairs that are in a session

(if applicable for the session type) and refresh the state of the session if it is incorrect. Issue this
command to query the states of the copy sets on the hardware. You are not required to run this command
under typical circumstances; Copy Services Manager refreshes the states of its sessions through multiple
means. However, if you discover an inconsistency between Copy Services Manager and the hardware,
you can use this command to enable Copy Services Manager to update itself. This command triggers
multiple queries on the hardware, which can impact hardware performance. Do not run this command
more frequently than every few minutes in each session.

The following table describes each session state.

Table 73. Session states

State Session type Description

Defined All The session exists but is inactive.
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Table 73. Session states (continued)

State Session type

Description

Flashing All

In a Metro Mirror or Global Mirror session,
data copying is temporarily suspended while
a consistent practice copy of data is being
prepared on site 2.

In a Metro Global Mirror session, data copying
is temporarily suspended while a consistent
practice copy of data is being prepared on site
3.

Prepared All

The source to target data transfer is active.

In a Metro Mirror, Global Mirror, or Metro Global
Mirror session, the data that is written to the
source is transferred to the target, and all
volumes are consistent and recoverable.

In a FlashCopy session, the volumes are not yet
consistent, but the flash is ready to begin.

Important: For sessions on the following
storage systems, do not alter the relationships
on the hardware that you established with Copy
Services Manager:

« Systems running IBM Spectrum Virtualize

For example, if a Metro Mirror session with one
copy set is in the Prepared state, and you stop
the role pair, the session is still displayed in the
Prepared state.

Preparing All

The volumes are initializing, synchronizing, or
resynchronizing.

In a Metro Mirror, Global Mirror, or Metro Global
Mirror session, synchronization occurs after the
first Start command is issue on a session.
Resynchronization occurs when a volume was
prepared and then suspended. The hardware
records the changed tracks so that on the next
startup, only the changed tracks are copied.

In a FlashCopy session, the volumes are
initializing. The preparing state for FlashCopy
sessions applies only to FlashSystem/IBM
Spectrum Virtualize or SAN Volume Controller
storage systems.

Protected Safeguarded Copy

All volumes in the session have a valid backup.

Note: The Target Available state overrides the
Protected state if a Recover Backup has been
issued to the session.

Recovering All

The session is in the process of recovering.
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Table 73. Session states (continued)

State

Session type

Description

Suspended

Al

Data copying has temporarily stopped.

Important: The suspended state applies only
to Global Mirror, Metro Mirror, and Metro Global
Mirror sessions.

Suspended (Partial)

Multi-target sessions

Data copying between the source site and one
of the target sites has suspended.

SuspendedH1H3 MGM

Metro Global Mirror

Data copying between site 1 and site 3 is
suspended.

SuspendedH1H2 MGM

Metro Global Mirror

Data copying between site 1 and site 2 is
suspended.

Suspending

All

The session is changing into a Suspended state.

Important: The Suspending state applies only
to Metro Mirror Sessions in Global Copy mode,
Global Mirror, and Metro Global Mirror sessions
and does not apply to FlashSystem/IBM
Spectrum Virtualize or SAN Volume Controller
storage systems.

Target available

All

Target volumes are available for application
updates.

Terminating

FlashCopy

The session is being terminated because you
issued a Terminate action under the following
conditions:

» You permitted the target to be Metro Mirror or
Global Copy.

 You set the Require or Attempt to Preserve
Mirror option.

The session displays as Terminating until the
FlashCopy background copy is complete and no
longer exists on the hardware.

Unprotected

Safeguarded Copy

Not all volumes in the session have a valid
backup.

Note: The Target Available state overrides the
Unprotected state if a Recover Backup has been
issued to the session.

Role pair status and progress

In a session, a role pair is the association of two volume roles that take part in a copy relationship. Copy
Services Manager provides detailed role pair status and progress messages for sessions.

The role pair status and progress messages are updated to provide a message that indicates what the
session is doing at the time. By hovering over a progress bar, you can see specific information about

the action that is running on the session. Some status messages might include an estimated time-to-
completion for the action in hours and minutes.

Role pair status is not provided for the FlashSystem/IBM Spectrum Accelerate Snapshot sessions
because role pairs are not used for these sessions.
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The status messages are displayed in the Session Details and Role Pair Details page.

Table 74. Detailed status messages for Participating and Non-Participating role pairs

Supported session type

Status message

FlashCopy
Metro Mirror
Global Copy
Global Mirror

Starting role_pair_name relationships on the
hardware

Metro Mirror
Global Mirror

Waiting for all pairs in the role pair role_pair_name
to reach state of state

FlashCopy
Metro Mirror
Global Copy
Global Mirror

Terminating all pairs in role pair role_pair_name

FlashCopy
Metro Mirror
Global Mirror

Recovering all pairs in role pair role_pair_name

Metro Mirror
Global Copy
Global Mirror

Suspending all pairs in role pair role_pair_name

FlashCopy Backgrqund copy is running for role pair
role_pair_name

Global Copy Waiting for al! pairs in role pair role_pair_name to
become consistent

Global Copy Waiting for all.p.ai.rs in role pairs role_pair_name to
complete the initial copy

FlashCopy Waiting for all pairs in role pairs role_pair_name to
complete FRR

Global Mirror Waiting for all pairs in role pairs role_pair_name to

join the Global Mirror session

Safeguarded Copy

The hardware is preparing to create a backup for all
role volumes.

Viewing session details

You can view detailed information about a session, including role pairs, error count, whether the session is
recoverable, copying progress, session type, and the timestamp.

Perform these steps to view session details:

1. In the menu bar, click Sessions.

2. On the Sessions page, select the session that you want to view.
3. From the Session Actions list, select View/Modify > View Details.
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Viewing additional details for Global Mirror sessions

Additional detail information is available for IBM DS8000 Global Mirror sessions that do not have an
Inactive status. This information includes details about the Global Mirror master, consistency groups that
have been formed, and data exposure.

Complete these steps to view additional details for Global Mirror sessions:

1. In the menu bar, click Sessions.
2. On the Sessions page, select the Global Mirror session that you want to view.
3. From the Session Actions list, select View/Modify > View Details.
4. Click the Global Mirror Info tab.
The following information is displayed on the tab:

Global Mirror Master
Shows the name of the storage system acting as the Global Mirror master.

Last Master Consistency Group Time
Shows the time that the last consistency group was formed

Master Time During Last Query
Shows the time on the master storage device when the query was performed,

Data Exposure
Shows the average exposure to potential data loss in seconds over the query interval.

Session ID
Shows the Global Mirror session ID.

Master State
Shows the state of the master session on the hardware.

Unsuccessful CGs since last successful CG
Shows the number of consistency groups that have failed to form since the last successful
consistency group was formed.

CG Interval Time
Shows the interval time between attempts to form a consistency group.

Max Coordination Interval
Shows the extended distance consistency maximum coordination interval.

Max CG Drain Time
Shows the maximum time the consistent set of data is allowed to drain at the remote site before
failing consistency group formation.

Unsuccessful CGS/Previous Query
Shows the number of consistency groups and percentage of consistency groups that were
unsuccessful since the previous query.

Unsuccessful CGS/Total
Shows the total number of unsuccessful consistency groups and percentage of consistency groups
that have failed.

Successful CGS/Previous Query
Shows the number of consistency groups and percentage of consistency groups that were
successful since the previous query.

Successful CGS/Total
Shows the total number of successful consistency groups and percentage of consistency groups
that have been successful.

Consistency Group Failure Messages
Shows the failure messages that have occurred on the Global Mirror session that prevented the
formation of a consistency group.

Data Exposure chart
Shows the data exposure values in seconds for the last 15 minutes or 24 hours.
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Highlight Data Exposure
Use the following fields to define a value in seconds for which you want data exposure to tracked in
the Data Exposure chart.

Show Data Exposure over
Data exposure that is over the value that is entered in this field is shown in the Data Exposure
chart.

Show Data Exposure under
Data exposure that is under the value that is entered in this field is shown in the Data
Exposure chart.

Export Global Mirror Data
Exports data for Global Mirror role pairs to a CSV file. You can use this data to analyze trends in
your storage environment that affect your RPO.

Attention: Because historical data is purged when you delete a session or set the
management server as the standby server, export data before you perform these actions.

Viewing Global Mirror RPO historical data
You can view historical data for any session type that has Global Mirror.

Starting with Copy Services Manager 6.2.10, you can view the RPO historical data for a selected session
and role pair from the Copy Services Manager GUI. This information is available over selected ranges per
Global Mirror session.

Interpreting historical Global Mirror RPO data

When you view the chart in the GUI, the x-axis is the time that the RPO data was collected. On the
y-axis is the actual average RPO time in seconds. You can see when there were spikes in the RPO, which
represent greater data exposure periods. If any disasters occurred during those spikes, more data could
have been lost.

You can investigate if there were any issues when the spikes occurred. Issues could be SAN-related, or
from other causes.

Complete these steps to view historical Global Mirror RPO data:

1. In the menu bar, click Sessions.

2. On the Sessions page, select the session that you want to view.

3. From the Session Actions list, select View/Modify > View Global Mirror Data.

A chart appears where you can select a data range using the lower bar to see specific point-in-time

historical information. For more detail, export the RPO history and LSS OOS history of the session to a CSV
file. See “Exporting historical data for Global Mirror role pairs” on page 207 for more information.

Viewing LSS 0SS chart

You can view historical data for any session type that has Global Mirror.

Starting with Copy Services Manager 6.2.11, you can view the LSS (Logical Subsystem) OOS (Out of Sync
Tracks) historical data for a selected session, LSS and role pair from the Copy Services Manager GUI. This
information is available over selected ranges per Global Mirror session.

Interpreting historical Global Mirror LSS OSS data

When you view the chart in the GUI, the x-axis is the time that the LSS OOS data was collected and the
y-axis is the count of OOS tracks. You can use the LSS OOS historical data to determine whether one or
more LSS has a high O0S count that might result in a high RPO value that is viewed in the Global Mirror
RPO data chart.

To filter the specific LSS, click the side bar and select the LSS you want to view in the graph.
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Each line on the chart represents a different LSS on the selected box and role pair in the session. You can
filter on which LSS you would prefer to view and the time range as well.

The time is limited to 7 days of data, due to the large number of data points. When many LSS are viewed
together, the top 10 LSS with the highest OOS count gets summarized when hovering over a data point.
1. In the menu bar, click Sessions.

2. On the Sessions page, select the session that you want to view.

3. From the Session Actions list, select View/Modify > View Global Mirror Data.

4. From the side bar, select LSS Graph.

A chart appears where you can select a data range that uses the top drop-down calendars for a 7 days
range and then use lower bar to see specific point-in-time information. For more detail, export the RPO

history and LSS OOS history of the session to a CSV file. See “Exporting historical data for Global Mirror
role pairs” on page 207 for more information.

Viewing session properties

You can view and modify the description and options for a session. The options that are presented depend
on the storage system type and the session type that you select.

To view or modify the properties for a session, complete the following steps:

1. In the menu bar, click Sessions.
2. On the Sessions page, select the session with the properties that you want to view.
3. From the Session Actions list, click View/Modify > Properties.
The properties that are displayed depend on the session type as described in the following sections.

IBM DS8000 sessions
The properties for IBM DS8000 sessions depend on the session type.

The following sections describe the properties for each session type.

FlashCopy session properties

Use the View/Modify Properties notebook to view or modify properties for IBM DS8000 FlashCopy
sessions.

The properties are displayed on different tabs in the notebook. Use the Session Options tab to set
properties that apply to the entire session. Use the H1-T1 Options tab to set properties that apply to the
role pair.

Session Options
Enter the properties for the session.

Description
Type the description for this session.

System or sysplex
Select the z/0S system or sysplex that you want to associate with the session. When this option
is set, the Flash command is submitted through the z/OS connection to that system or sysplex
to provide performance improvements during the FlashCopy process. To enable this feature,
volumes in the session must be attached to the system or sysplex and I0S APAR OA59561 must
be applied.

If you select No Association, then the session submits the command in the regular manner and
the performance advantage of submitting the FlashCopy operation through the system or sysplex
will not be applicable.

This option is displayed only if the copy services management server is installed on or connected
to a z/OS host system.
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H1-T1 Options
Enter the properties for the role pair.

Incremental
Select this option to apply incremental changes to the target volume. After the initial FlashCopy
operation, only data that changed on the source volume since the last FlashCopy operation was
performed is copied to the target volume. If the multiple incremental feature is supported on the
storage system, it will be used.

If you select this option, a persistent FlashCopy relationship is created regardless of whether you
select the Persistent check box.

Persistent
Select this option to keep the FlashCopy relationship established on the hardware after all source
tracks are copied to the target volume. If you do not select this option, the local replication
relationship ends after the target volume contains a complete point-in-time image of the source
volume.

No Copy
Select this option if you do not want the hardware to write the background copy until the source
track is written to. Data is not copied to the target volume until the blocks or tracks of the source
volume are modified.

This option is required for space-efficient volumes.

Fail Flash if target is online (CKD only)
Select this option to fail any command for a FlashCopy relationship if the target volume is in the
Online state. For more information about this state, refer to the documentation for the storage
system.

This option applies only to count key data (CKD) volumes.

Reset target reserves (FB only)
Select this option to reset the SCSI reserves on the FlashCopy target volumes.

This option applies only to fixed block (FB) volumes.

Note: The SCSI reserves are reset only when the Flash command is issued, after the Reset target
reserves (FB only) option is selected.

Allow FlashCopy target to be Metro Mirror source
Select this option to enable the FlashCopy operation if the target volume of the FlashCopy
relationship is also the source volume of a Metro Mirror relationship. If this option is not selected,
the FlashCopy operation fails.

Requirement: This option requires that the IBM Remote Pair FlashCopy option is available for
your IBM DS8000 storage system. To determine whether you can use the IBM Remote Pair
FlashCopy option with your IBM DS8000 storage system, see the IBM DS8000 documentation for
microcode level that you are using.

Select one of the following options to specify whether you want to maintain consistency, if
possible:

Do not attempt to preserve Metro Mirror consistency
Click this option if you want the FlashCopy operation to complete without preserving
consistency of the Metro Mirror relationship on the remote site. The FlashCopy operation does
not occur on the remote site.

Attempt to preserve Metro Mirror consistency, but allow FlashCopy even if Metro Mirror target
consistency cannot be preserved
Click this option to preserve the consistency of the Metro Mirror relationship at the target of
the FlashCopy relationship when both the source and target of the FlashCopy relationship are
the source of a Metro Mirror relationship. If the consistency cannot be preserved, a full copy
of the Metro Mirror relationship at the target of the FlashCopy relationship is performed. To
preserve consistency, parallel FlashCopy operations are performed on both sites if possible.
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Attempt to preserve Metro Mirror consistency, but fail FlashCopy if Metro Mirror target
consistency cannot be preserved
Click this option to prevent a full copy from being performed over the Metro Mirror link.
Instead, if possible, parallel FlashCopy operations are performed on both sites. If the
consistency cannot be preserved, the flash for the FlashCopy relationships fails, and the data
of the Metro Mirror relationship at the target of the FlashCopy relationship is not changed.

Metro Mirror Single Direction session properties

Use the View/Modify Properties notebook to view or modify properties for IBM DS8000 Metro Mirror
Single Direction sessions.

The properties are displayed on different tabs in the notebook. Use the Session Options tab to set
properties that apply to the entire session. Use the H1-H2 Options tab to set properties that apply to the
role pair.

Session Options
Enter the properties for the session.

Description
Type the description for this session.

Reset Secondary Reserves
Select this option to remove any persistent reserves that might be set on the target volumes of the
copy sets when a Start command is issued for the session.

c Attention: This option causes the session to overwrite all data that is on the target volume.

Fail MM/GC if target is online (CKD only)
Select this option to fail any session commands for a Metro Mirror or Global Copy relationship
if the target volume is in the Online state. For more information about this state, refer to the
documentation for the storage system.

This option applies only to count key data (CKD) volumes.

H1-H2 Options
Enter the properties for the role pair.

Metro Mirror Suspend Policy
Select one of the following options to specify the policy for holding or releasing input/output (I/0)
after a Metro Mirror relationship is suspended. When a relationship is in a Suspended state, write
operations from the source volume are no longer mirrored to the target volume.

Hold I/O after Suspend
Click this option to prevent the source volume from receiving new data after the relationship is
suspended. Use this option if you want to determine the scope of the suspension before new
data is written to the source volume. This option helps to ensure that the data on the source
and target volumes remains the same.

To enable write operations to the source volume to continue, issue the Copy Services Manager
Release I/0command for the session. If you do not issue this command, write operations
are enabled when the hardware timeout value on the storage system expires.

Release I/0 after Suspend
Click this option to enable the source volume to automatically receive data after the
relationship is suspended. Use this option if you want to limit the effect on the applications
that are writing to the source volume. This option is enabled by default.

Attention: This option can cause the data on the source volume to be different from
the data on target volume.

z/0S Management
Select the following options to manage IBM z/0S features for the role pair.
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The z/0S Management options are displayed only if Copy Services Manager is installed on or
connected to a z/OS host system. You can add a z/OS host connections in Copy Services Manager
regardless of the operating system on which the application is installed.

When you are connected to a z/OS host system, you can manage z/0S features for volumes that
are attached to the host system. In addition, you can manage these features for volumes that are
attached to other z/0OS systems that are connected to the host system through a sysplex.

System or sysplex
Select the z/0OS system or sysplex that you want to associate with the session. Commands for
z/0S features are issued to this system or sysplex. Volumes in the session must be attached to
the system or sysplex to enable the features.

Enable Hardened Freeze
Select this option to enable the z/OS Input/Output Supervisor (I0S) to manage freeze
operations.

Requirement: This option requires the z/OS address spaces Basic HyperSwap Management
and Basic HyperSwap API. For instructions about how to start these address spaces, see
the information about preparing to use Basic HyperSwap from z/OS in the IBM Copy Services
Manager Installation and Configuration Guide.

If you select this option, I0S can freeze volumes regardless of whether the Copy Services
Manager server is started or stopped.

In addition, this option enables you to include z/OS system volumes such as paging, database,
and IBM WebSphere Application Server hierarchical file system (HFS) as Metro Mirror volumes
in the session. When you select this option, IOS manages the freeze operations for all

Metro Mirror volumes in the session, which prevents Copy Services Manager from freezing

the volumes and possibly freezing itself. This option does not enable I0S to manage freeze
operations for Global Mirror volumes.

Metro Mirror Failover/Failback session properties

Use the View/Modify Properties notebook to view or modify properties for IBM DS8000 Metro Mirror
Failover/Failback sessions.

The properties are displayed on different tabs in the notebook. Use the Session Options tab to set
properties that apply to the entire session. Use the H1-H2 Options tab to set properties that apply to the
role pair.

Session Options
Enter the properties for the session.

Description
Type the description for this session.

Reset Secondary Reserves
Select this option to remove any persistent reserves that might be set on the target volumes of the
copy sets when a Start command is issued for the session.

Q Attention: This option causes the session to overwrite all data that is on the target volume.

Fail MM/GC if target is online (CKD only)
Select this option to fail any session commands for a Metro Mirror or Global Copy relationship
if the target volume is in the Online state. For more information about this state, refer to the
documentation for the storage system.

This option applies only to count key data (CKD) volumes.

H1-H2 Options
Enter the properties for the role pair.
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Metro Mirror Suspend Policy
Select one of the following options to specify the policy for holding or releasing input/output (I/0)
after a Metro Mirror relationship is suspended. When a relationship is in a Suspended state, write
operations from the source volume are no longer mirrored to the target volume.

Hold I/O after Suspend
Click this option to prevent the source volume from receiving new data after the relationship is
suspended. Use this option if you want to determine the scope of the suspension before new
data is written to the source volume. This option helps to ensure that the data on the source
and target volumes remains the same.

To enable write operations to the source volume to continue, issue the Copy Services Manager
Release I/0command forthe session. If you do not issue this command, write operations
are enabled when the hardware timeout value on the storage system expires.

Release I/0 after Suspend
Click this option to enable the source volume to automatically receive data after the
relationship is suspended. Use this option if you want to limit the effect on the applications
that are writing to the source volume. This option is enabled by default.

Attention: This option can cause the data on the source volume to be different from
the data on target volume.

z/0S Management
Select the following options to manage IBM z/0S features for the role pair.

The z/0S Management options are displayed only if Copy Services Manager is installed on or
connected to a z/OS host system. You can add a z/OS host connections in Copy Services Manager
regardless of the operating system on which the application is installed.

When you are connected to a z/OS host system, you can manage z/0S features for volumes that
are attached to the host system. In addition, you can manage these features for volumes that are
attached to other z/0OS systems that are connected to the host system through a sysplex.

System or sysplex
Select the z/0OS system or sysplex that you want to associate with the session. Commands for
z/0S features are issued to this system or sysplex. Volumes in the session must be attached to
the system or sysplex to enable the features.

Enable Hardened Freeze
Select this option to enable the z/OS Input/Output Supervisor (I0S) to manage freeze
operations.

Requirement: This option requires the z/OS address spaces Basic HyperSwap Management
and Basic HyperSwap API. For instructions about how to start these address spaces, see
the information about preparing to use Basic HyperSwap from z/OS in the IBM Copy Services
Manager Installation and Configuration Guide.

If you select this option, I0S can freeze volumes regardless of whether the Copy Services
Manager server is started or stopped.

In addition, this option enables you to include z/OS system volumes such as paging, database,
and IBM WebSphere Application Server hierarchical file system (HFS) as Metro Mirror volumes
in the session. When you select this option, IOS manages the freeze operations for all

Metro Mirror volumes in the session, which prevents Copy Services Manager from freezing

the volumes and possibly freezing itself. This option does not enable I0S to manage freeze
operations for Global Mirror volumes.

If you select the Manage H1-H2 with HyperSwap option for the session, this option is
ignored. HyperSwap includes I0S for managing freeze operations. The Enable Hardened
Freeze option ensures data integrity if Copy Services Manager freezes and HyperSwap are not
enabled for a session.

Manage H1-H2 with HyperSwap
Select this option to trigger a HyperSwap operation, which redirects application I/O to the
target volumes when there is a failure on the host accessible volumes. Copy Services Manager
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uses HyperSwap to manage the H1-H2 sequence of a Metro Mirror or Metro Global Mirror
session.

Disable HyperSwap
Select this option to prevent a HyperSwap operation from occurring.

Reset In Use By System on Secondary Volumes
Select this option to have the load of the configuration automatically reset the In Use
By System state on all secondary volumes (UCBNALOC = OFF). When this option is not
selected, a load of the configuration fails when secondary volumes are in the In Use By
System state (UCBNALOC is ON). This feature is only available after APAR OA53082 is
applied to the z/OS system.

Unbox Secondary Volumes
Select this option to have the load of the configuration automatically unbox all secondary
volumes in the configuration. When this option is not selected, a load of the configuration
fails when secondary volumes are in a boxed state. This feature is only available after
APAR OA53082 is applied to the z/OS system.

On Planned HyperSwap Error:

Partition out the failing system(s) and continue swap processing on the remaining
system(s)
Select this option to partition out the failing system and continue the swap processing
on any remaining systems.

Disable HyperSwap after attempting backout
Select this option to enable I0S to back out the HyperSwap operation, if possible, if an
error occurs during HyperSwap processing. HyperSwap is disabled.

On Unplanned HyperSwap Error:
Partition out the failing system(s) and continue swap processing on the remaining
system(s)
Select this option to partition out the failing systems and continue HyperSwap

processing on the remaining systems when a new system is added to the sysplex
and the HyperSwap operation does not complete.

Requirement: If you select this option, you must restart the system.

Disable HyperSwap after attempting backout
Select this option to enable IOS to back out the HyperSwap operation, if possible, if an
error occurs during HyperSwap processing. HyperSwap is disabled.

Metro Mirror Failover/Failback with Practice session properties

Use the View/Modify Properties notebook to view or modify properties for IBM DS8000 Metro Mirror
Failover/Failback with Practice sessions.

The properties are displayed on different tabs in the notebook. Use the Session Options tab to set
properties that apply to the entire session or multiple role pairs in the session. Use the H2-I2 Options tab
to set properties that apply to that role pair.

Session Options
Enter the properties for the session.

Description
Type the description for this session.

Reset Secondary Reserves
Select this option to remove any persistent reserves that might be set on the target volumes of the
copy sets when a Start command is issued for the session.

e Attention: This option causes the session to overwrite all data that is on the target volume.
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Fail MM/GC if target is online (CKD only)
Select this option to fail any session commands for a Metro Mirror or Global Copy relationship
if the target volume is in the Online state. For more information about this state, see the
documentation for the storage system.

This option applies only to count key data (CKD) volumes.

Metro Mirror Suspend Policy
Select one of the following options to specify the policy for holding or releasing input/output (I/0)
after a Metro Mirror relationship is suspended. When a relationship is in a Suspended state, write
operations from the source volume are no longer mirrored to the target volume.

Hold I/O after Suspend
Click this option to prevent the source volume from receiving new data after the relationship is
suspended. Use this option if you want to determine the scope of the suspension before new
data is written to the source volume. This option helps to ensure that the data on the source
and target volumes remains the same.

To enable write operations to the source volume to continue, issue the Copy Services Manager
Release I/0command for the session. If you do not issue this command, write operations
are enabled when the hardware timeout value on the storage system expires.

Release I/0 after Suspend
Click this option to enable the source volume to automatically receive data after the
relationship is suspended. Use this option if you want to limit the effect on the applications
that are writing to the source volume. This option is enabled by default.

Attention: This option can cause the data on the source volume to be different from
the data on target volume.

z/0S Management
Select the following options to manage IBM z/OS features for the H1-12 and H2-H1 role pairs.

The z/0S Management options are displayed only if Copy Services Manager is installed on
or connected to a z/OS host system. You can add a z/OS host connection in Copy Services
Manager regardless of the operating system on which the application is installed.

When you are connected to a z/OS host system, you can manage z/0S features for volumes
that are attached to the host system. In addition, you can manage these features for volumes
that are attached to other z/OS systems that are connected to the host system through a
sysplex.

System or sysplex
Select the z/0S system or sysplex that you want to associate with the session. Commands
for z/OS features are issued to this system or sysplex. Volumes in the session must be
attached to the system or sysplex to enable the features.

Enable Hardened Freeze
Select this option to enable the z/OS Input/Output Supervisor (I0S) to manage freeze
operations.

Requirement: This option requires the z/OS address spaces Basic HyperSwap
Management and Basic HyperSwap API. For instructions about how to start these address
spaces, see the information about preparing to use Basic HyperSwap from z/0S in the IBM
Copy Services Manager Installation and Configuration Guide.

If you select this option, I0S can freeze volumes regardless of whether the Copy Services
Manager server is started or stopped.

In addition, with this option, you can include z/OS system volumes such as paging,
database, and IBM WebSphere Application Server hierarchical file system (HFS) as Metro
Mirror volumes in the session. When you select this option, I0OS manages the freeze
operations for all Metro Mirror volumes in the session, which prevents Copy Services
Manager from freezing the volumes and possibly freezing itself. This option does not
enable IOS to manage freeze operations for Global Mirror volumes.
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H2-1I2 Options
Enter the properties for the role pair.

Persistent
Select this option to keep FlashCopy pairs persistent on the hardware.

Incremental
Select this option to apply incremental changes to the target volume. After the initial FlashCopy
operation, only data that changed on the source volume since the last FlashCopy operation
completed is copied to the target volume. If the multiple incremental feature is supported on the
storage system, it will be used. If you select this option, a persistent FlashCopy relationship is
created regardless of whether you select the Persistent check box.

Reset target reserves (FB only)
Select this option to reset the SCSI reserves on the FlashCopy target volumes.

This option applies only to fixed block (FB) volumes.

Note: The SCSI reserves are reset only when the Flash command is issued, after the Reset target
reserves (FB only) option is selected.

Global Mirror Single Direction and Failover/Failback session properties

Use the View/Modify Properties notebook to view or modify properties for IBM DS8000 Global Mirror
Single Direction and Global Mirror Failover/Failback sessions.

The properties are displayed on different tabs in the notebook. Use the Session Options tab to set
properties that apply to the entire session. Use the H1-J2 Options tab to set properties that apply to the
role pair.

Session Options
Enter the properties for the session.

Description
Type the description for this session.

Reset Secondary Reserves
Select this option to remove any persistent reserves that might be set on the target volumes of the
copy sets when a Start command is issued for the session.

Q Attention: This option causes the session to overwrite all data that is on the target volume.

Fail MM/GC if target is online (CKD only)
Select this option to fail any session commands for a Metro Mirror or Global Copy relationship
if the target volume is in the Online state. For more information about this state, refer to the
documentation for the storage system.

This option applies only to count key data (CKD) volumes.

H1-J2 Options
Enter the properties for the role pair.

Consistency group interval time (seconds)
Type how often, in seconds, the Global Mirror session attempts to form a consistency group. A
lower value possibly reduces the data exposure of the session. However, a lower value also causes
the session to attempt to create consistency groups more frequently, which can increase network
traffic.

Recovery Point Objective Alerts
Specify the length of time that you want to set for the recovery point objective (RPO) thresholds.
The values determine whether a Warning or Severe alert is generated when the RPO threshold is
exceeded for a role pair. The RPO represents the length of time in seconds of data exposure that is
acceptable if a disaster occurs.
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Use the following options to set the RPO threshold values. For both options, you can specify an
RPO threshold in the range of 0 - 65535 seconds. The default is 0 seconds, which specifies that no
alerts are generated.

Warning level threshold (seconds)
Type the number of seconds that you want to set for the warning level RPO threshold. If the
RPO is greater than this value, an alert is generated.

If the value in this field is other than O, it must be greater than the value in the Consistency
group interval time (seconds) field and less than the value in the Severe level threshold
(seconds) field.

Severe level threshold (seconds)
Type the number of seconds that you want to set for the severe level RPO threshold. If the
RPO is greater than this value, an alert is generated and the session status changes to Severe.

If the value in this field is other than 0, it must be greater than the value in the Warning level
threshold (seconds) field.

Global Mirror Failover/Failback with Practice session properties

Use the View/Modify Properties notebook to view or modify properties for IBM DS8000 Global Mirror
Failover/Failback with Practice sessions.

The properties are displayed on different tabs in the notebook. Use the Session Options tab to set
properties that apply to the entire session. Use the individual role pair option tabs to set properties that
apply to specific role pairs. For example, options for the H1-J2 role pair are contained in the H1-J2
Options tab.

Session Options
Enter the properties for the session.

Description
Type the description for this session.

Fail MM/GC if target is online (CKD only)
Select this option to fail any session commands for a Metro Mirror or Global Copy relationship
if the target volume is in the Online state. For more information about this state, see the
documentation for the storage system.

This option applies only to count key data (CKD) volumes.

Reset Secondary Reserves
Select this option to remove any persistent reserves that might be set on the target volumes of the
copy sets when a Start command is issued for the session.

Q Attention: This option causes the session to overwrite all data that is on the target volume.

H1-J2 Options
Enter the properties for the role pair.

Consistency group interval time (seconds)
Type how often, in seconds, the Global Mirror session attempts to form a consistency group. A
lower value possibly reduces the data exposure of the session. However, a lower value also causes
the session to attempt to create consistency groups more frequently, which can increase network
traffic.

Max Coordination Interval (milliseconds)
Type in the maximum amount of time, in milliseconds, for the extended-distance consistency-
coordination interval. The default value for new sessions is 50 milliseconds. Setting this field to 0
is equivalent to <auto> and indicates to the storage system to use the default value.

Max CG Drain Time (seconds)
Type in the maximum amount of time, in seconds, that the consistent set of data is allowed to
drain at the remote site before it fails consistency group formation. The default value for new
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sessions is 90 seconds. Setting this field to 0 is equivalent to <auto> and indicates to the storage
system to use the default value.

Recovery Point Objective Alerts
Specify the length of time that you want to set for the recovery point objective (RPO) thresholds.
The values determine whether a Warning or Severe alert is generated when the RPO threshold is
exceeded for a role pair. The RPO represents the length of time in seconds of data exposure that is
acceptable if a disaster occurs.

Use the following options to set the RPO threshold values. For both options, you can specify an
RPO threshold in the range of 0 - 65535 seconds. The default is 0 seconds, which specifies that no
alerts are generated.

Warning level threshold (seconds)
Type the number of seconds that you want to set for the warning level RPO threshold. If the
RPO is greater than this value, an alert is generated.

If the value in this field is other than 0, it must be greater than the value in the Consistency
group interval time (seconds) field and less than the value in the Severe level threshold
(seconds) field.

Severe level threshold (seconds)
Type the number of seconds that you want to set for the severe level RPO threshold. If the
RPO is greater than this value, an alert is generated and the session status changes to Severe.

If the value in this field is other than 0, it must be greater than the value in the Warning level
threshold (seconds) field.

H2-12 Options
Enter the properties for the role pair.

Persistent
Select this option to keep FlashCopy pairs persistent on the hardware.

No Copy
Select this option if you do not want the hardware to write the background copy until the
source track is written to. Data is not copied to the H2 volume until the blocks or tracks of the
I2 volume are modified.

Incremental
Select this option to apply incremental changes to the target volume. After the initial
FlashCopy operation, only data that changed on the source volume since the last FlashCopy
operation completed is copied to the target volume. This option is only valid if the source
storage system supports multiple incremental FlashCopy.

If you select this option, a persistent FlashCopy relationship is created regardless of whether
you select the Persistent check box.

Reset target reserves (FB only)
Select this option to reset the SCSI reserves on the FlashCopy target volumes.

This option applies only to fixed block (FB) volumes.

Note: The SCSI reserves are reset only when the Flash command is issued, after the Reset
target reserves (FB only) option is selected.

Journal Options
Reflash After Recover

Select this option to reflash a consistent set of data to the journal volume after a Recover
command is issued to the session. Reflashing to the journal volume ensures that there is a
consistent copy of the data to recover from if failures occur during resynchronization. If you do not
select this option, the journal volumes will not have a consistent copy of the data after the recover
operation. However, the space will be available when space-efficient volumes are used.
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Global Mirror Either Direction and Global Mirror Either Direction with Two-
Site Practice session properties

Use the View/Modify Properties notebook to view or modify properties for IBM DS8000 Global Mirror
Either Direction and Global Mirror Either Direction with Two-Site Practice sessions.

The properties are displayed on different tabs in the notebook. Use the Session Options tab to set
properties that apply to the entire session. Use the individual role pair option tabs to set properties that
apply to specific role pairs. For example, properties for the H1-J2 role pair are contained in the H1-J2
Options tab.

Session Options
Enter the properties for the session.

Description
Type the description for this session.

Reset Secondary Reserves
Select this option to remove any persistent reserves that might be set on the target volumes of the
copy sets when a Start command is issued for the session.

c Attention: This option causes the session to overwrite all data that is on the target volume.

Fail MM/GC if target is online (CKD only)
Select this option to fail any session commands for a Metro Mirror or Global Copy relationship
if the target volume is in the Online state. For more information about this state, refer to the
documentation for the storage system.

This option applies only to count key data (CKD) volumes.

H1-J2 Options and H2-J1 Options
Enter the properties for the role pair.

Consistency group interval time (seconds)
Type how often, in seconds, the Global Mirror session attempts to form a consistency group. A
lower value possibly reduces the data exposure of the session. However, a lower value also causes
the session to attempt to create consistency groups more frequently, which can increase network
traffic.

Max Coordination Interval (milliseconds)
Type in the maximum amount of time, in milliseconds, for the extended-distance consistency-
coordination interval. The default value for new sessions is 50 milliseconds. Setting this field to 0
is equivalent to <auto> and indicates to the storage system to use the default value.

Max CG Drain Time (seconds)
Type in the maximum amount of time, in seconds, that the consistent set of data is allowed to
drain at the remote site before it fails consistency group formation. The default value for new
sessions is 90 seconds. Setting this field to 0 is equivalent to <auto> and indicates to the storage
system to use the default value.

Recovery Point Objective Alerts
Specify the length of time that you want to set for the recovery point objective (RPO) thresholds.
The values determine whether a Warning or Severe alert is generated when the RPO threshold is
exceeded for a role pair. The RPO represents the length of time in seconds of data exposure that is
acceptable if a disaster occurs.

Use the following options to set the RPO threshold values. For both options, you can specify an
RPO threshold in the range of 0 - 65535 seconds. The default is 0 seconds, which specifies that no
alerts are generated.

Warning level threshold (seconds)
Type the number of seconds that you want to set for the warning level RPO threshold. If the
RPO is greater than this value, an alert is generated.
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If the value in this field is other than 0, it must be greater than the value in the Consistency
group interval time (seconds) field and less than the value in the Severe level threshold
(seconds) field.

Severe level threshold (seconds)
Type the number of seconds that you want to set for the severe level RPO threshold. If the
RPO is greater than this value, an alert is generated and the session status changes to Severe.

If the value in this field is other than 0, it must be greater than the value in the Warning level
threshold (seconds) field.

H1-I1 and H2-I2 Options
Enter the properties for the role pair. The following options are available only for IBM DS8000 version

4.2 or later.

Incremental
Select this option to apply incremental changes to the target volume. After the initial FlashCopy
operation, only data that changed on the source volume since the last FlashCopy operation
completed is copied to the target volume. This option is only valid if the source storage system
supports multiple incremental FlashCopy. If you select this option, a persistent FlashCopy
relationship is created.

Reset target reserves (FB only)
Select this option to reset the SCSI reserves on the FlashCopy target volumes.

This option applies only to fixed block (FB) volumes.

Note: The SCSI reserves are reset only when the Flash command is issued, after the Reset target
reserves (FB only) option is selected.

Journal Options
Reflash After Recover

Select this option to reflash a consistent set of data to the journal volume after a Recover command

is issued to the session. Reflashing to the journal volume ensures that there is a consistent copy of
the data to recover from if failures occur during resynchronization. If you do not select this option, the
journal volumes will not have a consistent copy of the data after the recover operation. However, the
space will be available when space-efficient volumes are used.

Metro Global Mirror session properties

Use the View/Modify Properties notebook to view or modify properties for IBM DS8000 Metro Global
Mirror sessions.

The properties are displayed on different tabs in the notebook. Use the Session Options tab to set
properties that apply to the entire session. Use the individual role pair option tabs to set properties that
apply to specific role pairs. For example, properties for the H1-H2 role pair are contained in the H1-H2
Options tab.

Session Options
Enter the properties for the session.

Description
Type the description for this session.

Reset Secondary Reserves
Select this option to remove any persistent reserves that might be set on the target volumes of the
copy sets when a Start command is issued for the session.

e Attention: This option causes the session to overwrite all data that is on the target volume.

Fail MM/GC if target is online (CKD only)
Select this option to fail any session commands for a Metro Mirror or Global Copy relationship
if the target volume is in the Online state. For more information about this state, refer to the
documentation for the storage system.
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This option applies only to count key data (CKD) volumes.

H1-H2 Options
Enter the properties for the role pair.

Metro Mirror Suspend Policy
Select one of the following options to specify the policy for holding or releasing input/output (I/0)
after a Metro Mirror relationship is suspended. When a relationship is in a Suspended state, write
operations from the source volume are no longer mirrored to the target volume.

Hold I/0 after Suspend
Click this option to prevent the source volume from receiving new data after the relationship is
suspended. Use this option if you want to determine the scope of the suspension before new
data is written to the source volume. This option helps to ensure that the data on the source
and target volumes remains the same.

To enable write operations to the source volume to continue, issue the Copy Services Manager
Release I/0command for the session. If you do not issue this command, write operations
are enabled when the hardware timeout value on the storage system expires.

Release I/O after Suspend
Click this option to enable the source volume to automatically receive data after the
relationship is suspended. Use this option if you want to limit the effect on the applications
that are writing to the source volume. This option is enabled by default.

Attention: This option can cause the data on the source volume to be different from
the data on target volume.

z/0S Management
Select the following options to manage IBM z/OS features for the role pair.

The z/0S Management options are displayed only if Copy Services Manager is installed on or
connected to a z/OS host system. You can add a z/OS host connections in Copy Services Manager
regardless of the operating system on which the application is installed.

When you are connected to a z/OS host system, you can manage z/OS features for volumes that
are attached to the host system. In addition, you can manage these features for volumes that are
attached to other z/OS systems that are connected to the host system through a sysplex.

System or sysplex
Select the z/OS system or sysplex that you want to associate with the session. Volumes in
the session must be attached to the system or sysplex that you choose to enable the z/OS
features. Commands for the features are issued to this system or sysplex.

Enable Hardened Freeze
Select this option to enable the z/OS Input/Output Supervisor (I0S) to manage freeze
operations.

Requirement: This option requires the z/OS address spaces Basic HyperSwap Management
and Basic HyperSwap API. For instructions about how to start these address spaces, see
the information about preparing to use Basic HyperSwap from z/OS in the IBM Copy Services
Manager Installation and Configuration Guide.

If you select this option, I0S can freeze volumes regardless of whether the Copy Services
Manager server is started or stopped.

In addition, this option enables you to include z/OS system volumes such as paging, database,
and IBM WebSphere Application Server hierarchical file system (HFS) as Metro Mirror volumes
in the session. When you select this option, IOS manages the freeze operations for all

Metro Mirror volumes in the session, which prevents Copy Services Manager from freezing

the volumes and possibly freezing itself. This option does not enable IOS to manage freeze
operations for Global Mirror volumes.

If you select the Manage H1-H2 with HyperSwap option for the session, this option is
ignored. HyperSwap includes I0S for managing freeze operations. The Enable Hardened
Freeze option ensures data integrity if Copy Services Manager freezes and HyperSwap are not
enabled for a session.
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Manage H1-H2 with HyperSwap
Select this option to trigger a HyperSwap operation, which redirects application I/0 to the
target volumes when there is a failure on the host accessible volumes. Copy Services Manager
uses HyperSwap to manage the H1-H2 sequence of a Metro Mirror or Metro Global Mirror
session.

Disable HyperSwap
Select this option to prevent a HyperSwap operation from occurring.

Reset In Use By System on Secondary Volumes
Select this option to have the load of the configuration automatically reset the In Use
By System state on all secondary volumes (UCBNALOC = OFF). When this option is not
selected, a load of the configuration fails when secondary volumes are in the In Use By
System state (UCBNALOC is ON). This feature is only available after APAR OA53082 is
applied to the z/OS system.

Unbox Secondary Volumes
Select this option to have the load of the configuration automatically unbox all secondary
volumes in the configuration. When this option is not selected, a load of the configuration
fails when secondary volumes are in a boxed state. This feature is only available after
APAR OA53082 is applied to the z/OS system.

On Planned HyperSwap Error:

Partition out the failing system(s) and continue swap processing on the remaining
system(s)
Select this option to partition out the failing system and continue the swap processing
on any remaining systems.

Disable HyperSwap after attempting backout
Select this option to enable I0S to back out the HyperSwap operation, if possible, if an
error occurs during HyperSwap processing. HyperSwap is disabled.

On Unplanned HyperSwap Error:

Partition out the failing system(s) and continue swap processing on the remaining
system(s)
Select this option to partition out the failing systems and continue HyperSwap
processing on the remaining systems when a new system is added to the sysplex
and the HyperSwap operation does not complete.

Requirement: If you select this option, you must restart the system.

Disable HyperSwap after attempting backout
Select this option to enable IOS to back out the HyperSwap operation, if possible, if an
error occurs during HyperSwap processing. HyperSwap is disabled.

H1-J3 Options and H2-J3 Options
Enter the properties for the role pair.

Consistency group interval time (seconds)
Type how often, in seconds, the Global Mirror session attempts to form a consistency group.
A lower value possibly reduces the data exposure of the session. However, a lower value
also causes the session to attempt to create consistency groups more frequently, which can
increase network traffic.

Max Coordination Interval (milliseconds)
Type in the maximum amount of time, in milliseconds, for the extended-distance consistency-
coordination interval. The default value for new sessions is 50 milliseconds. Setting this field
to 0 is equivalent to <auto> and indicates to the storage system to use the default value.

Max CG Drain Time (seconds)
Type in the maximum amount of time, in seconds, that the consistent set of data is allowed
to drain at the remote site before it fails consistency group formation. The default value for
new sessions is 90 seconds. Setting this field to 0 is equivalent to <auto> and indicates to the
storage system to use the default value.
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Recovery Point Objective Alerts
Specify the length of time that you want to set for the recovery point objective (RPO)
thresholds. The values determine whether a Warning or Severe alert is generated when the
RPO threshold is exceeded for a role pair. The RPO represents the length of time in seconds of
data exposure that is acceptable if a disaster occurs.

Use the following options to set the RPO threshold values. For both options, you can specify
an RPO threshold in the range of 0 - 65535 seconds. The default is 0 seconds, which specifies
that no alerts are generated.

Warning level threshold (seconds)
Type the number of seconds that you want to set for the warning level RPO threshold. If
the RPO is greater than this value, an alert is generated.

If the value in this field is other than 0, it must be greater than the value in the
Consistency group interval time (seconds) field and less than the value in the Severe
level threshold (seconds) field.

Severe level threshold (seconds)
Type the number of seconds that you want to set for the severe level RPO threshold. If
the RPO is greater than this value, an alert is generated and the session status changes to
Severe.

If the value in this field is other than 0, it must be greater than the value in the Warning
level threshold (seconds) field.

Journal Options
Reflash After Recover

Select this option to reflash a consistent set of data to the journal volume after a Recover command

is issued to the session. Reflashing to the journal volume ensures that there is a consistent copy of
the data to recover from if failures occur during resynchronization. If you do not select this option, the
journal volumes will not have a consistent copy of the data after the recover operation. However, the
space will be available when space-efficient volumes are used.

Metro Global Mirror with Practice session properties

Use the View/Modify Properties notebook to view or modify properties for IBM DS8000 Metro Global
Mirror with Practice sessions.

The properties are displayed on different tabs in the notebook. Use the Session Options tab to set
properties that apply to the entire session. Use the individual role pair option tabs to set properties that
apply to specific role pairs. For example, properties for the H1-H2 role pair are contained in the H1-H2
Options tab.

Session Options
Enter the properties for the session.

Description
Type the description for this session.

Reset Secondary Reserves
Select this option to remove any persistent reserves that might be set on the target volumes of the
copy sets when a Start command is issued for the session.

e Attention: This option causes the session to overwrite all data that is on the target volume.

Fail MM/GC if target is online (CKD only)
Select this option to fail any session commands for a Metro Mirror or Global Copy relationship
if the target volume is in the Online state. For more information about this state, refer to the
documentation for the storage system.

This option applies only to count key data (CKD) volumes.

H1-H2 Options
Enter the properties for the role pair.
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Metro Mirror Suspend Policy
Select one of the following options to specify the policy for holding or releasing input/output (I/0)
after a Metro Mirror relationship is suspended. When a relationship is in a Suspended state, write
operations from the source volume are no longer mirrored to the target volume.

Hold I/O after Suspend
Click this option to prevent the source volume from receiving new data after the relationship is
suspended. Use this option if you want to determine the scope of the suspension before new
data is written to the source volume. This option helps to ensure that the data on the source
and target volumes remains the same.

To enable write operations to the source volume to continue, issue the Copy Services Manager
Release I/0command forthe session. If you do not issue this command, write operations
are enabled when the hardware timeout value on the storage system expires.

Release I/0 after Suspend
Click this option to enable the source volume to automatically receive data after the
relationship is suspended. Use this option if you want to limit the effect on the applications
that are writing to the source volume. This option is enabled by default.

Attention: This option can cause the data on the source volume to be different from
the data on target volume.

z/0S Management
Select the following options to manage IBM z/0S features for the role pair.

The z/0S Management options are displayed only if Copy Services Manager is installed on or
connected to a z/OS host system. You can add a z/OS host connections in Copy Services Manager
regardless of the operating system on which the application is installed.

When you are connected to a z/OS host system, you can manage z/0S features for volumes that
are attached to the host system. In addition, you can manage these features for volumes that are
attached to other z/0OS systems that are connected to the host system through a sysplex.

System or sysplex
Select the z/0OS system or sysplex that you want to associate with the session. Commands for
z/0S features are issued to this system or sysplex. Volumes in the session must be attached to
the system or sysplex to enable the features.

Enable Hardened Freeze
Select this option to enable the z/OS Input/Output Supervisor (I0S) to manage freeze
operations.

Requirement: This option requires the z/OS address spaces Basic HyperSwap Management
and Basic HyperSwap API. For instructions about how to start these address spaces, see
the information about preparing to use Basic HyperSwap from z/OS in the IBM Copy Services
Manager Installation and Configuration Guide.

If you select this option, I0S can freeze volumes regardless of whether the Copy Services
Manager server is started or stopped.

In addition, this option enables you to include z/OS system volumes such as paging, database,
and IBM WebSphere Application Server hierarchical file system (HFS) as Metro Mirror volumes
in the session. When you select this option, IOS manages the freeze operations for all

Metro Mirror volumes in the session, which prevents Copy Services Manager from freezing

the volumes and possibly freezing itself. This option does not enable I0S to manage freeze
operations for Global Mirror volumes.

If you select the Manage H1-H2 with HyperSwap option for the session, this option is
ignored. HyperSwap includes I0S for managing freeze operations. The Enable Hardened
Freeze option ensures data integrity if Copy Services Manager freezes and HyperSwap are not
enabled for a session.

Manage H1-H2 with HyperSwap
Select this option to trigger a HyperSwap operation, which redirects application I/O to the
target volumes when there is a failure on the host accessible volumes. Copy Services Manager
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uses HyperSwap to manage the H1-H2 sequence of a Metro Mirror or Metro Global Mirror
session.

Disable HyperSwap
Select this option to prevent a HyperSwap operation from occurring.

Reset In Use By System on Secondary Volumes
Select this option to have the load of the configuration automatically reset the In Use
By System state on all secondary volumes (UCBNALOC = OFF). When this option is not
selected, a load of the configuration fails when secondary volumes are in the In Use By
System state (UCBNALOC is ON). This feature is only available after APAR OA53082 is
applied to the z/OS system.

Unbox Secondary Volumes
Select this option to have the load of the configuration automatically unbox all secondary
volumes in the configuration. When this option is not selected, a load of the configuration
fails when secondary volumes are in a boxed state. This feature is only available after
APAR OA53082 is applied to the z/OS system.

On Planned HyperSwap Error:

Partition out the failing system(s) and continue swap processing on the remaining
system(s)
Select this option to partition out the failing system and continue the swap processing
on any remaining systems.

Disable HyperSwap after attempting backout
Select this option to enable I0S to back out the HyperSwap operation, if possible, if an
error occurs during HyperSwap processing. HyperSwap is disabled.

On Unplanned HyperSwap Error:

Partition out the failing system(s) and continue swap processing on the remaining
system(s)
Select this option to partition out the failing systems and continue HyperSwap
processing on the remaining systems when a new system is added to the sysplex
and the HyperSwap operation does not complete.

Requirement: If you select this option, you must restart the system.

Disable HyperSwap after attempting backout
Select this option to enable IOS to back out the HyperSwap operation, if possible, if an
error occurs during HyperSwap processing. HyperSwap is disabled.

H1-J3 Options and H2-J3 Options
Enter the properties for the role pair.

Consistency group interval time (seconds)
Type how often, in seconds, the Global Mirror session attempts to form a consistency group.
A lower value possibly reduces the data exposure of the session. However, a lower value
also causes the session to attempt to create consistency groups more frequently, which can
increase network traffic.

Max Coordination Interval (milliseconds)
Type in the maximum amount of time, in milliseconds, for the extended-distance consistency-
coordination interval. The default value for new sessions is 50 milliseconds. Setting this field
to 0 is equivalent to <auto> and indicates to the storage system to use the default value.

Max CG Drain Time (seconds)
Type in the maximum amount of time, in seconds, that the consistent set of data is allowed
to drain at the remote site before failing consistency group formation. The default value for
new sessions is 90 seconds. Setting this field to 0 is equivalent to <auto> and indicates to the
storage system to use the default value.

Recovery Point Objective Alerts
Specify the length of time that you want to set for the recovery point objective (RPO)
thresholds. The values determine whether a Warning or Severe alert is generated when the
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RPO threshold is exceeded for a role pair. The RPO represents the length of time in seconds of
data exposure that is acceptable if a disaster occurs.

Use the following options to set the RPO threshold values. For both options, you can specify
an RPO threshold in the range of 0 - 65535 seconds. The default is 0 seconds, which specifies
that no alerts are generated.

Warning level threshold (seconds)
Type the number of seconds that you want to set for the warning level RPO threshold. If
the RPO is greater than this value, an alert is generated.

If the value in this field is other than 0, it must be greater than the value in the
Consistency group interval time (seconds) field and less than the value in the Severe
level threshold (seconds) field.

Severe level threshold (seconds)
Type the number of seconds that you want to set for the severe level RPO threshold. If
the RPO is greater than this value, an alert is generated and the session status changes to
Severe.

If the value in this field is other than 0, it must be greater than the value in the Warning
level threshold (seconds) field.

H3-I3 Options
Enter the properties for the role pair.

No Copy
Select this option if you do not want the hardware to write the background copy until the
source track is written to. Data is not copied to the H3 volume until the blocks or tracks of the
I3 volume are modified.

This option is available only for IBM DS8000 version 4.2 or later.

Incremental
Select this option to apply incremental changes to the target volume. After the initial
FlashCopy operation, only data that changed on the source volume since the last FlashCopy
operation completed is copied to the target volume. This option is only valid if the source
storage system supports multiple incremental FlashCopy. If you select this option, a persistent
FlashCopy relationship is created.

Reset target reserves (FB only)
Select this option to reset the SCSI reserves on the FlashCopy target volumes.

This option applies only to fixed block (FB) volumes.

Note: The SCSI reserves are reset only when the Flash command is issued, after the Reset
target reserves (FB only) option is selected.

Journal Options
Reflash After Recover

Select this option to reflash a consistent set of data to the journal volume after a Recover command

is issued to the session. Reflashing to the journal volume ensures that there is a consistent copy of
the data to recover from if failures occur during resynchronization. If you do not select this option, the
journal volumes will not have a consistent copy of the data after the recover operation. However, the
space will be available when space-efficient volumes are used.

Metro Mirror - Metro Mirror session properties

Use the View/Modify Properties notebook to view or modify properties for IBM DS8000 Metro Mirror -
Metro Mirror sessions.

If Copy Services Manager is installed on or connected to a z/OS host system, the properties are displayed
on different tabs in the notebook. Use the Session Options tab to set properties that apply to the entire
session. Use the individual role pair option tabs to set z/OS management properties that apply to specific
role pairs. For example, properties for the H1-H2 role pair are contained in the H1-H2 Options tab. Use
the HyperSwap Options tab to set properties for managing HyperSwap operations for the session.
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If Copy Services Manager is not installed on or connected to a z/OS host system, only the Session Options
tab is displayed.

Connecting to a z/0S host: You can add a z/OS host connection in Copy Services Manager regardless

of the operating system on which the application is installed. When you are connected to a z/OS host
system, you can manage z/0S features for volumes that are attached to the host system. In addition, you
can manage these features for volumes that are attached to other z/OS systems that are connected to the
host system through a sysplex.

Session Options
Enter the properties for the session.

Description
Type the description for this session.

Reset Secondary Reserves
Select this option to remove any persistent reserves that might be set on the target volumes of the
copy sets when a Start command is issued for the session.

Q Attention: This option causes the session to overwrite all data that is on the target volume.

Fail MM/GC if target is online (CKD only)
Select this option to fail any session commands for a Metro Mirror or Global Copy relationship
if the target volume is in the Online state. For more information about this state, refer to the
documentation for the storage system.

This option applies only to count key data (CKD) volumes.

Metro Mirror Suspend Policy
Select one of the following options to specify the policy for holding or releasing input/output (I/0)
after a Metro Mirror relationship is suspended. When a relationship is in a Suspended state, write
operations from the source volume are no longer mirrored to the target volume.

Hold I/O after Suspend
Click this option to prevent the source volume from receiving new data after the relationship is
suspended. Use this option if you want to determine the scope of the suspension before new
data is written to the source volume. This option helps to ensure that the data on the source
and target volumes remains the same.

To enable write operations to the source volume to continue, issue the Copy Services Manager
Release I/0command for the session. If you do not issue this command, write operations
are enabled when the hardware timeout value on the storage system expires.

Release I/O after Suspend
Click this option to enable the source volume to automatically receive data after the
relationship is suspended. Use this option if you want to limit the effect on the applications
that are writing to the source volume. This option is enabled by default.

Attention: This option can cause the data on the source volume to be different from
the data on target volume.

System or sysplex
Select the z/0S system or sysplex that you want to associate with the session. Commands for
z/0S features are issued to this system or sysplex. Volumes in the session must be attached to the
system or sysplex to enable the features.

If you select No Association, the options that are on the remaining tabs in the notebook are
unavailable.

This option is displayed only if Copy Services Manager is installed on or connected to a z/OS host
system.

H1-H2 Options, H1-H3 Options, and H2-H3 Options
Enter the properties for the role pair.
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Manage Hx-Hx with HyperSwap
Select this option to trigger a HyperSwap operation, which redirects application I/O to the target
volumes when there is a failure on the host accessible volumes. Copy Services Manager uses
HyperSwap to manage the H1-H2, H1-H3, or H3-H2 sequence of the session.

HyperSwap Options
Enter the HyperSwap properties for the role pairs that are in the session. If you select Manage Hx-Hx
with HyperSwap on the H1-H2 Options, H1-H3 Options, or H2-H3 Options tab, these properties
define how HyperSwap Manager determines the target site for the HyperSwap operation, the priority
for target sites, and the process that occurs in the event of an error during the operation.

Disable HyperSwap
Select this option to prevent a HyperSwap operation from occurring for all of the role pairs in
the session. This option is typically selected to disable HyperSwap temporarily. For example, to
disable HyperSwap for planned maintenance.

Reset In Use By System on Secondary Volumes
Select this option to have the load of the configuration automatically reset the In Use By System
state on all secondary volumes (UCBNALOC = OFF). When this option is not selected, a load of the
configuration fails when secondary volumes are in the In Use By System state (UCBNALOC is ON).
This feature is only available after APAR OA53082 is applied to the z/OS system.

Unbox Secondary Volumes
Select this option to have the load of the configuration automatically unbox all secondary volumes
in the configuration. When this option is not selected, a load of the configuration fails when
secondary volumes are in a boxed state. This feature is only available after APAR OA53082 is
applied to the z/OS system.

On Planned HyperSwap Error:

Partition out the failing system(s) and continue swap processing on the remaining system(s)
Select this option to partition out the failing system and continue the swap processing on any
remaining systems.

Disable HyperSwap after attempting backout
Select this option to enable I0S to back out the HyperSwap operation, if possible, if an error
occurs during HyperSwap processing. HyperSwap is disabled.

On Unplanned HyperSwap Error:

Partition out the failing system(s) and continue swap processing on the remaining system(s)
Select this option to partition out the failing systems and continue HyperSwap processing
on the remaining systems when a new system is added to the sysplex and the HyperSwap
operation does not complete.

If you select this option, you must restart the system.

Disable HyperSwap after attempting backout
Select this option to enable I0S to back out the HyperSwap operation, if possible, if an error
occurs during HyperSwap processing. HyperSwap is disabled.

HyperSwap Site Selection
Select one of the following options to specify how HyperSwap Manager selects the target site for a
HyperSwap operation.

Allow HyperSwap Manager to determine the HyperSwap site
Select this option to enable HyperSwap to select the target site for a HyperSwap operation.

HyperSwap Manager selects the target site that keeps the most sysplex members active. If
multiple target sites are equal candidates for the HyperSwap operation, HyperSwap Manager
uses the Site HyperSwap Priorities value to select the target site. For example, if both site

1 and site 3 are equal, but the Site HyperSwap Priorities priority is site 3, site 2, and site 1,
HyperSwap Manager selects site 3.

Determine the HyperSwap site by specified priorities
Select this option to direct HyperSwap Manager to select the target site based on the priority
list that is specified by the Site HyperSwap Priorities option.
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HyperSwap Site Priorities
Specify the priority in which HyperSwap Manager selects the target site for a HyperSwap
operation.

The default value priority is site 1, site 2, and site 3. This order indicates that the first priority is
site 1, the second priority is site 2, and the third priority is site 3. If site 1 is the active site, then
site 1 is ignored and HyperSwap Manager selects site 2 or 3 depending on the load status and
availability of the sites, with site 2 being the preferred site.

If you select Allow HyperSwap Manager to determine the HyperSwap site, this option is used
only when multiple target sites are equal candidates for a HyperSwap operation.

If you select Determine the HyperSwap site by specified priorities, this option determines the
order in which HyperSwap Manager selects the target site.

Metro Mirror - Global Mirror session properties

Use the View/Modify Properties notebook to view or modify properties for IBM DS8000 Metro Mirror -
Global Mirror sessions.

The properties are displayed on different tabs in the notebook. Use the Session Options tab to set
properties that apply to the entire session. Use the individual role pair option tabs to set properties that
apply to specific role pairs. For example, properties for the H1-H2 role pair are contained in the H1-H2
Options tab.

Session Options
Enter the properties for the session.

Description
Type the description for this session.

Reset Secondary Reserves
Select this option to remove any persistent reserves that might be set on the target volumes of the
copy sets when a Start command is issued for the session.

c Attention: This option causes the session to overwrite all data that is on the target volume.

Fail MM/GC if target is online (CKD only)
Select this option to fail any session commands for a Metro Mirror or Global Copy relationship
if the target volume is in the Online state. For more information about this state, refer to the
documentation for the storage system.

This option applies only to count key data (CKD) volumes.

H1-H2 Options
Enter the properties for the role pair.

Metro Mirror Suspend Policy
Select one of the following options to specify the policy for holding or releasing input/output (I/0)
after a Metro Mirror relationship is suspended. When a relationship is in a Suspended state, write
operations from the source volume are no longer mirrored to the target volume.

Hold I/O after Suspend
Click this option to prevent the source volume from receiving new data after the relationship is
suspended. Use this option if you want to determine the scope of the suspension before new
data is written to the source volume. This option helps to ensure that the data on the source
and target volumes remains the same.

To enable write operations to the source volume to continue, issue the Copy Services Manager
Release I/0command for the session. If you do not issue this command, write operations
are enabled when the hardware timeout value on the storage system expires.

Release I/0 after Suspend
Click this option to enable the source volume to automatically receive data after the
relationship is suspended. Use this option if you want to limit the effect on the applications
that are writing to the source volume. This option is enabled by default.
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Attention: This option can cause the data on the source volume to be different from
the data on target volume.

z/0S Management
Select the following options to manage IBM z/0S features for the role pair.

The z/OS Management options are displayed only if the copy services management server is
installed on or connected to a z/OS host system. You can add a z/OS host connection to the

copy services management server regardless of the operating system on which the application is
installed.

When you are connected to a z/OS host system, you can manage z/OS features for volumes that
are attached to the host system. In addition, you can manage these features for volumes that are
attached to other z/OS systems that are connected to the host system through a sysplex.

System or sysplex
Select the z/OS system or sysplex that you want to associate with the session. Commands for
z/0S features are issued to this system or sysplex. Volumes in the session must be attached to
the system or sysplex to enable the features.

Enable Hardened Freeze
Select this option to enable the z/OS Input/Output Supervisor (I0S) to manage freeze
operations.

Requirement: This option requires the z/OS address spaces Basic HyperSwap®
Management and Basic HyperSwap API. For instructions about how to start these address
spaces, see the information about preparing to use Basic HyperSwap from z/0OS in the IBM
Copy Services Manager Installation and Configuration Guide.

If you select this option, IOS can freeze volumes regardless of whether the copy services
management server is started or stopped.

In addition, with this option you can include z/0S system volumes such as paging,
database, and IBM WebSphere Application Server hierarchical file system (HFS) as Metro
Mirror volumes in the session. When you select this option, I0OS manages the freeze
operations for all Metro Mirror volumes in the session, which prevents the copy services
management server from freezing the volumes and possibly freezing itself. This option
does not enable I0S to manage freeze operations for Global Mirror volumes.

If you select the Manage H1-H2 with HyperSwap option for the session, this option is
ignored. HyperSwap includes I0S for managing freeze operations. The Enable Hardened
Freeze option ensures data integrity if copy services management server freezes and
HyperSwap is not enabled for a session.

Manage H1-H2 with Hyperswap
Select this option to trigger a HyperSwap operation, which redirects application I/O to the
target volumes when a failure occurs on the host accessible volumes. HyperSwap is used
to manage the H1-H2 sequence of a Metro Mirror or Metro Global Mirror session.

Disable HyperSwap
Select this option to prevent a HyperSwap operation from occurring.

Reset In Use By System on Secondary Volumes
Select this option to have the load of the configuration automatically reset the In Use
By System state on all secondary volumes (UCBNALOC = OFF). When this option is not
selected, a load of the configuration fails when secondary volumes are in the In Use By
System state (UCBNALOC is ON). This feature is only available after APAR OA53082 is
applied to the z/0S system.

Unbox Secondary Volumes
Select this option to have the load of the configuration automatically unbox all
secondary volumes in the configuration. When this option is not selected, a load of
the configuration fails when secondary volumes are in a boxed state. This feature is
only available after APAR OA53082 is applied to the z/OS system.
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On Planned HyperSwap error:
Partition out the failing system(s) and continue swap processing on the remaining
system(s)

Select this option to partition out the failing system and continue the swap processing
on any remaining systems.

Disable HyperSwap after attempting backout

Select this option to enable I0S to back out the HyperSwap operation, if possible, if an
error occurs during HyperSwap processing. HyperSwap is disabled.

On Unplanned HyperSwap error:
Partition out the failing system(s) and continue swap processing on the remaining
system(s)

Select this option to partition out the failing systems and continue HyperSwap
processing on the remaining systems when a new system is added to the sysplex
and the HyperSwap operation does not complete.

Requirement: If you select this option, you must restart the system.
Disable HyperSwap after attempting backout

Select this option to enable I0S to back out the HyperSwap operation, if possible, if an
error occurs during HyperSwap processing. HyperSwap is disabled.

H1-33 Options and H2-J3 Options
Enter the properties for the role pair.

Consistency group interval time (seconds)
Type how often, in seconds, the Global Mirror session attempts to form a consistency group. A
lower value possibly reduces the data exposure of the session. However, a lower value also causes
the session to attempt to create consistency groups more frequently, which can increase network
traffic.

Max Coordination Interval (milliseconds)
Type in the maximum amount of time, in milliseconds, for the extended-distance consistency-
coordination interval. The default value for new sessions is 50 milliseconds. Setting this field to 0
is equivalent to <auto> and indicates to the storage system to use the default value.

Max CG Drain Time (seconds)
Type in the maximum amount of time, in seconds, that the consistent set of data is allowed to
drain at the remote site before it fails consistency group formation. The default value for new
sessions is 90 seconds. Setting this field to 0 is equivalent to <auto> and indicates to the storage
system to use the default value.

Recovery Point Objective Alerts
Specify the length of time that you want to set for the recovery point objective (RPO) thresholds.
The values determine whether a Warning or Severe alert is generated when the RPO threshold is
exceeded for a role pair. The RPO represents the length of time in seconds of data exposure that is
acceptable if a disaster occurs.

Use the following options to set the RPO threshold values. For both options, you can specify an
RPO threshold in the range of 0 - 65535 seconds. The default is 0 seconds, which specifies that no
alerts are generated.

Warning level threshold (seconds)
Type the number of seconds that you want to set for the warning level RPO threshold. If the
RPO is greater than this value, an alert is generated.

If the value in this field is other than 0O, it must be greater than the value in the Consistency
group interval time (seconds) field, and less than the value in the Severe level threshold
(seconds) field.
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Severe level threshold (seconds)
Type the number of seconds that you want to set for the severe level RPO threshold. If the
RPO is greater than this value, an alert is generated and the session status changes to Severe.

If the value in this field is other than O, it must be greater than the value in the Warning level
threshold (seconds) field.

Journal Options
Reflash After Recover

Select this option to reflash a consistent set of data to the journal volume after a Recover command

is issued to the session. Reflashing to the journal volume ensures that there is a consistent copy of
the data to recover from if failures occur during resynchronization. If you do not select this option, the
journal volumes will not have a consistent copy of the data after the recover operation. However, the
space will be available when space-efficient volumes are used.

Metro Mirror - Global Mirror with Practice session properties

Use the View/Modify Properties notebook to view or modify properties for IBM DS8000 Metro Mirror -
Global Mirror with Practice sessions.

The properties are displayed on different tabs in the notebook. Use the Session Options tab to set
properties that apply to the entire session. Use the individual role pair option tabs to set properties that
apply to specific role pairs. For example, properties for the H1-H2 role pair are contained in the H1-H2
Options tab.

Session Options
Enter the properties for the session.

Description
Type the description for this session.

Reset Secondary Reserves
Select this option to remove any persistent reserves that might be set on the target volumes of the

copy sets when a Start command is issued for the session.
c Attention: This option causes the session to overwrite all data that is on the target volume.

Fail MM/GC if target is online (CKD only)
Select this option to fail any session commands for a Metro Mirror or Global Copy relationship
if the target volume is in the Online state. For more information about this state, see the
documentation for the storage system.

This option applies only to count key data (CKD) volumes.

H1-H2 Options
Enter the properties for the role pair.

Metro Mirror Suspend Policy
Select one of the following options to specify the policy for holding or releasing input/output (I/0)
after a Metro Mirror relationship is suspended. When a relationship is in a Suspended state, write
operations from the source volume are no longer mirrored to the target volume.

Hold I/O after Suspend
Click this option to prevent the source volume from receiving new data after the relationship is
suspended. Use this option if you want to determine the scope of the suspension before new
data is written to the source volume. This option helps to ensure that the data on the source
and target volumes remains the same.

To enable write operations to the source volume to continue, issue the Copy Services Manager
Release I/0command for the session. If you do not issue this command, write operations
are enabled when the hardware timeout value on the storage system expires.
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Release I/0 after Suspend
Click this option to enable the source volume to automatically receive data after the
relationship is suspended. Use this option if you want to limit the effect on the applications
that are writing to the source volume. This option is enabled by default.

Attention: This option can cause the data on the source volume to be different from
the data on target volume.

z/0S Management
Select the following options to manage IBM z/OS features for the role pair.

The z/OS Management options are displayed only if the copy services management server is
installed on or connected to a z/OS host system. You can add a z/OS host connection to the

copy services management server regardless of the operating system on which the application is
installed.

When you are connected to a z/OS host system, you can manage z/OS features for volumes that
are attached to the host system. In addition, you can manage these features for volumes that are
attached to other z/OS systems that are connected to the host system through a sysplex.

System or sysplex
Select the z/OS system or sysplex that you want to associate with the session. Commands for
z/0S features are issued to this system or sysplex. Volumes in the session must be attached to
the system or sysplex to enable the features.

Enable Hardened Freeze
Select this option to enable the z/OS Input/Output Supervisor (I0S) to manage freeze
operations.

Requirement: This option requires the z/OS address spaces Basic HyperSwap®
Management and Basic HyperSwap API. For instructions about how to start these address
spaces, see the information about preparing to use Basic HyperSwap from z/0OS in the IBM
Copy Services Manager Installation and Configuration Guide.

If you select this option, I0S can freeze volumes regardless of whether the copy services
management server is started or stopped.

In addition, with this option you can include z/0S system volumes such as paging,
database, and IBM WebSphere Application Server hierarchical file system (HFS) as Metro
Mirror volumes in the session. When you select this option, I0S manages the freeze
operations for all Metro Mirror volumes in the session, which prevents the copy services
management server from freezing the volumes and possibly freezing itself. This option
does not enable I0S to manage freeze operations for Global Mirror volumes.

If you select the Manage H1-H2 with HyperSwap option for the session, this option is
ignored. HyperSwap includes I0S for managing freeze operations. The Enable Hardened
Freeze option ensures data integrity if the copy services management server freezes and
HyperSwap is not enabled for a session.

Manage H1-H2 with Hyperswap
Select this option to trigger a HyperSwap operation, which redirects application I/O to the
target volumes when a failure occurs on the host accessible volumes. HyperSwap is used
to manage the H1-H2 sequence of a Metro Mirror or Metro Global Mirror session.

Disable HyperSwap
Select this option to prevent a HyperSwap operation from occurring.

Reset In Use By System on Secondary Volumes
Select this option to have the load of the configuration automatically reset the In Use
By System state on all secondary volumes (UCBNALOC = OFF). When this option is not
selected, a load of the configuration fails when secondary volumes are in the In Use By
System state (UCBNALOC is ON). This feature is only available after APAR OA53082 is
applied to the z/0S system.
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Unbox Secondary Volumes
Select this option to have the load of the configuration automatically unbox all
secondary volumes in the configuration. When this option is not selected, a load of
the configuration fails when secondary volumes are in a boxed state. This feature is
only available after APAR OA53082 is applied to the z/OS system.

On Planned HyperSwap error:
Partition out the failing system(s) and continue swap processing on the remaining
system(s)

Select this option to partition out the failing system and continue the swap processing
on any remaining systems.

Disable HyperSwap after attempting backout

Select this option to enable I0S to back out the HyperSwap operation, if possible, if an
error occurs during HyperSwap processing. HyperSwap is disabled.

On Unplanned HyperSwap error:
Partition out the failing system(s) and continue swap processing on the remaining
system(s)

Select this option to partition out the failing systems and continue HyperSwap
processing on the remaining systems when a new system is added to the sysplex
and the HyperSwap operation does not complete.

Requirement: If you select this option, you must restart the system.
Disable HyperSwap after attempting backout

Select this option to enable I0S to back out the HyperSwap operation, if possible, if an
error occurs during HyperSwap processing. HyperSwap is disabled.

H1-33 Options and H2-J3 Options
Enter the properties for the role pair.

Consistency group interval time (seconds)
Type how often, in seconds, the Global Mirror session attempts to form a consistency group. A
lower value possibly reduces the data exposure of the session. However, a lower value also causes
the session to attempt to create consistency groups more frequently, which can increase network
traffic.

Max Coordination Interval (milliseconds)
Type in the maximum amount of time, in seconds, that the consistent set of data is allowed to
drain at the remote site before it fails consistency group formation. The default value for new
sessions is 90 seconds. Setting this field to 0 is equivalent to <auto> and indicates to the storage
system to use the default value.

Max CG Drain Time (seconds)
Type in the maximum amount of time, in seconds, that the consistent set of data is allowed to
drain at the remote site before it fails consistency group formation. The default value for new
sessions is 90 seconds. Setting this field to 0 is equivalent to <auto> and indicates to the storage
system to use the default value.

Recovery Point Objective Alerts
Specify the length of time that you want to set for the recovery point objective (RPO) thresholds.
The values determine whether a Warning or Severe alert is generated when the RPO threshold is
exceeded for a role pair. The RPO represents the length of time in seconds of data exposure that is
acceptable if a disaster occurs.

Use the following options to set the RPO threshold values. For both options, you can specify an
RPO threshold in the range of 0 - 65535 seconds. The default is 0 seconds, which specifies that no
alerts are generated.
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Warning level threshold (seconds)
Type the number of seconds that you want to set for the warning level RPO threshold. If the
RPO is greater than this value, an alert is generated.

If the value in this field is other than 0, it must be greater than the value in the Consistency
group interval time (seconds) field, and less than the value in the Severe level threshold
(seconds) field.

Severe level threshold (seconds)
Type the number of seconds that you want to set for the severe level RPO threshold. If the
RPO is greater than this value, an alert is generated and the session status changes to Severe.

If the value in this field is other than 0, it must be greater than the value in the Warning level
threshold (seconds) field.

H3-13 Options
Enter the properties for the role pair.

No Copy
Select this option if you do not want the hardware to write the background copy until the source
track is written to. Data is not copied to the H3 volume until the blocks or tracks of the I3 volume
are modified.

Incremental
Select this option to apply incremental changes to the target volume. After the initial FlashCopy
operation, only data that changed on the source volume since the last FlashCopy operation
completed is copied to the target volume. This option is only valid if the source storage system
supports multiple incremental FlashCopy.

Reset target reserves (FB only)
Select this option to reset the SCSI reserves on the FlashCopy target volumes.

This option applies only to fixed block (FB) volumes.

Note: The SCSI reserves are reset only when the Flash command is issued, after the Reset target
reserves (FB only) option is selected.

Journal Options
Reflash After Recover

Select this option to reflash a consistent set of data to the journal volume after a Recover command

is issued to the session. Reflashing to the journal volume ensures that there is a consistent copy of
the data to recover from if failures occur during resynchronization. If you do not select this option, the
journal volumes will not have a consistent copy of the data after the recover operation. However, the
space will be available when space-efficient volumes are used.

Metro Mirror - Global Mirror with Site 3 Global Mirror session properties

Use the View/Modify Properties notebook to view or modify properties for IBM DS8000 Metro Mirror -
Global Mirror with Site 3 Global Mirror sessions.

The properties are displayed on different tabs in the notebook. Use the Session Options tab to set
properties that apply to the entire session. Use the individual role pair option tabs to set properties that
apply to specific role pairs. For example, properties for the H1-H2 role pair are contained in the H1-H2
Options tab.

Session Options
Enter the properties for the session.

Description
Type the description for this session.

Reset Secondary Reserves
Select this option to remove any persistent reserves that might be set on the target volumes of the

copy sets when a Start command is issued for the session.
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Q Attention: This option causes the session to overwrite all data that is on the target volume.

Fail MM/GC if target is online (CKD only)
Select this option to fail any session commands for a Metro Mirror or Global Copy relationship
if the target volume is in the Online state. For more information about this state, refer to the
documentation for the storage system.

This option applies only to count key data (CKD) volumes.

H1-H2 Options
Enter the properties for the role pair.

Metro Mirror Suspend Policy
Select one of the following options to specify the policy for holding or releasing input/output (I/0)
after a Metro Mirror relationship is suspended. When a relationship is in a Suspended state, write
operations from the source volume are no longer mirrored to the target volume.

Hold I/O after Suspend
Click this option to prevent the source volume from receiving new data after the relationship is
suspended. Use this option if you want to determine the scope of the suspension before new
data is written to the source volume. This option helps to ensure that the data on the source
and target volumes remains the same.

To enable write operations to the source volume to continue, issue the Copy Services Manager
Release I/0command forthe session. If you do not issue this command, write operations
are enabled when the hardware timeout value on the storage system expires.

Release I/0 after Suspend
Click this option to enable the source volume to automatically receive data after the
relationship is suspended. Use this option if you want to limit the effect on the applications
that are writing to the source volume. This option is enabled by default.

Attention: This option can cause the data on the source volume to be different from
the data on target volume.

z/0S Management
Select the following options to manage IBM z/OS features for the role pair.

The z/OS Management options are displayed only if the copy services management server is
installed on or connected to a z/OS host system. You can add a z/OS host connection to the

copy services management server regardless of the operating system on which the application is
installed.

When you are connected to a z/OS host system, you can manage z/OS features for volumes that
are attached to the host system. In addition, you can manage these features for volumes that are
attached to other z/OS systems that are connected to the host system through a sysplex.

System or sysplex
Select the z/0OS system or sysplex that you want to associate with the session. Commands for
z/0S features are issued to this system or sysplex. Volumes in the session must be attached to
the system or sysplex to enable the features.

Enable Hardened Freeze
Select this option to enable the z/OS Input/Output Supervisor (I0S) to manage freeze
operations.

Requirement: This option requires the z/OS address spaces Basic HyperSwap®
Management and Basic HyperSwap API. For instructions about how to start these address
spaces, see the information about preparing to use Basic HyperSwap from z/0S in the IBM
Copy Services Manager Installation and Configuration Guide.

If you select this option, IOS can freeze volumes regardless of whether the copy services
management server is started or stopped.
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In addition, with this option you can include z/0S system volumes such as paging,
database, and IBM WebSphere Application Server hierarchical file system (HFS) as Metro
Mirror volumes in the session. When you select this option, I0S manages the freeze
operations for all Metro Mirror volumes in the session, which prevents the copy services
management server from freezing the volumes and possibly freezing itself. This option
does not enable I0S to manage freeze operations for Global Mirror volumes.

If you select the Manage H1-H2 with HyperSwap option for the session, this option is
ignored. HyperSwap includes IOS for managing freeze operations. The Enable Hardened
Freeze option ensures data integrity if copy services management server freezes and
HyperSwap is not enabled for a session.

Manage H1-H2 with Hyperswap
Select this option to trigger a HyperSwap operation, which redirects application I/0 to the
target volumes when a failure occurs on the host accessible volumes. HyperSwap is used
to manage the H1-H2 sequence of a Metro Mirror or Metro Global Mirror session.

Disable HyperSwap
Select this option to prevent a HyperSwap operation from occurring.

On Configuration Error:
Partition the system(s) out of the sysplex

Select this option to partition a new system out of the sysplex when an error occurs
because the system cannot be added to the HyperSwap configuration.

Disable HyperSwap
Select this option to prevent a HyperSwap operation from occurring.

On Planned HyperSwap error:
Partition out the failing system(s) and continue swap processing on the remaining
system(s)

Select this option to partition out the failing system and continue the swap processing
on any remaining systems.

Disable HyperSwap after attempting backout

Select this option to enable IOS to back out the HyperSwap operation, if possible, if an
error occurs during HyperSwap processing. HyperSwap is disabled.

On Unplanned HyperSwap error:
Partition out the failing system(s) and continue swap processing on the remaining
system(s)

Select this option to partition out the failing systems and continue HyperSwap
processing on the remaining systems when a new system is added to the sysplex
and the HyperSwap operation does not complete.

Requirement: If you select this option, you must restart the system.
Disable HyperSwap after attempting backout

Select this option to enable IOS to back out the HyperSwap operation, if possible, if an
error occurs during HyperSwap processing. HyperSwap is disabled.

H1-33, H2-J3, H3-J1 and H3-J2 Options
Enter the properties for the role pair.

Consistency group interval time (seconds)
Type how often, in seconds, the Global Mirror session attempts to form a consistency group. A
lower value possibly reduces the data exposure of the session. However, a lower value also causes
the session to attempt to create consistency groups more frequently, which can increase network
traffic.
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Max Coordination Interval (milliseconds)
Type in the maximum amount of time, in milliseconds, for the extended-distance consistency-
coordination interval. The default value for new sessions is 50 milliseconds. Setting this field to 0
is equivalent to <auto> and indicates to the storage system to use the default value.

Max CG Drain Time (seconds)
Type in the maximum amount of time, in seconds, that the consistent set of data is allowed to
drain at the remote site before it fails consistency group formation. The default value for new
sessions is 90 seconds. Setting this field to 0 is equivalent to <auto> and indicates to the storage
system to use the default value.

Recovery Point Objective Alerts
Specify the length of time that you want to set for the recovery point objective (RPO) thresholds.
The values determine whether a Warning or Severe alert is generated when the RPO threshold is
exceeded for a role pair. The RPO represents the length of time in seconds of data exposure that is
acceptable if a disaster occurs.

Use the following options to set the RPO threshold values. For both options, you can specify an
RPO threshold in the range of 0 - 65535 seconds. The default is 0 seconds, which specifies that no
alerts are generated.

Warning level threshold (seconds)
Type the number of seconds that you want to set for the warning level RPO threshold. If the
RPO is greater than this value, an alert is generated.

If the value in this field is other than 0, it must be greater than the value in the Consistency
group interval time (seconds) field, and less than the value in the Severe level threshold
(seconds) field.

Severe level threshold (seconds)
Type the number of seconds that you want to set for the severe level RPO threshold. If the
RPO is greater than this value, an alert is generated and the session status changes to Severe.

If the value in this field is other than 0, it must be greater than the value in the Warning level
threshold (seconds) field.

Journal Options
Reflash After Recover

Select this option to reflash a consistent set of data to the journal volume after a Recover command

is issued to the session. Reflashing to the journal volume ensures that there is a consistent copy of
the data to recover from if failures occur during resynchronization. If you do not select this option, the
journal volumes will not have a consistent copy of the data after the recover operation. However, the
space will be available when space-efficient volumes are used.

Metro Mirror - Global Mirror with Site 4 Replication session properties

Use the View/Modify Properties notebook to edit properties for IBM DS8000 Metro Mirror - Global Mirror
with Site 4 Replication sessions.

The properties are displayed on different tabs in the notebook. Use the Session Options tab to set
properties that apply to the entire session. Use the individual role pair option tabs to set properties that
apply to specific role pairs. For example, properties for the H1-H2 role pair are contained in the H1-H2
Options tab.

Session Options
Enter the properties for the session.

Description
Type the description for this session.

Reset Secondary Reserves
Select this option to remove any persistent reserves that might be set on the target volumes of the
copy sets when a Start command is issued for the session.
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Q Attention: This option causes the session to overwrite all data that is on the target volume.

Fail MM/GC if target is online (CKD only)
Select this option to fail any session commands for a Metro Mirror or Global Copy relationship
if the target volume is in the Online state. For more information about this state, refer to the
documentation for the storage system.

This option applies only to count key data (CKD) volumes.
z/0S Management

Select the following options to manage IBM z/0S features for the role pair.

Enable Hardened Freeze
Select this option to enable the z/OS Input/Output Supervisor (I0S) to manage freeze
operations.

Requirement: This option requires the z/0S address spaces Basic HyperSwap® Management
and Basic HyperSwap API. For instructions about how to start these address spaces, see

the information about preparing to use Basic HyperSwap from z/OS in the IBM Copy Services
Manager Installation and Configuration Guide.

If you select this option, IOS can freeze volumes regardless of whether the copy services
management server is started or stopped.

In addition, with this option you can include z/OS system volumes such as paging, database,
and IBM WebSphere Application Server hierarchical file system (HFS) as Metro Mirror volumes
in the session. When you select this option, IOS manages the freeze operations for all Metro
Mirror volumes in the session, which prevents the copy services management server from
freezing the volumes and possibly freezing itself. This option does not enable IOS to manage
freeze operations for Global Mirror volumes.

If you select the Manage H1-H2 or H3-H4 with HyperSwap option for the session, this

option is ignored. HyperSwap includes I0S for managing freeze operations. The Enable
Hardened Freeze option ensures data integrity if copy services management server freezes
and HyperSwap is not enabled for a session.

Metro Mirror Suspend Policy
Select one of the following options to specify the policy for holding or releasing input/output (I/0)
after a Metro Mirror relationship is suspended. When a relationship is in a Suspended state, write
operations from the source volume are no longer mirrored to the target volume.

Hold I/O after Suspend
Click this option to prevent the source volume from receiving new data after the relationship is
suspended. Use this option if you want to determine the scope of the suspension before new
data is written to the source volume. This option helps to ensure that the data on the source
and target volumes remains the same.

To enable write operations to the source volume to continue, issue the Copy Services Manager
Release I/0command forthe session. If you do not issue this command, write operations
are enabled when the hardware timeout value on the storage system expires.

Release I/0 after Suspend
Click this option to enable the source volume to automatically receive data after the
relationship is suspended. Use this option if you want to limit the effect on the applications
that are writing to the source volume. This option is enabled by default.

Attention: This option can cause the data on the source volume to be different from
the data on target volume.

H1-H2 or H3-H4 Options
Enter the properties for the role pair.

z/0S Management

Select the following options to manage IBM z/0S features for the role pair.
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The z/OS Management options are displayed only if the copy services management server is
installed on or connected to a z/OS host system. You can add a z/OS host connection to the

copy services management server regardless of the operating system on which the application is
installed.

When you are connected to a z/OS host system, you can manage z/OS features for volumes that
are attached to the host system. In addition, you can manage these features for volumes that are
attached to other z/OS systems that are connected to the host system through a sysplex.

System or sysplex
Select the z/0S system or sysplex that you want to associate with the session. Commands for
z/0S features are issued to this system or sysplex. Volumes in the session must be attached to
the system or sysplex to enable the features.

Manage H1-H2 or H3-H4 with Hyperswap
Select this option to trigger a HyperSwap operation, which redirects application I/O to the
target volumes when a failure occurs on the host accessible volumes. HyperSwap is used to
manage the H1-H2 sequence of a Metro Mirror or Metro Global Mirror session.

HyperSwap options

Disable HyperSwap
Select this option to prevent a HyperSwap operation from occurring.

Reset In Use By System on Secondary Volumes
Select this option to have the load of the configuration automatically reset the In Use By System
state on all secondary volumes (UCBNALOC = OFF). When this option is not selected, a load of the
configuration fails when secondary volumes are in the In Use By System state (UCBNALOC is ON).
This feature is only available after APAR OA53082 is applied to the z/OS system.

Unbox Secondary Volumes
Select this option to have the load of the configuration automatically unbox all secondary volumes
in the configuration. When this option is not selected, a load of the configuration fails when
secondary volumes are in a boxed state. This feature is only available after APAR OA53082 is
applied to the z/OS system.

On Planned HyperSwap error:
Partition out the failing system(s) and continue swap processing on the remaining system(s)

Select this option to partition out the failing system and continue the swap processing on any
remaining systems.

Disable HyperSwap after attempting backout

Select this option to enable I0S to back out the HyperSwap operation, if possible, if an error
occurs during HyperSwap processing. HyperSwap is disabled.

On Unplanned HyperSwap error:
Partition out the failing system(s) and continue swap processing on the remaining system(s)

Select this option to partition out the failing systems and continue HyperSwap processing on the
remaining systems when a new system is added to the sysplex and the HyperSwap operation does
not complete.

Requirement: If you select this option, you must restart the system.
Disable HyperSwap after attempting backout
Select this option to enable I0S to back out the HyperSwap operation, if possible, if an error
occurs during HyperSwap processing. HyperSwap is disabled.
H1-33, H2-33, H3-J1 and H4JI Options
Enter the properties for the role pair.

Consistency group interval time (seconds)
Type how often, in seconds, the Global Mirror session attempts to form a consistency group. A
lower value possibly reduces the data exposure of the session. However, a lower value also causes
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the session to attempt to create consistency groups more frequently, which can increase network
traffic.

Max Coordination Interval (milliseconds)
Type in the maximum amount of time, in milliseconds, for the extended-distance consistency-
coordination interval. The default value for new sessions is 50 milliseconds. Setting this field to 0
is equivalent to <auto> and indicates to the storage system to use the default value.

Max CG Drain Time (seconds)
Type in the maximum amount of time, in seconds, that the consistent set of data is allowed to
drain at the remote site before it fails consistency group formation. The default value for new
sessions is 90 seconds. Setting this field to O is equivalent to <auto> and indicates to the storage
system to use the default value.

Recovery Point Objective Alerts
Specify the length of time that you want to set for the recovery point objective (RPO) thresholds.
The values determine whether a Warning or Severe alert is generated when the RPO threshold is
exceeded for a role pair. The RPO represents the length of time in seconds of data exposure that is
acceptable if a disaster occurs.

Use the following options to set the RPO threshold values. For both options, you can specify an
RPO threshold in the range of 0 - 65535 seconds. The default is 0 seconds, which specifies that no
alerts are generated.

Warning level threshold (seconds)
Type the number of seconds that you want to set for the warning level RPO threshold. If the
RPO is greater than this value, an alert is generated.

If the value in this field is other than 0, it must be greater than the value in the Consistency
group interval time (seconds) field, and less than the value in the Severe level threshold
(seconds) field.

Severe level threshold (seconds)
Type the number of seconds that you want to set for the severe level RPO threshold. If the
RPO is greater than this value, an alert is generated and the session status changes to Severe.

If the value in this field is other than 0, it must be greater than the value in the Warning level
threshold (seconds) field.

Journal Options
Enter the properties for the role pair.

Reflash After Recover

Select this option to reflash a consistent set of data to the journal volume after a Recover command

is issued to the session. Reflashing to the journal volume ensures that there is a consistent copy of
the data to recover from if failures occur during resynchronization. If you do not select this option, the
journal volumes will not have a consistent copy of the data after the recover operation. However, the
space will be available when space-efficient volumes are used.

Metro Mirror - Metro Mirror with Site 4 Replication session properties

Use the View/Modify Properties notebook to edit properties for IBM DS8000 Metro Mirror - Metro Mirror
with Site 4 Replication sessions.

If the copy services management server is installed on or connected to a z/OS® host system, the
properties are displayed on different tabs in the notebook. Use the Session Options tab to set properties
that apply to the entire session. Use the individual role pair option tabs to set z/OS management
properties that apply to specific role pairs. For example, properties for the H1-H2 role pair are contained
in the H1-H2 Options tab. Use the HyperSwap® Options tab to set properties for managing HyperSwap
operations for the session.

If the copy services management server is not installed on or connected to a z/OS host system, only the
Session Options tab is displayed.
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Session Options
Enter the properties for the session.

Description
Type the description for this session.

Fail MM/GC if target is online (CKD only)
Select this option to fail any session commands for a Metro Mirror or Global Copy relationship
if the target volume is in the Online state. For more information about this state, refer to the
documentation for the storage system.

This option applies only to count key data (CKD) volumes.

Reset Secondary Reserves
Select this option to remove any persistent reserves that might be set on the target volumes of the
copy sets when a Start command is issued for the session.

Q Attention: This option causes the session to overwrite all data that is on the target volume.

Metro Mirror Suspend Policy
Select one of the following options to specify the policy for holding or releasing input/output (I/0)
after a Metro Mirror relationship is suspended. When a relationship is in a Suspended state, write
operations from the source volume are no longer mirrored to the target volume.

Hold I/O after Suspend
Click this option to prevent the source volume from receiving new data after the relationship is
suspended. Use this option if you want to determine the scope of the suspension before new
data is written to the source volume. This option helps to ensure that the data on the source
and target volumes remains the same.

To enable write operations to the source volume to continue, issue the Copy Services Manager
Release I/0command for the session. If you do not issue this command, write operations
are enabled when the hardware timeout value on the storage system expires.

Release I/O after Suspend
Click this option to enable the source volume to automatically receive data after the
relationship is suspended. Use this option if you want to limit the effect on the applications
that are writing to the source volume. This option is enabled by default.

Attention: This option can cause the data on the source volume to be different from
the data on target volume.

System or sysplex
Select the z/0S system or sysplex that you want to associate with the session. Commands for
z/0S features are issued to this system or sysplex. Volumes in the session must be attached to the
system or sysplex to enable the features.

If you select No Association, the options that are on the remaining tabs in the notebook are
unavailable. This option is displayed only if the copy services management server is installed on or
connected to a z/OS host system.

H1-H2 Options, H1-H3 Options, H2-H3 Options, H3-H4 Options and H1-H4 Options
Enter the properties for the role pair.

Manage Hx-Hx with HyperSwap
Select this option to trigger a HyperSwap operation, which redirects application I/O to the target
volumes when there is a failure on the host accessible volumes. HyperSwap is used to manage the
H1-H2, H1-H3, or H3-H2 sequence of the session.

HyperSwap options
Enter the HyperSwap properties for the role pairs that are in the session. If you select Manage Hx-Hx
with HyperSwap on the H1-H2 Options, H1-H3 Options, or H2-H3 Options tab, these properties define
how HyperSwap Manager determines the target site for the HyperSwap operation, the priority for
target sites, and the process that occurs in the event of an error during the operation.
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Disable HyperSwap
Select this option to prevent a HyperSwap operation from occurring.

Reset In Use By System on Secondary Volumes
Select this option to have the load of the configuration automatically reset the In Use By System
state on all secondary volumes (UCBNALOC = OFF). When this option is not selected, a load of the
configuration fails when secondary volumes are in the In Use By System state (UCBNALOC is ON).
This feature is only available after APAR OA53082 is applied to the z/OS system.

Unbox Secondary Volumes
Select this option to have the load of the configuration automatically unbox all secondary volumes
in the configuration. When this option is not selected, a load of the configuration fails when
secondary volumes are in a boxed state. This feature is only available after APAR OA53082 is
applied to the z/OS system.

On Planned HyperSwap error:
Partition out the failing system(s) and continue swap processing on the remaining system(s)

Select this option to partition out the failing system and continue the swap processing on any
remaining systems.

Disable HyperSwap after attempting backout

Select this option to enable I0S to back out the HyperSwap operation, if possible, if an error
occurs during HyperSwap processing. HyperSwap is disabled.

On Unplanned HyperSwap error:
Partition out the failing system(s) and continue swap processing on the remaining system(s)

Select this option to partition out the failing systems and continue HyperSwap processing on the
remaining systems when a new system is added to the sysplex and the HyperSwap operation does
not complete.

Requirement: If you select this option, you must restart the system.
Disable HyperSwap after attempting backout

Select this option to enable I0S to back out the HyperSwap operation, if possible, if an error
occurs during HyperSwap processing. HyperSwap is disabled.

HyperSwap Site Selection
Select one of the following options to specify how HyperSwap Manager selects the target site for a
HyperSwap operation.

Allow HyperSwap Manager to determine the HyperSwap site
Select this option to enable HyperSwap to select the target site for a HyperSwap operation.

HyperSwap Manager selects the target site that keeps the most sysplex members active. If
multiple target sites are equal candidates for the HyperSwap operation, HyperSwap Manager
uses the Site HyperSwap Priorities value to select the target site. For example, if both site 1
and site 3 are equal, but the Site HyperSwap Priorities priority is site 3, site 2, and site 1,
HyperSwap Manager selects site 3.

Determine the HyperSwap site by specified priorities
Select this option to direct HyperSwap Manager to select the target site based on the priority
list that is specified by the Site HyperSwap Priorities option.

HyperSwap Site Priorities
Specify the priority in which HyperSwap Manager selects the target site for a HyperSwap
operation.

The default value priority is site 1, site 2, and site 3. This order indicates that the first priority is
site 1, the second priority is site 2, and the third priority is site 3. If site 1 is the active site, then
site 1 is ignored and HyperSwap Manager selects site 2 or 3 depending on the load status and
availability of the sites, with site 2 being the preferred site.

If you select Allow HyperSwap Manager to determine the HyperSwap site, this option is used only
when multiple target sites are equal candidates for a HyperSwap operation.
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If you select Determine the HyperSwap site by specified priorities, this option determines the
order in which HyperSwap Manager selects the target site.

Safeguarded Copy session properties

Use the View/Modify Properties notebook to view or modify properties for IBM DS8000 Safeguarded
Copy sessions.

The properties are displayed on different tabs in the notebook. Use the Session Options tab to set
properties that apply to the entire session. Use the Backup Options options tab to set properties that
apply to the backup. Use the H1-R1 Options tab to set properties that apply to the recovery relationship.

Session Options
Enter the properties for the session.

Description
Type the description for this session.

System or sysplex
Select the z/0OS system or sysplex that you want to associate with the session. When this option is
set, the Backup command is submitted through the z/OS connection to that system or sysplex to
provide performance improvements during the backup process. To enable this feature, volumes in
the session must be attached to the system or sysplex and I0S APAR OA59561 must be applied.

If you select No Association, then the session submits the command in the regular manner and
the performance advantage of submitting the backup through the system or sysplex will not be
applicable.

This option is displayed only if the copy services management server is installed on or connected
to a z/OS host system.

Backup Options
Enter the properties for the Safeguarded backups.

Expire Backup on Auto Roll
When this option is set, the session automatically expires a backup when the session determines
that one or more of the volumes has auto rolled the backup. Set the Expire Backup on Auto
Rol1l option to free up additional space whenever one or more volumes do not have enough
backup capacity to form new backups. This feature can help avoid out-of-space conditions.
However, when a backup is automatically expired, it is no longer available for recovery across
any of the volumes that contained that backup. By default, this option is NOT selected, so
you must select it to enable this feature. When this option is not set, the backup is not
automatically expired so that if one or more volumes did not auto roll the backup, those volumes
can still be recovered to that backup. To allow recovery to those volumes, you must remove
any volumes indicating that they auto rolled that backup, from the session. Search on the
topic "Recovering volumes to backups marked as not recoverable due to volume auto roll" in
the Troubleshooting section of the Copy Services Manager online help documentation at https://
www.ibm.com/support/knowledgecenter/SSESK4 for more information.

Note: If you select the Expire Backup on Auto Roll option, but the backup is in a recovery
relationship, and the hardware rolls a volume off, Copy Services Manager does not expire it.

For more explanation about expired backups and auto roll, see “Safeguarded Copy” on page 99.

Minimum Timeframe per backup
This option defines the minimum time in minutes that the session will allow the backup command
to be issued. The options are designed to ensure that the backup command cannot be issued at
a rate that would cause older backups to automatically roll off because of space conditions when
the preferred duration of the backups is no longer met.

Retention Period Since Last Recoverable Backup
This option defines the customers preferred duration for the backups on the session based on the
last recoverable backup that was taken. This option helps you define how long backups should be
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retained to meet service level agreements. The backup capacity for all volumes in the session and
the schedule of the backups should be set to values that support the retention period.

Important: The retention period is based on the second-to-last recoverable backup. The retention
design always keeps at least two recoverable backups. The hardware might not support recovery
of the last recoverable backup. If the hardware does not support it, Copy Services Manager allows
you to recover the last recoverable backup, but automatically takes a new backup so that the
recover can complete. Because a new backup takes up additional backup capacity, the design
ensures that there is always one backup available for recovery that does not use more backup
capacity. If additional backup capacity is used, it might cause older backups to automatically
expire on the hardware due to a lack of space. However, if the hardware supports it, the last
backup can be recovered without the need for an additional backup.

H1-R1 Options
Enter the properties for the role pair.

No Copy
This option defines if the recovery relationship will be established with background copy. If No
Copy is selected, then a background copy is not automatically started when the relationship is
established. To start the background copy for a no copy relationship issue the Initiate Background
Copy command. If No Copy is not selected, then a full background copy of the data will occur
when the relationship is established. If the recovery volume is a space efficient volume, the
background copy might lead to fully provisioning the volume.

Persistent
Select this option to keep the recovery relationship established on the hardware after all tracks
are copied to the target volume. If you do not select this option, the recovery replication
relationship is removed from the hardware after the target volume contains a complete image
of the recovered backup.

Requirement: This option requires that the persistent recovery option for Safeguarded Copy is
available for your IBM System Storage® DS8000° storage system. To determine whether you

can use the persistent recovery option for Safeguarded Copy with your System Storage DS8000
storage system, refer to the System Storage DS8000 documentation for microcode level that you
are using.

FlashSystems/IBM Spectrum Virtualize and SAN Volume Controller sessions

The properties for IBM FlashSystems/IBM Spectrum Virtualize and IBM System Storage SAN Volume
Controller sessions depend on the session type.

The following sections describe the properties for each session type with the exception of session types
that include only the Description property.

FlashCopy session properties

Use the View/Modify Properties notebook to view or modify properties for FlashSystem/IBM Spectrum
Virtualize and SAN Volume Controller FlashCopy sessions.

The properties are displayed on different tabs in the notebook. Use the Session Options tab to set
properties that apply to the entire session. Use the H1-T1 Options tab to set properties that apply to the
role pair.

Session Options
Enter the properties for the session.

Description
Type the description for this session.

H1-T1 Options
Enter the properties for the role pair.
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Incremental
Select this option to apply incremental changes to the target volume. After the initial FlashCopy
operation, only data that changed on the source volume since the last FlashCopy operation was
performed is copied to the target volume.

Background copy rate
Type the copy rate that the storage system uses to perform the background copy of the FlashCopy
role pair.

Note: For older storage systems running IBM Spectrum Virtualize, you can specify a value in the
range of 0-100. For newer storage systems at release 7.8.1 and higher, you can specify a value in
the range of 0-150. The default rate is 50.

Specify 0 if you do not want the hardware to write the background copy until the source track is
written to. Data is not copied to the target volume until the blocks or tracks of the source volume
are modified.

You can modify this value at any time during the session. If the session is performing a
background copy when you change the option, IBM Copy Services Manager immediately modifies
the background copy rate of the consistency group on the storage system. The storage system
consistency group immediately starts by using this new rate to complete the background copy.

Metro Mirror and Global Mirror Failover/Failback with Practice session
properties

Use the View/Modify Properties notebook to view or modify properties for FlashSystem/IBM Spectrum
Virtualize and SAN Volume Controller Metro Mirror Failover/Failback with Practice and Global Mirror
Failover/Failback with Practice sessions.

The properties are displayed on different tabs in the notebook. Use the Session Options tab to set
properties that apply to the entire session. Use the H2-I2 Options tab to set properties that apply to the
role pair.

Session Options
Enter the properties for the session.

Description
Type the description for this session.

H2-I2 Options

Enable automatic restart on unexpected suspends
When you select this option, the Copy Services Manager server automatically restarts the session
when it unexpectedly suspends due to reason code 1720 or 1920. An automatic restart is attempted
for every suspend with reason code 1720 or 1920 up to a predefined number of times within a
30-minute time period. The number of times that a restart is attempted is determined by the storage
server gmlinktolerance value. If the number of allowable automatic restarts is exceeded within the
time period, the session does not restart automatically on the next unexpected suspend. Issue a
Start command to restart the session, clear the automatic restart counters, and enable automatic
restarts.

Warning: When you enable this option, the session is automatically restarted by the server. When this
situation occurs, the secondary site is not consistent until the relationships are fully resynched.

Delay time before restart (seconds)
Specify the amount of time (in seconds) in which the copy services management server waits after
an unexpected suspend, before automatically restarting the session. The range of possible values
is 0 - 43200. The default is 0, which specifies that the session is restarted immediately following
an unexpected suspend.

Enter the properties for the role pair.
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Incremental
Select this option to set up the relationship for recording changes to the practice volume (H2).
All subsequent FlashCopy operations between the intermediate volume and the host volume copy
only the data that changed since the previous FlashCopy operation.

Background Copy Rate for H2-12
Type the copy rate that the storage system uses to perform the background copy of the FlashCopy
role pair.

Note: For older storage systems running IBM Spectrum Virtualize, you can specify a value in the
range of 0-100. For newer storage systems at release 7.8.1 and higher, you can specify a value in
the range of 0-150. The default rate is 50.

Specify 0 if you do not want the hardware to write the background copy until the source track is
written to. Data is not copied to the target volume until the blocks or tracks of the source volume
are modified.

You can modify this value at any time during the session. If the session is performing a
background copy when you change the option, IBM Copy Services Manager immediately modifies
the background copy rate of the consistency group on the storage system. The storage system
consistency group immediately starts by using this new rate to complete the background copy.

Global Mirror Failover/Failback with Change Volumes session properties

Use the View/Modify Properties notebook to view or modify properties for FlashSystem/IBM Spectrum
Virtualize and SAN Volume Controller Global Mirror Failover/Failback with Change Volumes sessions.

The properties are displayed on different tabs in the notebook. Use the Session Options tab to set
properties that apply to the entire session. Use the H1-H2 Options tab to set properties that apply to the
role pair.

Session Options
Enter the properties for the session.

Description
Type the description for this session.

H1-H2 Options
Enter the properties for the role pair.

Enable automatic restart on unexpected suspends
When you select this option, the Copy Services Manager server automatically restarts the session
when it unexpectedly suspends due to reason code 1720 or 1920. An automatic restart is
attempted for every suspend with reason code 1720 or 1920 up to a predefined number of
times within a 30-minute time period. The number of times that a restart is attempted is
determined by the storage server gmlinktolerance value. If the number of allowable automatic
restarts is exceeded within the time period, the session does not restart automatically on the next
unexpected suspend. Issue a Staxrt command to restart the session, clear the automatic restart
counters, and enable automatic restarts.

Note: If a Global Mirror with Change Volumes session is running with change volumes disabled,
this option causes the session to restart automatically with change volumes enabled; and to form
consistency groups based on the cycle time defined in the session properties. After the condition
that caused the suspend with reason code 1720 or 1920 is fixed, you can disable change volumes
manually in the View/Modify Properties window for the session in the GUI.

Warning: When you enable this option, the session is automatically restarted by the server.
When this situation occurs, the secondary site is not consistent until the relationships are fully
resynched.

Delay time before restart (seconds)
Specify the amount of time (in seconds) in which the copy services management server
waits after an unexpected suspend, before automatically restarting the session. The range of
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possible values is 0 - 43200. The default is 0, which specifies that the session is restarted
immediately following an unexpected suspend.

Enable change volumes
Select this option to enable the use of change volumes in the copy sets for the session. If this
option is not selected, the session functions the same as a Global Mirror Failover/Failback session.

Change volumes are denoted as Cx, where x identifies the site. These volumes contain point-in-
time images that are copied from the H1 and H2 volumes. The C1 volume stores changes from
the H1 volume. These changes are sent from the C1 volume to the H2 volume, and then to the C2
volume.

Because the data that is replicated between sites contains point-in-time changes rather than all
changes, a lower bandwidth link is required between the sites when change volumes are used.
However, the use of change volumes can result in an increase to data exposure. Therefore, you
might want to enable or disable this option, which depends on your network traffic or business
requirements.

When you select this option, it is the equivalent of setting the ~cyclingmode parameter tomulti
on a FlashSystem/IBM Spectrum Virtualize or SAN Volume Controller storage system. When you
clear this option, it is the equivalent of setting the ~cyclingmode parameter to none for these
storage systems.

Cycle period (seconds)
Specify the amount of time, in seconds, in which the change volumes are refreshed with a
consistent copy of the data. If a copy does not complete in the cycle period, the next cycle period
will not start until the copy is complete. The range of possible values is 60 - 86400. The default is
300.

Recovery Point Objective Alerts
Specify the length of time that you want to set for the recovery point objective (RPO) thresholds.
The values determine whether a Warning or Severe alert is generated when the RPO threshold is
exceeded for a role pair. The RPO represents the length of time, in seconds, of data exposure that
is acceptable if a disaster occurs.

Use the following options to set the RPO threshold values. For both options, you can specify an
RPO threshold in the range of 0 - 172800 seconds. The default is 0 seconds, which specifies that
no alerts are generated.

Warning level threshold (seconds)
Specify the number of seconds that you want to set for the warning level RPO threshold. If the
RPO is greater than this value, an alert is generated.

If the value in this field is other than 0, it must be greater than the value in the Cycle period
(seconds) field and less than the value in the Severe level threshold (seconds) field.

Severe level threshold (seconds)
Specify the number of seconds that you want to set for the severe level RPO threshold. If the
RPO is greater than this value, an alert is generated and the session status changes to Severe.

If the value in this field is other than 0, it must be greater than the value in the Warning level
threshold (seconds) field.
FlashSystem/IBM Spectrum Accelerate sessions
The properties for the FlashSystem/IBM Spectrum Accelerate sessions depend on the session type.

The following topic describes the properties for each session type with the exception of session types that
include only the Description property.

278 IBM Copy Services Manager: User's Guide



FlashSystem/IBM Spectrum Accelerate Global Mirror Failover/Failback
session properties

Use the View/Modify Properties notebook to view or modify properties for the FlashSystem/IBM
Spectrum Accelerate Global Mirror Failover/Failback sessions.

The properties are displayed on different tabs in the notebook. Use the Session Options tab to set
properties that apply to the entire session. Use the H1-H2 Options to set properties that apply to the role
pair.

Session Options
Enter the properties for the session.

Description
Type the description for this session.

H1-H2 Options
Enter the properties for the role pair.

Recovery point objective threshold (seconds)
Type the number of seconds that you want to set for the recovery point objective (RPO) threshold
for the role pair.

If the FlashSystem/IBM Spectrum Accelerate determines that the RPO is greater than this
threshold value, an alert is generated and the session status changes to Severe. You can specify
an RPO in the range of 30 - 86400 seconds. The default is 30 seconds.

Synchronization schedule (HH:MM:SS)
Select an interval to create a synchronization schedule. The schedule is used to form consistency
groups. The FlashSystem/IBM Spectrum Accelerate attempts to form consistent points of data by
taking automatic snapshots of the volumes in the session at this interval. The default is Minimum
Interval, which is 20 seconds.

If you select Never, synchronization is not scheduled and the FlashSystem/IBM Spectrum
Accelerate does not create consistency groups. When the FlashSystem/IBM Spectrum Accelerate
determines that the RPO threshold is exceeded, the session state becomes Severe.

FlashSystem/IBM Spectrum Accelerate Metro Mirror Failover/Failback
session properties

Use the View/Modify Properties notebook to view or modify properties for the FlashSystem/IBM
Spectrum Accelerate Metro Mirror Failover/Failback sessions.

The properties are displayed on different tabs in the notebook. Use the Session Options tab to set
properties that apply to the entire session. Use the H1-H2 Options to set properties that apply to the role
pair.

Session Options
Enter the properties for the session.

Description
Type the description for this session.

H1-H2 Options
Enter the properties for the role pair.

HyperSwap management: Manage H1-H2 with HyperSwap
Select this option to enable the relationship for HyperSwap on the Spectrum Accelerate System.
HyperSwap redirects application I/O to the target volumes when there is a failure on the host
accessible volumes. Copy Services Manager uses HyperSwap to manage the H1-H2 sequence of
the Metro Mirror session.
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FlashSystem/IBM Spectrum Accelerate Metro Mirror - Global Mirror session
properties

Use the View/Modify Properties notebook to view or modify properties for the FlashSystem/IBM
Spectrum Accelerate Metro Mirror - Global Mirror sessions.

The properties are displayed on different tabs in the notebook. Use the Session Options tab to set
properties that apply to the entire session. Use the H1-H3 Options and H2-H3 Options to set properties
that apply to the role pair.

Session Options
Enter the properties for the session.

Description
Type the description for this session.

H1-H3 Options and H2-H3 Options
Enter the properties for the role pair.

Recovery point objective threshold (seconds)

Type the number of seconds that you want to set for the recovery point objective (RPO) threshold
for the role pair.

If the Spectrum Accelerate system determines that the RPO is greater than this threshold value,
an alert is generated and the session status changes to Severe. You can specify an RPO in the
range of 30 - 86400 seconds. The default is 90 seconds.

Synchronization schedule (HH:MM:SS)

Select an interval to create a synchronization schedule. The schedule is used to form consistency
groups. The Spectrum Accelerate system attempts to form consistent points of data by taking
automatic snapshots of the volumes in the session at this interval. The default is the min_interval
schedule defined on the hardware.

If you select Never, synchronization is not scheduled and the Spectrum Accelerate system does
not create consistency groups. When the Spectrum Accelerate system determines that the RPO
threshold is exceeded, the session state becomes Severe.

Basic HyperSwap session properties
Use the View/Modify Properties notebook to view or modify properties for Basic HyperSwap sessions.

The properties are displayed on different tabs in the notebook. Use the Session Options tab to set
properties that apply to the entire session. Use the H1-H2 Options tab to set properties that apply to the
role pair.

Session Options
Enter the properties for the session.

Description
Type the description for this session.

Fail MM/GC if target is online (CKD only)
Select this option to fail any session commands for a Metro Mirror or Global Copy relationship
if the target volume is in the Online state. For more information about this state, refer to the
documentation for the storage system.

This option applies only to count key data (CKD) volumes.

H1-H2 Options
Enter the properties for the role pair.

z/0S Management
The z/0S Management options are displayed only if Copy Services Manager is installed on or
connected to a z/OS host system. You can add a z/OS host connections in Copy Services Manager
regardless of the operating system on which the application is installed.
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When you are connected to a z/OS host system, you can manage z/OS features for volumes that
are attached to the host system. In addition, you can manage these features for volumes that are
attached to other z/OS systems that are connected to the host system through a sysplex.

System or sysplex
Select the z/0S system or sysplex that you want to associate with the session. Commands for
z/0S features are issued to this system or sysplex. Volumes in the session must be attached to
the system or sysplex to enable the features.

Disable HyperSwap
Select this option to prevent a HyperSwap operation from occurring.

Reset In Use By System on Secondary Volumes
Select this option to have the load of the configuration automatically reset the In Use By
System state on all secondary volumes (UCBNALOC = OFF). When this option is not selected,
a load of the configuration fails when secondary volumes are in the In Use By System state
(UCBNALOC is ON). This feature is only available after APAR OA53082 is applied to the z/0OS
system.

Unbox Secondary Volumes
Select this option to have the load of the configuration automatically unbox all secondary
volumes in the configuration. When this option is not selected, a load of the configuration
fails when secondary volumes are in a boxed state. This feature is only available after APAR
OA53082 is applied to the z/0S system.

On Planned HyperSwap Error:

Partition out the failing system(s) and continue swap processing on the remaining
system(s)
Select this option to partition out the failing system and continue the swap processing on
any remaining systems.

Disable HyperSwap after attempting backout

Select this option to enable I0S to back out the HyperSwap operation, if possible, if an
error occurs during HyperSwap processing. HyperSwap is disabled.

On Unplanned HyperSwap Error:
Partition out the failing system(s) and continue swap processing on the remaining
system(s)
Select this option to partition out the failing systems and continue HyperSwap processing
on the remaining systems when a new system is added to the sysplex and the HyperSwap
operation does not complete.
Requirement: If you select this option, you must restart the system.

Disable HyperSwap after attempting backout
Select this option to enable I0S to back out the HyperSwap operation, if possible, if an
error occurs during HyperSwap processing. HyperSwap is disabled.

Viewing copy sets in a session

You can view the copy sets that are in a session. You can also export the copy sets to a comma-separated
value (CSV) file for backup purposes.

Follow these steps to view or export the copy sets for a session:

1. In the menu bar, click Sessions.
2. On the Sessions page, select the session that contains the copy sets.
3. From the Session Actions list, select View/Modify > View Copy Sets.
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Viewing storage system details

You can view detailed information about storage system, including the name, location, type, vendor, and
the status of all connections to the storage system.

Perform these steps to view storage system details:

1. In the menu bar, click Storage > Storage Systems.
2. On the Storage Systems page, click the ID for the storage system in Storage System column.

Viewing DS8000 advanced settings

You can use the Copy Services Manager GUI to view and download a file that contains the advanced
settings for DS8000 storage systems.

The DS8000 advanced settings file highlights which settings are modified from the default values. The
only values that are displayed in the table are properties that are not set to the default values.

Notes: To view the advanced settings, two conditions must be met:

- The DS8000 system must be at version 8.1.1. or higher.
« The user who is connected to the Hardware Management Console (HMC) must have admin-level access
on the DS8000.

Perform these steps to view the advanced settings for a DS8000 storage system by using the Copy
Services Manager GUI:

1. Log in to the Copy Services Manager GUI as an administrator.

2. In the menu bar, click Storage > Storage Systems.

3. From the Storage Systems tab, select the DS8000 storage system for which you want to view the
advanced settings.

4. Click Select Action > View Advanced Settings.

5. Atable is displayed that lists the advanced settings properties for the selected DS8000 storage
system. The current value for each property is shown, along with the associated default value for that
property.

Notes:

« If all values are set to the default, then no table is displayed.

« You cannot modify the advanced settings from within this table. You can only view and download
them.

6. You can open the advanced settings file, or save it to your local system.
7. Click OK to close the advanced settings information when you are finished.

Creating storage system diagnostics

You can perform a warm start or an on-demand data (ODD) dump of a selected storage system to collect
diagnostic information.

Sometimes IBM Support requires extra diagnostic information to help resolve a storage system issue by
determining the root cause. In this scenario, it can be useful to create storage system diagnostics.

A warm start is an error recovery process for the DS8000 storage system. A warm start collects microcode
data that is useful in diagnosing problems. It is designed for data integrity, data protection, and data
capture. For more information about the warm start procedure, see your storage system documentation.

An ODD dump is a nondisruptive action to collect the diagnostic information.

Note: Creating system diagnostics is only available in the Copy Services Manager GUI if a storage system
has an HMC connection. If the storage system only has a FICON z/OS connection, or is a SAN Volume
Controller or XIV-based system, then the option is not displayed.
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Follow these steps to perform a storage system warm start or ODD:

1. Log in to the Copy Services Manager GUI as an administrator.
2. In the menu bar, click Storage > Storage Systems.
You can also access this option from the Storage System Details page.
3. On the Storage Systems page, select the ID for the storage system in the Storage System column.
4. Click Select Action > Create System Diagnostics.
5. Select from the following options: On Demand Dump (default), or Warm Start.
6. Click OK.
« Ifyou choose the On Demand Dump option, the system starts to immediately process your request
after you click OK.

« If you choose the Warm Start option, a warning message appears in which you must confirm
before the warm start initiates. A warm start is the equivalent of rebooting the system without
powering it off.

Click OK in the message to proceed with the warm start, or click Cancel to exit without performing
the warm start.

System diagnostics information is created, which can be used as needed in resolving issues.

Viewing storage connection details

You can view storage connection details and a list of all storage systems that are located behind the
connection.

Perform these steps to view storage connection details:

1. In the menu bar, click Storage > Storage Systems.
2. On the Storage Systems page, click the Connections tab.
3. Click the ID for the storage system connection in the Storage Connection column.

Viewing volume details

You can view information about volumes such as the name of the volume, the capacity of the volume, and
the type of volume.

1. In the menu bar, click Storage > Volumes.

2. On the Volumes page, select a storage system.

3. Depending on the type of storage system, complete one of the following actions:
« Select ALIO Groups or a specific I/0 group.
« Select All Logical Storage Subsystems or a specific logical storage subsystem.
« Select All Pools or a specific pool.

4. Click Perform Query.
- Information about the volumes is displayed in a table.

- The Session column identifies any Copy Services Manager sessions that the volume is included in.
Knowing the session dependencies helps to determine:

— which volumes are in sessions
— which volumes might not be in sessions but should be
— which volumes might be shared across multiple sessions

Note: To see z/0OS volume device numbers in the Copy Services Manager GUI, APAR OA61363 must be
applied to the z/OS system that has the volumes attached.
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Tip: To filter the list by user name, full name, type, capacity, device number or sessions, enter the filter
text in the Filter field. You can enter complete or partial text. To remove the filtering for the list, click
the X'icon in the Filter field.

Viewing logical paths

You can view all logical paths that are defined on an IBM DS8000 storage system.

Complete one of these procedures to view logical paths:
- From the ESS/DS Paths page of Copy Services Manager:

a) In menu bar, click Paths.

b) Click the storage system ID to display logical paths for that storage system.
- From the Storage Systems page:

a) In menu bar, click Storage > Storage Systems.

b) Select the storage system for which you want to view logical paths.

¢) From the Select Action list, select View Paths. The paths page is displayed with a list of defined
logical paths.

Viewing host connection details

You can view and modify the connection information for a host system. You can modify the connection
information only if the host system in the Disconnected state.

Follow these steps to view or modify connection information for a host system:

1. In the menu bar, click Storage > Host Connections.
2. On the Host Connections page, click the link for the host system in the Host System column.

Viewing console messages

Copy Services Manager provides a detailed log of user and system activity.

To view this log, click Console in the menu bar. The Console window contains log entries that specify the
activity that has occurred and a link to the correlating message for that activity.

Note:

The console by default displays the last 2000 messages. This default value can be changed by adding
the following property to the server properties. Do not specify more than 5000 messages as you might
experience memory issues with the GUI attempting to load that many messages.

server.max.console.msgs=1200

Initiating a takeover on the standby management server

If the active management server fails, you can force the standby management server to take over
monitoring and managing replication responsibilities.

Important: If the current active management server is still active, you must not attempt to control the
replication environment simultaneously from both management servers. Instead, either reconfigure the
current active management server to be a standby management server, or shut it down.

Complete these steps to cause the standby management server to become the active management
server:

1. If the active management server is functioning, take it offline so that you do not have two active
management servers managing the same sessions.

2. Log on to the Copy Services Manager GUI that is running on the standby management server.

3. In the menu bar, click Settings > Management Servers.
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4. On the Management Servers page, from the Select Action list, select Takeover.
5. To reestablish high-availability, complete one of these steps:
= Choose another server to be the standby management server. See instructions for setting up a
standby management server.

- Bring the failed management server back online, and then make that server the standby
management server. See “Setting up a standby management server” on page 38.

« Bring the failed management server back online, and then make that server the active management
server to return to the original configuration. Repeat the steps in this section and then add the
original standby server as the standby server.

Important: Do not use the Reconnect command if you perform a takeover. You would use the Reconnect
command when the active server loses its connection with the standby server; it reconnects the two
servers. Do not use the Reconnect command after a takeover to reconnect to the original active server.

Logging to the syslog

When Copy Services Manager is running on a z/0OS system, it can send messages to the z/0S syslog
to help with diagnosing problems or externally automating actions based off of certain Copy Services
Manager messages.

You can configure z/0S syslog message output by modifying properties in the rmserver.properties
configuration file.

« You can toggle the message output on and off.

Note: By default, this logging is turned off, so you must enable it if you want to see these messages.
« You can choose to log all messages, or a subset of messages to the syslog.
Prerequisite: You must have Administrator privileges to perform this action.

1. Open the rmsexrver.properties file. You can access this file from the Copy Services Manager GUI
under Settings > Server Properties. You can manually enter and edit the file properties on that page.
Note: See “rmserver.properties file” on page 326 for more information on locating and using this file.

2. Set the following properties in the rmserver.properties file to enable and control the messages
that are logged to the z/OS syslog:

com.ibm.csm.zconsole.logging=none (default) | all | exxox
Specifies the standard out logging level to the syslog, where the possible values are none, all, or
error.

« When none is specified, Copy Services Manager does not log to the syslog at all (default).
« When all is specified, Copy Services Manager logs all I, W, and E messages to the syslog.
« When error is specified, Copy Services Manager logs all W and E messages to the syslog.

Example: To log all messages: com.ibm.csm.zconsole.logging=all

com.ibm.csm.zconsole.logging.includechildren=txue | false (default)
Specifies whether or not to log child messages to the syslog. By default, only high level messages
are logged. Child messages are not logged. Use this property setting to override this behavior and
enable child messages to be logged.

Notes:

- Be aware that setting the logging to all messages, including the child messages, can result in
a very large amount of messages. Only set the includechildxen property to true whenit is
important to see the child messages.

« When you set the includechildren property to true, all child messages are printed to the
syslog, including any in the excludedmsgs list, as discussed next.

Chapter 9. Monitoring health and status 285



Example: To log all child messages:
com.ibm.csm.zconsole.logging.includechildren=tzrue

com.ibm.csm.zconsole.logging.excludedmsgs=<messages to exclude in comma-separated list>
Specifies which messages to exclude from writing to the syslog, where the values are a comma-
separated list of message IDs. Any ID in the list will not appear in the syslog.

Note: The excludedmsgs property is only for parent messages.

Example: To exclude the IWNR1028I and IWNR6000I messages from being logged:
com.ibm.csm.zconsole.logging.excludedmsgs=IWNR1028I, IWNR6OOOI

Logging to a remote syslog server

The Copy Services Manager server stores audit logs on the server itself, where the product is installed. If
there is a requirement to store audit logs on an external server or monitor audit logs for the product, a file
monitor service can be set up to send audit logs to a remote syslog server.

There are several file monitor services that can be used. This task describes the use of product remote
syslog server to monitor the Copy Services Manager audit logs. These steps would be similar when used
for different file monitor services.

Note: The external syslog feature is not supported for Copy Services Manager servers running on DS8000
Hardware Management Console (HMC).

Configuring service on Windows

Follow these steps to configure the File Monitor Service by using remote syslog on windows. You can use
this service to capture information from csmMessage. log file.

1. Install remote syslog or File Monitor Service on Copy Services Manager server.
2. Set the necessary rule and corresponding action.

a) Define a new rule set.

b) In the configuration wizard, enter the name of the rule.

c) Click Next and select the rule that is mentioned in previous step.

d) Click Finish on the confirmation page to create the rule set.

e) In the main window, expand the created rule set from the navigation window.

f) Select Action level of the selected rule set.

g) Configure the Action.

- Enter IP or hostname of your syslog server.
« Select the Protocol Type.
« Set the Syslog port.

h) Click Save to apply the changes. Then, restart the service.
3. Setup File Monitor Service.

a) Go to Add Service and then File Monitor.

b) In the configuration wizard, create the name of the service. Use default settings and press Next.
¢) Click Finish on the confirmation page.

d) In the main window, expand Services from navigation window.

e) Select the newly created service, click Browse, and select csmMessage . 1og file. This file is usually
present at path_prefix/opt/IBM/CSM/wlp/usr/servers/csmServer/logs/CSM.

f) Select the created rule set.
g) Save the changes and restart the application.
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The File Monitor now sends all the incoming Copy Services Manager messages to the external syslog
server.

Configuring service on Linux/AIX

Follow these steps to configure the remote syslog configuration file on Linux/AIX. You can use this
configuration to capture information from csmMessage . log file.

Note: The following commands are meant for Unix system, which might differ for different level of Linux
and remote syslog server.

1. Setup rsyslog.conft to forward message to a remote server.

a) Open the rsyslog.conf in edit mode.
edit /etc/rsyslog.conf

b) The rsyslog.conf has several examples. Find and edit, or add the action that forwards the logs
to a remote syslog server. The target is the IP(hostname) for the remote syslog server and the port
is the communication port that is configured to receive the logs.

For example:

*.% action(type="omfwd" target="192.0.2.2" port="10514" protocol="tcp"
action.resumeRetryCount="100" queue.type="linkedList" queue.size="10000")
This action decouples the message sending from other logging actions, and
prevent delays when the remote system is not reachable. In addition, it
tries to connect 100 times before it discards message as undeliverable.

2. Modify rsyslog.conf to monitor csmMessage.log.

a) Load the imfile module at the beginning of remote syslog configuration file. This module monitors

the file.
module (load="imfile" PollingInterval="10")

Note: All modules are to be loaded once. Polling Interval is a module directive, which must be set
while you load the module.

b) Configure input and its parameters. This input is used by the imfile module to indicate which file to
monitor. Set the input to monitor file:
/opt/IBM/CSM/1liberty/wlp/usr/sexvers/csmServer/logs/CSM/csmMessage.log
input(type="imfile" File="/opt/IBM/CSM/liberty/wlp/usr/servers/csmServer/
logs/CSM/csmMessage.log" Tag="csmMessage")

3. Start and restart syslog.

Example for starting and stopping on some Linux platforms. For more information, view the remote

syslog documentation for the specified level and platform.

systemctl stop rsyslog

systemctl start rsyslog

The remote syslog server now sends all the incoming Copy Services Manager messages to the external
syslog server.

Alerts

Copy Services Manager can deliver two different types of alerts: either email alerts, or SNMP notifications.

Email alerts
You can receive email alerts from Copy Services Manager based on triggering events.
Email alerts are sent for the following general events:

Session State Change
When the state of any session changes, or if an auto-restart to a session was attempted.

Example: IWNR1950I [Aug 12, 2019 2:52:50 PM] Session GMP changed from the Preparing state to
the Prepared state.
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Configuration Change
When there are configuration changes involving adding or removing copy sets from sessions.

Example: IWNR19561 [Aug 14, 2019 2:12:46 PM] At least one copy set has been added to or
removed from session GMP.

Unexpected Severe Status
When any session goes into an unexpected Severe status.

Example: IWNR1958W [Aug 14, 2019 2:43:05 PM] Session GMP has changed to the SEVERE status
due to an unexpected error.

Communication Failure
When there is loss of communication to the storage systems.

Example: IWNR1955E [Aug 12, 2019 11:30:52 PM] The copy services management server,
serverA.xyz.xyzlabs.ibm.com, has encountered communication errors with storage system
DS8000:B0OX:2107.BOXAB.

Active Standby Connected
When the active and standby server are connected.

Example: IWNR1951I [Aug 12, 2019 11:32:54 PM] High-Availability relationship
serverA.xyz.xyzlabs.ibm.com->serverB.xyz.xyzlabs.ibm.com changed to the Synchronized state.

Active Standby Disconnected
When the active and standby server are disconnected.

Example: IWNR1951I [Aug 14, 2019 1:56:32 PM] High-Availability relationship
serverA>serverB.xyz.xyzlabs.ibm.com changed to the Disconnected state.

Scheduled Task Completed
When a scheduled task completes successfully.

Example: IWNR2212I [Aug 14, 2019 3:10:55 PM] The scheduled task TASKX has finished running.

Scheduled Task Failed
When a scheduled task fails to complete successfully.

Example: IWNR2219E [Aug 14, 2019 3:08:53 PM] Scheduled task TASKX failed due to an error that
was encountered while it was running.

Session RPO Trigger
When there are session RPO warning and severe threshold alerts.

Example: IWNR2752E [Aug 14, 2019 2:54:31 PM] The recovery point objective for the role pair of
H1-J2 in session GMP has passed the severe threshold of 2 seconds.

Logical Path Change
When there are DS8000 storage system logical path updates or errors.

Example: IWNR19571 [Aug 12, 2019 3:09:36 PM] At least one path definition has been added or
removed.

Configuring email alerts by using the GUI
Starting with Copy Services Manager Version 6.1.4, you can also use the GUI to configure email alerts.
Configuring email alerts at the GUI involves two steps:

« Configuring the email server
« Configuring the list of recipients

1. Log in to the Copy Services Manager GUI as an administrator.
2. Go to Settings > Alert Notifications. The Email configuration page is displayed.

288 IBM Copy Services Manager: User's Guide



Configuring the email server

You must first configure the email server to use for sending the alerts.

1.
2.
3.

5.

Click Edit.
Define an email server by entering a host name or IP address in the Email server field.
Enter the Port for the email server.

Note: The default port is 25.

. Optional: Enter a valid email address in the Reply-to address field.

Notes:

« You can only enter one reply-to address.
« The reply-to address receives emails if a recipient replies to the email alert.
Click Save to save the changes, or click Cancel to exit without saving your changes.

Configuring the list of recipients

Next, you must configure the list of email addresses for the alert recipients.

1.
2.

Click Add to add one or more email addresses for alert recipients.
Enter, or copy and paste one or more email addresses into the Add email alert recipients dialog.

Note: You can add more than one email address by using commas to separate each address.

. Before the 6.2.7 release, all of the email recipients that you specified in the previous step received all

of the alert types. However, starting with Copy Services Manager 6.2.7, you can specify which alerts
these email recipients will receive in the table under the field to add email addresses. See “Email
alerts” on page 287 for a detailed listing of the alert types. You can also view the alert descriptions by
using the pull-down option in the top right corner of the table. Select the types of alerts that you want
to go to these addresses, and click Add.

Note: (Optional) You can also use the filter field to search for alert types in the table.

Important: After an upgrade to version 6.2.7 or higher, any predefined email recipients automatically
get All Events.

. Click Add to save your changes, or click Cancel to exit without saving your changes.

« You can also select any email addresses that were previously added and click Remove to remove
them from the list of recipients.

. Optional: If the email server is configured, you can click Test to send a test email to all alert recipients.

This test verifies that the email server is configured properly, and that recipients are receiving the
emails.

Email alerts are now configured.

Configuring email alerts by using the CLI

Starting with Copy Services Manager Version 6.1.2, you can use the command-Lline to configure email
alerts.

The following commands are available for setting email alerts:

addemailsexrver

Configures the server to use for sending email alerts.

Note: The addemailservexr command can overwrite the existing server configuration.

lsemailserver

Displays the configuration that is being used for email alerts, if any.

rmemailserver

Removes the SMTP server configuration that is used to send email alerts.
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Note: After you submit the command, email alerts are no longer sent.
addemailalert
Adds email addresses to the list of email addresses that receive email alerts.

rmemailalert
Removes email addresses from the list of email addresses that receive email alerts.

lsemailalert
Displays the recipient list of email addresses to send email alerts to.

testalert
Uses the current alert configuration to send a test alert.
Note: Currently, this command only supports sending a test email alert.

For more information, see the IBM Copy Services Manager online product documentation (http://
www-01.ibm.com/support/knowledgecenter/SSESK4). Command syntax details are located under the
"Reference" section of the navigation.

The flow of tasks for configuring email alerts from the CLI is as follows:

1. Define an email server, and an optional reply-to email address.
2. Define the email recipients.

3. (Optional) You can use the testalext command to verify that the email alert function is working and
that recipients are receiving emails.

Important: If you have problems sending outgoing email alerts, you might need to

customize the setting that defines the outgoing email server name. The default server

name for sending email alerts is csmServer@<server hostname>. However, some environments
do not accept this server email address. You can change the default setting by using

the csm.sexver.notification.sender.address:[email address] parameterinthe
rmserver.properties file.

For more information, see “rmserver.properties file” on page 326.

SNMP alerts

SNMP alerts are sent with associated object IDs (OIDs).
SNMP alerts are sent during the following general events:
» Session state change

« Configuration change

- Suspending-event notification

- Communication failure

- Management Server state change

Configuring SNMP alerts by using the GUI

Starting with Copy Services Manager Version 6.1.4, you can also use the GUI to configure SNMP alerts.
To configure SNMP alerts, you must configure one or more SNMP managers.

1. Log in to the Copy Services Manager GUI as an administrator.

. Go to Settings > Alert Notifications. The Email configuration page is displayed by default.

. Click the SNMP tab.

. Click Add to configure one or more SNMP managers.
. Enter a Host name or address and an associated Port for a valid SNMP manager.

Note: The default port is 162.
6. Click Add to save the changes, or click Cancel to exit without saving your changes.

o b 0N
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Notes:

 You can add only one SNMP manager at a time.

« You can select any SNMP managers that were previously added and click Remove to remove them
from the list.

SNMP alerts are now configured.

Configuring the SNMP community name

The SNMP community name has a default value of public.

To change the community name, modify or add the csm.sexrver.snmp_community_stxring property in
the rmserver.properties file. This file is in the install
dir\liberty\wlp\usr\servers\csmServer\propertiespath_prefix/opt/IBM/CSM/wlp/ust
/servers/csmServer/properties directory.

Adding SNMP managers

Use the mksnmp command to add an SNMP manager to the list of servers to which Copy Services Manager
sends SNMP alerts.

Copy Services Manager uses management information base (MIB) files to provide a textual description
of each SNMP alert that is sent by Copy Services Manager. You must configure the SNMP manager to
use both the SYSAPPL-MIB.mib and ibm-CSM.mib files. These files are on the installation DVD in
the replication\CSM-Client\etc directory. Follow the directions that are provided by your SNMP
manager application to configure it to use the MIB files.

Copy Services Manager sends all SNMP alerts to each registered SNMP manager. SNMP alerts are not
specific to any particular session, and all alerts for any session are sent. You cannot choose to send a
subset of SNMP alerts.

Session state change SNMP trap descriptions

SNMP traps are sent during session state changes. A different trap is sent for each state change. These
alerts are sent by only the active management server.

A session state change SNMP trap is sent each time the session changes to one of the following states:

Defined

Preparing

Prepared

Suspended

Recovering

Flashing

Target Available

Suspending

(Metro Global Mirror only) SuspendedH2H3
(Metro Global Mirror only) SuspendedH1H3
Auto restarted

(Safeguarded Copy only) Protected
(Safeguarded Copy only) Unprotected

An SNMP trap is also sent when a recovery point objective (RPO) threshold is exceeded for a role pair that
is in the session.
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Table 75. Session state change traps

Object ID (OID)

Description

1.3.6.1.4.1.2.6.208.0.1

The state of session X has transitioned to Defined.

1.3.6.1.4.1.2.6.208.0.2

The state of session X has transitioned to Preparing.

1.3.6.1.4.1.2.6.208.0.3

The state of session X has transitioned to Prepared.

1.3.6.1.4.1.2.6.208.0.4

The state of session X has transitioned to Suspended.

1.3.6.1.4.1.2.6.208.0.5

The state of session X has transitioned to Recovering.

1.3.6.1.4.1.2.6.208.0.6

The state of session X has transitioned to Target Available.

1.3.6.1.4.1.2.6.208.0.19

The state of session X has transitioned to Suspending.

1.3.6.1.4.1.2.6.208.0.20

The state of session X has transitioned to SuspendedH2H3.

1.3.6.1.4.1.2.6.208.0.21

The state of session X has transitioned to SuspendedH1H3.

1.3.6.1.4.1.2.6.208.0.22

The state of session X has transitioned to Flashing.

1.3.6.1.4.1.2.6.208.0.23

The state of session X has transitioned to Terminating.

1.3.6.1.4.1.2.6.208.0.26

The recovery point objective for the role pair of X in session Y has
passed the warning threshold of Z seconds.

1.3.6.1.4.1.2.6.208.0.27

The recovery point objective for the role pair of X in session Y has
passed the severe threshold of Z seconds.

1.3.6.1.4.1.2.6.208.0.28

A suspend event occurred triggering the auto restart feature for
session X. The session will be restarted in Y seconds.

1.3.6.1.4.1.2.6.208.0.29

Session X was enabled for auto restart. However, the session could
not be restarted.

1.3.6.1.4.1.2.6.208.0.33

The state of session X has transitioned to Protected.

1.3.6.1.4.1.2.6.208.0.34

The state of session X has transitioned to Unprotected.

Configuration change SNMP trap descriptions

SNMP traps are sent when configuration changes occur. These alerts are sent by only the active

management server.

Configuration change SNMP traps are sent after the following configurations changes are made:

« One or more copy sets have been added or deleted from a session

An alert is sent for each set of copy sets added to or removed from a session. An alert for copy set
changes is sent only one time within 15 minutes of a configuration change, so you might not see alerts
from successive changes that occur within that 15-minute period. For example, you might make a copy
set configuration change that causes an alert to be sent at 10:41:01. If you were to make more copy
set changes at 10:42:04 and 10:50:09, no alerts would be sent for these two changes because they
occurred within the 15-minute minimum interval from the first alert.

« PPRC path definitions have changed

An alert is sent for each path configuration change that is made.
« Any path failures are detected

Even if not all of the paths went away, path failures can degrade replication bandwidth or performance.
Copy Services Manager periodically queries for path states and displays an associated message in the
GUL.

Notes:
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— An email notification is also sent out when any path failures occur.
— The event does not occur if there are no HMC connections for the storage system.

Table 76. Configuration change traps
Object ID (OID) Description

1.3.6.1.4.1.2.6.208.0.7 | One or more copy sets have been added or deleted from this session.

Note: An event is sent for each session at least every 15 minutes.

1.3.6.1.4.1.2.6.208.0.8 | Peer-to-Peer Remote Copy (PPRC) path definitions have changed. An event is
sent for each path configuration change.

1.3.6.1.4.1.2.6.208.0.30 | One or more logical paths between storage systems have entered an error
state or have been removed.

Suspending-event notification SNMP trap descriptions

SNMP traps are sent during suspending-event notifications. The traps are sent by the active and standby
management server.

Suspending-event notification SNMP traps indicate that a session has transitioned to a Severe status due
to an unexpected error.

Table 77. Suspending-event notification traps

Object ID (OID) Description

1.3.6.1.4.1.2.6.208.0.9 [The session is in a Severe state due to an unexpected error.

Communication-failure SNMP trap descriptions

SNMP traps are sent during communication failures. These alerts are sent by both the active and standby
management servers.

Communication-failure SNMP traps are sent after the following events occur:

- A server times out attempting to communicate with a storage system.

« A server encounters errors attempting to communicate with a storage system.

« An active server terminates communication with a standby server as a result of communication errors.
« A standby encounters communication errors with an active server.

After an SNMP trap for a given failure is sent, it is not resent unless communication has been
reestablished and failed again.

Table 78. Communication-failure traps

Object ID (OID) Description

1.3.6.1.4.1.2.6.208.0.10 | Server X has timed out attempting to communicate with storage system Y.

1.3.6.1.4.1.2.6.208.0.11 | Server X has encountered errors attempting to communicate with storage
system Y.

1.3.6.1.4.1.2.6.208.0.12 | Active server X has terminated communication with standby server Y as a
result of communication errors.

1.3.6.1.4.1.2.6.208.0.13 | Standby server X has encountered communication errors with active server Y.
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Management Servers state-change SNMP trap descriptions

SNMP traps are sent when the state of the management server changes. These alerts are sent by both the
active and standby management servers.

A management server state change SNMP trap is sent each time the management server changes to one
of the following states:

= Unknown

« Synchronization Pending
» Synchronized

- Disconnected Consistent
- Disconnected

Table 79. Management Servers state-change traps

Object ID (0OID) Description

1.3.6.1.4.1.2.6.208.0.14 | The copy services management server HA connection X->Y has changed state
to Unknown (previously Offline).

1.3.6.1.4.1.2.6.208.0.15 | The copy services management server HA connection X->Y has changed state
to Synchronized.

1.3.6.1.4.1.2.6.208.0.16 | The copy services management server HA connection X->Y has changed state
to Disconnected Consistent (previously Consistent Offline).

1.3.6.1.4.1.2.6.208.0.17 | The copy services management server HA connection X->Y has changed state
to Synchronization Pending.

1.3.6.1.4.1.2.6.208.0.18 | The copy services management server HA connection X->Y has changed state
to Disconnected.

Scheduled task notification SNMP trap descriptions

SNMP traps are sent for certain events that are associated with scheduled session tasks. These alerts are
sent by only the active management server.

Scheduled session task SNMP traps are sent after the following events occur:

« The scheduled task completes.
« The scheduled task fails due to an error that was encountered while it was running.

Table 80. Scheduled task notification traps

Object ID (OID) Description

1.3.6.1.4.1.2.6.208.0.31 | The scheduled task ibmTPCRtaskname has finished running.

1.3.6.1.4.1.2.6.208.0.32 | Scheduled task ibomTPCRtaskname failed due to an error that was
encountered while it was running.
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Chapter 10. Managing security

The Copy Services Manager authentication process uses a configured user registry from either: the
basic user registry (on distributed systems); an operating system repository, such as RACF (on the z/0S
platform); or a Lightweight Directory Access Protocol (LDAP) registry.

To perform certain actions and manage specific sessions in the Copy Services Manager GUI or CLI, the
user must also have the appropriate authorization. Authorization is granted by assigning a specific role to
the user account or user group.

Starting with Copy Services Manager Version 6.1.1, DS8000 storage systems can now use a Copy Services
Manager server to enable LDAP authentication on the storage system. For specific instructions on how to

configure LDAP support through Copy Services Manager on a DS8000 system, see your DS8000 product
documentation.

Adding a user to the basic user registry

You can add a new user to the basic user registry.

Perform the following steps to add a user to the basic user registry:

1. Log in to Copy Services Manager as a user with administrator privileges.

2. In the menu bar, click Settings > Administration.

3. On the Administration page, click Add Access. The Add Access wizard is displayed.
4

. The Create a User in the Basic User Registry task is already selected by default. Type the user name,
password, confirm the password, and click Next.

Notes:

« The user name cannot contain spaces, tabs, or any of the following special characters: " # $ % &' ()
4, <=>2 [\ M

« User names must be unique between the basic user registry and LDAP.

« Avoid having the same user ID with different cases. When you have multiple user IDs that are the
same spelling, but different case, and remove one of them, other case-variations of that user name
might also be removed from the Copy Services Manager access control list. This scenario can cause
unintended consequences when other case variations of the same user ID then attempt to log in.

The Select Access Level page is displayed.

5. Select the role to associate with this user.

6. If you selected the Operator role, select one or more sessions that this user can manage, and click
Next. The Confirmation page is displayed.

7. Click Next to confirm your access privilege selections for the user.
8. Click Finish to exit the wizard.

Configuring LDAP

You can configure LDAP authentication for Copy Services Manager by using either the GUI or the CLI.

Restriction: RACF LDAP is currently not supported, because the underlying product libraries require full
LDAP version 3 compliance. Specifically, it does not support most complex filters.

Configuring LDAP by using the GUI wizard

You can use a GUI wizard to configure LDAP authentication in your Copy Services Manager environment.
Perform the following steps to configure LDAP authentication support by using the GUI wizard:

1. Log in to the Copy Services Manager GUI as a user with administrator privileges.
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2. Click Settings > Administration.

Note: On the Administration page, you see a status indicator for the LDAP server. Before LDAP is
configured the first time, the status is shown as Not configured with a link to Modify.

3. Click Modify. The LDAP Configuration wizard is displayed.

Note: After you configure LDAP for the first time, a link to Remove the LDAP configuration becomes
available. For instructions on removing the LDAP server configuration, see “Removing LDAP by using
the GUI wizard” on page 298. After the initial configuration, the LDAP server status indicator also
changes from "Not configured" to the name of the LDAP server.

If you already have a manually configured custom LDAP repository in your environment, the Modify
link opens to the Advanced LDAP configuration tab where you can make direct edits. The Basic tab is
disabled if you are modifying a custom configuration.

4. Select either the Basic or Advanced tab. If you complete the information on the Basic tab, Copy
Services Manager automatically configures your LDAP registry based on those inputs. However, if you
want to edit the 1dapRegistry.xml file directly, for a more custom configuration with the LDAP
method, you can select the Advanced tab. The 1dapRegistzry.xml file contains information about
how Copy Services Manager connects to an LDAP server.

« If you select the Basic tab, go to “Configuring LDAP - Basic method” on page 296.

- If you select the Advanced tab go to “Configuring LDAP - Advanced method” on page 297.

Configuring LDAP - Basic method
You can configure LDAP in the GUI with the Basic method by completing a few fields.
You can configure LDAP in two ways:

« On the Basic tab, you complete fields that Copy Services Manager uses to set up the configuration. This
topic covers the Basic method.

- On the Advanced tab, you can directly edit the raw data in the LDAP registry file for a more customized
approach. Or, if you already have a custom LDAP configuration, you must use the Advanced tab to make
changes. For the Advanced method, go to “Configuring LDAP - Advanced method” on page 297.

Note: Copy Services Manager only tests or saves the configuration on the current tab that you are viewing,
whether Basic or Advanced. Changes that you make in one tab are not synchronized with the other tab.

Follow these steps if you select the Basic tab for configuring LDAP:

1. Select the authentication method, either Active Directory or LDAP. The Active Directory method is
already selected by default.

2. When you configure LDAP for the first time, no server is defined. Click Add Authentication Server.

3. Type the appropriate Authentication Server host name, and Port, and then click Add. The server
name is displayed in the Server list.
Note: You can specify one or more authentication servers. The ports must be an integer 1 - 65535.
4. Type the user ID in the Bind Distinguished Name (DN) or User ID field.
5. Type the associated password for the user ID in the Bind Password field.
6. Type a string value for the filter to search on in the Search base for users and groups field.
7. Optional: Select the Enable SSL check box to upload an SSL key file to the LDAP server that you are

connecting to. Then, click Load Certificate and select the file name.
Notes:

- When you modify an existing LDAP server configuration, the Enable SSL check box is already
selected. You can use the existing certificate file that is displayed, or click Load Certificate again if
you need to load a new one. You can also choose to remove the check from Enable SSL.

» You can load a certificate file that contains multiple certificates in a single file, if needed. For more
information, see “Creating a file with multiple certificates for LDAP configuration” on page 301.

8. Click Test to test the connection. If the system cannot connect, an error message appears.
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Note: If you get a message that no users or groups were found, you can modify your inputs and click
Test again. Alternately, you can save the configuration without making more changes.

9. Click Save to complete the LDAP configuration, or click Cancel to exit.

When all the fields are correctly completed, and the test connection is successful, one or more servers are
configured for LDAP authentication.

Configuring LDAP - Advanced method
You can configure LDAP in the GUI with the Advanced method by updating the LDAP registry file.
You can configure LDAP in two ways:

« On the Basic tab, you complete fields that Copy Services Manager uses to set up the configuration. For
the Basic method, go to “Configuring LDAP - Basic method” on page 296.

- On the Advanced tab, you can directly edit the raw data in the LDAP registry file for a more customized
approach. Or, if you already have a custom LDAP configuration, you must use the Advanced tab to make
changes. This topic covers the Advanced method.

Notes:

- Copy Services Manager only tests the configuration on the current tab that you are viewing, whether
Basic or Advanced. Changes that you make in one tab are not synchronized immediately with the other
tab. After saving the configuration, changes can be seen by clicking Modify again and viewing the tabs.

Follow these steps if you select the Advanced tab for configuring LDAP:

1. Edit the 1dapRegistry.xml file. The wizard displays the file with syntax highlighting to assist
you. See the WebSphere Application Server Liberty documentation for a full listing of the tags and
attributes available for the LDAP registry file.

The 1dapRegistry.xml file must be enclosed in server tags as shown:

<server>
<ldapRegistry>
</ldapRegistry>
</server>

Note: To change the password, starting with V6.2.7, you can now use the new Bind Password field,
instead of having to modify the 1dapRegistry.xml file with clear text.

If you update the password in the 1dapRegistry. xml file in plain text and save the file, Copy
Services Manager encrypts the password so that the next time the wizard is opened, the password
does not appear in plain text. However, to avoid any potential security issues of entering a password in
plain text at all, you can instead use the new Bind Password field on the Advanced tab.

2. Optional: Select the Enable SSL check box to upload an SSL key file to the LDAP server that you are
connecting to. Then, click Load Certificate and select the file name.

Notes:

« This action adds the attributes ss1Enabled="true" and ssl1Ref="1dapsslref" tothe
configuration. These attributes need to be removed from the text to disable SSL.

= When you modify an existing LDAP server configuration, the Enable SSL check box is already
selected, and the associated SSL attributes are already set to ss1Enabled="txrue" and
sslRef="1dapsslref". You can use the existing certificate file that is displayed, or click
Load Certificate again if you need to load a new one. Or, remove these attributes from the
ldapRegistry.xml file to disable SSL.

 You can load a certificate file that contains multiple certificates in a single file, if needed. For more
information, see “Creating a file with multiple certificates for LDAP configuration” on page 301.

3. Optional: If you plan on using a configuration with nested groups, the following additional parameter
must be added to the 1dapregistry.xml file:
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recursiveSearch="true"

See “Configuring nested groups in LDAP” on page 298 for more information.
4. Click Test to test the connection. If the system cannot connect, an error message appears.

Note: If you get a message that no users or groups were found, you can modify your inputs and click
Test again. Alternately, you can save the configuration without making more changes.

5. Click Save to complete the LDAP configuration, or click Cancel to exit.

When all the fields are correctly completed, and the test connection is successful, one or more servers are
configured for LDAP authentication.

Configuring nested groups in LDAP

Nested groups are supported as part of the Advanced LDAP setup.

If your LDAP or Active Directory configuration contains users in nested groups, an additional parameter
is required. See the optional step “3” on page 297 in the previous advanced configuration procedure for
more information.

Note: This parameter adds some overhead to the search algorithm, and might affect the search
performance if it is set.

Removing LDAP by using the GUI wizard

After you configure LDAP authentication in your Copy Services Manager environment, you can also remove
the configuration by using the GUI.

Perform the following steps to remove the LDAP authentication support by using the GUI:

1. Log in to the Copy Services Manager GUI as a user with administrator privileges.

2. In the menu bar, click Settings > Administration.
Note: On the Administration page, you see a status indicator for the LDAP server. After LDAP is
configured, the links give the options to Modify or Remove the LDAP configuration.
For instructions on configuring LDAP, see “Configuring LDAP by using the GUI wizard” on page 295.

3. Click Remove. A message is displayed asking you to confirm that you want to remove the LDAP
configuration.

4. Click Yes to confirm the removal or click No to cancel.

5. If you click Yes, another message is displayed telling you that the LDAP configuration was successfully
removed. Click OK to close the message.

The LDAP configuration is removed, and the status indicator for the LDAP server is labeled as Not
Configured with a link to Modify.

Configuring LDAP by using the CLI

You can use the command-Lline interface (CLI) to configure LDAP authentication in your Copy Services
Manager environment.

The basic user registry is the default user-authentication method for Copy Services Manager. If you do
not use the basic user registry, you can configure Copy Services Manager to use either an Active Directory
Server or an LDAP Server-based authentication method.

Note: After LDAP authentication is configured, users from the basic user registry are still able to
authenticate. It is recommended that you leave at least one user from the basic user registry with the
administrator role. This user serves as a backup if there is ever a loss in communication to the LDAP
servers.

Perform the following steps to configure LDAP authentication support by using the CLI:

1. Log in to Copy Services Manager CLI as a user with administrator privileges.
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2. You can choose to establish either an Active Directory or LDAP Server configuration.

a) Enter the mkadcfg command to configure Copy Services Manager to use Active Directory server-
based authentication.

»— mkadcfg -server adserver -username —»

-help ;<

-h
?adservername:port
e

»— username ( -domain — domain »«

L -password — password

Parameters

~help | -h | -?
Lists help for the command. If you specify additional parameters and arguments, those
parameters and arguments are ignored.

-serxver adserver
Specifies the Active Directory servers. The input format is "adservername:port", for example, "
adServerl:636". Multiple backup Active Directory servers can be specified by using a semicolon
to separate each server. If a port is not specified, the default port that is used is 389.

-usexrname username
Specifies the user name that is required for accessing the Active Directory domain. Any domain
user from the Active Directory server that is identified by the server parameter can be specified
for this operation.

-passwoxd password
Specifies the password of the user who is specified with the usexrname parameter. To hide
the password, call the command without this option. The command prompts for the password,
which is not echoed.

-domain domain
Specifies the domain of the user who is specified with the username parameter.

Example:

csmcli> mkadcfg -server ADserverl.ibm.com:1234 -username admin -password
passwOrd -domain ibm.com

The following output is returned:

IWNR4950I [Aug 11, 2015 9:28:06 AM] Successfully updated the LDAP
configuration.

b) Enter the mkldapcfg command to configure Copy Services Manager to use LDAP server-based
authentication.
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»— mkldapcfg L J -server ldapserver —»
-help -keyfilepath — keyfilepath
-h
-?
-baseDN — Ildapbase — -bindDN — ldapbinddn —»
{—£:::?kkuwen@v ::J—J

L -password password J A

Parameters

~help | -h | -?
Lists help for the command. If you specify additional parameters and arguments, those
parameters and arguments are ignored.

-keyfilepath keyfilepath
Specifies the absolute path of the key file that holds the CA certificate. If multiple certificates
are required, then include all of them in a single file to be provided as input. The file should be
present on the system from which mkldapcf is initiated. This parameter is optional.

\ 4

Y

Note: For information on how to create a file with multiple certificates, see “Creating a file with
multiple certificates for LDAP configuration” on page 301.

-server ldapserver
Specifies the LDAP servers. The input format is "ldapservername:port", for example,
"ldapserverl:636". Multiple backup LDAP servers can be specified by using a semicolon to
separate each server. Multiple LDAP servers must be replicas of the primary LDAP server, or
they can be any LDAP host with the same schema, which contains data that is mirrored from the
same LDAP Data Interchange Format (LDIF) file. If a port is not specified, the default ports that
are used are 389 for ldap:// and 636 for ldaps://.

-baseDN Idapbase
Specifies the LDAP base DN.

-bindDN bindDN
Specifies the binding DN of an LDAP user who has sufficient permissions to read user data.

-passwoxd password
Specifies the password of the user who is specified with bindDN parameter. To hide the
password, call the command without this option. The command prompts for the password,
which is not echoed.

Example:

csmcli> mkldapcfg -server ldapserver.ibm.com:1234
-bindDN cn=root -baseDN ou=test,o=ibm,c=us -password passwOrd
The following output is returned:

IWNR4950I [Aug 11, 2015 8:45:21 AM] Successfully updated the
LDAP configuration.

Example:

csmcli> -server ldapserver.ibm.com:1234 -bindDN cn=root
-baseDN ou=test,o=ibm,c=us -keyfilepath c:\security\ldap.crt

The following output is returned:

Please enter a password:>
An LDAP configuration already exists. Are you sure you want to replace

300 IBM Copy Services Manager: User's Guide



it? [y/n]:y
IWNR4950I [Aug 11, 2015 8:45:21 AM] Successfully updated the LDAP
configuration.

Note: Only one authentication method can be used. For example, if you enter the mkadcfg command
first, and then enter the mkldapcfg command later, the last command overwrites the previous
configuration.

When Copy Services Manager is configured to connect to the appropriate server, all LDAP users are
authenticated through that server.

Creating a file with multiple certificates for LDAP configuration
You can add multiple certificates to a single file to upload for LDAP configuration.

If you have an environment with multiple LDAP servers, you can upload a file with multiple certificates for
LDAP configuration. Two situations might require the use of a file with multiple certificates:

« Some of them are not signed with the same certificate (or not signed by a certificate authority at all).

- They are all signed with the same certificate, but the certificate was generated with a weak algorithm
that the Copy Services Manager security settings are rejecting.

To load multiple certificates, you need to first create a text file that contains all of the necessary
certificates.

1. Open a new text file in a text editor, such as Notepad for Windows or vi for Linux.

2. Paste each section of encoded certificate data into the file with separation by new lines.
A certificate looks like this example:

----- BEGIN CERTIFICATE-----
MITICMTCCAZqgAwIBAgIIRwuGTeIhbRwwDQYJKoZIhvcNAQEFBQAWOTELMAKGALUE
BhMCdXMxDDAKBgNVBAOTA21ibTEcMBoGALUEAXMTbmF1dGlsdXMtbGRhcHN1cnZ1
cjAeFwOxNzA5MDYxMzMOMz1aFwOx0ODA5MDcxMzMOMz1aMDkxCzAIBgNVBAYTANVz
MQwwCgYDVQQKEWNpYmOXxHDAaBgNVBAMTE25hdXRpbHVZLWXxKYXBzZXJ2ZXIwgZ8w
DQYJKoZIhvcNAQEBBQADgY®AMIGIAOGBAOBCkixbcnhedJyhv1GUV/kQyi/Bet7n
9SJE4Q1ZJtpL4AFi6C7zMs01QqIGXaRS4hzMcxAmhGpz /UD2k2N49RRkCtbgboYRvb
TcoywJIW2xtlwRZkbZul7keMOHFPbdW7 /RgNs4n/GIyF1KGWOt4dHICPNULmMOHWh
4+KcXS8fWkafAgMBAAGTQjBAMBOGALUdDgQWBBQKYGUIhDHWMVd7XxQLuf4jYN3gx
bzAfBgNVHSMEGDAWEBQKyYGuIhDHWMVd7xQLuf4iYN3gxbzANBgkqhkiGOwOBAQUF
AAOBgQA9AU3j1lamb63rEdCz1j2t09yChDwyRA5IRqAbz59C14mLyFvTkeolwyJ+oP
1T8VStwgYObux3sOMTCuK3jONtkqJS9sBMuSnVAaswIRNFR+dYNX4nyKVAB/r9Rm
ndbo7YXP+9Rb1UCE+H6hmbSUM] LNpgKvs94xZBqAGDFBWOUY8Q==

----- END CERTIFICATE-----

So multiple certificates in a single file look like this example:

----- BEGIN CERTIFICATE-----
<Baseb4 encoded certificate data>
----- END CERTIFICATE-----

----- BEGIN CERTIFICATE-----
<Baseb4 encoded certificate data>
----- END CERTIFICATE-----

----- BEGIN CERTIFICATE-----
<Baseb4 encoded certificate data>
----- END CERTIFICATE-----

3. Save the file.

You now have a file with multiple certificates to use for LDAP configuration. Select to upload this multi-
certificate file when you configure LDAP authentication for Copy Services Manager. For more information,
see “Configuring LDAP” on page 295.

Switching the default Copy Services Manager certificates

You can change the default certificates that are supplied by Copy Services Manager.

The HTTPS certificates used by browsers for the Copy Services Manager graphical user interface (GUI)
can be switched independently of the Copy Services Manager server and client certificates.
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Switching default Copy Services Manager graphical user interface(GUI)
HTTPS certificates: Automated process

You can switch the default Copy Services Manager GUI certificates that are supplied by Copy Services
Manager. With this automated process, you can switch default certificates by uploading the HTTPS
truststore file from the GUI.

The automated process switches out the default HTTPS truststore file. The default truststore file is:
« wlp/usr/servers/csmServer/resources/security/key. jks

This file is at these locations.

« path_prefix/opt/IBM/CSM/ forz/OS®

« install dir/libexty/ for distributed systems

To switch out the default Copy Services Manager GUI HTTPS certificates by using the automated process
from Copy Services Manager GUI, complete the following steps.

Restriction: You cannot follow this procedure to switch out the default HTTPS certificates when Copy
Services Manager is installed on the DS8000 Hardware Management Console (HMC). To switch out
the default HTTPS certificates when Copy Services Manager is installed on the DS8000 Hardware
Management Console (HMC), see the topic titled Communications Certificate in the latest version of
DS8900 documentation.

1. Navigate to the Copy Services Manager GUI as a user with administrator privileges.
2. Click Settings > Advanced Tools.

3. Scroll to the Import custom Truststore for HTTPS connections to the server section and click Import
Truststore.

The Import Truststore window is displayed.
4. Click Choose a Truststore to import and select the truststore file that you want to upload.

5. Optional: If the truststore file is password-protected, type the password in Truststore password
(optional) box.

6. Click Use uploaded Truststore.

A confirmation message that a restart of the server is required for the truststore file to take effect, is
displayed.

7. Click OK.
When the server is restarted, HTTPS communication uses the new truststore file.

If the GUI does not load after this procedure, it can be due to issues in loading the new keystore. To
resolve the issue, review the messages log, which is available at the following path.

<CSM Installation Directory>/liberty/wlp/usr/sexrvers/csmServer/logs/
messages.log

Look for a message about the truststore file. All errors that are related to the new truststore file, must be
resolved to be able to access the GUI.

A backup of the Copy Services Manager configuration is taken before the new truststore is implemented.
The original truststore is also backed up to the file system with the extension . bak appended. You

can revert the uploaded truststore and restore the original truststore. To restore the original truststore,
remove the newly created truststore and rename the . bak file to its original name. If you are switching
between a P12 and JKS file format, a backup . bak file is not created for the previous file type. If you
would like to restore to the old file, change the bootstrap.property to point to the previous file and set the
correct password. Clear text is the acceptable format and it is converted to a hash algorithm upon restart
of the server or if a new truststore is uploaded.

Note: For more information, see “Restoring the Copy Services Manager database” on page 30.
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Switching default Copy Services Manager graphical user interface(GUI)
HTTPS certificates: Manual Process

You can switch the default Copy Services Manager GUI certificates that are supplied by Copy Services
Manager.

To switch out the default Copy Services Manager GUI HTTPS certificates, you need to change the keystore
file that is used by the csmServer application server that is running under WebSpere Liberty. The default
keystore file is:

« wlp/usr/servers/csmServer/resources/security/key. jks
This file is at these locations.

« path_prefix/opt/IBM/CSM/ forz/OS®

« install dir/libexty/ for distributed systems

You can create new versions of this file by using iKeyman, which is distributed with the Copy Services
Manager version of Java™.

Note:
 You can locate the iKeyman tool at install dir/liberty/wlp/IBM/Java/jre/bin/ikeyman (or
ikeyman.exe on Windows systems).

« The iKeyman tool is not available on z/0OS. Therefore, you must first complete this procedure on a
distributed system, and then upload the changes to the z/OS server. The JKS files need to be uploaded
to z/OS UNIX System Services in a binary format.

« On z/0S, you can use the command-Lline based tool ikeycmd located in path_prefix/opt/IBM/CSM/
Java/bin to create and manage key files and certificates. However, the commands are not described
here in detail. For more information, use the ikeycmd -help command in ikeycmd.

Restriction: You cannot follow this procedure to switch out the default https certificates when Copy
Services Manager is installed on the DS8000 Hardware Management Console (HMC).

When you switch default Copy Services Manager certificates, you can use a shared custom certificate for
all your Copy Services Manager servers (Active and Standby server), or have dedicated certificates for
each Copy Services Manager server.

You can also encrypt the keystore passwords to avoid specifying plain text passwords in property files.
Use the securityUtility script to encode a password. The tool is at these locations.

« path_prefix/opt/IBM/CSM/wlp/bin/ forz/0OS°®

« install dir/libexrty/wlp/bin/ for distributed

Usage example:

wlp/bin> securityUtility encode --encoding=xor passwOrd
ixor}Lz4sLChvLTs=

Encoding options:

--encoding={xor|aes|hash}
Specify how to encode the password. Supported encodings are xor, aes,
and hash. The default encoding is xor.

Note: Copy Services Manager currently supports encrypted passwords for the HTTPS keystore only by
XOR encoding.

Follow these steps to switch out the default certificates that are assigned by Copy Services Manager.
The example uses different keystore file names to clearly differentiate the configuration from default
keystores and certificates. It also prevents you from overwriting the original files.

1. Back up the original versions of the key . jks files to a new directory.

2. IniKeyman, select Key Database File > New to create a new keystore file, for example,
myCsmKeyStore. jks file, and provide a password for it.
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Note: If you use the default file name key . jks, save the new file to a different location from the
existing version of the file so that you do not overwrite it.

3. IniKeyman, select Key database content > Personal Certificates > New Self-Signed to generate a
new self-signed certificate. Or, you can choose to import a signed certificate, by selecting Import.

a. Assign a label to the self-signed certificate. For example, you can select a label such as csm-
<servername> to indicate that the label is different from the default.

b. Enter a key size of at least 2048 for a new self-signed certificate.

c. Change the default algorithm to a more-secure signature algorithm. The iKeyman tool suggests
an SHA-1 signing algorithm, and a one-year expiration by default. You can change the signature
algorithm to that of SHA256WithRSA, and add an extended expiration date.

4. Optional: If you want dedicated (self) signed server certificates for each Copy Services Manager server,
repeat step 3 to create another keystore file with another (self) signed certificate. For dedicated (self)
signed server certificates, enter the server name in the keystore file names as well, for example,
myCsmKeyStore <ServerName>.jks

5. Edit the bootstrap.properties file to point the server to use the new keystore file that contains
the SSL certificate. In the bootstrap.properties file for the csmServer application, you can define
the HTTPS keystore that is used by browser connections to the Copy Services Manager server GUI. The
bootstrap.properties fileis at these locations.

« path_prefix/opt/IBM/CSM/wlp/usr/sexrvers/csmServer/ for z/OS
« install dir/liberty/wlp/usxr/servers/csmServer/ for distributed systems

If you do not specify a full path name for keystore_location, you can copy the
myCsmKeyStore<ServerName>. jks file to the default folders. This ensures that the file is
automatically picked up with a Copy Services Manager server backup when the backup is created
with Copy Services Manager 6.2.9 or higher. These are the default folders for the keystore file.

« path_prefix/opt/IBM/CSM/wlp/usr/servers/csmServer/resources/security forz/0S

« install dir/liberty/wlp/usr/servers/csmServer/resources/security fordistributed
systems

The default path name of keystore_location is where you copy the keystore file, therefore you
need to specify only your keystore file. Following example shows how to specify the copied keystore
file located in csmServer/resources/security.

#relative to csmServer/resources/security
keystore_location=myCsmKeyStore<ServerName>. jks
keystore_password=<assigned password>

Note: In the bootstrap.properties file, when you enter the value for keystore_location, usea
slash ‘/’" as a path separator. When you use a backslash, you must add two backslashes together, such
as ‘\\'. Adding a single backslash can cause the file to not be found. The Copy Services Manager server
can even fail to start.

If you do not define a keystore_location, the server defaults to use a key . jks file in the
resources/security directory, when the Copy Services Manager server is started.

If the specified keystore file is not found when, the Copy Services Manager server starts, a default file
is created to serve browser connection requests to the Copy Services Manager GUI. This file has a
certificate with an expiration of 1 year.

The password that is defined in keystore_password is eXclusive OR (XOR) encrypted with the
securityUtility.

For more information, see “bootstrap.properties file” on page 322.

6. Restart the Copy Services Manager server for the changes to take effect. You can check the
csmServer messages.log file to check whether the bootstrap.properties configuration
changes were successful and the correct keystore and certificate is used. The csmSexrver
messages.log file is at these locations.
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« path_prefix/opt/IBM/CSM/wlp/usr/sexrvers/csmServer/logs for z/OS
e install dir/liberty/wlp/usr/servers/csmServer/logs for distributed systems

The default Copy Services Manager certificates that are supplied by Copy Services Manager GUI for
browser HTTPS requests are switched out.

Switching default Copy Services Manager server and client certificates

You can switch the default server and client certificates for Copy Services Manager. This manual process
involves uploading the . jks files.

The server and client certificates are used for encrypting all connections between any Copy Services
Manager client to any Copy Services Manager server. The Copy Services Manager clients include the
command-line interface (CLI), the graphical user interface (GUI), and high availability (HA) clients for
Copy Services Manager active and standby connections. To switch out the default Copy Services Manager
server and client certificates, you need to change these two main files.

« etc/csmKeyStore. jks
« etc/csmTrust. jks

These files are at these locations.

« path_prefixz/opt/IBM/CSM/wlp/usr/servers/csmServer/etc/ forz/0OS®
e install dir liberty/wlp/usr/servers/csmServer/etc/ for distributed

You can create new versions of these files by using iKeyman, which is distributed with the Copy Services
Manager version of Java™.

Note:

 You can locate the iKeyman tool at install dir/liberty/wlp/IBM/Java/jre/bin/ikeyman (or
ikeyman.exe on Windows systems).

« The iKeyman tool is not available on z/OS. Therefore, you must first complete this procedure on a
distributed system, and then upload the changes to the z/OS server. The JKS files need to be uploaded
to z/OS UNIX System Services in a binary format.

« On z/0S, you can use the command-Lline based tool ikeycmd located in path_prefix/opt/IBM/CSM/
Java/bin to create and manage key files and certificates. However, the commands are not described
here in detail. For more information, use the ikeyemd -help command in ikeycmd.

Restriction: You cannot follow this procedure to switch out the default https certificates when Copy
Services Manager is installed on the DS8000 Hardware Management Console (HMC).

When you switch default Copy Services Manager certificates, you can use a shared custom certificate for
all your Copy Services Manager servers (Active and Standby server), or have dedicated certificates for
each Copy Services Manager server. When using dedicated server certificates, you need to ensure that
the keystore only contains the dedicated (self) signed server certificate. The truststore that is used by
client connections must import each certificate that might be used by any of your servers. Otherwise, it
can happen that only local client connections are established, but there are no connections to other Copy
Services Manager servers that use a different (self) signed certificate in their keystore.

You can also encrypt the keystore passwords to avoid specifying plain text passwords in property files.
Use the securityUtility script to encode a password. The tool is at these locations.

« path_prefixz/opt/IBM/CSM/wlp/bin/ forz/0S®
e install dir/liberty/wlp/bin/ for distributed

Usage example:

wlp/bin> securityUtility encode --encoding=xor passwOrd
$x0r}Lz4sLChvlLTs=

Encoding options:
--encoding={xor|aes|hash}
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Specify how to encode the password. Supported encodings are xor, aes,
and hash. The default encoding is xor.

Note: Copy Services Manager currently supports encrypted passwords for the HTTPS keystore only by
XOR encoding.

Follow these steps to switch out the default certificates and key files that are assigned by Copy Services
Manager. The example uses different keystore and truststore file names to clearly differentiate the
configuration from keystores and certificates. It also prevents you from overwriting the original files.

1. Back up the original versions of the csmKeyStore. jks and csmTrust. jks files to a new directory.
These files are at these locations:

 path_prefix/opt/IBM/CSM/wlp/usr/servers/csmServer/etc/ for z/0OS
« install dir/liberty/wlp/usr/servers/csmServer/etc/ for distributed systems

2. IniKeyman, select Key Database File > New and create a new keystore file and provide a password
forit.
For example, name the file nyCsmKeyStozre. jks file, and provide a password for it.

Note: If you use the default file name key . jks, save the new file to a different location from the
existing version of the file so that you do not overwrite it.

3. IniKeyman, select Key database content > Personal Certificates > New Self-Signed to generate a
new self-signed certificate. Or, you can choose to import a signed certificate, by selecting Import.

a. Assign a label to the self-signed certificate. For example, you can select a label such as csm-
<servername> o indicate that the label is different from the default.

b. Enter a key size of at least 2048 for a new self-signed certificate.

c. Change the default algorithm to a more-secure signature algorithm. Change this algorithm
to a more-secure signature algorithm. You can change the signature algorithm to that of
SHA256WithRSA, and add an extended expiration date.

4. Click Extract Certificate and export the certificate as csm-<servername>.arm, which is the public
certificate information.

5. Optional: If you want dedicated (self) signed server certificates for each Copy Services Manager
server, repeat step 3 to create another keystore file with another (self) signed certificate. For
dedicated (self) signed server certificates, enter the server name in the keystore file names as well,
for example, nyCsmKeyStore <ServerName>.jks

6. Create a JKS file for the common truststore, for example myCsmTrust. jks file by selecting Key
Database > File New, and provide a password for it.
Note: If you use the default file name key . jks, save the new file to a different location from the
existing version of the file so that you do not overwrite it.

7. In the Key database content menu, select Signer Certificates. Click Add to add the extracted
certificate, csm-<serverame>.arm, and assign the same label as you did in step 3.a., such as
csm-<servername>.

Repeat this step to import all extracted certificate files for each server in case you use dedicated
server certificates, as created in step 5. Use different labels for each imported certificate, such as
csm-<servername> to distinguish the certificates later.

The iKeyman tool automatically saves your information and you can simply exit the tool.

8. Move the new myCsmKeyStore. jks and myCsmTrust. jks files that you re-created with the
iKeyman tool, into these original directories.
» path_prefix/opt/IBM/CSM/wlp/usr/servers/csmSexrver/etc/ for z/OS
« install dir/liberty/wlp/usr/servers/csmServer/etc/ for distributed systems
If you use dedicated keystore files for each Copy Services Manager server, such as
myCsmKeyStore<ServerName>. jks, copy the corresponding keystore to the appropriate Copy

Services Manager server. The truststore file myCsmTrust. jks is common and can be used for any of
your Copy Services Manager servers or external CSMCLI clients.
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9.

10.

11.

Create a backup of your rmserver.properties file. In the rmserver.properties file, you can
define your custom keystore and truststore files to be used by the Copy Services Manager server. The
rmserver.properties file is at these locations.

e path_prefix/opt/IBM/CSM/wlp/usr/sexrvers/csmServer/properties forz/OS
« install dir/libexrty/wlp/usr/servers/csmServer/properties for distributed systems

Locate the default sections of the file and update the file name and password for the following
options as shown:

# *Used to setup SSL sockets between the clients and server.
communications.keyStore=etc/myCsmKeyStore<ServerName>.jks
communications.keyStorePwd=<Password for myCsmKeyStore<ServerName>.jks>

# *Used so that Clients can authenticate with the server using Certificates.
communications.authStore=etc/myCsmTrust. jks
communications.authStorePwd=<Password for myCsmTrust.jks>

Note:
- Certificate configuration errors in this file result in GUI, CLI, or HA client not connecting to the
server.

Back up a copy of your csmConnection.properties file. In the csmConnection.properties
file, you can define the truststore that is used by any GUI or HA client to connect to local or remote
server. Back up a copy of your csmConnection.properties file.

This file is at these locations:

» path_prefix/opt/IBM/CSM/wlp/usr/servers/csmServer/etc/ for z/OS
« install dir/libexrty/wlp/usr/servers/csmServexr/etc/ for distributed systems

Update csmConnection.properties with the truststore file name and the certificate name in the
keystore file. For the csm.server.certificate field, enter the name that you assigned to the
self-signed server certificate, as you created in step 3.a. Refer to the following example to update the
csmConnection.properties.

csm.server.keystore=etc/myCsmTrust. jks
csm.server.certificate=csm-<servername>

Note: : You do not need to specify a password for the truststore in this file. The truststore password
as specified in rmserver. properties is used to access the file.

Edit the bootstrap.properties file to point the server to use the new keystore file that contains
the SSL certificate. In the bootstrap.properties file, you can define the HTTPS keystore that is
used by browser connections to the Copy Services Manager server GUIL. The HTTPS certificates can
be switched independently, but it is simpler to use the same certificates as switched for the Copy
Services Manager server. The bootstrap.properties fileis at these locations.

« path_prefix/opt/IBM/CSM/wlp/usr/servers/csmServexr/ for z/OS
» install dir/liberty/wlp/usxr/servers/csmServer/ for distributed systems

To edit the bootstrap.properties file, copy the myCsmKeyStore<ServerName>. jks file to the
default folder. The default folder in the following path.

» path_prefix/opt/IBM/CSM/wlp/usr/servers/csmServer/resources/security for
z/0S

« install dir/liberty/wlp/usr/servers/csmServer/resources/security for
distributed systems

Note:

- If the specified keystore file is not found when, the Copy Services Manager server starts, a default
file is created to serve browser connection requests to the Copy Services Manager GUI. This file has
a certificate with an expiration of 1 year.
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« If you do not define a keystore_location, the server defaults to use a key . jks file in the
resources/security directory, when the Copy Services Manager server is started.

» The password that is defined in keystore_password is eXclusive OR (XOR) encrypted with the
securityUtility.
For more information, see “bootstrap.properties file” on page 322.

12. Optional: You can also edit the bootstrap.properties file by specifying a relative or absolute
path name to point to your keystore file at etc/myCsmKeyStore<ServerName>. jks.

The following example shows how to specify the keystore with a relative path name to the
default folder. On Windows systems, you can also prefix the drive letter in an absolute path name
declaration.

#relative to csmServer/resources/security
keystore_location=myCsmKeyStore<ServerName>.jks

keystore_password=<assigned password>

j#fabsolute path example on Windows
Jtkeystore_location=C:/<path_prefix>/CSM/liberty/wlp/usr/servers/csmServer/etc/
myCsmKeyStore<ServerName>. jks

Note: In the bootstrap.properties file, when you enter the value for keystore_location, use
a slash ¢/’ as a path separator. When you use a backslash, you must add two backslashes together,
such as ‘\\'. Adding a single backslash can cause the file to not be found. The Copy Services Manager
server can even fail to start.

13. Restart the Copy Services Manager server for the changes to take effect. You can check the
csmServer messages.log file to check whether the bootstrap.properties configuration
changes were successful and the correct keystore and certificate is used. The csmServer
messages.log file is at these locations.

» path_prefix/opt/IBM/CSM/wlp/usr/servers/csmServer/logs for z/OS
« install dir/liberty/wlp/usx/servers/csmServer/logs for distributed systems
The next five steps involve the command-Lline interface (CLI).

14. Copy your common trust file myCsmTrust. jks to the Copy Services Manager CLI directory at
install dir/CLI/etc.

15. Create a properties directory in the CLI directory (install dir/CLI/properties)

16. Create acsmclient.properties file in the properties directory. This file is used to specify a
custom truststore for encryption between the CLI client and the Copy Services Manager server. Add
the following details in the file.

communications.trustStore=etc/myCsmTrust.jks
communications.trustStore.password=<assigned password>

Note:

» The default csmTrust. jks file is embedded in the csmcli. jar file. You cannot remove it. Use
the csmclient.properties file to use a different truststore. The truststore file is at install
dir/CLI/etc by default.

- Certificate configuration errors in this file result in CSMCLI login not working due to invalid
encryption for authenticating with the Copy Services Manager server.

17. Log on to the Copy Services Manager CLI.

18. Optional: If you have the stand-alone CLI extracted on other systems in your environment, repeat the
CLI steps.

19. To establish a Copy Services Manager HA relationship to another Copy Services Manager server,
switch the default certificates for the other Copy Services Manager server. Copy the dedicated server
keystore file and common truststore file to the other Copy Services Manager server and update all
property files as described in steps 8-18.

If you do not switch the certificates for the other Copy Services Manager server, the Copy Services
Manager Management server relationship is not established and fails with a connection error.
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20. To use LDAP configuration for Copy Services Manager user authentication on the Copy Services
Manager server, follow the next steps to switch the keystore of the csmAuth server as well.

21. Copy your new keystore file that you created in step 3 into the original csmAuth keystore directory.

» path_prefix/opt/IBM/CSM/wlp/usr/servers/csmAuth/resources/security/ forz/0OS

« install dir/liberty/wlp/usr/servers/csmAuth/resources/security/ for distributed
systems

If you use dedicated keystore files for each Copy Services Manager server, such as
myCsmKeyStore<ServerName>. jks, copy the corresponding keystore to the appropriate Copy
Services Manager server.

22. Edit the bootstrap.properties file of the csmAuth server to point the server to use the new
keystore file that contains your certificate that is used for the SSL connection. The file is at these
locations.

« path_prefix/opt/IBM/CSM/wlp/usr/servers/csmAuth/ forz/0S
« install dir/liberty/wlp/usr/servers/csmAuth/ for distributed systems
The default path name of the keystore_location is where you copied the keystore file, therefore

you need to specify only your keystore file. Following example shows how to specify the copied
keystore file located in csmAuth/resources/security.

#relative to csmAuth/resources/security
keystore_location=myCsmKeyStore<ServerName>.jks
keystore_password=<assigned password>

Note:

e Inthe bootstrap.propexrties file, when you enter the value for keystore_location, use a
slash ‘/’” as a path separator. When you use a backslash, you must add two backslashes together,
such as ‘\\'. Adding a single backslash can cause the file to not be found. The Copy Services
Manager server can even fail to start.

« If you do not define a keystore_location, the server defaults to use a key . jks file in the
resources/security directory, when the Copy Services Manager server is started.

- If the specified keystore file is not found when, the Copy Services Manager server starts, a default
file is created to serve browser connection requests to the Copy Services Manager GUI. This file has
a certificate with an expiration of one year.

« The password that is defined in keystore_password is eXclusive OR (XOR) encrypted with the
securityUtility.
23. Restart the Copy Services Manager authentication server for the changes to take effect. You
can check the csmAuth messages.log file to check whether the bootstrap.properties
configuration changes were successful and the correct keystore and certificate is used. The csmAuth
messages.log file is at these locations.

« path_prefix/opt/IBM/CSM/wlp/usr/servers/csmAuth/logs for z/OS
» install dir/liberty/wlp/usxr/servers/csmAuth/logs for distributed systems

The default certificates that are supplied by Copy Services Manager are switched out.

Synchronizing a remote server with the csmAuth certificate

You can set up remote Copy Services Manager servers for LDAP authentication redundancy.

To configure LDAP authentication redundancy, both servers need to start csmAuth with the same
truststore file (key . jks). You can use either the Copy Services Manager GUI or the CLI to synchronize
remote servers with the csmAuth certificate.
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Synchronizing a remote server with the csmAuth certificate by using the GUI
You can synchronize a remote server with the csmAuth certificate by using the GUL.
You must have administrator authority to perform this task.

1. Log in to the Copy Services Manager GUI as a user with administrative authority.
2. From the menu, click Settings > Advanced Tools.
3. Scroll down to find the section for exporting and synchronizing a truststore file.
Note: You can click Export to export the truststore file. This file is used for remote authentication
by storage systems, including DS8000. Synchronizing does not require exporting, but it ensures that

when the synchronization occurs, that the exported file can allow the storage system to use both Copy
Services Manager servers.

4. Click Synchronize to synchronize the exported truststore file onto another Copy Services Manager
server. Complete the following fields:

a) Enter the Host name or IP address for the Copy Services Manager server.

b) Enter the Port for the Copy Services Manager server. The default port is the one that the current CLI
connection is using.

Note: If you want to synchronize from Copy Services Manager on the DS8000 HMC to another
server that has a different CLI port, you might first need to unblock the firewall for that port.

¢) Enter the User name for a user with administrator authority on the Copy Services Manager server.
d) Enter the Password for the specified user.
5. For changes to take effect, csmAuth needs to be restarted on the destination server.

One or more remote Copy Services Manager servers are synchronized with the same truststore file to
enable LDAP authentication redundancy.

Synchronizing a remote server with the csmAuth certificate by using the CLI
You can synchronize a remote server with the csmAuth certificate by using the CLI.
You must have administrator authority to perform this task.

1. Log in to the Copy Services Manager command line as a user with administrative authority.

2. Run the syncauthservice command to synchronize remote Copy Services Manager servers with
the same truststore file (key . jks). By synchronizing these files, the remote authentication can
communicate with either server by using the same key_itso. jks file.

Note: See the syncauthservice command in the IBM Copy Services Manager online product
documentation (http://www-021.ibm.com/support/knowledgecenter/SSESK4) for more information.

The Command-line Interface User's Guide also provides details on the syncauthsexvice command.
See “Publications and related information” on page xiv for where to locate this guide.

3. For changes to take effect, csmAuth needs to be restarted on the destination server.

One or more remote Copy Services Manager servers are synchronized with the same truststore file to
enable LDAP authentication redundancy.

Granting access privileges for LDAP or RACF users or groups

You can assign user roles to a user or group, which then enables you to grant access privileges to
individual sessions and tasks.

Perform the following steps to authorize an LDAP or RACF user or group:
Notes:

« You can use an operating system repository, such as RACF, which is the example that is used in this
task, for z/OS systems. LDAP can be used for both distributed systems and z/OS systems.
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he immediate parent group must be added as a user to be able to log in with user names that belong to

the group.
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10.
11.

Log on to Copy Services Manager as a user with administrator privileges.
. In the menu bar, click Settings > Administration.
On the Administration page, click Add Access. The Add Access wizard is displayed.

. To search on an existing LDAP or RACF (for example) user or group to grant access to, select Search
for Users or Groups, and type the name of the LDAP or RACF user or group.

Tip: You can enter a partial name and use the * wildcard character to represent zero or more
characters. For some registries, the search on user or group is case-sensitive.
. Click Next. The Select Users and Groups page is displayed.
. Choose one or more LDAP or RACF users or group names by selecting the appropriate check boxes.
. Click Next. The Select Access Level page is displayed.
. Select the role to associate with the LDAP or RACF user or group.

Notes:

- If you selected more than one LDAP or RACF user or group, you must assign them all the same
role. To assign different roles to different LDAP or RACF users or groups, you must select them
individually.

« If an LDAP or RACF user is assigned to one role as an individual and a different role as a member of
a group, the user has access to the permissions of the role with greater access.

. If you selected the Operator role, select one or more sessions that this LDAP or RACF user or group
can manage, and click Next. The Confirmation page is displayed.

Click Next to confirm your access privilege selections for the LDAP or RACF user or group.
Click Finish to exit the wizard.

Viewing access privileges for a user or group

You can view a list of all Copy Services Manager users and groups and their assigned roles. You can also
view the assigned sessions for each user or group.

Complete the following steps to view access privileges for a user or group:

1.
2.

5.

Log in to Copy Services Manager as a user with administrator privileges.

In the menu bar, click Settings > Administration. The Administration page is displayed with a list of
Copy Services Manager user and user group names, and their associated role.

. Select the user or group whose access privileges you want to view.
. From the Select Action list, select View/Modify Access. The View/Modify Access page is displayed.

This page shows the role assigned to the user or group and lists the sessions that the user or group can
manage.

Click Cancel to close the page.

Modifying access privileges for a user or group

You can change the user role and assigned sessions for a Copy Services Manager user or group.

Complete the following steps to modify the access privileges for a user or group:

1.
2.

3.

Log in to Copy Services Manager as a user with administrator privileges.

In the menu bar, click Settings > Administration. The Administration page is displayed with a list of
Copy Services Manager users and user group names, and their associated roles.

Select the user or group whose access privileges you want to modify.
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4. From the Select Action list, select View/Modify Access. The View/Modify Access page is displayed.
This page shows the role assigned to the user or group and lists the sessions that the user or group can
manage.

Note: You can also modify user or group access by clicking Add Access from the Administration page.
Then you can select Search for Users or Groups and enter a user or group name. For some registries,
the search on user or group is case-sensitive. Click Next, and then select the user or group for which
you want to modify the access level, and click Next again.

5. Select the role to associate with the user or group.

6. If you selected the Operator role, select one or more sessions that the user or group can manage and
click Next.

7. Click OK.

Deleting access privileges for a user or group

You can delete access privileges for a Copy Services Manager user or group. When you delete access, the
user or group ID cannot access the Copy Services Manager GUI or run commands from the command line.

Perform the following steps to delete user or group access:

1. Log in to Copy Services Manager as a user with administrator privileges.

2. In the menu bar, click Settings > Administration. The Administration page is displayed with a list of
Copy Services Manager users and user groups and their associated role.

3. Select the user or group for which you want to delete access.
4. From the Select Action list, select Delete Access.

Important:

« At the command line, you can use the rmusex and rmauth commands to delete user access
privileges. The xrmusexr command is for users from the basic user registry, and only removes access
for those users. The xrmauth command must be used to remove access for LDAP users.

See the Copy Services Manager Command-Line Interface User's Guide for more information on
using the xrmuser and xrmauth commands. You can find details on where to obtain this guide in
“Publications and related information” on page xiv.

« When you delete access for a basic user, the user is deleted and the user's access is removed. When
you delete access for an LDAP user or group, or, for example, a RACF user or group on z/0S, only
access is removed. The user or group is not deleted from the LDAP registry or the RACF repository.

5. A warning message appears for you to confirm that you want to delete access for the selected user.
Select Yes to delete, or No to cancel.

Dual control

Dual control functionality is provided for additional security starting with Copy Services Manager Version
6.2.5.

Dual control provides a higher level of security. When dual control is enabled on a Copy Services Manager
server, the security procedure requires two people with proper authority to perform a given task or
action. This design helps to prevent malicious attacks against the server. It also provides added safety
for commands that are issued against the server because multiple people have to agree that the task or
action should be taken.

Dual control can be enabled or disabled at the GUI. The dual control setting can be accepted or rejected in
the GUI and CLI, but can only be viewed in the GUI.

Enabling or disabling dual control requires two users with admin authority - at either the Admin or User
Admin level. Approving or rejecting a dual control request requires two users that have authority for the
type of command that was being requested. Monitors should never see requests because they cannot
issue any actions.
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Dual control requests
The following list details the types of dual control requests that are supported in Version 6.2.5:

Run command
Any command action issued against a Copy Services Manager session. These actions include
commands, such as Staxrt H1->H2, Suspend, Recover, Texminate, and Backup.

SnapGroup command
A command against a snapgroup in a snapshot session for IBM Spectrum Accelerate devices.

Set Properties on a session
Modifying the description or properties for a session.

Add/Remove Copy sets
Adding or removing copy sets on a session.

Scheduled Task (modify, delete, enable, disable, run)
Modifying, deleting, enabling , disabling, or running a scheduled task. Creating a scheduled task does
NOT require dual control because the creation does not run or enable the schedule of the task.

Note: After a task is enabled and approved by a second user, the task runs on the defined schedule
automatically without requiring approval each time that it runs.

User Action (add access, delete access, modify access, create user, remove user)
Managing users from the Administration tab.

Enable/Disable Dual Control on the server
The act of turning dual control on or off on a Copy Services Manager server.

Set CG Name on a session
Defining a consistency group name for a given session.

An active/standby setup command (set standby, set as standby) for high availability (HA)
Setting a server as a standby, or setting a standby server both require dual control. Additional rules
apply for active/standby support with dual control.

Dual control request notifications

When dual control is enabled on a server, a request is created. This request displays under
the Notifications->Dual Control Requests tab on the Copy Services Manager GUI Navigator (and
corresponding Copy Services Manager CLI commands).

When one or more requests exist, a number appears next to the Notifications tab in the Navigator,
alerting the requester and any valid approvers that there is a pending request. A valid approver is anyone
who is NOT the requester, and has the authority to issue the command or task that was requested.

Example: If both John and Bob can manage session GMP, but Tim cannot, when John issues a Start
H1->H2 command to session GMP, both John and Bob can see the pending request, but Tim does not.

The Notification->Dual Control Requests panel displays all the requests in a table that lists the ID, Type,
Requesting User, Time Requested, and Summary for each request. The requester sees a Cancel button
next to the request, and can cancel the request at any time before someone else approves it. Approvers
see the Approve and Reject buttons. If the Approve button is selected, approvers are asked to confirm
that they want to approve the request. If they do approve, then the request is executed. If they choose to
Reject the request, they can optionally enter a reason for the rejection. The request is then denied, and
removed from the table.

Important:

1. When you enable a server for dual control, it is important to remember that all of the previously listed
actions require two users to execute them. You must ensure that you always have at least two users
defined on the server that is used to approve the actions. Otherwise, you might be locked out of issuing
actions.

2. Dual control can only be enabled or disabled by an Admin or User Admin, and therefore needs
approval by another Admin or User Admin. So you must have at least two Admins or User Admins
defined on the server.
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When dual control is enabled, and the Copy Services Manager server is restarted, or a High Availability
takeover occurs, any pending dual control requests are automatically rejected, thereby leaving no pending
requests when the servers come back up.

When dual control is disabled, any pending dual control requests are automatically rejected.
Active/standby design for dual control

Dual control for Copy Services Manager includes the following design considerations for the active/
standby servers:

« Active/standby support is handled by enabling dual control on the Define Standby and Set this
Server as Standby commands ONLY.

- If the active server has dual control enabled, the standby MUST also have dual control enabled before
you attempt to create the connection.

- If the standby server has dual control enabled, it is NOT necessary for the active server to have dual
control enabled, although this scenario is highly unlikely and results in the standby losing dual control.

« If dual control is enabled on the active server, the connection MUST be set up from the active server. If
you attempt the connection from the standby, it fails. You cannot set a server as a standby of another
without the active giving permission.

« If dual control is enabled on both servers, approval to set up the connection is multi-phased and
requires the approval first on the active server, and then on the standby server.

« When dual control is enabled and the Define Standby or Set this Server as Standby
command is called, a dual control request is created as in the following example:

Feb 7, 2019 2:14:56 PM : csmadmin : IWNR2629I : User csmadmin requested command
SET_STANDBY on the standby server. The time of the request is
Thu Feb 07 14:14:56 CST 2019.

- The Remove Active, Remove Standby, Takeover, and Reconnect commands do not need dual
control. If the active/standby connection is already set up, then dual control has already approved the
pairing. After the action is complete, dual control is still enabled, and all dangerous actions still require
multiple users.

- If an active/standby connection already exists, and is in a Connected or Synchronized state when
attempting to set up dual control on the active server, then after dual control is approved by a second
user, the dual control requirement is synchronized on the standby server. When a takeover is issued
on the standby server, the standby server should automatically be in dual control mode as well (the
takeover does not require dual approval).

Important:

— To avoid getting locked out of dual control actions after a takeover, you MUST ensure that two Admins
(or User Admins) already exist on both the active and standby servers BEFORE you enable dual
control.

— Itis VITAL to ensure there are at least two Admins or User Admins defined on both the active and
standby servers. If not, a takeover might be issued where the server ends up in dual control mode
because the active server was dual control. If the standby is in dual control without at least two
Admins or User Admins defined, then you will be locked out of executing most actions, and will
not have the ability to disable dual control or add additional users without a second admin. If this
situation occurs, you will need to contact IBM Support.

The following table shows the possible variations of active/standby enablement and the expected results.

Table 81. Active/standby enablement variation and results

Command issued Active status Standby status Result
DEFINE STANDBY Active dual control off Standby dual control off | Sync completes without
approvals
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Table 81. Active/standby enablement variation and results (continued)

Command issued Active status

Standby status

Result

DEFINE STANDBY Active dual control on

Standby dual control off

Approve Request on
active fails and issues
message IWNR3016E
with reason code 124
(must enable dual
control on standby)

DEFINE STANDBY Active dual control on

Standby dual control on

Approve on active,
approve on standby,
and then sync should
complete

DEFINE STANDBY Active dual control off

Standby dual control on

Approve on standby,
and then sync should
complete

SET THIS SERVER AS
STANDBY

Active dual control off

Standby dual control off

Sync completes without
approvals

SET THIS SERVER AS
STANDBY

Active dual control on

Standby dual control off

No approvals, but fails
and issues message
IWNR3016E with reason
code 125 (must connect
from active)

SET THIS SERVER AS
STANDBY

Active dual control on

Standby dual control on

Approve Request on
standby fails and issues
message IWNR3016E
with reason code 125
(must connect from
active)

SET THIS SERVER AS
STANDBY

Active dual control off

Standby dual control on

Approve on standby,
and then sync should
complete

Using dual control

You must use the Copy Services Manager GUI to enable or disable dual control requests. You can approve,

reject, cancel, or view a listing of dual control requests in both the GUI and CLI.

Enabling dual control
You can enable dual control using the GUI.

Follow these steps to enable dual control:

1. Log in to the Copy Services Manager GUI as a user with administrator (either Admin or User Admin)

privileges.
2. Click Settings > Administration.
3. Click Enable Dual Control.

Note: If the Enable Dual Control button is disabled, then someone has already enabled dual control.

A request to enable dual control is sent, and appears in the Notifications > Dual Control Requests table.

A second administrator (Admin or User Admin) must approve the request to enable dual control. The
person who requested that dual control be enabled, can also view and cancel the request from the
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Notifications > Dual Control Requests table before it is approved or rejected. See “Canceling a dual
control request” on page 317.

When dual control is enabled, the Enable Dual Control button is not usable until dual control is disabled
again.

Disabling dual control
You can disable dual control using the GUI.

Follow these steps to disable dual control:

1. Log in to the Copy Services Manager GUI as a user with administrator (either Admin or User Admin)
privileges.

2. Click Settings > Administration.

3. Click Disable Dual Control.

Note: If the Disable Dual Control button is disabled, then someone has already disabled dual control.

A message displays indicating that a dual control request was sent. The request then appears in the
Notifications > Dual Control Requests table.

A second administrator (Admin or User Admin) must approve the request to disable dual control. The
person who requested that dual control be disabled, can also view and cancel the request from the
Notifications > Dual Control Requests table before it is approved or rejected. See “Canceling a dual
control request” on page 317.

When dual control is disabled, the Disable Dual Control button is not usable until dual control is enabled
again.
Viewing dual control requests

You can use either the GUI or CLI to view a listing of pending dual control requests.

Viewing dual control requests using the GUI
You can use the GUI to view pending dual control requests.

If there are any pending dual control requests, you will see a number listed on the Notifications tab that
corresponds to the number of pending requests.

Note: Only pending requests are shown. You can only see pending requests that you have the ability to
approve, reject or cancel. As soon as a request is approved, rejected or canceled, it no longer displays in
the table. The console will show the history for previous dual control requests.

Follow these steps to view dual control requests in the GUI:

1. Log in to the Copy Services Manager GUI.
2. Click Notifications > Dual Control Requests to view a table listing the dual control requests.

All the requests that have been created by or require approval from the current user are displayed.

Viewing dual control requests using the CLI
You can use the CLI to view pending dual control requests.
Follow these steps to view pending dual control requests using the CLI:

1. Log in to the Copy Services Manager CLI.
2. Enter the following command: 1sdcrequests-1.
Note: See the Copy Services Manager Command-Line Interface User's Guide for more information

on using the 1sdcrequests command. You can find details on where to obtain this guide in
“Publications and related information” on page xiv.
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All the requests that have been created by or require approval from the current user are displayed.

Approving or rejecting a dual control request

You can use either the GUI or CLI to approve or reject a dual control request.

Approving or rejecting a dual control request using the GUI
You can use the GUI to approve or reject a dual control request.

If there are any pending dual control requests, you will see a number listed on the Notifications tab that
corresponds to the number of pending requests.

Follow these steps to approve or reject a dual control request using the GUI:
1. Log in to the Copy Services Manager GUI.

2. Click Notifications > Dual Control Requests to view a table listing the pending dual control requests.

3. Click Approve for any requests that you want to approve. A confirmation message displays for you to
confirm or cancel the approval. Click Yes to approve or No to cancel. Or you can click Reject for any
requests that you want to reject. A message box displays in which you can optionally enter a reason for
rejecting the request. Click Reject again to reject the request, or click Close to cancel.

Note: If you confirm the approval or rejection, then the request goes away. There is no undo action to
reject a previous approval, or approve a previous rejection.

The request is approved or rejected for the associated action or command, and disappears from the list of
pending requests.

Approving or rejecting a dual control request using the CLI

You can use the CLI to approve or reject a dual control request.

Dual control requests can only be approved or rejected by an Admin or User Admin other than the one
who sent the original request.

Follow these steps to approve or reject a dual control request using the CLI:
1. Log in to the Copy Services Manager CLI.

2. Enter the following command: dcxequestaction, along with the appropriate syntax to approve or
reject the request.

Note: See the Copy Services Manager Command-Line Interface User's Guide for more information
on using the dcxequestaction command. You can find details on where to obtain this guide in
“Publications and related information” on page xiv.

The request is approved or rejected for the associated action or command.

Canceling a dual control request
You can cancel a dual control request that you submitted for approval.

If you submit a dual control request that requires approval, and then want to cancel it before it gets
approved, you can do so. Only the individual who submitted the request can cancel it.

You can cancel a dual control request from the GUI with the Cancel button.

Note: To "cancel" a dual control request from the CLI, you would just use the dcxrequestaction
command to reject it. See the Copy Services Manager Command-Line Interface User's Guide for more
information on using the dcxrequestaction command. You can find details on where to obtain this guide
in “Publications and related information” on page xiv.

1. Log in to the Copy Services Manager GUI.

2. Click Notifications > Dual Control Requests to view a table listing the dual control requests.
3. Click Cancel next to the request that you want to cancel.
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Note: The cancel button appears next to a request only if the logged in user is the requester of the
associated dual control request.

The request is canceled, and disappears from the table of pending dual control requests.

Changing a user password

Only users can change their own passwords.

Administrators cannot change any user passwords except their own. If a user forgets the password, an
administrator must delete the user's access, re-add the user to the basic user registry, and set a default
password that the user can change.

Note: Only users from the basic user registry can change their password. This option is not available to
LDAP users, or users from a z/OS operating system repository, such as RACF.

Users can perform the following steps at the GUI to change their own password:
1. Log on to Copy Services Manager.

2. Locate the user name on the menu bar. Hover over it and click Edit Password. The Edit Password
wizard is displayed.

. Enter a new password in the Password field.
. Retype the new password to confirm.

. Click Next. A message indicates that the password was successfully changed.
. Click Finish to exit the wizard.

o o1 bW

Managing security changes after an upgrade

After you upgrade Copy Services Manager, the upgrade might also include upgrades to internal
components, such as Java.

Secure LDAP

To support a more secure LDAP connection, Java made a change in endpoint validation from relaxed

to strict by default. Unfortunately, any existing LDAP connections that were not configured for endpoint
identification fail if endpoint identification is required. Therefore, by default, Copy Services Manager
disables endpoint identification in Java. This practice ensures that existing LDAP connections that are not
configured for endpoint identification still work and you can continue logging in to Copy Services Manager.

If your LDAP service has been configured for endpoint identification, it is recommend that you re-enable

this Java feature for better security. To reset the Java property after an upgrade, perform the following
steps:

1. Open the JVM.options file.

2. Set the following property to false, as shown:
-Dcom.sun.jndi.ldap.object.disableEndpointIdentification=false
3. Restart the Copy Services Manager server.

Copy Services Manager should be able to reconnect to LDAP servers for user authentication.
Storage system connections
For DS8000 HMC users: Java updates can cause disconnects to DS8000° systems after Copy Services

Manager upgrades if Java disables older encryption algorithms. Contact support to help re-enable the
algorithms.

z/0S over IP connection with self-signed certificates

If you used self-signed certificates to establish a host connection to z/OS over IP before upgrading to
Copy Services Manager 6.2.9, you might need to re-certify and reclaim the certificates to successfully
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connect again after upgrading to 6.2.9. The newer versions of Java (as of version 1.8 -- 8.0.6.10) require a
key tag attribute called CA: TRUE, which is not available from older, self-signed certificates.

Recommended: You should purchase a signed CA to provide an additional layer of security.

« See the IBM Copy Services Manager Implementation Guide (http://www.redbooks.ibm.com/
redbooks/pdfs/sg248375.pdf) Redbooks publication located on the IBM Redbooks website
(www.redbooks.ibm.com/) for more information on how to generate a self-signed certificate in z/0OS.
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Appendix A. Configuration files

This topic provides default file locations for Copy Services Manager configuration files.

The following table shows the default file location for each configuration file.

Configuration file

Default location

bootstrap.properties

« For management server on distributed systems: install

dir\liberty\wlp\usr\servers\csmServer\bootstrap.pr

operties
« For authentication server on distributed systems: install

dir\liberty\wlp\usr\servers\csmAuth\bootstrap.prop

erties

« For management server on
z/0S: path_prefix/opt/IBM/CSM/wlp/usr/sexrvers/
csmServer/bootstrap.properties

« For authentication server on
z/0S: path_prefix/opt/IBM/CSM/wlp/usr/sexrvers/
csmAuth/bootstrap.properties

csmConnections.properties

« For distributed systems: install
dir\liberty\wlp\usr\servers\csmServer\properties

« Forz/OS: path_prefix/opt/IBM/CSM/wlp/usr/servers/
csmServer/properties

diagnostics.properties

« For distributed systems: install
dir\liberty\wlp\usr\servers\csmServer\properties

« Forz/OS: path_prefix/opt/IBM/CSM/wlp/usr/servers/
csmServer/properties

javaoptions.properties

If the javaoptions.properties file preexists in your
environment, it is located in the following directory:

« For distributed systems: install dir\CLI
« Forz/OS: path_prefix/opt/IBM/CSM/CLI

Note: Note: If the CLI/javaoptions.properties file does not
exist, you can create it and define the JAVA_OPTIONS parameter
with your required options.

repcli.properties

« For distributed systems: install dir\CLI
« Forz/OS: path_prefix/opt/IBM/CSM/CLI

rmserver.properties

« For distributed systems: install
dir\liberty\wlp\usr\servers\csmServer\properties

« Forz/OS: path_prefix/opt/IBM/CSM/wlp/usr/servers/
csmServer/properties

Note: You can also access and manually edit the

rmserver.properties file from within the Copy Services Manager

GUI under Settings > Server Properties.
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bootstrap.properties file

Two bootstrap.properties files contain the configuration attributes for the Copy Services Manager
servers. One bootstrap properties file sets the configuration for the management server and another for
the authentication server.

The bootstrap.properties fileis in the following locations on distributed systems:

« Management server:
install_dir\liberty\wlp\usr\servers\csmServer\bootstrap.properties

« Authentication server:
install_dir\liberty\wlp\usr\servers\csmAuth\bootstrap.properties

The bootstrap.properties fileisin the following locations on z/OS systems:

« Management server: path_prefix/opt/IBM/CSM/wlp/usx/servers/csmServer/
bootstrap.properties

« Authentication server: path_prefix/opt/IBM/CSM/wlp/usr/sexvers/csmAuth/
bootstrap.properties

The file contains the following properties:

https_port_var
Specifies the GUI port (for csmServer) or the authentication port (for csmAuth). The port number is
set during installation. However, you can modify this property value to change the port number after
installation.

keystore_id
Specifies a unique configuration ID.

keystore_location_prefix
Simplifies specification of the key ring URL for z/OS. The default value is blank for file-based
keystores.

keystore_location
Specifies an absolute or relative path to the keystore file. If a relative path is provided (for example,
key . jks), the server attempts to locate the file in the csmServer/resources/security directory.

keystore_password
Specifies the password that is used to load the keystore file. The value can be stored in cleartext or
encoded form. An encoded password string is preceded with §xor}.

keystore_type
Specifies a keystore type that is supported by the target SDK. The default value is JKS.

keystore_fileBased
Specifies whether the keystore is based on a file. The default value is true.

keystore_readOnly
Specifies whether the keystore is to be used by the server for read operations only. The default value
is false. The value false indicates that the server can write to the keystore.

ssl_protocol
Specifies the SSL handshake protocol that is used on the HTTPS port for that server. The value
is determined by the Java release and can default to the minimum value (for instance, TLSv1.2)
automatically during upgrade.

Note: You must restart the server for your modifications of the bootstrap properties file to take effect in
the server configuration.

The default contents of each bootstrap.properties file is displayed in the following example.

THHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHE
#This section is for the HTTPS settings of the IBM Copy Services Manager GUI. #
THHHHHHHHHHHHHHHEHHHEHEHHHHEEHEHHHEEEHHHHEEHHHHHEEEHHHHEEERHHHEEEHHHEEEEHHEEEEEE
https_port_var=9559
ssl_protocol=TLSv1.2
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T X
#This section is for the keystore certificate information. This can be #

#changed to match your environment. i
# £
#Note that keystore_location is relative to csmServer/resources/security #
#The keystore_location_prefix is typically left blank for file based i
itkeystores. #

L T 2 T2 2
keystore_id=keystore

keystore_location_prefix=

keystore_location=key.jks

keystore_password={xortHjktbwhvMzkM0iOp0id=

keystore_type=JKS

keystore_fileBased=true

keystore_readOnly=false

HHHHHHHHEHHEHHHEHHEHHEEHHEHHEEHEHHEEHEHHEEHHEHHEEHHEHHEEHHEHEEHHEHEEHHERHEEE
#This section is a sample JCERACFKS certificate keystore configuration that #
jtcan be uncommented and modified to match your environment. #
3 3
#The location must be a safkeyring url syntax with the first qualifier as the #
#IWNSRV and keyring owner and the second qualifier as the keyring name. The #

#saftkeyring url syntax is important, in order to pass it propertly into #
#server.xml, it is split across two properties values. The i
itkeystore_location_prefix is set to "safkeyring:" while the keystore_location #
#is the rest of the safkeyring url. i
i i
#The keystore id and password will be used to create a local keystore with #

#the specified ID and password holding the cached certificate for the GUI. #

Jtkeystore_
{#tkeystore_location_prefix=safkeyring:
itkeystore_location=//CSMUSER/GUIKEYRING
itkeystore_password=password
itkeystore_type=JCERACFKS
itkeystore_fileBased=false
itkeystore_readOnly=true

csmConnections.properties file

The csmConnections.propexrties file contains configuration information about Copy Services
Manager graphical user interface (GUI) and management server connection information.

The csmConnections.properties file is located in the install
dir\liberty\wlp\usr\sexrvers\csmServer\properties directory on distributed systems, and the
path_prefix/opt/IBM/CSM/wlp/usr/servers/csmSexrver/properties directory on z/OS.

The file contains the following properties:

csm.server.address
The domain name or IP address of the Copy Services Manager server. The default value is
localhost.

Tip: This value must match the value of the sexver property in the
install dir\CLI\repcli.properties file on distributed systems, and the
path_prefix/opt/IBM/CSM/CLI/xepcli.properties file onz/0S.

csm.server.port
The client port for the GUI to connect to the management server. The default value is 9560.

Tip: This value must match the install
dir\liberty\wlp\usr\servers\csmServer\properties\rmserver.properties file and
the port property inthe install dir\CLI\repcli.properties file on distributed

systems; and the path_prefix/opt/IBM/CSM/wlp/usr/sexrvers/csmServer/properties/
rmserver.properties file, and the port property in the path_prefix/opt/IBM/CSM/CLI/
repcli.properties file on z/OS.

csm.server.authtype
The authentication type for the GUI to connect to the management server. The default value is
certificate.
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csm.server.keystore
The location of the csmGuiTrust trust file for certificate authentication of the GUI. The default value
is /etc.

csm.server.certificate
The certificate ID. The default value is csmserverdefault.

csm.server.standbyPort
The HTTPS port that is used for a standby management server. Define this property if the active and
standby management servers run on two different GUI ports to ensure that the URL links to the other
management server are valid. For example, if you have an active Windows management server that
uses port 9559 for the GUI and a standby z/OS management server that uses port 33209 for the GUI,
set this property, if you want the GUIs to be able to start the remote GUI.

The default contents of each csmConnections.properties file is displayed in the following example.

Note: The values that are set in this file are case-sensitive and must not contain spaces.

3

# Define the information for connecting to the CSM Server.
3

csm.server.address=localhost

csm.server.port=9560

HHHHHHHHHHHHHHEHHHHHEHHHHHHHERHHHHE R
# CERTIFICATE BASED AUTHENTICATION FROM UI TO CSM SERVER

e e e e L L L e e e e e e L e e e L e L e L e e e e e T T T
csm.server.authtype=certificate
csm.server.keystore=etc/csmTrust. jks
csm.server.certificate=csmserverdefault

Jtcsm.server.standbyPort=

diagnostics.properties file

The diagnostics.propexrties file contains configuration information about Copy Services Manager
log packages.

The diagnostics.propertiesfileisinthe install
dir\liberty\wlp\usr\servers\csmServer\properties directory on distributed systems, and the
path_prefix/opt/IBM/CSM/wlp/usr/sexrvers/csmServer/properties directory on z/OS.

Restart the Copy Services Manager graphical user interface to activate property changes. Properties are
not synchronized between the Copy Services Manager management servers and must be maintained on
each Copy Services Manager management server.

The file contains the following properties:

sourcedir
The source directory to be used to create the Copy Services Manager log package.

targetdir
The target directory where Copy Services Manager log packages are to be created. The
default directory is install dir\liberty\wlp\usr\servers\csmServer\diagnostics
on distributed systems, and path_prefix/opt/IBM/CSM/wlp/usr/servers/csmServer/
diagnostics on z/OS.

javaoptions.properties file

The javaoptions.properties file contains the information that is used by the Copy Services Manager
CLI for Java runtime.

When the javaoptions.properties property file specifies the JAVA_OPTIONS parameter, Copy
Services Manager uses those options when starting Java for the CLI.
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If the javaoptions.properties file preexists in your environment, it is located in the install
dir\CLI\ directory for distributed systems, and the path_prefix/opt/IBM/CSM/CLI directory for
z/0S.

Note: If the CLI/javaoptions.properties file does not exist, you can create it and define the
JAVA_OPTIONS parameter with your required options.

Restart the Copy Services Manager CLI to activate Java property file changes. The Java properties are
valid for all Copy Services Manager CLI users on the modified system.

Some examples of possible options in the javaoptions.properties file include:

Xquickstart
Enables the CLI to start up with a subset of optimizations, which can improve the performance when
invoking the CLI for short operations. Batch jobs initiate individual calls to the Copy Services Manager
CLI, which means that Java has to be started up for each call. This requirement can add to the overall
runtime of the batch job. However, you can use the Java Quickstart option to reduce the Java start
time.

Xmx<value>
Modifies the max memory setting for the CLI. If no javaoptions.properties file is present, the
Xmx value defaults to 512m (512 MB).

Duser.language=<I[>
Specifies the code of a supported language for the Copy Services Manager CLI to use. This parameter
overrides the default language locale setting of the CLI host system.

Copy Services Manager supports the following language locales:
« Chinese - China (zh-CN)

« Czech (cs)

« English (en)

« French (fr)

« German (de)

« Hungarian (hu)

« Ttalian (it)

« Japanese (ja)

« Korean (ko)

« Polish (pl)

« Portuguese - Brazil (pt-BR)
« Russian (ru)

« Spanish (es)

After the javaoptions.properties file is set up, every time the Copy Services Manager CLI is invoked,
the specified Java options are used.

Example: Code sample for a javaoptions.properties file that sets the maximum memory to 1024
MB, specifies Quickstart, and sets the CLI language to English:

# This is the properties file that can be used to add additional options
to the CSM CLI Java runtime without having to update the sh/bat files.

# Add additional options to the parm below separated by a space.
# ex. -Xmx1024m -Xquickstart -Duser.language=en

JAVA_OPTIONS=-Xmx1024m -Xquickstart -Duser.language=en
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repcli.properties file

The repcli.properties file contains the server and port information that is used to communicate with
the Copy Services Manager server and the command-line interface.

The repcli.propertiesfileis locatedinthe install dir\CLI\ directory for distributed systems,
and the path_prefix/opt/IBM/CSM/CLI directory for z/OS.

Restart Copy Services Manager to activate property changes. Properties are not synchronized between
the Copy Services Manager management servers and must be maintained on each Copy Services Manager
management server.

The file contains the following properties:

server
The domain name or IP address of the Copy Services Manager server. The default value is
localhost.

Tip: This value must match the value of the csm.sexver.address property in the

install dir\liberty\wlp\usr\servers\csmServer\csmConnections.propertiesfile
for distributed systems, and the path_prefix/opt/IBM/CSM/wlp/usr/servers/csmServer/
csmConnections.properties file for z/OS.

port

The client port that is used by the CLI to communicate with the Copy Services Manager server. The
default value is 9560.

Tip: This value must match the communications.poxrt property in the rmserver.properties
file that is located in the install dir\liberty\wlp\usr\servers\csmServer)\

directory for distributed systems, and in the path_prefix/opt/IBM/CSM/wlp/usz/
servers/csmServer/ directory for z/OS. And this value must also match the
csm.sexver.port propertyinthe csmConnections.properties fileinthe install
dir\liberty\wlp\usr\servers\csmServer\ directory for distributed systems, and the
path_prefix/opt/IBM/CSM/wlp/usr/servers/csmSexrver/ directory for z/OS.

rmserver.properties file

The rmserver.properties file contains various configuration settings for Copy Services Manager
server.

The default location of the rmserver.properties fileis the install
dir\liberty\wlp\usr\servers\csmServer\properties directory on distributed systems, and the
path_prefix/opt/IBM/CSM/wlp/usr/servers/csmSexrver/properties directory on z/OS.

Note: You can use the chsystem command with the -£ sexrverx parameter to change the properties.

You can also access and manually edit the rmserver.properties file from within the Copy Services
Manager GUI under Settings > Server Properties.

Restart Copy Services Manager to activate the property changes. Properties are not synchronized
between the Copy Services Manager management servers and must be maintained on each Copy Services
Manager management server.

The file contains the following parameters that you might need to customize for your environment:
log.file
The name of the Copy Services Manager server log file. The default value is csmTrace.log.

The newest log file is the name the same as this value. Subsequent log files have a number that is
appended to the file name. For example, csmTracel.log and csmTrace2.log.

This log file isinthe install dir\liberty\wlp\usr\servers\csmServer\logs\CSM
directory on distributed systems, and the path_prefix/opt/IBM/CSM/wlp/usxr/sexrvers/
csmServer/logs/CSM directory on z/OS.
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log.file.maxFiles
The maximum number of Copy Services Manager server log files that are created before old log files
are overwritten. The default value is 50.

log.file.maxFileSize
The maximum size, in KB, of each Copy Services Manager server log file. The default value is 10240.

communications.port
The client port that is used by the GUI and CLI to communicate with the Copy Services Manager
server. The default value is 9560.

Tip: This value must match the poxt property in

the install dir\CLI\repcli.properties fileandthe install
dir\libery\wlp\usr\servers\csmServer\properties\csm.Connection.properties
file on distributed systems, and it must match the

porxt property in the path_prefix/opt/IBM/CSM/CLI/xrepcli.properties

file and the path_prefix/opt/IBM/CSM/wlp/usr/servers/csmServer/properties/
csmConnection.properties file on z/OS.

communications.haPort
The standby management server port that is used for communication between the active and standby
management server. The default value is 9561.

csm.server.snmp_community_string
The SNMP community name. The default value is public.

csm.server.sus_gc_pairs_on_gm_pause
A flag that indicates whether to suspend the Global Copy pairs when a Global Mirror session is
suspended. The valid values are true and false.

csm.server.suspend_all_shared_gm_sessions
A flag that indicates whether to keep all shared Global Mirror sessions in a suspended state and not
restart the sessions automatically, when the Suspend command is issued. The valid values are true
and false.

db.backup.location
The directory that is used by the mkbackup command to store a backup copy of
the IBM Copy Services Manager database. By default, the backup file is stored in
the install dir\liberty\wlp\usr\servers\csmServer\database\csmdb directory for
distributed systems, or in the path_prefix/opt/IBM/CSM/wlp/usr/servers/csmServer/
database/csmdb directory for z/OS.

server.logpackages.maxpackages
The maximum number of log packages that is maintained by the server.

server.backup.maxbackups
The maximum number of backups that is maintained by the server.

csm.server.notification.sender.address: <email address>
Specifies the email address from which to send outgoing email alerts. By default, outgoing email
alerts are set to come from the generated email address csmServer@<server hostname>. However,
for some SMTP server software or configurations, this email address is not accepted. Therefore, you
can change the outgoing server email address to something that meets the requirements of your
environment.

csm.server.ldap.enabled
Enables LDAP in your environment when set to true.

Note: The default value for csm.sexver.ldap.enabled is set to false for z/OS systems and true
for distributed systems.

com.ibm.csm.<sessionName>.<rolepair>.userpfc
Specifies which of the Metro Mirror relationships for the Preserve Mirror feature to use. When the
Metro Mirror pairs are established or failed over, any pairs that are marked with this property are
set up so that when the source is flashed the Preserve Mirror feature knows to use these pairs.
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For example, setting the property to com.ibm.csm.MySess.H1-H2.userpfc indicates that session
"MySess" and the role pair "H1-H2" to be used for Preserve Mirror.

Notes:

« This property default is set to false. It must be set to true to enable the option on the role pair.

« Use underscores to indicate any spaces in the property setting. For example, for the session
"MySess" you would specify My _Sess in the property.

com.server.svc.fc.cleanrate=<cleanrate>

com.server.svc.fc.cleanrate.<sessionName>=<cleanrate>
A cleaning rate can be specified for a FlashCopy session (or a session that contains a FlashCopy
sequence) that is independent of the background copy rate. The clean rate controls the rate at which
the cleaning process operates. The cleaning process copies data from the target volume of a mapping
to the target volumes of other mappings that depend on this data.

Notes:

« For older storage systems that run IBM Spectrum® Virtualize, the <cleanrate> range is 0-100. For
new storage systems at release 7.8.1 and higher, the range is 0-150. If this property is not specified,
the default rate is 50. For more information on the clean rate, see your storage system user guide.

« This property is only valid for storage systems that run IBM Spectrum Virtualize. If a <sessionName>
is not specified, the cleaning rate value is applied to all FlashCopy sessions, and sessions that
contain a FlashCopy sequence, for storage systems that are running IBM Spectrum Virtualize.

csm.auto.restart.after.swap=<true>
After a swap occurs, this option automatically restarts replication from the site that was swapped to,
to the alternative site without user intervention.

When HyperSwap is enabled on multi-target sessions with Metro Mirror relationships, by default a
HyperSwap command or event results in all I/O being swapped to the Metro Mirror secondary. And
then the Copy Services Manager session moves to a Target Available state.

After the swap, no replication occurs, and a manual Staxrt command must be issued for replication to
run again.

If HyperSwap is enabled on the role pair that is automatically started, as soon as all pairs in the role
pair reach a Prepared state, the HyperSwap configuration is automatically loaded as well. This option
helps to ensure that replication is started quickly after a HyperSwap command or event to provide
continual disaster recovery and high availability needs.

When this option is set, synchronization starts automatically, which causes the alternative site to be
inconsistent until all pairs in the role pair reach a Prepared state.

com.ibm.csm.zconsole.logging=none (default) | all | exrox
Specifies the standard out logging level to the syslog, where the possible values are none, all, or error.

« When none is specified, Copy Services Manager does not log to the syslog at all (default).
- When all is specified, Copy Services Manager logs all I, W, and E messages to the syslog.
« When error is specified, Copy Services Manager logs all W and E messages to the syslog.

Example: To log all messages

com.ibm.csm.zconsole.logging=all

com.ibm.csm.zconsole.logging.includechildren=txue | false (default)
Specifies whether to log child messages to the syslog or not. By default, only high-level messages are
logged. Child messages are not logged. Use this property setting to override this behavior and enable
child messages to be logged.

Notes:
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- Be aware that setting the logging to all messages, including the child messages, can result in a large
number of messages. Only set the includechildxen property to true when it is important to see
the child messages.

« When you set the includechildxen property to true, all child messages are printed to the
syslog, including any in the excludedmsgs list, as discussed next.

Example: To log all child messages

com.ibm.csm.zconsole.logging.includechildren=true

com.ibm.csm.zconsole.logging.excludedmsgs=<messages to exclude in comma-separated list>
Specifies which messages to exclude from writing to the syslog, where the values are a comma-
separated list of message IDs. Any ID in the list does not appear in the syslog.

Note: The excludedmsgs property is only for parent messages.

Example: To exclude the IWNR1028I and IWNR6000I messages from being logged:

com.ibm.csm.zconsole.logging.excludedmsgs=IWNR1028I, IWNNR6OOOI

csm.disable.mm.mode.sessionname=true | false (default)
Specifies whether to disable Metro Mirror mode, where session_name is the name of the session on
which you want to disable it or not. This property affects Metro Mirror Failover/Failback sessions only.

« Replace any spaces in session_name with an underscore symbol ("_").
« This property is case-sensitive.

Note: If you do not see the option take effect right away in the GUI, you can either restart the Copy
Services Manager server, or issue a command, such as Stop, to have the GUI refresh the available
commands list.

Example: To disable Metro Mirror mode in session "My MM:"

csm.disable.mm.mode.My_MM=true

csm.percent.complete.warning.threshold=<pexcent from 0-100> | O (default)
Specifies the percent of completion of a Global Copy session before a warning is issued. This property
affects Metro Mirror Failover/Failback sessions only, and after a StaxtGC H1->H2 or StaxrtGC H2-
>H1 command. The percentage (<percent from 0-100>) option must be an integer in the range O -
100.

- If the current progress on the session is less than or equal to the value specified in the property,
then a warning status message appears on the session, and the session stays in a Preparing or
Warning state.

- If the progress is greater than the value specified in the property, then no status message
(IWNR2768W) displays, and the session shows Preparing or Normal status.

» The status message that appears:
IWNR2768W
[May 21, 2020 3:43:49 PM] Session MM and role pair H1-H2 is at or below
the warning threshold of x percent complete.

Example: A session is started with the StaxtGC H1->H2 command. The percent complete specified
is 80. While the progress for the session shows anything in the range 0 - 80, the session shows
Preparing or Warning with a status message. When the progress is 80% or greater, the status message
goes away, and the session goes into Preparing or Normal state.

csm.percent.complete.warning.threshold=80
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Appendix B. Using the system logger in a Copy
Services Manager environment

The system logger is an IBM z/0S component that provides a logging facility for applications running in a
single-system or multisystem sysplex. There are many factors to consider when you are using the system
logger in a IBM Copy Services Manager environment and are using Metro Mirror sessions.

Configuring the system logger for use in the Copy Services Manager
environment

When the system logger is used in an IBM Copy Services Manager environment, steps must be taken to
avoid data consistency issues.

The following situations can lead to data consistency issues when using Copy Services Manager with the
system logger:

« The Release I/0 after Suspend option has been selected for a Metro Mirror session.

« The system logger couple data sets (CDSs) are not part of the Metro Mirror session. In this situation, the
data sets are not frozen even though the related application secondary volumes have been frozen.

« The system logger log streams use coupling facility (CF) structures.
- After a suspend event, the primary site fails and you must recover at the alternate site.

If the secondary disks in the Metro Mirror session are frozen and the workload continues to run using
the primary disks, the data on the secondary disks is out of sync with the CF structures or the CDSs. If
you attempt to restart the applications using the frozen secondary disks, the restart fails because of this
inconsistency. For example, Customer Information Control System (CICS) require a cold start instead of
an emergency restart, and transaction backout and handling of in-doubt transactions are not possible.

If Release I/0 after Suspend has been selected for Metro Mirror sessions, the actions that are shown in
Figure 21 on page 332 are required.
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Figure 21. Planned swap

1. In the system logger policy, all CF log streams must be forced to duplex to staging data sets. The
following data sets must be in the same Metro Mirror session:

« Log stream staging data sets that are direct access storage device (DASD)-only
 CF log stream data sets
« All of the offload data sets for both types of log streams
2. Four system logger CDSs must be set up as follows:
« The primary system logger CDS in Site 1 must be in the same Metro Mirror session.
« The spare system logger CDS in Site 1 must not be in a Metro Mirror session.
« The alternate system logger CDS in Site 2 must not be in a Metro Mirror session.
» The spare system logger CDS in Site 2 must not be in a Metro Mirror session.
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Set up all CDS types other than the system logger CDSs as required for Copy Services Manager. That is,
the primary system logger CDS should be in Site 1 and the alternate system logger CDS in Site 2. There
should be spare CDSs in both sites. The alternate and spare CDSs should be not be in a Metro Mirror
session.

By following the preceding steps, the primary system logger CDS, CF log stream staging, and offload data
sets are on volumes in the Metro Mirror session. If a freeze occurs, system logger data will be consistent
on the secondary devices. If the reason for the freeze requires that you restart from the secondary
devices, you can recover and use this frozen copy of the system logger environment.

Important: Ensure that no CF log streams remain allocated in any coupling facilities that the production
systems have access to following a disaster. In this situation, recovery occurs from the mirrored copies
of the data. If any log streams are allocated, you must force the connections and ensure the structure is
deleted before restarting your production systems.

Reintroducing frozen system logger CDSs into your sysplex

In the event that CDSs become frozen, you can correct the issue that resulted in the freeze and re-
introduce the CDS into your sysplex.

Reintroducing CDSs after an unplanned swap

After a suspend event, the secondary disks are frozen and you cannot access the disks. To recover at
the secondary site, you must make the disks accessible by using IBM Copy Services Manager to initiate
a recover. The Recover command performs the steps necessary to make the target available as the new
primary site. Upon completion of this command, the session is in the Target Available state.

If the active Copy Services Manager server was located at Site 1, and the system the server was running
on failed, you must use your standby server to recover. Issue the Takeover command, before initiating the
Recover command.

When the session is in the Target Available state, the systems at Site 2 can be restarted using the Site 2
volumes.

Switching Disks Back to Site 1 After an Unplanned Failover to Site 2

To switch disks back to Site 1, see the information about switching from Site 2 to Site 1 in the following
sections.

Reintroducing CDSs after a planned swap
Typically, you perform a planned switch from Site 1 to Site 2 for one of the following reasons:

« The Site 1 disk is temporarily unavailable because of a disruptive disk maintenance action.
- Site 1 is temporarily unavailable in its entirety because of a site maintenance activity.

In these situations, switch the disks to Site 2. When the Site 1 disk is available again, switch back to the
Site 1 disk when you have the Site 2-to-Site 1 mirroring in full duplex.

Considerations for a Planned Metro Mirror Swap

When the system logger CDS is part of the Metro Mirror session and you plan to switch your primary disks
from Site 1 to Site 2, you must complete the following tasks to release the allocation against the system
logger CDS:

1. Switch to the system logger CDS that is not in the Metro Mirror session (that is, make the Site 2
alternate system logger CDS the new primary system logger CDS) by issuing the following command:

SETXCF COUPLE, TYPE=LOGR, PSWITCH
2. Make the Site 2 spare CDS the new alternate data set by issuing the following command:

SETXCF COUPLE,TYPE=LOGR,ACOUPLE=(spare cds in site 2)
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When you switch back from Site 2 to Site 1, switch the Metro Mirror direction and then perform a CDS
switch to return to the normal CDS configuration. After you switch the Metro Mirror session direction,
perform the following actions to switch the CDS:

1. Make the primary at Site 1 the alternate by issuing the following command:
SETXCF COUPLE,TYPE=LOGR,ACOUPLE=(original primary cds in site 1)
2. Make the original primary the primary again using the following command:
SETXCF COUPLE, TYPE=LOGR, PSWITCH
3. Make the original alternate CDS at Site 2 the alternate again using the following command:
SETXCF COUPLE,TYPE=LOGR,ACOUPLE=(original alternate cds in site 2)
Considerations for Planned HyperSwap

If you are using Copy Services Manager planned HyperSwap capability and you have your system logger
CDSs mirrored, when swapping disks from Site 1 to Site 2, switch your CDS configuration to use only Site
2 CDSs before running the SWAP command to perform the disk swap. When swapping back to the Site 1
disks, use the normal CDS configuration after the HyperSwap has completed successfully.
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Appendix C. Accessibility features for IBM Copy
Services Manager

Accessibility features help users who have a disability, such as restricted mobility or limited vision, to use
information technology products successfully.

Accessibility features
The following list includes the major accessibility features in IBM Copy Services Manager:

« Keyboard-only operation

Interfaces that are commonly used by screen readers

Keys that are discernible by touch but do not activate just by touching them
 Industry-standard devices for ports and connectors

The attachment of alternative input and output devices

Keyboard navigation

Use the following key combinations to navigate the interface by keyboard:
« To go directly to the topic pane, press Alt+K, and then press Tab.

- In the topic pane, to go to the next link, press Tab.

« To go directly to the Search Results view, press Alt+R, and then press the Enter or Up-Arrow key to enter
the view.

« To go directly to the Navigation (Table of Contents) view, press Alt+C, and then press the Enter or
Up-Arrow key to enter the view.

- To expand and collapse a node in the navigation tree, press the Right and Left-Arrow keys.
« To move to the next topic node, press the Down-Arrow or Tab key.

« To move to the previous topic node, press the Up-Arrow key or Shift+Tab.

 To go to the next link, button, or topic node from inside on of the views, press Tab.

« To scroll all the way up or down in a pane, press Home or End.

 To go back, press Alt+Left Arrow; to go forward, press Alt+Right Arrow.

 To go to the next pane, press F6.

« To move to the previous pane, press Shift+Fé6.

« To print the active pane, press Ctrl+P.

IBM and accessibility

For more information about IBM's commitment to accessibility, see the IBM Human Ability and
Accessibility Center website at =* http://www.ibm.com/able.
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Notices

This information was developed for products and services offered in the US. This material might be
available from IBM in other languages. However, you may be required to own a copy of the product or
product version in that language in order to access it.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product, program, or
service that does not infringe any IBM intellectual property right may be used instead. However, it is the
user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can
send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive, MD-NC119
Armonk, NY 10504-1785

us

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM Intellectual
Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law

IBM Japan Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for convenience only and do not in
any manner serve as an endorsement of those websites. The materials at those websites are not part of
the materials for this IBM product and use of those websites is at your own risk.

IBM may use or distribute any of the information you provide in any way it believes appropriate without
incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Director of Licensing

IBM Corporation

North Castle Drive, MD-NC119
Armonk, NY 10504-1785

us
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Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by
IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any
equivalent agreement between us.

The performance data discussed herein is presented as derived under specific operating conditions.
Actual results may vary.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products

and cannot confirm the accuracy of performance, compatibility or any other claims related to non-
IBMproducts. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

This information is for planning purposes only. The information herein is subject to change before the
products described become available.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to actual people or business enterprises is
entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs
in any form without payment to IBM, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the operating platform

for which the sample programs are written. These examples have not been thoroughly tested under

all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these
programs. The sample programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative
work must include a copyright notice as follows:

© (your company name) (year).

Portions of this code are derived from IBM Corp. Sample Programs.
© Copyright IBM Corp. _enter the year or years_.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.

Privacy policy considerations

IBM Software products, including software as a service solutions, (“Software Offerings”) may use cookies
or other technologies to collect product usage information, to help improve the end user experience,

to tailor interactions with the end user, or for other purposes. In many cases no personally identifiable
information is collected by the Software Offerings. Some of our Software Offerings can help enable you
to collect personally identifiable information. If this Software Offering uses cookies to collect personally
identifiable information, specific information about this offering’s use of cookies is set forth below.

This Software Offering does not use cookies or other technologies to collect personally identifiable
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